
D
ra

w
in

g 
by

 A
lla

n 
O

m
m

er
li

Yo
u 

ca
n 

dr
aw

 th
e w

or
ld PowerCADDTM

5/10/2018



Version 9.5

M
at

t A
rn

ol
d

Alas, Whip, the PowerCADD Plugger has gone political on us.  SAD!



i

Introduction
Acknowledgements

Symbols The following symbols are used in this manual to highlight special 
information:

NOTE: Indicates a special note.

TIP: Indicates a tip.

CAUTION: Alerts you to give this special caution.

Tells where to find more details about a particular subject.

💬💬

💡💡

⚠

👍👍❤ !

❗ 👌👌!

🎖🎖 🕺🕺 🚫🚫

🔔🔔 😀😀 🙂🙂

And in this wonderful new world of social media, we’ve included a few 
things to alert you to user favorites, much loved features and other emotional 
reactions.

Anything in red is probably obsolete and needs checking.

Anything in green needs a hyperlink on the page.

How to Read This Document
This manual is an interactive PDF that acts in some ways like a book and also like a program, with links that 
will take you from one page to another.  

To operate properly within PowerCADD, the document name must be:

PowerCADD™ Documentation.pdf

And it must be installed in the PowerCADD Documentation directory, specifically:

Applications/PowerCADD 9/Documentation/PowerCADD™ Documentation.pdf

Please feel free to download and install this manual on an iPad where it will be an excellent reference easily 
viewed and navigated in iBooks, Adobe Acrobat or any other PDF viewer app, however some features of the 
interactive PDF will not work on an iOS device such as the Previous and Next page buttons, and any links to 
another PDF such as to the PowerCADD Documentation or Tutorial.  

This manual can be downloaded to your iPad from

http://www.seqair.com/WildTools/Documentation/Docs.html

!

http://www.seqair.com/WildTools/Documentation/Docs.html
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This chapter is organized around five major headings:

o	 Tool palette
o	 Drawing tools
o	 Dimensioning tools
o	 Symbol tools
o	 Modifier tools
o	 Notation tools

Thus, if you want to find information on a tool, refer to the Tool palette 
section of this chapter.  Similarly, the rest of the tools are organized in this 
chapter as they appear in the Tool palette.

NOTE: Pressing the mouse button while on any tool will display the entire 
tool palette.  If Tool Tips are enabled, holding your mouse over a tool will 
display its name.  Control- or right-click anywhere on the tool palette and 
select the Change Palette Orientation menu item to switch between vertical 
or horizontal palette orientations.

NOTE: Select the Commands tab in the PowerCADD Preferences dialog 
to assign a custom key command to any tool in the palette.

Tool Palette

💬💬

💬💬

Tools

Anchor
[TheToolPalette]
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Also, see Preferences for more information on Enabling Tool Tips and
Tool Preferences for personalizing your drawing environment.

The Tool palette is the portion of the PowerCADD drawing environment 
that holds the various drawing tools available to you.  These tools permit 
you to draw objects such as lines, arcs, ellipses, circles, rectangles, polygons, 
as well as freehand shapes and dimensions.  The tools are represented by 
icons symbolizing their function and purpose. 

To customize the settings of a tool palette:
o	 Press the Control key and click anywhere in the palette.
o	 Choose Palette Settings from the Contextual menu.  The following 

dialog will appear:

o	 Make the desired setting changes and click Done.

The palette settings for each tool palette may be adjusted independently.

Being able to independently adjust the settings for each tool palette provides 
you a great deal of flexibility in customizing your workspace. 

Given the frequency with which tool palettes are accessed during a typical 
drawing session, auto-fade has been turned off as a default setting.  To 
avoid disrupting your work-flow, we recommend leaving auto-fade turned 
off until you become familiar with PowerCADD and with the auto-fade 
feature for tools and floating windows.

!
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NOTE: The normal state for a tool palette is determined by the Window 
Opacity setting.  A tool palette that has faded on screen will automatically 
return to its normal state when you move the mouse over the palette.

The ability to turn Auto-Fade on or off for a tool palette is controlled by 
the Window Fading Preference settings.  If the Auto-Fade settings are 
dimmed as shown on the left:
o	 Choose Preferences from the PowerCADD menu.
o	 Select the General tab. 
o	 Select the Window Fading box to turn it on. 
o	 Click OK.
o	 Try to set the Auto-Fade settings for the floating window again as 

described earlier.

PowerCADD’s modular design permits loading of External plug-in tools 
which may be appended to the main PowerCADD tool palette or appear as 
a stand-alone tool palette.  If your tool palettes do not appear the same as 
the images shown in this manual or if you do not see a tool or tool palette 
mentioned here, it is possible you have not loaded the correct External.

Also, see Loader Preferences  for more information on loading and managing 
External plug-ins.

With experience, you will quickly become adept at selecting the appropriate 
tool to use for the task you wish to accomplish.  Tools are activated by 
clicking on them, and stay active until another tool is selected.  The Return 
or Enter key will select the last tool used.

External Tools

About the Palette Tools Once a palette tool has been selected, it remains active, or selected, until it 
is deselected. 

Once you select a tool from the tool palette and draw an object, you do not 
have to select the tool again in order to draw more of the same objects.  This 
feature gives you greater efficiency compared to other drawing programs, 
which force you to return to the palette when you wish to use the same tool 
repeatedly. 

Also, see Tool Preferences for more information on customizing the behavior 
of tool fallout and general tool behavior.

💬💬

!
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Each palette tool has its own set of default attributes, such as line weight, fill 
pattern, and color.  These default attributes are independently assigned to 
each palette tool and remain in effect until you change them. 

The default attributes for tools also include Transparency for Pen and Fill 
settings.  See Attributes in the Menu section for more information on 
working with the Attributes floating window.

PowerCADD includes a Preference setting allowing you to assign Global 
Tool attributes.  Please see Global Attributes for additional information.

Deep Zoom Deep zooming and zoom on the fly while drawing is available when using 
the preset key commands and any drawing tool.

To use Deep Zooming and Zoom on the Fly while drawing:
o	 Select any tool in the tool palette (e.g. the Selection Arrow tool).
o	 Press the 1 key to zoom in.
o	 Press the 2 key to zoom out.
o	 Press the 3 key to return to a previous zoom level.

The current mouse location is the center of the zoom-in or zoom-out 
operation.

To zoom on the fly while drawing:
o	 Select any tool in the tool palette (e.g. the Line tool)
o	 Drag to start the drawing operation.
o	 Press the 1 key

	 The drawing will zoom in; the current mouse location is the center of 
the zoom operation.

o	 Press the 2 key to zoom out.

	 You may cycle back and forth between zooming in and out.

o	 Release the mouse when the desired zoom is reached to complete the 
drawing operation.

Zooming in and out on the fly while drawing works with click-drag, click-
click, hybrid click-click tool settings as specified in the Tool Preferences Tab 
of the PowerCADD menu.

Zoom on the Fly

Anchor
[DeepZoom]

[ZoomOnTheFly]

!
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While deep zoom percentages can exceed 200,000,000, most objects will 
become illegible before that zoom level is reached.  At approximately 20,000 
times zoom WYSIWYG (What You See is What You Get) line weights are 
disabled and all objects are rendered to screen at one point. 

Their true WYSIWYG line weight is displayed again when the zoom level 
is less than approximately 20,000 times.  If the drawing is set up to show 
rulers, tick marks in the rulers are not displayed when the zoom percentage 
exceeds approximately 6400 times (ruler tick marks are displayed again 
automatically when zooming out to less than approximately 6400 times).

Also, Scroll Wheel zooming with your mouse (or touch pad on a laptop) is 
also available on the fly while drawing. See Tool Preferences Mouse Wheel 
Options for additional information.

A tool’s default attributes are changed by selecting the tool in the palette 
and then choosing the desired line type, fill pattern, and colors from the 
appropriate menus.

If an object is selected before a default attribute is changed, then only that 
object’s attributes are changed.  If only the tool is selected, then the selected 
tool takes on the new attributes.

All new objects drawn with a palette tool retain the current tool settings 
and defaults.  The settings are saved as defaults for the palette tools in the 
drawing.  You can create a drawing template of your settings and defaults by 
using PowerCADD’s Stationery feature explained later in the Menu chapter.

NOTE: Previously drawn objects are not affected by palette default changes 
and maintain their original default characteristics until selected and 
changed.

To change the default attributes for an individual palette tool:
o	 Double-click a palette tool.

	 This will deselect all objects and select the tool.

	 Tool defaults cannot be changed if an object is selected in the drawing area.

o	 Control-click on the desired tool in the palette.
o	 Choose the desired default settings from the contextual menu.

The selected attributes will remain active until changed by following this set 
of procedures again.

Change a Tool’s 
Default Attributes

💬💬

Anchor
[ChangeToolDefaultAttr]
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To change the default attributes for all palette tools:
o	 Double-click a palette tool.
o	 Control-click on the desired tool in the palette.
o	 After the contextual menu appears, release the Control key and hold 

the Shift key.  Choose the desired default settings from the contextual 
menu. 

The selected attributes will remain active until changed by following this set 
of procedures again.

Change an Object’s 
Attributes Only

To change an object’s attributes without changing the default 
attributes of the palette tool:
o	 Select the object(s) in the drawing.
o	 Control-click on a selected objects and choose the desired option 

changes from the contextual menu.

The selected options will apply only to the object selected and not to the 
palette tool.

NOTE: Using a contextual menu to change the attributes of an object in 
the drawing, the default attributes, or the default attributes of all palette 
tools is only one method.  You can also change attributes by choosing items 
from the Attr menu or by choosing items in the Attributes floating window.

NOTE: To set text default sizes and fonts for the Text and Leader Line tools, 
double-click the Text or Leader Line tool, then Control- or right-click and 
choose the desired font attributes from the contextual menu.  To set text 
default sizes and fonts for Dimension tools, double-click any dimension 
tool, then Control- or right-click and pick the desired font attributes from 
the contextual menu.

💬💬

💬💬



Tools8

Selection Tools

Being able to quickly and easily select objects and navigate in your drawing is 
critical to efficient drawing production, management and editing. The first 
row of the tool palette contains tools for selecting objects and navigating 
in the drawing window. This section provides an overview of the tools and 
important techniques to speed up your workflow.

Before we discuss the specific selection tools, let’s review fundamental 
aspects of selecting objects in PowerCADD that affect all tools.

The Selection Filter floating window allows you to specify the type of 
objects to be selected.  This becomes particularly important when working 
in drawings containing large numbers of objects or when working in a busy 
drawing area.

To open the Selection Filter Window choose Selection Filter from the 
Window menu or select Selection Filter in the Anchor Window.

Selection Filter 
Floating Window

The checkboxes allow you to specify the objects to be selected.  By choosing 
only those objects you want to select, you may work with ease in busy areas 
of the drawing without fear of moving or deleting other objects.

o	 Check the boxes corresponding to the objects you wish to select. 
Unchecked object types cannot be selected.

o	 The objects checked on in the Selection Filter window will be the only 
items selected regardless of the method of selection.

Selection Filter settings have unlimited potential to save significant amounts 
of time. For example, if it became necessary to change all the arcs to a fill 
pattern in a large drawing, it would be extremely tedious to visually locate 
and manually select each arc.  By setting the Selection Filter to Arcs only, 

Anchor
[SelectionFilterWindow]



Tools9

you may perform a Select All and change every arc in a matter of seconds 
rather than minutes.

CAUTION: Selection Filter settings do not see inside a Group or Symbol 
when performing a Select All operation.  For example, setting the Selection 
Filter to Arcs only and performing a Select All would only select Arcs which 
are NOT inside a Group.

Selection Filter settings also apply when using the Select Special… menu 
item, the Magic Wand Tool, and Edit All Layers.  See Menu chapter for 
additional information on Edit All Layers.

CAUTION: Only Vertex and Align snapping will work for unchecked 
objects in the Selection Filter window. 

⚠

⚠

Forms of Selection 
Available

PowerCADD offers many different forms of object selection.  You may 
select single objects, multiple objects, objects in a specific area, random 
selection, and Select All.

To select any object, simply place the cursor on the object and click.  If the 
object is filled, click anywhere inside the perimeter of the object.  If the 
object is not filled, select the perimeter of the object.

The Shift key allows you to add or subtract from the set of currently selected 
objects regardless of the method of selection used.

o	 Press the Shift key.
o	 Click on each object to be selected.
o	 To deselect a selected object, select it again.

Various methods of selecting objects exist including tools, menu items and 
combinations thereof and no single method will address every drawing 
situation.  While we’ll cover the basic operation of the selections tools here, 
it is worth experimenting with how all the selection features described 
earlier integrate with how the selection tools operate.

!
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Selection Arrow Tool
The Selection Arrow tool allows you to use cursors to select objects in the 
drawing area in order to change or move them, to choose items from the 
menu, and to select tools from the drawing palette.

The Selection Arrow tool is one of the most frequently used tools from 
the Tool palette and must be understood thoroughly in order to master 
PowerCADD.

The Selection Arrow cursor is primarily used to select tools from the Tool 
palette, to choose commands and options from the Menu bar, and to use 
the scroll bars. 

In addition, when the Selection Arrow cursor is moved to the drawing area, 
it becomes a Selection cursor for selecting an object or group of objects 
from the drawing for further editing, changes, or movement.  The Selection 
cursor will change states to reflect the current operation as described below.

In the palette area, or when choosing menu items, the Selection cursor is 
an arrow.

When the Selection Arrow cursor is moved to the drawing area, it becomes 
a large crosshair cursor, or simply a Selection cursor.

When the Selection Arrow cursor is moved to the drawing area and you 
perform a click and drag operation, the cursor changes to a Selection 
Marquee cursor.

When the Option key is pressed when dragging an object the duplication 
cursor appears.

When drawing tools are selected, the Selection Arrow cursor converts to a 
Drawing cursor when moved into the drawing area.

The Move cursor appears when dragging or moving objects.

The Target cursor is used to place objects, establish a rotation point, or place 
a dynamic radius.  Generally the Target cursor is used when you need to 
show PowerCADD where something should be placed.

NOTE: Autoscroll feature: When you attempt to move the Selection 
cursor beyond the screen but where paper still exists, PowerCADD will 

Selection Arrow Cursor

Selection Cursor

Selection Marquee Cursor

Duplication Cursor

Drawing Cursor

Move Cursor

Target Cursor

💬💬
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automatically scroll the screen to accommodate your action.  This Autoscroll 
feature makes it easy for you to draw objects larger than the screen without 
the inconvenience of having to stop your drawing, scroll manually to 
another part of your paper, select the object, and then resize it.  By moving 
the cursor farther off the page, you will increase the speed at which you 
autoscroll. This will allow you to move rapidly across a large drawing. 

Any time an object is selected or not selected, visual confirmation is 
provided as illustrated here.

Notice the small squares (handles) at each of the corners and mid points 
of the circle.  The handles are the limits of the objects bounding box and 
may be grabbed using the Selection cursor to resize the selected object(s).  A 
bounding box is the smallest rectangular area that will completely enclose 
an object’s geometry.  The sides of the bounding box are always oriented 
parallel to the horizontal and vertical axes.

Once active, the object can then be changed.  Resizing, stretching, shrinking, 
or filling an object with a pattern are examples of a change. 

In addition to displaying handles, you can also have selected objects 
highlight in any color you choose. See View Preferences on customizing 
how selected objects are displayed on screen.

You can adjust the size of the handles. See View Preferences in the Menu 
chapter for additional information on adjusting the size of the handles.

The Selection cursor allows you to select objects by clicking on items as 
previously discussed, or by performing a click and drag to define a selection 
marquee.

!

!
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When picking objects using a selection marquee the following rules 
apply:
o	 All objects touching the marquee are selected.  In this example only the 

line and circle are selected because the gray selection marquee touched 
only those objects. Notice there are no handles shown for the arc, only 
for the circle and line.

o	 Press the Command key and only objects completely inside the 
marquee are selected.

	 The marquee becomes transparent instead of a gray fill when holding  
the Command key.  In this example, only the arc is selected because it 
is entirely inside the selection marquee.

See Tool Preferences for information on how to reverse the behavior of the 
Select by Touching versus Select Enclosing process.

NOTE: You cannot change an object without first selecting it using any of 
the selection tools, selection menu items, or any combination thereof.

💬💬
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To select a line or an arc:
o	 Select the Selection Arrow tool from the Tool palette.
o	 Move the cursor to the object you want to select.
	
	 As you move the cursor from the palette area to the drawing area, the 

Selection Arrow cursor changes into a Selection cursor as the following 
shows.

	 Click on the perimeter (edge) of an object with no fill to select it.

	 Click anywhere inside or on a filled object to select it.

How to Select 
an Object

NOTE: Release the mouse button when you select an object.  Otherwise 
the selection cursor will turn into a Move cursor.  If this happens, don’t 
panic—just release the mouse button.  If you accidentally move the object 
simply choose Undo from the Edit menu to return the object to its previous 
position.  The Move cursor is shown to the left.

💬💬

Move Cursor

How to Select all 
Objects in a Drawing

To select all objects in the current layer of the drawing:
o	 Choose Select All from the Edit menu.

You will notice each of the drawing’s objects have their handles activated.

CAUTION: Be aware when you use the Select All command; you are 
selecting all objects in the currently selected layer whether the objects can 
be seen in the present window or not.  Any commands issued subsequent to 
Select All will affect each object on the active layer of the drawing.

CAUTION: If you have Edit All Layers turned On, you are selecting all 
objects on all visible layers.

See Select All for more details.

⚠

⚠

!
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To deselect all objects in the current layer of a drawing, that is, to 
select no objects at all: 
o	 With the Selection cursor, click in a blank, empty space in the drawing.

o	 Double-click on a palette tool.
–or–
o	 Choose Deselect All from the Edit menu.
 

Deselect All 
Objects

To move an object:
o	 Use the Selection cursor to select the object you wish to move, and 

continue to hold the mouse button.  It is important not to release the 
mouse button at this time.

o	 As you hold the mouse button on an object, the Selection cursor turns 
into a Move cursor.

o	 While continuing to hold the mouse button, drag the object to the 
desired location.

How to Move 
an Object

If you move the object past the boundaries of the current window, the 
Autoscroll feature will move the document for you within the limits of the 
current page size.

NOTE: Reference the Move Object Tool discussed later in this section for 
additional information on selecting and moving an object.

NOTE: Dynamic Snapping is also in effect at both the start and end of a 
move by drag operation.  The Shift key may also be used to constrain the 
move by drag operation to either the X or Y axis.

To move an object (or all selected objects) but constrain the move in 
only the vertical orientation, do this:

Move Cursor

💬💬

💬💬
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To move an object (or all selected objects) but constrain the move in 
only the horizontal orientation, do this:

You can use snap commands to grab any object from a specific point and 
snap it into place to finish the move operation.  Snap commands can be 
applied to anything you can see on screen, including the object you’ve 
selected for moving.  It takes a bit of practice to get the co-ordination just 
right, but it is easy once you learn how.

NOTE: You can duplicate an object as part of a move operation by holding 
the Option key while you drag the objects with the mouse.💬💬
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To duplicate the object while you move it:
o	 Start the move by dragging operation as previously described.
o	 Press the Option key.  Observe, the duplication cursor appears.
o	 Continue to hold the Option key and drag to where you want the 

object to be duplicated.
o	 Release the mouse.

The duplicate is created in the specified location.

NOTE: The distance and angle you specified when dragging the original 
object is remembered.  You can duplicate another object the same distance 
and angle by Command-D.

Duplicate an 
Object While You 

Move It

💬💬
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To resize an object:
o	 Select the Selection Arrow tool from the Tool palette. 
o	 Move the cursor to the drawing area.
o	 Select the object you wish to resize.
o	 The selected object’s handles have become activated.
o	 Place the cursor on top of one of the handles.
o	 Press the mouse button and drag the edit handle in the desired 

direction.

How to Resize 
an Object

NOTE: Remember, snap commands are available during a reshape/resize 
operation. 💬💬
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To delete an object:
o	 Select the Selection Arrow tool from the Tool palette. 
o	 Move the cursor to the drawing area.
o	 Select the object you wish to delete.
 
	 Notice the selected object’s handles appear.

o	 Press the Delete or Backspace key.
–or–
o	 Choose Clear from the Edit menu.

CAUTION: If all objects in the current layer of the drawing are selected, 
pressing the Delete or Backspace key will remove them entirely from 
the PowerCADD document.  Failure to Undo such a mistake could be 
disastrous (see Undo in the Edit menu).  Remember to save your drawing 
at regular intervals see Save in the File menu.

How to Delete 
an Object

⚠ ❗❗
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Swipe Selection Tool
This tool selects all objects the cursor touches.

It provides a quick way to select one item or multiple items by simply 
drawing a freehand shape across any part of the object(s). 

To use the Swipe Selection tool:
o	 Select the Swipe Selection tool from the first row of the Tool palette.
o	 Drag the cursor over the object(s) to be selected.
o	 Press the Shift key to add or subtract items from the set of selected 

objects.

TIP: Press the Z key to automatically activate the Swipe Selection tool 
when any other tool is active.  Release the Z and the Selection Arrow tool 
is automatically activated.

💡💡
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Polygon Select Tool
This tool selects all objects completely enclosed by a polygon fence you 
draw.

The tool provides tremendous selection control as a selection fence may be 
drawn in any shape needed.  Thus, you can draw the sides of the polygon 
precisely where you need them.  A polygon corner can even be snapped to 
an object.

For an object to be selected, all of its endpoints or vertices must lie within 
the polygon.

To use the Polygon Select tool:
o	 Select the Polygon Select Tool from the Tool palette.
o	 Move the cursor to the location in your drawing area you wish to begin 

and press the mouse button.
o	 Drag the cursor to the end of the first side and release the mouse 

button.

	 The first side of the selection polygon has now been established.

o	 Move the cursor to the end of the second side and click.

	 The second side of the selection polygon has been established.

o	 Continue this pattern to add as many sides as you wish to enclose 
the objects you wish to select, with the last mouse click closing the 
polygon.
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Selection Lasso Tool
This tool lets you select all objects enclosed by a freehand shape that you 
draw with the tool.

A Lasso Selection is, in principle, a cross between the Polygon Select and the 
Swipe Selection tools, and they complete the suite of tools. 

Like the Polygon Select took, only objects inside the selection boundary 
(fence) are selected.  Like the Swipe Selection tool, the boundary can be an 
irregular shape.

To use the Selection Lasso tool:
o	 Select the Selection Lasso tool from the Tool palette.
o	 Move the cursor to the area of the drawing you wish to make a selection.
o	 Drag the cursor around the area of the objects you wish to select and 

release.

The objects enclosed in the area will be selected.
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Zoom Tool
This is a fast and efficient way to magnify part of a PowerCADD drawing 
document.  It allows you to zoom in or out of a section of the drawing by 
factors of 2X or dynamically to any percentage factor you specify.

There are two states for the Zoom tool’s cursors.  Zoom in (+) is the default 
when you pick the tool.  To Zoom out (–) hold the Option key when the 
Zoom tool is active.

To zoom in 2X with the Zoom tool:
o	 Select the Zoom tool from the Tool palette.
o	 Move the cursor to the drawing area.  

	 The cursor will change to the Zoom In cursor.

o	 Place the cursor in the area you wish to magnify and click.

You will automatically zoom in 2X with each click of the mouse button 
when the Zoom tool is active.

Zoom In     Zoom Out

To return to the original, less magnified view, choose Previous View from 
the View menu.

The Zoom tool can also be used to dynamically zoom into a specific area by 
encompassing the area with a rectangle drawn with the Zoom tool.

To magnify a selected part of the drawing:
o	 Select the Zoom tool from the Tool palette.
o	 Move the cursor to the drawing area.
o	 Place the cursor in the area you wish to magnify and drag diagonally 

away from this point.  As you drag the mouse, you will notice a selection 
rectangle being drawn.  The rectangle should be drawn to encompass 
the area that you wish to enlarge. 

o	 Release the mouse button. 

The screen will now be redrawn to display the area you selected.  The size of 
your zoom selection rectangle will govern the zoom factor. 
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Magic Wand Tool
This tool lets you use a single click to select all objects that match your 
specified attributes. 

To use the Magic Wand tool:
o	 Press the Option key and select the Magic Wand tool from the Tool 

palette.  The following dialog will appear:

o	 Click on an inactive checkbox to activate the attribute to be used as 
the selection criteria.  To deactivate an attribute click on an active 
checkbox.

o	 Click OK to return to the drawing window; the Magic Wand cursor 
appears.

o	 Click on an object to select it.

All other objects matching the attributes specified in the dialog box are 
selected.

The tool will select only those objects which are the same as the first object 
selected.  For example, if a circle is the first object selected, only circles 
(along with the related matching attributes) are selected. 

Checking Pen Color, Pen Pattern, Pen Opacity, Line Weight, Arrow, Fill 
Color, Fill Pattern, Fill Opacity, Hatch, Dash, and End Caps specifies those 
attributes by which objects are selected.

Checking Object Type

Anchor
[MagicWandTool]
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Move Object Tool
This tool uses a single click to select an object about a preset snap point and 
a drag operation to move it.

To use the Move Object tool:
o	 Select the Move Object tool from the Tool palette.
o	 Move the cursor into the drawing area, the Selection cursor changes to 

a Target cursor.
o	 Position the cursor on the object to be moved. 
o	 Press and hold the mouse button, the object is automatically selected 

and handles appear.  Drag the object to the desired location and release 
the mouse.

o	 To duplicate an object while moving it, press the Option key while 
dragging.  The duplicate cursor will appear, release the mouse then 
release the Option key.

Dynamic Snapping is automatically in effect when you position the cursor 
over one of the default snap locations, as defined by the locations of handles. 

You may also force snapping using any of the predefined snap keys.

The Shift key may also be used to constrain the move by dragging operation 
to either the X or Y axis.

The Move Object tool may also be applied after you have selected objects 
in the drawing.  

If the objects are selected first, position the Move Object cursor over one of 
the selected objects and drag the mouse; all selected objects will be moved.

Placing the Move Object cursor over the handle of a selected object will 
move the selected object from that automatic snap point: the object cannot 
be stretched with the Move Object tool.

To stretch an object, use the Selection Arrow tool.

Anchor
[MoveObjectTool]
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Pan Tool
This is a fast and efficient way to move around your drawing.

To pan around your drawing:
o	 Select the Pan tool from the Tool palette.
o	 Move the cursor to the drawing area.
o	 Drag the hand to pan the drawing area.
 
NOTE:  Dragging the cursor beyond the current viewable area will 
automatically pan the drawing window.

💬💬
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Text Tools

Text Tool
The Text tool allows you to add a line or paragraph of text to a drawing. 

When a new PowerCADD document is opened, the text defaults (font, 
color, size, style, and so on) are those saved in the Untitled stationery 
drawing or in your custom stationery pad drawing.

Selecting the Text tool and choosing the appropriate text characteristics 
from the Text menu or the Text Attributes floating window may change 
these defaults.

NOTE: Picking the Text tool can automatically switch you to the Text 
Layer (or another layer name of your choosing) if the Layer Tools feature is 
checked on in the Layout Menu.    If the Layer Tools feature is not checked 
on, text is drawn on the active layer.

NOTE: After saving your PowerCADD 9 drawing, all text entries are 
automatically indexed by Spotlight in MacOS.  Older PowerCADD 
drawings must be saved as PowerCADD 9 to index their text for Spotlight.  
For more information on using Spotlight to search for content in a 
document see Apple’s help and support files included in MacOS. 

PowerCADD takes full advantage of the technologies of the MacOS for 
smooth text rendering without being affected by font size or rotation angle.

Any font size, style or family (e.g. Helvetica, Times, etc) installed and available 
in your word processor or other applications can be used in your PowerCADD 
drawings.  There are no special font requirements for PowerCADD.

Font sizes can range from as small as 1 point to 1000 point or larger.

If a particular font style is grayed out in the Text Menu, or if you are unable 
to assign your text a specific font style (e.g. bold or bold-italic) try changing 
to a different font family (e.g. change from Geneva to Arial).  Alternatively 
you may wish to contact the font manufacturer to see if they offer the 
particular font style you are looking for.

T

💬💬

💬💬
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To add text to a PowerCADD document:
o	 Select the Text tool from the Tool palette. 
o	 Move the cursor to the drawing area where you wish to add text.  When 

you move to the drawing area, the cursor turns into a Text Insertion 
cursor.

o	 Click in the area chosen for text (or click and drag), and the Text 
Insertion cursor becomes a blinking vertical bar. 

Text Insertion Cursor

o	 Type the desired text on the keyboard.
o	 Correct immediate mistakes by using the Delete or Backspace keys.
o	 Use the Return key to add a new line to the text.

To add a paragraph to the drawing:
o	 Select the Text tool from the Tool Palette.
o	 Move the cursor onto the drawing area where you wish to add the 

paragraph.
o	 Drag to indicate the size of the paragraph.  A temporary rectangle will 

be drawn indicating the left and right boundary of the paragraph.
o	 Type the desired text on the keyboard.  Text will be placed inside the 

rectangle in paragraph format.
o	 Correct immediate mistakes by using the Delete or Backspace keys.
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The Text tool also works like a word processor with words automatically 
wrapping onto the next line when the right boundary is ‘bumped’. 

The rectangle shown below defines the temporary boundary of your 
paragraph.  If your initial paragraph boundary is not large enough, the 
boundary will dynamically grow downwards while typing text.

You have control over the formatting of text with in a single text block. 
Different font sizes, colors, styles, families, and attributes can be used 
within the same text block.

Resizing Text Blocks Long single lines of text may also be reshaped into a paragraph block.

To dynamically resize and reflow a text block:
o	 Select a block of text in the drawing.  The selection handles will appear.
o	 Select a selection handle and drag to resize the text block.  The text is 

reflowed as you drag.
o	 Release the mouse when the text block is at the desired size.

The size of a text block can be resized 
dynamically simply by dragging a selection 
handle bar. The text will automatically reflow 
within the text block.

The size of a text block 
can be resized 
dynamically simply by 
dragging a selection 
handle bar. The text will 
automatically reflow 
within the text block.

1) move the mouse
over a selection
handle bar

2) drag the selection handle
bar to resize the text block

3) release the mouse to complete
the resizing operation.

The Edit Window may also be used to specify the exact width of a selected 
text block.  When the text block changes sizes the text automatically reflows.

To use the Edit Window to resize and reflow a text block:
o	 Select a block of text in the drawing.  The selection handles will appear.
o	 Press the Tab key to activate the Edit Window.
o	 Enter the desired value in the Width field of the Edit Window and 

press the Return or Enter key.
o	 Enter the desired value in the Height field of the Edit Window and 

press the Return on Enter key.

The text is automatically reflowed vertically to accommodate the specified 
width of the text block.
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NOTE: The Edit Window can also be used to specify the rotation angle of 
a selected text block by entering a specific value in the Angle field of the 
Edit Window. 

To add text to a line of existing text:
o	 Select the Text tool from the Tool palette.
o	 Use the cursor to select the text you wish to modify.
o	 Move the text cursor to the drawing area where you wish to modify 

text.  Note when you move the Selection Arrow cursor to the drawing 
area, the arrow turns into a Text Insertion cursor.

o	 Move the Text Insertion cursor into position within the text block and 
click. 

o	 You may now modify the text.

Double-click on a text block with the Selection Arrow tool selected to edit it.

1) select the text block

The Edit Window may be used to specify the 
exact width (or rotation angle) of a text block. 
The text is automatically reflowed vertically to 
accomdate the specified width

2) enter the desired width in the 
Edit Window Width field and 
press the "Return" or "Enter" key

The Edit Window may be 
used to specify the exact 
width (or rotation angle) of 
a text block. The text is 
automatically reflowed 
vertically to accomdate 
the specified width

3) the text block is resized to the
specified width and the text is
automatically reflowed vertically

Adding Text to a 
Line of Existing Text

💬💬

💡💡
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Position the Text Insertion cursor to the right of the text to be deleted. 
Backspace over the incorrect text. 

Alternatively, you may select the text to be deleted as in standard word 
processors, and press the Backspace key to delete. 

To change the characteristics of a block of text within a drawing 
document:
o	 Select the Selection Arrow tool from the Tool palette.
o	 Move the cursor to the drawing area and click in the block of text you 

wish to modify.  The handles surrounding the block of text have been 
activated, as shown in the following example.

Rotated text may be edited by clicking on the text with the Text Insertion 
cursor.

Rotated text, if selected with the Text Insertion cursor, will be rotated to 
zero for normal editing.  When editing is complete and another selection is 
made, the text will return to its original rotation.  A rotated text block can 
be resized, even when it is rotated.

Editing Rotated Text

Deleting Characters 
from Existing Text

Changing the 
Appearance of Text 

in a Drawing

o	 Choose the appropriate text characteristics you wish to modify from 
the Text menu. 

	 Characteristics include choice of font type, style, and size.

	 In addition, you may modify such text formatting features as 
justification and the case of letters.

After you have selected the text characteristics from the Text menu, the 
desired effects will be immediately noticeable on the screen.

Rotated Text Before Editing Rotated Text During Editing
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See Text in the Menu chapter for details on working with fonts and text 
styles.

See Text Attributes in the Menu chapter for details on working with the 
Text Attributes floating window for setting font and text styles.  Also see 
Attributes in the Menu chapter for details on working with the Attributes 
floating window for setting color, fill and other attributes of text blocks.

NOTE: To change the attributes of a particular letter, word or range of 
words in a text block use the text tool, drag to highlight the particular 
characters then change the desired attributes. 

💬💬

Moving Text in 
a Drawing

To move a block of text within a drawing document:
o	 Select the Selection Arrow tool from the Tool palette.
o	 Move the cursor to the drawing area and select the block of text you 

wish to move.  Hold the mouse button down after you select the block 
of text.

	 The Selection cursor will turn into a Move cursor.

You may now reposition the block of text as you would any other drawing 
object.

NOTE: The Autoscroll feature is in effect while moving objects in the 
PowerCADD document window.

To delete a block of text from a drawing document:
o	 Select the Selection Arrow tool from the Tool palette.
o	 Move the cursor to the drawing area and select the block of text you 

wish to delete. 

	 The handles surrounding the block of text will appear.

o	 Press the Delete (or Backspace) key.
–or–
o	 Choose Clear or Cut from the Edit menu.
–or–
o	 Press Command-X.

Alternatively, when editing text you may drag over part of the text to 
highlight it.  When text is highlighted, it may be cut or copied and pasted 
into the same text block or into a text block in any drawing (eliminating 

Deleting Text 
From a Drawing

💬💬

!

!
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unnecessary typing).  The active text insertion point determines where text 
is pasted.

NOTE: You can also drag and drop text from your PowerCADD drawing 
into your word processor or spreadsheet, the Finder Desktop (creates a 
picture clipping file) or another PowerCADD drawing.

💬💬

Still True?

Edit Text Window Existing text may be edited in an enlarged Edit Text window.  

Any attribute which can be assigned from the Text menu can be applied in 
the Edit Text window or from the Text Attributes floating window.

Pen color may be selected from the Attr Menu or from the Attributes 
Floating window.

To activate the Edit Text window:
o	 Select the text to be edited.
o	 Choose Edit from the Edit Menu.

	 The selected text opens in a new floating window on top of your 
drawing.

o	 Edit the text as needed. 
o	 When finished, click on the Edit Text window’s close box or press 

Command-W.

Displays the current 
zoom percentage; 
100% is actual printed 
size.

Close Box:
Click here to close

the window or press
C ommand + W

 keys

Zoom Box:
Click here to expand

the size of the Edit
Text Window.

Zoom In/Out Icons:
Click to zoom in or

out by a factor of 2X

Horizontal and vertical scroll bars appear if there
is additional text which is not shown in the window.
Drag a scroll bar to see the additional text.

Resize Box:
Click and drag here
to make the window
bigger or smaller.

Display Size:
Check this box and 
enter a value to 
specify the preferred 
font size for editing 
text in this window.

To make text editing easier, zooming in or out is available in the Edit Text window.

To zoom in or out in the Edit Text Window: 
o	 Activate the Text Edit window as described earlier.
o	 Choose Zoom In from the View menu or use the key command you 

have assigned to that menu item. 

Anchor
[EditTextWindow]
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o	 Text will display larger when zoomed in, and you may edit the text 
attributes using available menu items in the Text and Attr menus.

o	 When finished, click on the Edit Text window’s close box.

To zoom out in the Edit Text Window, choose Zoom Out from the View 
menu or use the key command you have assigned to that menu item.

NOTE: Click on the Zoom In or Zoom Out Magnifying Glass icons in 
the Edit Text window to change the display size of text.  This change affects 
the font size displayed in the window only; the actual font size attribute of 
the text is not affected.  To make editing small font sizes easier, the Edit 
Text Window allows you specify a preferred font size.  This change only 
affects the font size for editing in the Edit Text window; the actual font size 
attribute is not affected.  Closing the Edit Text window will render the text 
to screen at the original font size.

To specify a display font size in the Edit Text Window:
o	 Activate the Text Edit window as described earlier.
o	 Check the Display Size box and enter a value in the Display Size field.

The next time you open the Edit Text window the zoom ratio is automatically 
set to simulate displaying text in the specified size.

💬💬
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Advanced Text Tool
The Advanced Text tool integrates the ability to create single lines of caption 
text and paragraph text blocks along with the ability to create and edit tables 
in your drawing. 

Formatted text and tables may also be copied and pasted from other 
spreadsheet or word processing applications.

Advanced Text operates in two basic ways.  A single click to create single 
lines of advanced caption style text or a click-and-drag to create advanced 
paragraph text. 

The Advanced Text Editing window is used to enter or edit text or tables, 
and provides numerous advanced features including control over paragraphs 
and line spacing, kerning, and ligatures. 

NOTE: Selecting the Advanced Text tool can automatically switch you to 
the Text Layer (or another layer name of your choosing) if the Layer Tools 
feature is checked on in the Layout Menu.  If the Layer Tools feature is not 
checked on, Advanced Text is drawn on the active layer.

NOTE: After saving your PowerCADD 9 drawing, all advanced text entries 
are automatically indexed by Spotlight in the MacOS.  Older PowerCADD 
drawings must be saved as PowerCADD 9 to index their text for Spotlight.  
For more information on using Spotlight to search for content in a 
document see Apple’s help and support files included in the MacOS.

Also, see Text in the Menu chapter, and Text Tool in this chapter, for general 
information on moving and working with text.  Also see Attributes in the 
Menu chapter for details on working with the Attributes floating window 
for setting color, fill and other attributes of text blocks.  Also reference the 
Apple MacOS help files for information on working with the Font Panel 
and related system level text features.

💬💬

💬💬

Anchor
[AdvancedTextTool]

!
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Both advanced and traditional text objects are treated the same when using 
the Selection Filter to select text objects only.  However, it is easy to tell 
the two apart when selected; the corner selection handles of Advanced Text 
objects are larger and hollow when compared to traditional text objects as 
pictured here:

Differences Between 
Advanced Text and 

Regular Text

Advanced Text takes advantage of numerous MacOS system level features 
that are not available with the traditional PowerCADD Text tool.  To retain 
the advanced formatting features, when coordinating drawings that will 
be saved and opened in previous versions of PowerCADD, all Advanced 
Text objects including tables will be converted to PDF.  The resulting PDF 
objects will print correctly in previous versions of PowerCADD but cannot 
be edited.

Creating Advanced 
Caption Text

To create a single line of advanced caption style text:
o	 Select the Advanced Text tool from the Tool palette.
o	 Move the cursor into the drawing window and the cursor changes to a 

Text Insertion cursor.
o	 Click to define the left hand starting point of the text.
o	 The Advanced Caption Text Edit Window opens.
o	 Type the desired text using the keyboard.
o	 Close the Advanced Text Edit Window by clicking the close box, or 

pressing Command-W, or by clicking anywhere in the drawing window.

The text will be inserted into the drawing.

Anchor
[AdvancedCaptionText]
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Access to various editing and formatting controls for Advanced Caption 
Text are accessed from the toolbar or contextual menus in the Advanced 
Caption Text edit window.

Advanced Caption Text 
Edit Window Features

(1) Window Buttons: Click the left button to close the window (or press 
Command-W).  Click the right most button to maximize the size of the 
window to fit your screen.  When a window is maximized clicking the same 
button will minimize the window to its previous size.  The center button is 
always inactive.

(2) Font Styles: When text is selected, click on an icon to apply the 
designated style.  If a style button is dimmed the font family chosen (e.g. 
Geneva) may not support that particular style.

(3) Window Body: The primary area of the text edit window used to enter 
and edit text.

(4) Super Script/Sub Script: Clicking the Super Script icon will raise the 
selected characters above the baseline.  Clicking the Sub Script icon will 
lower the selected characters below the baseline.  The incremental amount of 
the super or sub script offset is proportional to the font size used.  The super 
or sub script setting may be applied more than once by clicking multiple 
times on the appropriate icon.  To remove super or sub script formatting, 
select the super or sub scripted characters and click on the opposing icon.  
For example, to restore super scripted characters select them and click on 
the sub script icon.

(5) Toolbar Button: Click this button to show or hide the Toolbar.

(6) Customize: Click to display a drop down panel containing items to 
customize the toolbar.  You may add or remove items, change their location, 
or change the display size of icons in the toolbar.  Control- or right-clicking 
on the toolbar will display a contextual menu to access the customize menu 
or change the display of the toolbar icons. 
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(7) Link: Select the desired characters and click to open the Link Destination 
Sheet.  Type the desired internet address (e.g. http://www.engsw.com) and 
click OK.  The selected characters will be formatted as blue and underlined 
in both the Advanced Text Edit Window and in the drawing.  Links are not 
active in the main drawing window.  To visit a link, open the Advanced Text 
Edit Window and click on the linked text.

(8) Font: Click to open the MacOS Font Panel.  The Font Panel is a standard 
font selection window used across many MacOS applications to choose a 
particular font or to set the style, size and other formatting characteristics. 
For more information on working with the Font Panel search for ‘Font 
Panel’ in the help files that come with MacOS.

(9) Word: Click to see a list of suggestions to complete or change the 
current word. 

To see and apply a suggested word: 
o	 Position the text insertion cursor to the right of the word and click.  

The text insertion cursor will blink.
o	 Click Word: a list of suggested words will appear.  If a list does not 

appear then there are no suggested words.
o	 Click on the desired suggested word and press the Return key to apply 

it.  The up and down arrows on the keyboard will also navigate through 
the list of suggested words; press the Return key to apply the selected 
suggested word

(10) Abc: Click to open the MacOS Spelling and Grammar Checker Panel. 
The Spelling and Grammar checker is a standard window used across many 
MacOS applications.  The Spelling and Grammar Checker Panel can also 
be used to select dictionaries or add words to your dictionary.  If words in 
the Advanced Text Edit Window appear with a red underline then they 
have been flagged as being misspelled or perhaps they are spelled correctly 
but not in the dictionary.  To enable or disable check as you type spell 
checking, Control- or right-click in a blank are of the Advanced Text Edit 
Window and choose the appropriate item from the contextual menu.  For 
more information on working with the Spelling and Grammar checker 
search for ‘Check Spelling’ in the help files that come with MacOS. 

(11) Find: Click to open the MacOS Find/Replace text dialog.  The Find/
Replace operation only looks inside of the currently active (open) Advanced 
Text Edit Window.  Other Advanced Text blocks in the drawing are ignored 
even if they contain a word defined in the Find/Replace dialog. 

TIP: To perform a global Find/Replace operation on all text in the drawing, 
choose Find… from the Text menu.  The Find… menu item looks inside of both 💡💡
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regular and advanced text blocks, leader line objects and text inside of groups.

(12) Zoom: Click to set how large or small text is displayed when editing. 
A zoom percentage of 100% is actual printed size.  The zoom percentage, 
whether larger or smaller, does not affect the true font size attribute (e.g. 12 
points is still 12 points regardless of the zoom percentage assigned).

(13) Resize box: Click and drag to make the window larger or smaller.

Converting to 
Paragraph Text

To change Advanced Caption Text to Advanced Paragraph Text: 
o	 Select the Advanced Caption Text block in the drawing.
o	 Drag one of the selection handles to increase or decrease the size of the 

text block.
–or–
o	 Select the Advanced Caption Text block in the drawing.
o	 Press the Tab key to activate the Edit Window.
o	 Type a new value in the Width field and press the Return key.

HINT: To convert multiple Advanced Caption Text blocks to Advanced 
Paragraph Text blocks at the same time, Group them first (Arrange menu, 
Group). Then select the handle of the group and drag to increase the size 
of the group.

💡💡
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Various editing and formatting controls for Advanced Paragraph Text are 
accessed from the toolbar or contextual menus in the Advanced Paragraph 
Text Edit Window. 

The Advanced Paragraph Text Edit Window contains all of the options 
available for Advanced Caption Text plus the following items: (see Advanced 
Caption Text discussed earlier in this section for additional descriptions).

Advanced Paragraph Text 
Edit Window Features

Creating Advanced 
Paragraph Text

Paragraph text has advantages over caption text in that you have access to 
additional options for character, line and paragraph formatting, the ability 
to create tables, or to copy and paste formatted table or text content from 
other applications.

To create an Advanced Paragraph Text Block:
o	 Select the Advanced Text tool from the Tool Palette.
o	 Move the cursor into the drawing window; the cursor changes to a Text 

Insertion cursor.
o	 Click and drag to define a rectangle to set the size of the text block.
o	 The Advanced Paragraph Text Edit Window opens.
o	 Type the desired text using the keyboard.
o	 Close the Advanced Paragraph Text Edit Window by clicking the close 

box, or pressing Command-W, or by clicking anywhere in the drawing 
window. The text will be inserted into the drawing.

(1) Ligature Adjustments: Allows you to combine two or more characters 
together to create a ligature.  Æ (‘A’ and ‘E’) and æ (‘a’ and ‘e’) combined 
together are examples of ligatures.  Ligatures are only supported for fonts 
with extended character sets or expert font sets so not all fonts installed in 
MacOS will support ligature adjustments.
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To adjust ligatures: 
o	 Select the characters to be adjusted in the Advanced Paragraph Text 

Edit Window. 
o	 Click on the Ligature button to apply the desired ligature adjustment.

(2) Kerning Adjustments: Allows you to increase or decrease the spacing 
between characters. The value in the kerning field applies standard kerning 
to the selected characters using information provided by the font.  Because 
kerning adjusts the natural space between characters, the overall effect 
of kerning may not be the same for all characters in a given font or font 
style.  The effect of kerning will also vary between font families (e.g. Times 
versus Helvetica) and font types (e.g. Open Type versus True Type).  The 
overall amount of kerning of selected characters can also be affected by the 
preceding or following characters (including spaces) in other parts of the 
line of text. 

To adjust kerning: 
o	 Select the characters to be adjusted in the Advanced Paragraph Text 

Edit Window.
o	 Enter a numeric value in the kerning field or click the up or down 

arrow icons.  Positive values increase the spacing between characters.  
Negative values decrease the spacing between characters.

o	 To restore the default character spacing repeat the kerning adjustment 
but enter a value of zero in the kerning field

(3) Rulers: Formatting rulers provide access to control over tabs, left indents, 
alignment, font styles, paragraph spacing and lists.  These items contain 
both standard and custom choices used across many MacOS applications.

Styles: The Style popup menu contains standard choices for font styles. 
If no text is selected, the chosen style is applied to all new text entered.  If 
existing text is selected the new style is applied to the selection.  To create 
your own favorite style, select the text with the desired format, color, font 
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type and choose Other... from the Styles popup.  Favorite styles are shared 
among all MacOS applications which use the standard Styles popup menu.

Justification: Click on a justification icon to set the desired left, center, full, 
or right justification.  If no text is selected, the new justification is applied to 
all new text entered.  If existing text is selected the new justification settings 
are applied to the selection.

Spacing: The Spacing popup menu contains standard choices for adjusting 
line and paragraph spacing.  If no text is selected, the spacing is applied to 
all new text entered.  If existing text is selected the new spacing is applied 
to the selection.  For additional control of both line and paragraph spacing 
choose Other... from the Spacing popup.

Lists: The Lists popup menu contains standard choices for adjusting line 
and paragraph spacing.  If no text is selected, the spacing is applied to all 
new text entered.  If existing text is selected the new spacing is applied to the 
selection.  For additional control of the bullets or to add a prefix and suffix 
to a list item choose Other... from the Spacing popup. 

Tabs: Existing tabs across the ruler may be moved by dragging them left 
or right.  To remove an existing tab click and drag down and away from 
the ruler.  To add a new tab (left, center, right or decimal tab) drag its 
corresponding icon from the choices in the top right onto the ruler.  To 
adjust both the position of existing text and any associated tab, select the 
text first, then drag the tab in the ruler.

Indents: The horizontal bar at the left end of the ruler sets the indentation 
for the first line of a paragraph.  If no text is selected the indentation will 
apply to new text entered.  If existing text is selected the first line of the 
paragraph is indented and the related text is reflowed.

TIP: To change the right hand margin, exit the Advanced Paragraph Text 
Edit Window.  Select the text block in the drawing and drag a selection 
handle wider or smaller.  The text will automatically reflow.

(4) Baseline Shift: Enter a specific value or click the up or down icons 
to increase or decrease the selected characters up or down relative to the 
baseline of surrounding text.  A positive value moves the selection above the 
baseline of the rest of the line; a negative value moves it below the baseline.

(5) Tables: Click this button to create a new table.  Tables are discussed in 
detail later in this section.

💡💡
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There may be times when it is quickest to reuse existing text that was typed 
and formatted in other applications.

To use text from another application which cannot be edited in 
PowerCADD: 
o	 Use the print command to create a PDF file in the other application.
o	 Open a drawing and choose Place from the File menu.
o	 Place the PDF file into your drawing.
o	 The formatting of the original document is retained but cannot be 

edited in PowerCADD.

If the file contained more than one page, only the first page is placed.  If you 
need all the pages of a multi-page document create a custom page size (see 
the help file included with MacOS) which is large enough to include your 
entire document on a single page.  The PDF file will then place as a single 
item in PowerCADD.

TIP: To convert the PDF file to editable text select the PDF file containing 
the text, then choose PDF To Objects from the Tool menu.  The PDF is 
converted to Advanced Text objects which may be edited.  Note, paragraphs 
are converted to distinct lines when converted; to maintain paragraph 
formatting use the copy and paste method described below.

To use text from another application which can be edited in 
PowerCADD: 
o	 Select all the text in the original file and choose Copy from the Edit 

menu.
o	 In the PowerCADD drawing, choose the Advanced Text Tool and click 

and drag to create a new Paragraph Text Block.
o	 In the Advanced Paragraph Text Edit Window choose Paste from the 

Edit menu. 

	 The formatting of the original text, including font size, style, and tabs, 
is retained.

o	 Close the Advanced Text Edit window and the text is inserted into the 
drawing as an editable text block.

Using Formatted 
Text from Other 

Applications

💡💡
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The Advanced Paragraph Text tool is used to create new tables.  The table 
may be inserted as part of an existing Advanced Paragraph Text Block, or be 
independent of other text blocks.

To create a new, independent, table:
o	 Select the Advanced Text tool from the Tool Palette.
o	 Click and drag to define a new Advanced Text block.  The Advanced 

Paragraph Text Edit Window opens.
o	 Click on the Add Table icon in the Toolbar.
o	 A new empty table is created containing two rows and three columns. 

The Table Inspector window opens.

Creating Tables

o	 Use the Table Inspector to set the properties of the table.
o	 Click in a cell to enter data.  All font formatting features of the 

Advanced Paragraph Text Edit Window are available.
o	 Click the top left button in the Table Inspector window to close it.
o	 Close the Text Edit Window and the Table is inserted into the drawing.

To create a table that is part of an existing Advanced Paragraph Text 
Block: 
o	 Select the Advanced Paragraph Text block in the drawing and press  

Command-E (or double-click to edit it).
o	 In the Advanced Text Window, move the cursor to where you want the 

table inserted and click: a flashing text insert icon will appear. 
o	 Click on the Add Table tool icon in the Toolbar.
o	 A new empty table is created in the specified location.
o	 Make the desired entries into the table, close the Table Inspector and 

close the Advanced Text Edit Window.  The table appears as part of you 
text block in the drawing.
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Use the Table Inspector to adjust various properties of selected cells after a 
table is created.

Customizing Table 
Properties

Columns & Rows

Alignment

Adjust the number of Columns or Rows: Type a value in the corresponding 
field or click the up or down arrows.

Merge Cells: When two or more cells are selected, click Merge Cells to 
combine them into a single cell. If both cells contained data, the data is 
retained and inserted onto two separate lines in the new cell.

Split Cells: When a merged cell is selected, click Split Cells to separate 
them.  If the cell being split contained data, the new split cell will be empty.

Text in a cell may be aligned using a combination of two methods.

Horizontal: Text in a cell may be aligned horizontally the same as traditional 
text outside of a table.  Click in the cell, then click the left, center, full or 
right justification icons to apply the corresponding alignment.

Vertical: Text within the cell may also be aligned vertically by clicking in 
the cell, then clicking on the corresponding top, baseline, center or bottom
alignment icons.

Cell Borders and 
Backgrounds

The cell border and background for a single selected cell, or selected range 
of cells, may be adjusted for color and line weight.

Cell Border: Enter a numeric value in the Cell Border field or click on the 
up or down arrow icons to change the size of the cell boarder in one pixel 
increments.  Click on the color rectangle to select a cell border color from 
the MacOS Color Panel.

Cell Background: Choose the Color Fill popup menu to assign a color fill 
or no fill to a cell.  A cell background of None will allow objects below the 
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table to be visible through the table.  Choose Color Fill from the popup 
menu and click on the color rectangle to select a cell background color from 
the MacOS Color Panel.  A background color of white will hide all objects 
below a table.

Editing an Existing Table To edit an existing table that is either independent or part of another 
Advanced Paragraph Text block:
o	 Double-click on the Advanced Paragraph Text block containing the 

table. 
o	 The Advanced Text Edit Window will open.
o	 Press the Control key and click on the existing table or click the existing 

table and click the New Table icon in the toolbar.
o	 Choose Table... from the contextual menu.
o	 The Table Inspector will open.
o	 Make the desired changes.  Close the Table Inspector and close the 

Advanced Text Edit Window; the revised table is displayed in the 
drawing. 

Using Formatted Text from 
Other Applications

There may be times when it is quickest to reuse existing tables created in 
another spreadsheet application such as Microsoft Excel or Apple Numbers.

To use a table from another application which cannot be edited in 
PowerCADD: 

o	 Use the print command to create a PDF file in the other application.
o	 Open a drawing and choose Place from the File menu.
o	 Locate the PDF file and place that into your drawing.
o	 The formatting of the original document is retained but cannot be 

edited.

If the file contained more than one page, only the first page is placed.  If you 
need all the pages of a multi-page document create a custom page size (see 
the help file included with MacOS) which is large enough to include your 
entire document on a single page.  The PDF file will then place as a single 
item in PowerCADD.

To use a table from another application such as Excel or Numbers 
which can be edited in PowerCADD:
o	 Select the range of cells in the spreadsheet application and choose 

Copy from the Edit menu.
o	 In the PowerCADD drawing, choose the Advanced Text Tool and click 

and drag to create a new Paragraph Text Block.
o	 In the Advanced Paragraph Text Edit Window choose Paste from the 

Edit menu.
o	 A new table is created matching the table in the spreadsheet application.  

Control- or right-click on the table and choose Table... from the 
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contextual menu to open the Table Inspector to make any changes.
o	 Close the Advanced Text Edit window and the table is inserted into the 

drawing as an editable text block.

Advanced Text 
Edit Window 

Contextual Menus

Following is a list of locations in the Advanced Text Edit Window which 
will open a contextual menu specific to that location.  In many cases the 
contextual menu provides access to additional features or editing options.

To apply a contextual menu item simply select it from the list of contextual 
menu items that appears.

o	 Control-click in a blank area in the body of the window.
o	 Control-click on a selected character(s).
o	 Control-click on a linked character(s).
o	 Control-click  on the Toolbar.
o	 Control-click on an icon in the Toolbar.

Editing Advanced Text To edit an existing Advanced Caption or Paragraph Text Block in the 
drawing simply select the text block and press Command-E or double-click 
on it with the Selection Arrow tool.  In both cases the Advanced Text Edit 
Window will open.

Make the desired changes and close the window to have those changes 
appear in the drawing.

Changing Pen 
Color Attributes

You can change the pen color for all text in an Advanced Caption or 
Paragraph Text Block or just selected text within a text block.

To change the color of all text in any Advanced Text Block:
o	 Use the Selection Arrow tool and click once on the text block to select it.
o	 Choose the desired pen color from the Attributes Window, a contextual 

menu (Control- or right-click on the text block) or the Attribute menu.
o	 All text in the text block will change to reflect the selected color.

Hypertext link colors remain blue and underlined regardless of what pen 
color attribute is selected for the text block. If multiple Advanced Text 
Blocks are selected, the chosen color is applied to all selected items. 

To change the color of selected text in an Advanced Text Block: 
o	 Use the Selection Arrow tool and double-click on the text block to 

open the Advanced Text Edit Window (or press Command-E).
o	 Select the desired characters and choose a pen color from the Attribute menu.
o	 The selected text in the text block will change to reflect the chosen color.

Hypertext link colors remain blue and underlined regardless of what pen 
color attribute is selected for the text block.
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Sticky Note Tool
The Sticky Note tool allows you to insert non-printing type notes and 
comments in a drawing. 

Inserting a Sticky Note can be an effective way to draw attention to 
comments regarding design or drawing changes that need to be made prior 
to issuing a drawing for client review.

To insert a new Sticky Note in a drawing: 
o	 Select the Sticky Note tool from the Tool Palette.
o	 Move the cursor into the drawing window; the cursor changes to a Text 

Insertion cursor.
o	 Click and drag to define a text block for your Sticky Note.
o	 The Advanced Text Edit window opens with a yellow background.
o	 Type the desired text using the keyboard.
o	 Close the Advanced Text Edit window; the Sticky Note will be inserted 

into the drawing.

NOTE: After saving your PowerCADD 9 drawing, all sticky note entries 
are automatically indexed by Spotlight in MacOS.  Older PowerCADD 
drawings must be saved as PowerCADD 9 to index their sticky notes for 
Spotlight.  For more information on using Spotlight to search for content in 
a document see Apple’s help and support files included in MacOS.

NOTE: The yellow background and drop shadow attributes of a Sticky 
Note cannot be modified.

To edit an existing Sticky Note in a drawing: 
o	 Select the Sticky Note tool from the Tool Palette.
o	 Double-click on the existing Sticky Note in the drawing.
o	 Type the desired text using the keyboard.
o	 Close the Advanced Text Edit window; 

The revised Sticky Note will be inserted into the drawing.

NOTE: Select the Selection Arrow tool and double-click on any Sticky 
Note to edit it.

💬💬

💬💬

💬💬
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To resize an existing Sticky Note in a drawing:
o	 Select the Selection Arrow tool from the Tool Palette.
o	 Click on the existing Sticky Note in the drawing to select it.
o	 Press and drag on an edit handle; the text will automatically reflow to 

match the new size.
o	 Release the mouse to complete the operation.

NOTE: Use the Edit Window to specify an exact width or rotation angle 
for a Sticky Note. 💬💬
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Leader Tool
The Leader tool allows you to create custom leaders with text.  The tool 
has an option that allow you to always create a smooth looking leader line.
 
To set the behavior of the tool:
o	 Press the Option key and select the Leader tool from the Tool palette.  

The following dialog will appear:

T

o	 Enter the text associated with the leader.  The text cursor is automatically 
placed when the leader is finished so you can type information 
without selecting the Text tool.  Text may be entered by standard word 
processing methods.  A mouse click or the Enter key will complete the 
leader.

o	 Pressing the Esc key after you draw the first segment of the leader will 
abort the drawing operation and no object will created.  If you have 
created the leader line and see the text insertion cursor, the operation 
cannot be aborted.  Pressing the Return key will automatically exit the 
drawing process, the leader line will be selected and pressing the Delete 
key will remove it from the drawing.

NOTE: After saving your PowerCADD 9 drawing, all leader line entries 
are automatically indexed by Spotlight in MacOS.  Older PowerCADD 
drawings must be saved as PowerCADD 9 to index their leader lines for 
Spotlight.  For more information on using Spotlight to search for content in 
a document see Apple’s help and support files included in MacOS.

💬💬

o	 Select the Smooth checkbox and click OK.

To use the Leader tool:
o	 Select the Leader tool from the Tool palette.
o	 Place the cursor where you want the leader line’s arrow to be located 

and press the mouse button.
o	 Drag to position the bend in the leader line and release.
o	 Move the cursor horizontally to position the leader’s endpoint and click.

Anchor
[LeaderTool]



Tools50

NOTE: Selecting the Leader tool can automatically switch you to the Text 
Layer (or another layer name of your choosing) if the Layer Tools feature 
is checked in the Layout menu.  If the Layer Tools feature is not checked, 
leader lines and text are drawn on the active layer.

To edit a leader:
o	 To change the position of the leader text, select the text and move it as 

you would any object.  To relocate the text horizontally or vertically, 
select it and press the Shift key.  You may now move the text without 
disturbing the leader.  The Shift key constrains the movement to 
vertical and horizontal.

o	 To extend the horizontal section of the leader or move it and the text 
to the other side, select the leader handle near the text and drag.  The 
change can only be made horizontally.  This process will not affect the 
angle of the leader.

o	 To change the angle or distance from the object, select the handle at the 
bend of the leader and drag.  The angle and distance may be changed 
while the horizontal line and the text remain locked at horizontal.

o	 Use the Text tool to add text.  Place the Text cursor where you wish to 
make the change, click and type or use the Edit command.  Select the 
leader, choose Edit from the Edit menu, and type your changes.

o	 You may ungroup the leader line from the text.  This operation will 
change the leader into a polygon.  The leader can then be resized as you 
would resize a polygon, by selecting the handles and dragging.  The text 
is now separate from the leader.

To draw a leader without text, press the Enter key when the Text cursor 
appears.  The Leader tool will remain active so you may draw another leader. 

NOTE: To create a smooth looking Leader, select the item(s) and pick 
Smooth from the Tool menu, Polygon menu.  You may also Unsmooth a 
previously smoothed Leader.

💬💬

💬💬
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To change the size of a leader object text block:
o	 Select the leader line.  The selection handles will appear.
o	 Move the cursor so it is over a selection handle of the text block.
o	 Drag the handle to dynamically change the width of the text block.
o	 The height of the text block will change and the text will automatically 

reflow.
o	 Release the mouse to complete the operation.

1) Place the cursor over
a selection handle bar
and press the mouse button.

2) Drag the mouse to
resize the text block. Notice
the text automatically
reflows as you drag.

3) Release the mouse
button to complete the
operation.

First Line 
Second Line 
3rd Line

First Line 
Second Line 

3rd Line

drag this handle bar left

Original Edit Result

The text alignment of Leader text will change when a Leader object is 
reshaped from left to right or from right to left; for example:
o	 Begin with a leader line with left justified text on the right side of the 

leader line as illustrated below.
o	 Drag the edit handle of the leader line left until the text block moves 

to the left of the leader line. 
o	 The text justification will flip from left justified (original) to right 

justified (result) as shown below.
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o	 Enter the desired value in the Leader Text Offset field.  The value 
entered is at normal print size (100% printing or 1:1 scale) regardless 
of drawing scale. 

o	 The value for Leader Text Offset are drawing specific and saved with 
the drawing.

To specify the offset distance between the end of a leader line and 
the insertion point of the text block:
o	 Choose Drawing Setup from the Layout menu.
o	 Select the Dimensions tab, the following dialog will appear: 

To edit the content of Leader line text block:
o	 Select the Leader line containing the text block to be edited.
o	 Choose Edit from the Edit menu (or press Command-E).
o	 The Text Edit window will open.  Make the desired changes and close 

the Text Edit window. 
o	 Alternatively, you may also edit the text directly in the drawing window 

by choosing the Text tool and clicking in the text block.

NOTE: Select the Selection Arrow tool and double-click on any Leader 
Line text block to edit it.

Editing Leader Text

💬💬
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Text on Path Tool
This tool maps a block of text to an object’s path.

Text on Path has a variety of uses, including mapping text to rivers, streets 
or highways, labeling contour lines or applying text to circles and arcs to 
creating drawing seals.  The possible uses are endless. 

The text is placed at the beginning of the object and each character is rotated 
to match the slope of the object.  This may be any object except symbols, 
and dimensions.

To use the Text on Path tool:
o	 Select the Text on Path tool from the Tool palette.
o	 Place the cursor on the text block and press.
o	 Drag the cursor to the object; the end you choose will be the end from 

which it starts placing text.  A bridge line will connect the two objects 
to indicate the tool is active.

o	 Release the mouse button.

The result is a group containing individual characters on the path with the 
specified alignment.

NOTE: The Text on Path tool produces a unique text block for each 
character.  As such MacOS Spotlight searches will only index each character, 
not the entire word they may represent.

NOTE: The object being targeted to receive the text on path operation can 
be either a distinct object in the drawing or part of a Group of objects.

NOTE: The orientation of the text to the object depends on which end of 
the object you pick.  For example, if you pick the left end of a line, the text 
will map along its top, reading left to right.  If you pick the right end of a 

💬💬

💬💬

💬💬
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line, the text will map upside-down along its bottom, reading right to left, 
so justification will be reversed.

The text can be justified four ways on the object much like text is justified 
in a paragraph: left, right, center, and full. 

Each justification setting works just like their namesakes in word processors. 

To set the justification, activate the Text on Path dialog by pressing the 
Option key while selecting Text on Path.  The following dialog appears:

Full justification fits the text to the path, and will change the spacing 
between letters to accommodate the path’s length.

Left justification spaces out the text normally, starting at the beginning of 
the path.  If the text isn’t long enough, blank space will be left at the end of 
the path.  If the text is too long, a warning will appear, stating that it will 
truncate the extra text. Text from the end of the text block will be truncated.

Center justification spaces out the text normally, relative to the center of the 
path.  If the text isn’t long enough, blank space will be left at the beginning 
and end of the path.  If the text is too long, a warning will appear, stating 
that it will truncate the extra text.  Text from the beginning and end of the 
text block will be truncated.
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Right justification spaces out the text normally, relative to the end of the 
path.  If the text isn’t long enough, blank space will be left at the beginning 
of the path.  If the text is too long, a warning will appear, stating that it will 
truncate the extra text.  Text from the beginning of the text block will be 
truncated.
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Date Stamp Tool
The Date Stamp tool inserts the creation and modification times and dates 
into your documents as specified by the Date & Time settings in your 
MacOS.  

The Date Stamp object may be inserted anywhere in your drawing, and it 
is ‘smart’. The object will automatically update each time you open or save 
a drawing.

NOTE: The Date Stamp tool is an External plug-in.  In order for this tool 
to appear in the Tool menu it must be checked on when PowerCADD is 
launches.  See Loader Preferences for more on turning External plug-ins 
On and Off.

To set the behavior of the tool:
o	 Press the Option key and select the Date Stamp tool from the Tool 

palette.  The following dialog will appear:

💬💬

o	 The examples below illustrate the optional settings available and how 
some of them will appear in your drawing.

To use the Date Stamp tool:
o	 Select the Date Stamp tool from the Tool palette.
o	 Place the cursor where you want the Date Stamp to be located and 

press the mouse button.
o	 Drag to position the object and release the mouse.

The date and/or time is inserted in the drawing.

CAUTION: You cannot change the font size or style of the smart Date 
Stamp objects.  If you Ungroup a Date Stamp object it will be converted 
to a Placed object, and the object will no longer automatically update.  To 
change the text attributes, set the attributes of the Date Stamp tool first, 
then insert a new Date Stamp object into the drawing.

⚠
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Drawing Tools
Don’t be deceived by the elegant and simple drawing tools section of the 
PowerCADD tool palette.  These tools are powerful yet easy tools that 
enable you to create a complete range of basic to advanced geometry and 
designs quickly and easily.  The following section describes each of the 
PowerCADD drawing tools.

Before describing each tool in detail, the following general information 
applies when working with all drawing tools.

o	 Dynamic Snapping may be used to modify the start or end points 
when drawing an object. 

o	 Zoom on the fly is available.  You can zoom in or out during the 
drawing operation.

o	 AutoScrolling is in effect.  The screen will automatically scroll if you 
drag to draw an object which is larger than the currently displayed 
drawing area.

o	 Direct input via the Edit Window is available.  Pressing the Tab key 
during a drawing operation will suspend the drawing operation and 
allow you to enter precise object dimensions in the Edit Window.  
Press the Return key when you are finished entering the information in 
the Edit Window and the object will be created. 

o	 The the Shift key will toggle between constrained and unconstrained 
drawing or resizing operations.  For example, to resize an existing 
circle, pressing the Shift key when dragging its handle will maintain 
the circle’s aspect ratio.  Pressing the Shift key when drawing an ellipse 
will constrain the shape into a circle.

o	 Any object may be edited using the mouse or the Edit Window after 
it is drawn.
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To edit an object using the mouse after it was drawn:
o	 Select the object to be edited.
o	 Press the mouse button down on an object’s edit handle.
o	 Drag the handle to reshape the object.
o	 Release the mouse button when the desired height and width have 

been achieved.
o	 By pressing the Shift key, the object can be reshaped while remaining 

in proportion to the original object.

Editing an Object 
Using the Mouse

To edit an object using the Edit Window:
o	 Select the object to be edited.
o	 Activate the Edit Window by pressing the Tab key. 
o	 Use the mouse or the Tab key to enter the desired edit field.
o	 Use standard text editing methods to change the edit field values. 
o	 Use the Directional Arrow keys to jump to the start (left) or end (right) 

of content in an Edit Window field.
o	 Press the Return or Enter key to complete the change.

Editing an Object 
Using the Edit Window

While each tool typically draws beginning from an end point, you may 
also draw an object about its center.  When using this method, begin at the 
center point.

To draw an object by its center: 
o	 Select a drawing tool from the Tool palette.
o	 Move the cursor to the drawing area of the screen.
o	 Press the mouse and drag to start drawing the object.
o	 Tap the Space Bar.
o	 Drag away from the center point. 

	 The object appears as you drag.  

	 It can be dragged to any length and angle, with its center anchored at 
the point specified.

o	 Release the mouse to complete the object.

NOTE: Before releasing the mouse when drawing an object, tapping the 
Space Bar will toggle between drawing a line by its center or end point.

Draw by Center

💬💬

Anchor
[EditWindow]



Tools59

Line Drawing Tools

The third row of the Tool palette contains a suite of tools for creating line 
geometry. 

Each tool may be used to create lines at any length or angle and with any 
type of attribute you choose (dashed lines, color, line weight, arrows, etc). 

Line Tool
This tool is used to draw a line at any angle.

To use the Line tool:
o	 Select the Line tool from the Tool palette.
o	 Move the cursor to the drawing area of the screen. 
o	 Press the mouse button where you want to start drawing (the starting 

point) and move the mouse in the desired direction.
o	 The line becomes longer the farther you move the cursor from the 

starting point.

	 Conversely, the line becomes shorter the closer the cursor is moved to 
the starting point. 

	 As you move the cursor, notice the Dynamic Ruler Guides in the 
horizontal and vertical rulers and the values in the Edit Window which 
allow you to track your cursor movement. 

o	 By moving the cursor about the starting point, you will be able to draw 
a line at any angle.

o	 Release the mouse button to complete the line.

NOTE: By default the line is drawn at any arbitrary angle you choose. 
Pressing the Shift key when dragging will constrain the line to any of the 
preset snap angles.  Snap angles may be set in the Drawing Setup dialog 
from the Layout Menu.

1_starting point

2_drag
3_release

💬💬
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Multi-Angle Line Tool
The Multi-angle Line draws lines at the preset snap angles set in Drawing 
Setup of the Layout menu. The default angles are 0, 30, 45, 60, and 90 
degrees and their complements.

By using this tool, the angle of lines are constrained or snapped as shown. 
You can also specify any angle in increments as small as one second of a 
degree. For information on changing the default or adding to the snap 
angles, see Drawing Setup in the Menu chapter.

To use the Multi-Angle Line tool:
o	 Select the Multi-Angle Line tool from the Tool palette.
o	 Move the cursor to the drawing area.
o	 Press the mouse button where you want to start drawing and move the 

mouse in the desired direction. 
o	 The line becomes longer the farther you move the cursor from the 

starting point.  Conversely, the line becomes shorter the closer the 
cursor is to the starting point.

If you try to draw a line with an angle of 35˚ or 85˚ from horizontal, 
PowerCADD will produce a line closest to the preset snap angle of 30˚ and 
90˚, respectively.

Lines with angles other than those listed above would also be similarly 
constrained.

NOTE: To draw lines at angles other than the preset snap angles press the 
Shift key to release the snap constraint.

NOTE: You can specify the preset snap angles.  See Drawing Setup, Snap, 
Constrain Snap Angles for additional information.

0º

90º

45º
60º

30º

💬💬

💬💬
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Continuous Line Tool
The Continuous Line tool is used to draw lines between the last point 
clicked and the next mouse click.

Lines are drawn from the last mouse-up point to the current mouse-down 
location and they automatically connect at their common end points.  
Pressing and holding the mouse button will not only draw the line to the 
mouse-down location, but will allow the end of the line to be stretched or 
moved to an appropriate location.  

The next click will draw a new line connecting it to the last line or last 
mouse click.

To use the Continuous Line tool:
o	 Using the Selection Arrow tool, click the mouse in the drawing window 

to set the start point for the Continuous Line tool.
o	 Select the Continuous Line tool from the Tool palette and move the 

cursor to the drawing area.
o	 Click and drag the mouse button; a new line will start from the previous 

mouse click and end when you release the mouse.
o	 The line becomes longer the farther you move the cursor from the 

starting point.  Conversely, the line becomes shorter the closer the 
cursor is to the starting point.

CAUTION: After selecting the Selection Arrow, if you click in the drawing 
and the next operation is the Continuous Line tool, a line will be drawn 
starting from where you clicked in the drawing.

⚠
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Parallel Line Tool
The Parallel Line tool may be used to draw parallel lines or a parallel polygon. 

Although the Parallel Line tool was designed for drawing walls in house 
plans, it can be used to draw many other shapes, which require parallel lines 
or require the finished shape be a closed polygon.

The closed polygon appears to have a hole in its center. 

The polygon can be filled, reshaped or changed just as any other polygon.

NOTE: Selecting the Parallel Line tool can automatically switch you to 
the Wall Layer (or another layer name of your choosing) if the Layer Tools 
feature is checked on in the Layout Menu.  If the Layer Tools feature is not 
checked on, objects are drawn on the active layer.

To use the Parallel Line tool:
o	 Select the Parallel Line tool from the Tool palette.
o	 Move the cursor to the drawing area.
o	 Press the mouse button where you want to start drawing and move 

the mouse in the desired direction.  You will notice three lines being 
drawn.  The outermost two solid lines will remain when the drawing is 
done.  The blue centerline is a visual aid to assist you in constructing 
your parallel lines.  The centerline will disappear when you finish 
constructing the object. 

o	 The lines become longer the farther you move the cursor from the 
starting point.  Conversely, the lines become shorter the closer the 
cursor is moved to the starting point. 

o	 Click where you want to place each of the intersection points or corner.
o	 Change the direction of the mouse.  Notice the angle is constrained to 

either 90˚ or 45˚.  If you press the Shift key while moving the mouse, 
you can drag the line to any desired angle.

o	 Click at the next desired point and continue drawing.
o	 Double-click to stop the drawing process.

1_press mouse to set start point
2_drag

blue construction line

3_release

4_drag to
see segment
length

5_click to set
segment length

6_double click to end

When using the Parallel Line tool, you will see two solid lines that represent 
the offsets and a ghost line in the center, which represents the centerline. 

💬💬
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Tap the Space Bar to shift the offset to the left, right or center positions 
while drawing.  This shift is not permanent and will revert back to the 
original position after the current object is created.

To end a drawing operation with the Parallel Line tool, double-click the 
mouse where you want to end. 

Draw by center is not available for the Parallel Line tool.

Pressing the Space Bar will cycle between left, center and right offsets.

NOTE: You can also specify a precise length and angle for each segment as 
you draw using direct input in the Edit Window.

To specify a length and angle as you draw: 
o	 Start to draw using the Parallel Line tool. 
o	 Press the Tab key and release the mouse.
o	 Enter the specific length or angle in the appropriate field of the Edit 

Window and press the Enter or Return key.
o	 If you entered a specific angle, drag the mouse in the drawing to define 

the length and click the mouse button.  If you entered a specific line 
length, drag your mouse to define the angle and click the mouse button.

To change the right and left offset (the space between the parallel 
lines):
o	 Press the Option key and select the Parallel Line tool from the Tool 

palette.  The following dialog will appear:

💬💬

o	 The Parallel line tool requires at least one value be entered in the Right 
or Left Offset fields.  The value is to scale based on values you entered 
for Drawing Setup in the Layout Menu.  Enter your offset values then 
press the Return key or click OK to continue.  To set an offset, enter 
half of the total offset required.  For example, if the wall is to be 6” 
wide, the right offset should be 3” and the left offset should be 3”.  

o	 To draw parallel lines, rather than a polygon, select Lines rather than Polygon. 
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If you normally dimension by the center of the wall, click Center Points and 
a non-printing point will be placed when drawing parallel lines.

There is an option for additional offsets to the Parallel Line tool.  If you 
would like additional offsets, your object must be a closed shape and the 
Lines option must be set.  The following example shows only one offset.

The following example shows both offsets being used.

Both offsets are measured as the distance from the outside line. If you want 
a 3-inch offset from the outside line for Offset 1 and Offset 2, you would 
use 3 inches for Offset 1 and 6 inches for Offset 2.

To set an offset, enter half of the total offset required. For example, if the 
wall is to be 6” wide, the right offset should be 3” and the left offset should 
be 3”. If you set the right offset to 6” and the left offset to 0”, you could 
create the walls of a building utilizing the outer dimensions by drawing 
counterclockwise.



Tools65

Additional optional settings for the Parallel Line tool are:

Polygon creates the parallel lines as a polygon that can be moved and 
manipulated.

Lines create the parallel lines as a set of lines placed in the drawing. All line 
segments remain as individual objects unless they are grouped or connected 
using Attach from the Tool menu.

Auto Line Cut allows you to place parallel lines and cut other lines at their 
intersections.  For example, you have constructed the outer walls of a floor 
plan using parallel lines.  You now need to create interior walls that connect 
to the outer walls with cutting and intersection cleanup.  Place the cursor 
on the point of the exterior wall where you wish to begin the interior wall.  
Press and drag the parallel line to construct the wall and click twice to end 
the object.  The interior wall has joined itself to the exterior wall without 
intersecting lines in the way.

Construct a solid wall floor plan.

To place a wall, construct a parallel line from a point on the exterior wall.

The added interior wall will be placed with the intersecting lines removed.

To create a wall between two walls cutting both intersections, place the 
cursor on the exterior wall and drag a parallel line to the interior wall and 
release.
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The opening will be inserted with the intersecting lines cleaned up and the 
short piece removed.

If a fill pattern or color is assigned to the Parallel Line tool, polygons 
matching the pattern or color will be assigned to the cavity between the two 
original wall lines.  This method of poché does not require the parallel lines 
to be a polygon.

Poché

To assign attributes or to poché with the Parallel Line tool:
o	 Select the Parallel Line tool from the Tool palette.
o	 Make sure no object in the drawing is selected. 
o	 If you would like a pattern in the wall cavity, choose Fill from the 

Attribute menu and determine the pattern of choice from the pop-out 
menu.

If you would prefer a grayscale or color instead of a pattern,
o	 Choose Fill from the Attribute menu and choose black from the pop-

out menu.
o	 Choose Fill Color from the Attribute menu and determine the color of 

choice from the pop-out menu.

Once you have set the attribute for the Parallel Line tool, it will remain the 
default until changed.

NOTE: The Paint Bucket tool may also be used to create a polygon that 
may be filled and used to poché the walls. The polygon created using the 
Paint Bucket tool may be on its own layer or on the same layer as the walls.

💬💬
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Rectangle Tools

PowerCADD provides three rectangle tools: Constrained Rectangle, Rotated 
Rectangle and Rounded Rectangle.  All tools create rectangles, which can be 
subsequently edited with the mouse or the Edit Window.

Constrained Rectangle Tool
This tool is used to draw rectangles constrained to the horizontal and 
vertical axes. 

To create a Constrained Rectangle:
o	 Select the Constrained Rectangle tool from the Tool palette. 
o	 Move the cursor onto the drawing where you wish to begin the 

rectangle.
o	 Press the mouse button to establish the starting point. 
o	 Continue to hold the mouse button and drag away from the starting 

point.
o	 Release the mouse button to complete the rectangle when it is the 

desired size and shape.

1_press to start

2_drag

3_release

4_result



Tools68

Rotated Rectangle Tool
This tool is used to draw rotated rectangles at any angle without constraint 
to the horizontal or vertical axes.

To create a Rotated Rectangle:
o	 Select the Rotated Rectangle tool from the Tool palette.
o	 Move the cursor onto the drawing area where you wish to begin the 

rectangle. 
o	 Press to establish the starting point.
o	 Continue to hold the mouse button as you drag away from the starting 

point. 
o	 Release the mouse button when the desired axis angle and direction 

has been defined.
o	 Move the mouse in any direction to define the desired characteristics 

of the rectangle.
o	 Click to establish the rectangle. 

1_press
to start

3_release
2_drag to
set length

4_drag to
set width

5_click

6_result

Pressing the Shift key while creating the rotated rectangle will allow you to 
constrain the axis of the rectangle to the preset snap angles.

Once the axis is established, it can be edited by using the Rotate command 
or the Edit Window.  The Edit Window can be used to establish the axis 
angle during creation of the rectangle, or it can be used to edit an existing 
rectangle.
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Round Rectangle Tool
This tool is used to draw squares and rectangles with rounded corners.

The use of the Round Rectangle tool is similar to the Rectangle tool:
o	 Select the Round Rectangle tool from the Tool palette. 
o	 Move the cursor to the drawing area where you want to place your 

rectangle.
o	 Press the mouse button to set the starting point.
o	 Move the cursor diagonally away from the starting point.  As you move 

the cursor away from the starting point the object becomes larger.  If 
you move the cursor back toward the starting point, the rectangle 
becomes smaller.

o	 Release the mouse button when the rectangle or square is the correct 
size.

Notice the extra edit handle that appears in the upper left corner when the 
round rectangle is selected. 

This corner radius handle is used to change the radius of the corners. 
Selecting and moving the corner radius handle can easily alter the shape of 
the curved corners. 

To change the radius of the rectangular object’s corners:
o	 Select the Selection Arrow tool.
o	 Move the Selection Arrow to the drawing area and select the rounded 

rectangle (or square) you wish to modify. Its handles should now be 
visible.

o	 Select the corner radius handle and hold the mouse button down.
o	 While holding the mouse button down, move the corner radius handle. 

As you move the handle, note the change in the corner radius.
o	 Release the mouse button when you see the desired radius.

corner radius
handle bar

B efore A fter

click and
drag this
edit handle
bar

NOTE: The corner radius handle can be dragged to a zero radius producing 
a “round” rectangle that has square corners.💬💬
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The default radius of the corner curvatures may be set as follows:
o	 Press the Option key and select the Round Rectangle tool from the 

Tool palette.  The following dialog will appear:

The dialog allows you to specify the type of round rectangle that will be 
created.

It offers two forms of initial creation: fillet rectangle or round end rectangle.  
Both options create the object with a corner edit handle to change the 
corner radius after creation.

The dialog box also allows you to specify the radius of the filleted corners.  

To specify a radius, simply select the current radius value and replace it with 
the new value.  This default setting will remain in effect until you change it.

o	 Select the object type desired.  After you have made your selection, 
press the Return key or click OK.
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Circle and Ellipse Tools

PowerCADD provides a suite of three circle and two ellipse tools for 
creating a wide range of simple and complex designs.  

All tools create circles or ellipses, which can be subsequently edited with the 
mouse or the Edit Window as described at the start of the Drawing Tools 
section.

Diameter Circle Tool
This tool allows you to construct circles based upon a given diameter.

To create a circle based on its diameter:
o	 To see the dimensions of the circle while drawing, open the Edit 

Window by choosing Edit from the Window menu.
o	 Select the Diameter Circle tool from the Tool palette.
o	 Place the cursor where you wish to start the circle, press the 

mouse button.  The point you specify will represent a point on the 
circumference of the circle.

o	 Drag the mouse away from the starting point and watch the Edit 
Window until you reach the value desired.  Release the mouse button.  
As you drag away from the starting point, a temporary blue construction 
line will appear to aid you in constructing the circle.

1_press
to start

2_drag
3_release
4_result

Once established, the circle can be changed using standard PowerCADD 
methods.

The Diameter Circle tool is useful when you need to create a circle, which 
passes through two points or is a specific diameter. 

To create a circle which passes through two points:
o	 To observe the dimension of the circle while drawing, open the Edit 

Window.
o	 Select the Diameter Circle tool from the Tool palette.
o	 Place the cursor on the first of the two points and press the mouse 

button.
o	 While watching the Edit Window, drag the mouse until the desired 

diameter or the second point has been reached, release the mouse button.
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o	 While establishing the diameter, notice as you drag the cursor away 
from the starting point you may also rotate the circle about the starting 
point.  While dragging, move the cursor about the starting point to 
view the rotation.  This will allow you to place the circle so its perimeter 
passes through two points and still retains its diameter.

Once established, the circle can be changed using standard PowerCADD 
methods.
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Radius Circle Tool
This tool allows you to create circles based upon a given radius. 

To create a circle based on a given radius
o	 To see the dimensions of the circle while drawing, open the Edit 

Window by choosing Edit from the Window menu.
o	 Select the Radius Circle tool from the Tool palette.
o	 Place the cursor where you wish to locate the center of the circle and 

press the mouse button. 
o	 Drag away from the starting point and watch the Edit Window until 

you reached the desired radius. 
o	 Release the mouse button. As you drag the circle out, a temporary 

blue construction line will appear from the center of the circle to the 
circumference to aid you in the construction of the circle.

3_release

4_result

1_press
to start

2_drag

Once established, the circle can be edited using standard PowerCADD 
methods.

This tool is also helpful when a circle is needed with its center at a specific 
point and its circumference touching another point.

Start the circle at the specified point, drag the cursor to the second point, 
and release the mouse button.
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Three-Point Circle Tool
This tool allows you to create a circle that must pass through three points. 

To create a circle based on three points:
o	 Select the Three-Point Circle tool from the Tool palette.
o	 Place the cursor on the first of the three points and press the mouse 

button.
o	 Drag to the second point and release.  An expandable circle will appear 

which passes through the two specified points and the cursor. 
o	 Click on the third point.

1_press

2_drag

3_release

4_drag

5_click

6_result

Once established the circle can be changed using standard PowerCADD 
methods.

Points placed so they form a straight line, or close to a straight line, will 
create enormous circles that will extend a great distance off the drawing 
page. 

⚠
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Ellipse Tools

Constrained Ellipse Tool
This to is used to draw ellipses constrained to the horizontal and vertical 
axes.

To create a Constrained Ellipse:
o	 Select the Constrained Ellipse tool from the Tool palette. 
o	 Move the cursor onto the drawing where you wish to begin the ellipse.
o	 Press the mouse button to establish the starting point.
o	 Continue to hold the mouse button as you drag away from the starting 

point.
o	 When the ellipse is the desired shape, release the mouse button.

1_press to start

2_drag to set
size of ellipse

3_release

4_result

Pressing the Shift key after you begin drawing will constrain the horizontal 
and vertical proportions of the ellipse. 

For example the ellipse tool can be used to create a circle, where the 
horizontal and vertical proportions of the ellipse are equal.

PowerCADD provides two ellipse tools: a Constrained Ellipse tool and a 
Rotated Ellipse tool. Both tools are used to create ellipses, which can be 
subsequently edited with the mouse or the Edit Window.
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Rotated Ellipse Tool
This tool is used to draw ellipses at any angle without constraint to the 
horizontal or vertical axes.

To create a rotated ellipse:
o	 Select the Rotated Ellipse tool from the Tool palette.
o	 Move the cursor onto the drawing where you wish to begin the ellipse. 
o	 Press to establish the starting point.
o	 Continue to hold the mouse button as you drag away from the starting 

point.
o	 Release the mouse button when the desired axis angle and direction 

has been defined.
o	 Move the mouse in any direction to define the desired characteristics 

of the ellipse.
o	 Click to complete the ellipse.

Pressing the Shift key while creating the rotated ellipse will allow you to 
constrain the axis of the ellipse to the preset snap angles.

Once the axis is established, it can be edited by using the Rotate command 
or the Edit Window. 

The Edit Window can be used to establish the axis angle during creation of 
the ellipse, or it can be used to edit an existing ellipse as described earlier 
in this section.
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Arc Tools

PowerCADD provides a suite of four circular arc tools and one elliptical arc 
tool for creating a wide range of simple and complex designs. 

All tools create arcs, which can be subsequently edited with the mouse or 
the Edit window as described at the start of the Drawing Tools section.

Radius Arc Tool
This tool allows you to draw an arc based on a given radius.

A radial arc is a portion of a circle which can represent any part of a circle 
from 0° 0’ 1” to 360° 0’ 0”.

To create a radial arc:
o	 To see the dimensions of the arc while drawing, open the Edit Window 

by choosing Edit from the Window menu. 
o	 Select the Radius Arc tool from the Tool palette. 
o	 Place the cursor in a location representing the center of the radial arc. 

Press the mouse button.  Since a radial arc is a portion of a circle, it 
is created in much the same way as a circle.  The center of a radial arc 
would be the center of a circle if the radial arc were extended 360˚.

o	 Drag away from the starting point and watch the Edit Window until 
you reach the desired radius and release the mouse button.

o	 As you drag the cursor, a temporary radial line will appear to aid in the 
construction of the arc.

o	 Move the cursor in the direction you wish for the arc to extend.  When 
the arc has reached the desired angular degree, click to establish the arc.

1_press
to start 2_drag

3_release

4_drag

5_click

6_result

The radial arc can be edited and filled like any object in PowerCADD.

Press the Shift key to constrain the radius arc to the preset snap angles in 
the Drawing Setup dialog.
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Three-Point Arc Tool
This tool allows you to create an arc that passes through three points.

To create a circular arc based on three points:
o	 Select the Three Point Arc tool from the Tool palette.
o	 Place the cursor on the first of the three points and press the mouse 

button.
o	 Drag the cursor to the second point and release.  An expandable arc 

will appear that passes through the two specified points and the cursor.
o	 Click on the third point.

The arc is established and can be changed using standard PowerCADD 
editing methods.

1_press

2_drag

3_release

4_drag

5_click

6_result
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Arc by Diameter Tool
This tool allows you to draw a circular arc by specifying a diameter.

Arc by Diameter is a two-point arc tool which produces a 180° circular arc.

To draw an arc:
o	 Place the cursor at the desired location for the first point of the diameter 

line. 
o	 Press and drag.  A ghost line will appear indicating the length and angle 

of the diameter line.  Release to complete the arc.

1_press
to start

2_drag
3_release

4_result

When creating an arc, you can change its horizontal or vertical orientation 
by tapping the Space Bar while dragging the diameter ghost line.

To constrain the diameter line to the preset snap angles, press the Shift key 
while drawing the diameter.



Tools80

Arc by Chord Tool
This tool allows you to draw a circular arc by first specifying a chord line 
and then a height.

Arc by Chord is a three-point arc tool which produces circular arcs given 
only a chord length and height.

To draw an arc:
o	 Select the Arc by Chord tool.
o	 Place the cursor at the desired location for the first point of the chord 

line.
o	 Press and drag.  A ghost line will appear indicating the length and angle 

of the chord line.  Release to end the chord line.
o	 Move the mouse to specify the height of the arc and click to complete 

the arc.

1_press
to start 2_drag

3_release

4_drag
5_click

6_result

To constrain the chord line to the preset snap angles, press the Shift key 
while drawing the chord.

NOTE: Arcs that have little curvature may place their center point off the 
drawing page.💬💬
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Elliptical Arc Tool
This tool allows you to create an elliptical arc of any size.

Elliptical arcs are quarter sections of ellipses or circles.

To draw an elliptical arc:
o	 Select the Elliptical Arc tool from the Tool palette. 
o	 Place the cursor where you wish to begin the arc and press the mouse 

button.
o	 Drag away from the starting point until you have created an arc of 

appropriate size and release the mouse button.

1_press
to start

3_release

2_drag

4_result

The arc has been established and can be edited using standard PowerCADD 
methods.

The elliptical arc can be filled and edited just like any other object.

When creating an elliptical arc, you can change its horizontal or vertical 
orientation by tapping the Space Bar while dragging the arc.

Pressing the Shift key while creating an elliptical arc will constrain the arc 
to the preset snap angles.  The constraint will apply to a line that passes 
through the start and finish points of the bounding rectangle.
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Polygon and Bézier Tools

Before describing each Polygon and Bézier tool in detail, the following 
general information applies when working with all these tools. 

o	 Dynamic Snapping may be used to modify the start or end points of 
any polygon or Bézier both during object creation and when editing.

o	 AutoScrolling is in effect.  The screen will automatically scroll if you 
drag to draw an object which is larger than the currently displayed 
drawing area.

o	 Direct input via the Edit Window is only accepted for the Polygon and 
Regular Polygon tools.

o	 Polygons and Béziers may be edited after they’re created using the 
mouse by selecting the object and picking Reshape from the Edit 
Menu.

See sections in the manual regarding the Tool Menu, Polygon Menu and 
Edit Menu, Reshape for additional features and information on working 
with Polygons and Béziers.

!
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Polygon Tool
This tool allows you to create open or closed polygon shapes with two or 
more sides.

Polygons are objects with at least two sides and are normally drawn closed 
like hexagons and triangles.

To create an open or closed polygon:
o	 Select the Polygon tool from the Tool palette.
o	 Place the cursor where you wish to start the polygon and press the 

mouse button.
o	 Move the cursor to the end of the first side.  You will see the first side 

of the polygon being formed as you move away from the starting point.  
Release the mouse button to establish the first side of the polygon. 

o	 Move the cursor to the end of the second side of the polygon.  Again 
you will see the line segment being formed as you move the mouse.  
Click the mouse button to establish the second side of the polygon.

o	 Continue this pattern to add as many sides as you wish. 
o	 To create a closed polygon continue the process of adding sides until 

you have returned to the starting point.  Upon reaching the starting 
point, place the cursor directly over the first point created and click.  
The polygon will become an editable object and the Polygon Drawing 
tool will remain selected. 

o	 To create an open polygon, add as many sides as necessary and click 
twice on the end point of the last side entered.  The line segments will 
become an editable object and the Polygon Drawing tool will remain 
selected. 

Closed and open polygons can be reshaped and filled with patterns.

Press the Shift key to constrain the side being drawn to the preset snap 
angles specified in Drawing Setup.

Press the Option key to prevent closure and to allow placing duplicate 
control points on top of each other.  
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This is helpful if two points in the polygon are very close together.  

If you get near an existing point, a snap function may attach the points 
causing the polygon to close and become an object.  To prevent this, press 
the Option key and the polygon will not close.

Press the Enter key to end the current polygon and leave the Polygon tool 
selected.

Reshaping a Polygon To reshape a polygon using the mouse:
o	 Select the polygon to be edited.
o	 Choose Reshape from the Edit menu.
o	 Each vertex of the polygon will display an edit handle.
o	 Use the mouse to drag each handle to the desired location. 
o	 Press the Option key and select an edit handle to delete it.  The cursor 

will change to include a (–) sign when the mouse is over the edit handle.
o	 Press the Option key and click anywhere on the polygon to add a new 

point.  The cursor will include a (+) sign when the mouse is on the 
polygon.

o	 Press the Enter key or click in the drawing window to complete the 
edit operation. 

NOTE: You can also use the Edit Window to create open or closed polygon 
shapes quickly accurately.

The ability to directly enter data in the Edit Window while creating an 
object can have significant advantages.  A single polygon can be filled to 
create color renderings, or used to perform area and perimeter calculation 
for land use or space planning analysis among many other benefits.  For 
example, you might have received a photocopy reduction of a surveyor’s 
land parcel drawing, and you’d like to quickly draw it based on the layout 
information provided. 

To draw a polygon using direct data entry in the Edit Window:
o	 Select the Polygon Drawing tool from the Tool palette.
o	 Place the cursor where you wish to start the polygon and press the 

mouse button.
o	 Start to drag the mouse to draw the first segment of the polygon.
o	 Without releasing the mouse button, press the Tab key then release 

the mouse.
o	 The Edit Window will be activated.  Press the Tab key to navigate in 

the Edit Window to the Length Field.
o	 Type a value in the Length Field and press the Return key.
o	 Drag the mouse in the drawing window to define the angle.  Press the 

Shift key to constrain the movement to the preset snap angles.

💬💬
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o	 Click the mouse to complete the first segment.
o	 Drag the mouse to begin the next segment.
o	 Press the Tab key then release the mouse. 
o	 Press the Tab key again to navigate in the Edit Window to the Angle 

Field.
o	 Type a value in the Angle Field and press the Return key.
o	 Drag the mouse in the drawing window to define the length.
o	 Click the mouse and second segment is completed.
o	 Repeat these steps for each segment and press the Esc key when all 

segments have been drawn. 
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Smooth Polygon Tool
Smooth Polygons, also known as B-Spline curves, are a type of mathematical 
curve similar to a French curve used in manual drafting.  

A Smooth Polygon, or B-Spline, generates continuous curves based on the 
straight polygon segments you draw.

To create an open or closed Smooth Polygon:
o	 Select the Smooth Polygon tool from the Tool palette. 
o	 Place the cursor where you wish to start the polygon and click.
o	 Move the cursor to the end of the first side.  You will see the first side of 

the smooth polygon being formed as you move away from the starting 
point.  Release the mouse button.  The first side of the smooth polygon 
has been established.

o	 Move the cursor to the end of the second side of the smooth polygon 
and click.  Again you will see the line segment being formed as you 
move the mouse.  The second side of the smooth polygon has been 
established. 

o	 Continue this pattern to add as many sides as you wish.
o	 To create a closed polygon continue the process of adding sides until 

you have returned to the starting point.  Upon reaching the starting 
point, place the cursor directly over the first point created and click.  
The smooth polygon will become an editable object and the Smooth 
Polygon tool will remain selected.

NOTE: A smooth polygon may also be created by drawing a regular polygon 
and choosing Smooth from the Polygon submenu in the Tool menu.

NOTE: To convert a smooth polygon into a regular, straight-sided polygon, 
choose UnSmooth from the Polygon submenu in the Tool menu.

💬💬

💬💬
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To reshape a smooth polygon using the mouse:
o	 Select the smooth polygon to be edited. 
o	 Choose Reshape from the Edit menu.
o	 Each control point for the smooth polygon will display a handle. 
o	 Drag each handle to the desired location.
o	 Option-click on an edit handle to delete it.  The cursor will change to 

include a (–) sign when the mouse is over the edit handle. 
o	 Option-click anywhere on the smooth polygon to add a new control 

point.  The cursor will include a (+) sign when the mouse is on the 
smooth polygon.

o	 Press the Esc or Enter key to complete the edit operation.

Reshaping a 
Smooth Polyon



Tools88

Freehand Tool
The Freehand tool allows you to create unstructured freehand lines and 
shapes.

To use the Freehand tool:
o	 Select the Freehand tool from the Tool palette.
o	 Place the cursor where you wish to begin the freehand line and press 

the mouse button. 
o	 Move the cursor in any direction and the unstructured line will appear.  

This tool is much like drawing with a pencil or pen.  You are allowed to 
draw a freehand line in any direction without constraint.

o	 Release the mouse button when the desired object has been created to 
end the freehand line. 

The Freehand Drawing tool will remain selected to allow additional drawing 
without reselecting the tool.

The Freehand tool uses intelligent thinning of points or vertices during the 
drawing process to produce polygons matching the mouse movement.  The 
resulting objects can be filled, moved, smoothed, or reshaped as needed to 
add or delete unneeded points.

NOTE: The Freehand tool (or any PowerCADD tool) can also be used with 
a graphics tablet and stylus instead of a mouse.  The Freehand and Freehand 
Bézier tools in particular benefit from the more intuitive feel of sketching 
with a stylus verses dragging with a mouse.

💬💬
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o	 Press the option key and select the Freehand tool.  The following dialog 
will appear:

Distance controls the number of screen pixels the mouse must move before 
a point is added to the polygon.  Typically, you will use a value of 4 to 
8 pixels.  Smaller numbers produce more finely detailed polygons; larger 
numbers produce coarser polygons.

Line controls a filter that’s used after the polygon is drawn to throw away 
points that are roughly in-line.  If you enter a value of 2 for Line, then for 
any three points, A, B and C, the point B is thrown away if it falls within 2 
screen pixels of the line AC.  It is best to leave this value at 1 or 2, for most 
purposes.

Smooth converts the polygon to a B-spline.  This is the same as choosing 
the Smooth command.
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Freehand Bézier Tool
The Freehand Bézier tool creates a Bézier curve from the freehand shape 
that is drawn. 

Like the other Freehand tool, the Freehand Bézier points are intelligently 
thinned during the drawing process. The resulting Bézier curve may be 
reshaped by using the Bézier editing methods discussed below.

To set the behavior of the tool:
o	 Press the Option key and select the Freehand Bézier tool.  The following 

dialog will appear:

Distance controls the number of screen pixels the mouse must move before 
a point is added to the polygon.  Typically, you will use a value of 4 to 
8 pixels.  Smaller numbers produce more finely detailed polygons; larger 
numbers produce coarser polygons.

Line controls a filter that’s used after the polygon is drawn to throw away 
points that are roughly in-line.  If you enter a value of 2 for Line, then for 
any three points, A, B and C, the point B is thrown away if it falls within 2 
screen pixels of the line AC.  It is best to leave this value at 1 or 2, for most 
purposes.

Fit controls the behavior of the Bézier curve fitting that’s done after you 
draw.  Smaller numbers result in more Bézier segments; larger numbers 
result in fewer Bézier segments.  The range of allowable numbers is 1 to 400, 
however it is best to use values around 20.   Extremely high or low numbers 
sometimes produce strange results.

Reshaping a 
Smooth Polyon

To reshape a polygon using the mouse:
o	 Select the Freehand Bézier to be edited.
o	 Choose Reshape from the Edit Menu.
o	 Adjust the control rods to reflect the new shape.
o	 Press the Esc key to compete the edit operation.

You can also add, subtract or modify the control rods of a Freehand Bézier 
using a combination of key commands the mouse.  See the Bézier Tool later 
in this section for additional information.
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Bézier Tool
Bézier curves are smooth mathematical curves that pass through specified 
adjustable points.  Béziers are the electronic equivalent of the French curve.

Bézier curve composed of two Bézier segments

A Bézier segment consists of three basic elements:  Anchor points, control 
points, and controls rods. 

Anchor points represent the end points of a segment. 

A control point is a point associated with an anchor point that affects the 
direction and shape of the curve when dragged.  Increasing the distance 
between a control point and its anchor point increases the pull on the curve; 
conversely, decreasing the distance decreases the pull on the curve.  If the 
distance is zero, a sharp corner is produced in the curve. 

A control rod represents the distance between a control point and its 
anchor point. It is important to note the curve through an anchor point is 
always tangent to the control rod connected to the anchor point. 

When the Bézier Curve tool is in use, you will see a pen-like cursor.  There 
are seven variations of this cursor depending on what type of operation you 
are performing.

The Drawing cursor is the first cursor that will appear when you begin 
constructing a Bézier curve.  The plus (+) indicates the creation or addition 
of anchor points.

The Reshape cursor will appear when the Reshape command is applied to 
a selected Bézier curve.

The Delete cursor will appear when the Option key is pressed during 
drawing or reshaping. The minus (–) indicate the removal of anchor points 
and control points.  Pressing the Option key and clicking on the center of 
an anchor point deletes the anchor point.  Pressing the Option key and 
clicking on the end of a control rod point deletes the control rod segment.

Drawing Cursor

Reshape Cursor

Delete Cursor

Anchor
[BezierTool]
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The Add cursor will appear when Option key is pressed during drawing and 
reshaping and clicking anywhere on a curve.  The plus (++) indicates the 
addition of anchor points.

The Close curve cursor will appear when Option-Control keys are pressed 
during drawing and clicking on the first point in the Bézier.  The Bézier will 
automatically close.

The Move Segment cursor will appear when the Command key is pressed 
during drawing or reshaping and clicking anywhere on the surface of the 
curve.  Drag the cursor to move the segment in or out to change the shape 
of the curve. 

The Knife cursor will appear when Option-Control keys are pressed and 
you select an existing anchor point of a closed Bézier.  The Bézier curve is 
broken at the anchor point and may be dragged apart. 

The Break/Extend cursor will appear when the Command key is pressed 
during drawing or reshaping and you select a control point or anchor 
point.  The break and extend operations allow you to lengthen, shorten, 
or break the control rods to create discontinuous curves or right angle 
bends.   You can also expand a previously collapsed or broken control 
rod by pressing the Command key and clicking on the node with the 
collapsed controlled rod.

To draw a Bézier:
o	 Select the Bézier tool from the Tool Palette.
o	 Move the cursor to the location you wish to start the curve.  Press and 

drag.  An anchor point and its control points will appear.  When the 
control rod is the desired length and angle, release the mouse button.

o	 Move the cursor into position for the end point of the first Bézier 
segment and press.  Drag to locate the control points and rods as 
described above.  To create a straight segment, click to place an anchor 
but do not drag out the control points.

o	 If another anchor point is needed, follow the directions for locating 
another anchor point.  You may add as many Bézier segments as you 
wish using this procedure.  If you want to create a closed path, drag one 
end anchor point of a segment and place it on top of the curve’s other 
end anchor point. 

o	 To end the Bézier drawing process, press the Esc or Enter keys or 
double-click.

You may undo the last curve segment while drawing or reshaping by 
pressing Command-Z. 

Add Cursor

Close Curve Cursor

Move Segment Cursor

Open Curve Cursor

Break/Extend Cursor

Drawing Béziers
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Multiple curve segments can be removed one at a time by pressing the 
Delete key for each segment.

To undo the current drawing or reshaping session, press the Enter key, then 
press Command-Z.

To edit an existing Bézier curve, select a curve and choose Reshape from the 
Edit menu.  Anchor points, control points and rods will reappear for you 
to make adjustments. 

Bézier curves have nearly-limitless flexibility.  Once a curve is created, 
it can be adjusted to produce almost any shape including long flowing 
paths, intricate scroll-like patterns, and straight lines.  All of these 
shapes are made by variations of basic adjustments.  Adjustments 
to curve segments can be made any time during the Bézier drawing 
process by moving anchor points, control points, or by dragging the 
curve itself.

To move an anchor point while drawing or when using the Reshape 
command: 
o	 Place the cursor over the desired anchor point, press and drag to a 

new position.  The curve will change as the anchor point is being 
moved, but the control points and rods will remain at their set length 
and angle.

o	 When the anchor point is in the desired location, release the mouse.

To move a control point while drawing or when using the Reshape 
command:
o	 Place the cursor over the desired control point.  Press and drag 

to a new position.  You may change the length of each rod 
independently.  Lengthening rods pulls on the curve in the direction 
of the rod length change; shortening the rod relaxes the pull of 
the curve.  Rotating the rod will change its angle.  If the anchor 
point associated with the control point is connecting two Bézier 
segments, both segments will change.

o	 When the control point is in the desired location, release the mouse.

To drag a curve segment while drawing or when using the Reshape 
command:
o	 Place the cursor over the desired curve segment. Press and drag to the 

desired location, then release.

NOTE: While drawing and reshaping Béziers, snapping is automatically turned 
off.  This enables you to make very minor changes to curves, without interference.  
To activate a snap, press the corresponding snap key on the keyboard.

Adjusting Béziers

💬💬



Tools94

The Bézier Curve tool has many advanced capabilities which are keystroke 
and mouse combinations; that is, you must press a key while clicking or 
dragging with the mouse.  The following information illustrates these 
combinations according to the end result on the curve.

Anchor points can be added to the end of existing curves, which adds 
additional Bézier segments.  You may also add anchors onto a curve itself, 
between its existing endpoints. 

To add an anchor point to the end of an open Bézier curve:
o	 Select a curve and choose Reshape from the Edit menu.
o	 The Bézier will automatically be extended from its end point.
o	 Move the cursor to the desired location, click to add an additional 

control point and drag to shape the curve. 

To add an anchor point to the start of an open Bézier curve:
o	 Select the Bézier tool.
o	 Click the end point of the Bézier.
o	 The Bézier will automatically be extended from the point you clicked.

To add an anchor point which creates a straight segment or sharp 
corner:
o	 Select a curve and choose Reshape from the Edit menu. 
o	 Move the cursor to the desired location and click.  A new anchor point 

is added with no control rods. 

To add an anchor point onto an existing curve segment:
o	 Select a curve and choose Reshape from the Edit menu. 
o	 Move the cursor on top of the segment, press the Option key and click.

To delete an anchor point from a curve:
o	 Select a curve and choose Reshape from the Edit menu.
o	 Move the cursor over the anchor point to be deleted, press the Option 

key and click.

You may add or delete control points and rods to existing anchor points 
while drawing or reshaping.  Once added, they can be dragged and shaped 
as needed.

To add a control point:
o	 Move the cursor over the desired anchor point, press the Command 

key and drag. 

To delete a control point:
o	 Move the cursor over the control point to be deleted, press the Option 

key and click.

Advanced Bézier Curves

Adding and Deleting 
Anchor Points

Adding and Deleting 
Control Points
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A discontinuous curve is a curve whose path makes an abrupt change in 
direction—a sharp corner.  The sharp corner is created by breaking a control 
rod into two independently-editable control rods.  When the control rod is 
broken, the two control rods appear hinged at the anchor point.  You may 
create discontinuous curves while drawing or reshaping.

To create a discontinuous curve:
o	 Move the cursor over a control point.  While pressing the Command 

key, press and drag.  The control rod will break at the anchor point, 
allowing you to rotate the rod.

To change a discontinuous curve back to a continuous curve:
o	 Move the cursor over the control point of a discontinuous curve.  Press 

the Command key and click the control point.

You may reshape a curve segment by pulling directly on the curve while 
drawing or reshaping.  This gives you lots of flexibility by allowing you to 
stretch and even shear curves

You may:
o	 Press and drag the curve to adjust the length of only the inside control 

rods, that is, the rods closest to the segment that is moved.  The curve 
will remain continuous.

o	 Press the Command key while pressing and dragging the curve.  This 
will break and adjust the control rods associated with the selected curve 
and produce a discontinuous curve.

o	 Press the Control key while pressing and dragging the curve.  This 
will adjust the selected curve segment and its adjacent curves, and will 
produce a discontinuous curve.

You may close a curve while drawing or editing: 
o	 Press the Option-Control keys and drag over the first point of the 

curve.
o	 The cursor will change to a close cursor.
o	 Click to close the curve.

You may break a closed curve while drawing:
o	 Press the Option-Control keys and select an anchor point of a closed 

curve.
o	 The curve will be broken at that anchor point.
o	 Drag the anchor points apart to open the curve.

To break a closed or open curve after it is drawn, use the Break tool.

Creating Discontinuous 
Curves

Pulling on the Curve

Closing a Curve

Breaking a Curve
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Regular Polygon Tool
The Regular Polygon tool is used to draw polygons with three or more sides 
of equal length and angles.

With the Regular Polygon tool, polygons with equal sides and equal angles can 
be constructed with great ease.  Regular polygons can be filled with patterns 
and reshaped.

The Regular Polygon tool allows you to specify the number of sides the 
polygon will have and how the polygon will be created.  There are two 
methods of creating polygons.  You may create the polygon by drawing 
from the shape’s center to a vertex (outside radius) or you may draw from 
the shape’s center to the midpoint of one surface (inside radius).  Once a 
method is set, it remains in effect until you change it.

To set the behavior of the tool:
o	 Press the Option key and select the Regular Polygon tool.  The 

following dialog will appear:

o	 Type the number of sides desired (3 or more) and set the method of 
construction.  Press the Return key or click OK.

To draw a regular polygon:
o	 Move the cursor to the drawing area where you wish to construct the 

polygon. 
o	 Press the mouse button to set the starting point, then drag the cursor from the 

starting point in any direction.  You will notice the polygon’s shape is instantly 
modified to show you what it will look like.  The line representing the polygon’s 
radius line is a visual aid only and will disappear when the polygon is complete.

o	 Press the Shift key while drawing to constrain the construction line to 
the preset snap angles.

o	 When you see the desired polygon, release the mouse button.

The regular polygon will appear.

OR

1_press

3_release

2_drag
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Dimensioning Tools

The dimensioning tools of the PowerCADD Tool palette consist of a suite 
of versatile, easy-to-use dimensioning tools. These tools enable you to 
dimension lines, angles, circles, and add centerlines and long breaks. The 
following section describes each of the PowerCADD drawing tools in detail.

NOTE: Selecting a Dimension tool can automatically switch you to the 
Dimension Layer (or another layer name of your choosing) if the Layer 
Tools feature is checked in the Layout menu.   If the Layer Tools feature is 
not checked, dimensions are drawn on the active layer.

Before describing each Dimensioning tool in detail, it is important to be 
aware of the following fundamental concepts, which apply to all dimension 
tools: 
o	 Dynamic Snapping may be used to modify the start or end points of 

any dimension both during object creation, when moving objects or 
positioning dimension lines.

o	 AutoScrolling is in effect.  The screen will automatically scroll if you 
drag to draw an object which is larger than the currently displayed 
drawing area.

o	 By default, the units of measure applied by a dimension tool are 
as specified in the Drawing Setup dialog.  You can override these 
preferences using optional settings described later in this section.  See 
Modifying Dimensions later in this section.

o	 A drawing may be dimensioned in single or mixed units.  For Example, 
you can draw in inches but dimension in millimeters or both inches 
and millimeters.

o	 The Dimensions Floating Window may be used to change attributes of 
any dimension in your drawing.  See the Window Menu section of this 
manual for additional information.

o	 Changing the size of a dimension line will automatically update the 
associated dimension text.

o	 Setting the text attributes for one dimension tool sets all dimension 
tools to match.

o	 The size and font of the dimension text may be modified with 
commands from the Text menu, Text Attributes Window or from a 

💬💬
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contextual menu.
o	 The dimension text can be moved on the drawing without disturbing 

the dimension line.
o	 To change the dimension default settings, press the Option key and 

select any dimension tool.  For more details about changing the 
Dimension tool defaults, or setting accuracy and tolerance, see Setting 
Dimension Defaults, later in this chapter.

o	 A dimension line and its accompanying measurement or leader lines 
may be modified after it is drawn.  For more information about 
modifying dimensions after they have been drawn, see Edit in the 
Menus chapter and “Modify Dimension” later in this chapter.

NOTE: Dimension text supports font styles such as bold, italic, and 
underline.  In the MacOS, not all font families include a bold, italic or 
other special font styles.

NOTE: Use the Move Points tool to change the length of your dimensions 
and objects at the same time.

See sections in the manual regarding the Attribute (Attr) Menu, Arrows and 
Layout Menu, Drawing Setup, Dimensions Tab for additional information 
on setting dimension tool preferences for your drawing.

💬💬

💬💬

!
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Linear Dimensioning Tools

Each of PowerCADD’s linear dimensioning tools is optimized for various 
standard drawing and dimensioning techniques traditionally used in 
manual drafting.  These tools allow you to efficiently and accurately create 
linear dimensions describing object geometry or the spaces and relationships 
between objects to effectively communicate your designs.
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Dimension Line Tool
The Dimension Line tool is used to draw lines at any angle and automatically 
includes the length dimension of the constructed lines.

Nearly all technical drawings require objects be dimensioned in a unit of 
measurement such as feet, inches, meters or centimeters.  In addition, the 
dimension lines usually have arrows on each end of the line delimiting the 
distance being measured.  A dimension line indicates the direction and 
length of a dimension.  Drawing with the Dimension Line tool measures 
the distance you have drawn and puts the dimension in the center of 
the dimension line.  This tool is normally set to draw lines ending with 
dimension indicators.  The dimension line end indicators can be arrows, 
circles, or slashes.

Drawing the dimension lines manually is a time-consuming and tedious 
task.  With the Dimension Line tools, this process is greatly simplified.

Like the Line tool, the Dimension Line tool is useful to draw dimension 
lines at any angle.  In addition, the Dimension Line tool creates a line, 
which includes its length in the currently selected unit of measurement

To use the Dimension Line tool:
o	 Select the Dimension Line tool from the Tool palette.
o	 Move the cursor to the drawing area of the screen.
o	 Press the mouse where you want to start drawing (the starting point) 

and move the mouse in the desired direction.
o	 By rotating the line about the starting point, you will be able to draw 

a line having various preset angles from the horizontal.  Normally the 
angles will be constrained to 0, 30, 45, 60, and 90 degrees (like the 
Multi-angle Line tool).  By pressing the Shift key, after drawing has 
started, you may draw lines at any angle you desire. 

o	 Release the mouse button upon completing the line.  The line and its 
corresponding dimensions will be drawn. 
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Notice the lines shown in the illustration include arrows at each end of the 
line segments and the length of each line in inches. 

NOTE: Changing the length of the dimension line causes the dimension 
text to reflect the new dimension.💬💬
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Witness Line Dimension Tool
The Witness Line Dimension tool is used to draw dimension lines with one 
or two extension lines.

An extension line “extends” from a point on the drawing to which a 
dimension line refers (see the illustration below).  The Witness Line 
Dimension tool is constrained to the preset snap angles specified in the 
Drawing Setup: Snap tab under the Layout menu.  Pressing the Shift key 
will override the preset snap angles, allowing you to draw a Witness Line 
Dimension at any angle.

To use the Witness Line Dimension Line tool:
o	 Select the Witness Line Dimension tool from the Tool palette.
o	 Move the cursor to the point on the object you wish to dimension.
o	 Press the mouse at the point where you wish to establish the dimension 

starting point.  Move the mouse to the end of the dimension.  The line 
you see being drawn is a dimension line.  When you have created the 
desired line, release the mouse button.

o	 Move the cursor away from the line.  As you begin to move away, you 
will see perpendicular lines appear from the sides of the dimension line. 
These lines are extension lines.  By moving the cursor you can set the 
angle of the dimension extension lines to any of the snap angles.  By 
pressing the Shift key you can constrain the dimension parallel to the 
first line.

o	 Click at the approximate location and angle of the dimension text.  You 
will now see the entire dimension line with corresponding extension 
lines.

The Witness Line Dimension tool can also be used to dimension the space 
between objects and they may be at any angle. Some examples of various 
dimensioning conditions include:
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Face Dimension Tool
The Face Dimension tool is used to dimension a flat surface at any angle by 
selecting the surface and dragging the dimension.  The Face Dimension tool 
can be used repeatedly without reselecting the tool.

To use the Face Dimension tool:
o	 Select the Face Dimension tool from the Tool palette. 
o	 Place the cursor on the surface to be dimensioned, press the mouse 

button. 
o	 Drag in the direction you wish to locate the dimension.  As you drag, 

a dimension line and two leaders will appear.  This parallel line can 
be offset to different angles depending on the dimension you need to 
specify.  Dimension lines will snap to the angles specified in Drawing 
Setup. 

o	 When the cursor is in the appropriate location, release the mouse 
button and the dimension will be established. 

Pressing the Shift key when drawing the dimension will release the 
dimension from the preset snap angles and snap it parallel to the surface 
being dimensioned.
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Chain Dimension Tool
The Chain Dimension tool is used to dimension a drawing with a series of 
dimensions that fall in a straight line.

To use the Chain Dimension tool:
o	 Select the Chain Dimension tool from the Tool palette.
o	 Place the cursor where you want to start the first leader line, press the 

mouse button.
o	 Drag in the direction to be dimensioned.  This line should span the 

same distance as the intended dimension. Release the mouse button.
o	 Move away from the line you just created.  An expanding dimension 

line will appear.  The dimension can be set to any angle and at any 
distance away from the object surface.

o	 Place the cursor where you want to place the dimension line and click. 
The first dimension is now established.  All subsequent dimensions will 
be located in a straight line with the first dimension.

o	 To establish the next dimension; click at the next dimension point.  
You may place as many string dimensions as you wish without re-
establishing the initial dimension.

o	 To stop a dimension string, click twice at the last dimension point or 
press the Esc or Enter key.  This will stop the dimension string and 
leave the tool selected.  You may then begin another dimension string.

o	 To deselect the Chain Dimension tool, click in a blank space in the 
drawing or select another tool.
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Stack Dimension Tool
The Stack Dimension tool is used to dimension a drawing with a stack of 
evenly spaced parallel dimensions originating from a common dimension 
line.

To use the Stack Dimension tool:
o	 Select the Stack Dimension tool from the Tool palette.
o	 Place the cursor where you want to start the first dimension and press 

the mouse button.
o	 Drag in the direction of the dimension point.  This line should span 

the same distance as the dimension line.  Release the mouse button. 
o	 Move away from the line you just created.  An expanding dimension 

line will appear.  The line, parallel to the line you created, represents the 
dimension line.  The perpendicular lines represent the extension lines.  
These lines can be set to any angle and at any distance away from the 
object surface. 

o	 Move to where you want to place the dimension line and click.  The 
first dimension is now established.  All subsequent dimensions will be 
located so a parallel stack will be formed by the stack dimension lines.

o	 To locate the next dimension; select the next dimension point.  You 
may place as many stack dimensions as you wish without reselecting 
the tool.

o	 To stop a stack dimension, click twice at the end of the last dimension 
or press the Esc or Enter key.  This will stop the stack dimension 
and leave the tool selected.  You are then free to begin another stack 
dimension. 

o	 If you want to deselect the tool, you may click in a blank space in the 
drawing or select another tool.
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Base Line Dimension Tool
This tool allows you to place a dimension on a point that tells you how far 
that point is away from the Drawing Origin. The dimensions are given in 
absolute values, representing how far the point is away from the current 
Drawing Origin.

To use the Base Line Dimension tool:
o	 Select the Base Line Dimension tool from the Tool palette.
o	 Place the cursor at the point you wish to dimension, press the mouse 

button.
o	 Drag the cursor vertically for an X-axis dimension and horizontally for 

a Y-axis dimension.  This tool will dimension one axis at a time.  If you 
want both X and Y coordinates dimensioned, place a dimension line 
both vertically and horizontally.

o	 At a suitable distance away from the dimension point release the mouse 
button.  The point-to-point drag will represent the leader line.  The 
dimension text will be placed at the end of the line.

To resize the leader, or if you change the scale, select the handle of the 
leader line by the text to resize.  If the drawing scale has been changed, 
this stretching operation will recalculate the dimension to match the units 
setting.

Dimensions are values as measured from the 0,0 drawing origin.  To change 
the drawing origin, 0,0 point:

You may use the snap options with this tool.  For example, to dimension 
the center point of a rectangle, hold the C key while drawing the dimension 
line to snap it to the center of the rectangle.
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To move the dimension text, simply select it and move it just as you would 
any object.

NOTE: The Drawing Origin can be repositioned and even snapped to an 
existing object in the drawing.  Changing the Drawing Origin will not 
modify existing Baseline Dimensions in the drawing; all new Baseline 
Dimensions will reflect the changed drawing origin.

💬💬



Tools107

Survey Dimension Tool
This tool allows you to add bearing and distance dimensions to your 
drawings.

The tool can be used to dimension polygons, lines, and other objects.  The 
dimension text is inserted and rotated to match the angle and bearing of the 
object and the dimension text is inserted above the line

To use the Survey Dimension tool:
o	 Select the Survey Dimension tool from the Tool palette.
o	 Place the cursor at the point to start the dimension and press the mouse 

button.
o	 Drag in the direction of the bearing.  A ghost line connects the starting 

point with the cursor.
o	 Release at the end of the dimension.  The distance and bearing appear.
o	 To change the method in which bearings and distances are displayed 

(such as azimuth or bearing), change the unit and angle defaults using 
Drawing Setup: Units in the Layout menu.

The information inserted for the dimension length and bearing are normal 
PowerCADD text objects.  As such, the values for length and bearing do 
not automatically recalculate after an object is reshaped, resized or rescaled.
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Radial & Angular Dimensioning Tools

Each of PowerCADD’s radial and angular dimensioning tools is optimized 
for various standard drawing and dimensioning techniques traditionally used 
in manual drafting.  These tools allow you to efficiently and accurately create 
radial and angular dimensions describing object geometry or the spaces and 
relationships between objects to effectively communicate your designs.

Radial Dimension Tool
The Radial Dimension tool allows you to dimension the radius of a circle or 
arc.  The tool may be used repeatedly without having to reselect it.

To use the Radial Dimension tool:
o	 Select the Radial Dimension tool from the Tool palette.
o	 Place the cursor on the circle or arc you wish to dimension, press the 

mouse button.
o	 The radial dimension will appear.  The placement of the dimension 

text is specified by the location of the cursor when the mouse button is 
released.  If the cursor is inside the circle, the text will be placed inside the 
circle; if the cursor is outside the circle, the text will be placed outside.

o	 When the cursor is in an appropriate location, release the mouse 
button, and the dimension is established.

To edit a radial dimension:
o	 To change the location of the dimension text, select it and drag the text 

to a new location.  If you change the location of the radial line, the text 
will snap back to its original position.

o	 To reset the angle or distance from the object, select the handle located at the 
bend of the radial dimension leader and drag.  The angle and distance may be 
changed while the horizontal line and the text remain locked at horizontal.

To change the dimension default settings, press the Option key and select the dimension 
tool.  You may set the defaults of the circular dimension tools independently.

To move the dimension text, simply select it and move it just as you would 
any object.
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Diametrical Dimension Tool
This tool is used to dimension the diameters of circles and arcs.

To use the Diametrical Dimension tool:
o	 Select the Diametrical Dimension tool from the Tool palette.
o	 Place the cursor on a circle or arc, press the mouse button.
o	 A diameter dimension line will appear.  The placement of the dimension 

text is specified by the location of the cursor when the mouse button is 
released.  If the cursor is inside the circle, the text will be placed inside 
the circle; if the cursor is outside the circle, the text will be placed 
outside. 

o	 A diameter dimension line will appear.  The placement of the dimension 
text is specified by the location of the cursor when the mouse button is 
released.  If the cursor is inside the circle, the text will be placed inside 
the circle; if the cursor is outside the circle, the text will be placed 
outside.

o	 When the mouse button is released, the dimension line is placed and 
the dimension text will appear.

To change the dimension default settings, press the Option key and select 
the dimension tool.  You may set the defaults of the circular dimension tools 
independently. 

To edit the Diametrical Dimension:
o	 To reset the angle of the dimension line or the distance from the object, 

select the handle located at the bend of the leader and drag.  The angle 
and distance may be changed while the horizontal line and text remain 
locked at horizontal.

o	 When resizing or relocating the dimension lines which are inside 
the circle or arc, the selection handle will be located on one of the 
arrowheads.  If the dimension text is in the way, move the text 
momentarily.

To move the dimension text, simply select it and move it just as you would 
any object.
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Two-Line Angular Dimension Tool
This tool is used to create a dimension arc between two lines which intersect 
or will intersect if extended. PowerCADD will insert leader lines which 
extend from the original lines.

To use the Two-Line Angular Dimension tool:
o	 Select the Two-Line Angular Dimension tool from the Tool palette.
o	 Place the cursor on the first of two lines that require a dimension, press 

the mouse button.
o	 Drag to the second line.  A bridge line will appear indicating the tool 

is active.  Release the mouse button. 
o	 The dimension will appear either inside or outside the angle depending 

on the cursor location.  Place the cursor where you want the dimension 
to be located and click.

If you drag the cursor outside of the angle, the dimension will flip to the 
outside or complement angle.

The dimension text can be moved around the drawing without disturbing 
the dimension line. Simply select it and move it as you would any object. 
The text remains associated with the dimension.

The Two-Line Angular Dimension tool can be used repeatedly without 
reselecting the tool or objects.  If you deselect the tool by accident, the 
Return or Enter key will reactivate the last tool selected.

The angular dimension can be edited.  If you select the dimension and select 
one of the handles, the dimension can be resized by dragging.  Dragging the 
arrow tip handles repositions the dimension and text without changing the 
dimension angle.  Dragging the leader handle will change the dimension angle. 
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Four-Point Angular Dimension Tool
This tool is used to create an angular dimension anywhere in the drawing.
 
To use the Four-Point Angular Dimension tool:
o	 Select the Four-Point Angular Dimension tool from the Tool palette.
o	 Place the cursor on the apex (1) of the angle to be dimensioned, press 

the mouse button. You do not have to define a specific point to be the 
apex. You may place it anywhere you wish.

o	 Drag from the apex to define the first side of the angle (2) and release 
the mouse button. 

o	 As you move from the end of the first line you will see a ghost line that 
represents the second line of the angle.  Drag the end of this line to a 
point that will define the angle (3).  Click to establish the angle (4).

o	 The dimension has been defined and the final click will define the 
location of the dimension arc (4).  Drag the cursor inside the defined 
lines to get the included angle, drag the cursor outside of the defined 
lines to get the complement of that angle.  Place the cursor where you 
want the dimension to be located and click.

o	 To move the dimension arc, select the arrow tip handle and drag it into 
location.  The dimension may be changed by dragging the leader tip 
handle.  When the dimension is stretched, it will be recalculated.  To 
move dimension text select it and move it into location.

The Four-Point Angular Dimension tool also allows you to dimension angles 
from a constrained snap angle.  For example if you had a triangle which you 
wanted to know its angles with respect to a preset snap angle, you could use 
the Four-Point Angular Dimension tool to insert the dimension with the 
correct extension lines.

To dimension from a constrained angle:
o	 Select the Four-Point Angular Dimension tool from the Tool palette.
o	 Place the cursor on the apex of the angle to be dimensioned, press the 

mouse button (1).
o	 Drag from the apex to define the first side of the angle and release the 

mouse button. The line you just specified should be a side of an object (2).
o	 Press the Shift key to constrain the ghost line to the preset snap angles 

specified in Preferences. As you move the cursor to the third point, the 
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ghost line will snap to the preset angles. In this case the dimension is 
snapped to horizontal (3).

o	 While pressing the Shift key, select a point that falls on the second side 
of the angle.  The dimension arc will appear upon placement of the 
third point.

o	 Place the cursor where you want the dimension arc to be located and 
click (4). 

o	 Upon placement of the fourth and final point, the dimension text 
will appear and an extension line from the apex of the angle to the 
dimension arc will appear along the constrained line (4).

Constraining a line tells PowerCADD you wish to place an extension line 
from the apex to the dimension arc.  Constraining the line also specifies 
which side of the angle is to receive the extension.

The Four-Point Angular Dimension tool can be used repeatedly without 
having to select objects.  If you drag the cursor outside of the angle, the 
dimension will flip to the outside or complement angle.

If the movement from point 3 to 4 is away from the origin, the constrained 
line will extend back to the apex of the angle.

The dimension text can be moved around the drawing without disturbing 
the dimension line. Simply select it and move it as you would any object.

The Four-Point Angular Dimension can be edited.  If you select the 
dimension and select one of the handles, the dimension can be resized by 
dragging.
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Option-clicking on Dimension tools presents a dialog box for setting the 
defaults of all the dimension tools. 

You may specify where the text will appear, where the arrows will appear, 
unit measurement system, angular measurement system, unit measurement 
accuracy, angular measurement accuracy, additional text present in the 
dimension, tolerance parameters, and if the text will rotate with the 
dimension line.

See Drawing Setup, Dimensions for additional information on setting 
dimension preferences for your drawing.

All Linear, Radial, and Angular Dimension tools operate with the same 
dialog settings.  If the dialog defaults are changed for one linear dimension 
tool, all linear dimension tools take on the setting. 

To change the default settings for all linear dimension tools:
o	 Double-click any Linear Dimension tool in the Tool palette.

	 Double-clicking ensures no other objects are selected.
 
o	 Press the Option key and click on any linear dimension tool in the Tool 

palette.  The following dialog will appear.

Setting Dimension 
Defaults

The Text box, at the top of the dialog, allows you to add text prefix or suffix 
to a dimension such as radial and diametrical symbols.

As a default, ^DIM^ is present in the box. This is actually a symbol telling 
PowerCADD the actual measurement numbers are to be placed in the 
dimension. If this is removed, no measurement will be displayed. If you 
inadvertently remove the symbol, simply type Shift-6, DIM, Shift-6. To add 
text to the dimension, enter the text using standard PowerCADD methods 
either before or after the ^DIM^ information in the Text Box.

Anchor
[SetDimensionDefaults]

!
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Units allows you to set the measurement system you wish to use, such as 
metric or imperial.  The dimension’s units can be set independently of the 
unit setting in Drawing Setup.

Accuracy allows you to set the unit accuracy of the dimension, for example, 
1/2” or 1/256”.  The dimensions unit accuracy can be set independently of 
the unit accuracy setting in Drawing Setup.

Placement allows you to specify where the dimension text will appear in 
relation to the dimension line.  You can position the text below the line, 
above the line, on the line, and so on.

Tolerances allows you to specify if the dimension will have a tolerance, the 
type of tolerance and the number of tolerance values.  You have the option 
of using one or two tolerances (which display as a dimension and an upper 
and lower tolerance), a Limit (which displays as two dimension stacked on 
top of each other denoting an upper and lower limit), or no tolerance at all. 
Tolerances of one and two allow you to enter the desired values. 

Tolerances Literal allows you to specify the tolerances entered to display 
exactly as typed, or if PowerCADD will remove all insignificant figures. 

For example, if you entered .25000, you could select the check box and that 
value would be entered.  If the check box is deselected, the displayed value 
will be .250.  Think of it as specifying “Tolerances as noted” except you are 
entering the values in the Dimension Edit dialog instead of manually for 
each dimension in the drawing.

Rotate Text allows you to specify if the dimension text will rotate with 
the dimension line, or if the dimension text will remain horizontal as the 
dimension line is set to a different angle.
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Leader Left allows you to specify if the leader line and dimension text 
appears to the left or right of the dimension arrow when using Radial and 
Diametrical dimension tools. This box is dimmed for all Linear and Angular 
dimension tools. 

Example when Horizontal Bar 
Fractions not checked.

Example when Horizontal Bar 
Fractions is checked on.

Show Unit will add the measurement unit to the end of the dimension text, 
such as km or mm. 

Arrows Inside allows you to specify if the dimension arrows will appear 
inside the dimension area or outside the dimension area.

Draw Horizontal Bar Fractions allows you to specify how fractional 
dimensions are displayed.

o	 Make the desired changes and click OK.

All Linear Dimensions will use the specified settings.

Circular Dimension tools can be set independent of each other.  If one is 
changed, the other is not affected.

The Angular Dimension tools operate with the same dialog settings. 
Changing one Angular Dimension tool changes both.
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Setting Dimension 
Defaults

In addition to editing the typical object attributes (e.g. line weight, arrows, 
color, etc.) you can also modify various properties after a dimension has 
been placed in the drawing.

Changing the drawing scale or layer scale does not change the dimension 
until the dimension line is stretched or scaled by using Scale from the Edit 
menu or by opening and closing a dimensions Edit dialog box.  This feature 
allows you have objects drawn at different scales appear on the same layer 
or in the same drawing just as you could do in manual drafting.  When 
you shorten or lengthen a dimension line, PowerCADD recalculates the 
dimension according to the active layer’s scale and current units.  If you 
stretch or modify dimension lines on a detail make sure the desired scale 
has been selected first.
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Dimension Edit Dialog
You can use the Dimension Edit dialog box to modify any dimension in 
the drawing.  If you select multiple dimensions, the changes made in the 
Dimension Edit dialog are applied to all selected dimensions. 

To edit a dimension (or all selected dimensions) using the Dimension 
Edit dialog:
o	 Select the dimension objects to edit.
o	 Pick Edit from the Edit Menu and the Dimension Edit dialog will 

appear.
o	 Adjust the desired settings and click OK.

	 See the following diagram and information discussed in “Setting 
Dimension Defaults” for a complete description of each setting.

The selected dimensions will be automatically updated to reflect the new 
changes.

If the drawing scale or layer scale were changed before editing the 
dimensions, the dimensions will be automatically recalculated.

NOTE: You can dimension in units which are different than those you 
drew in.  This can be handy for preparing a dual dimensioned drawing in 
both imperial and metric units.  After you have dimensioned your drawing 
once, select all the dimensions, paste them onto a new layer and use the 
Dimension Edit window to change the units (for example from inches to 
millimeters) and dimension text placement (for example from above to 
below the dimension line).

💬💬
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Dimension Window
You can use the Dimension Window to modify any dimension in the 
drawing.  If you select multiple dimensions, the changes made in the 
Dimension Window are applied to all selected dimensions.

The Dimension Window is a unique PowerCADD External and must be 
loaded in order to take advantage of this feature.  Reference the Loading 
Externals section of this manual for additional information on how to load 
the Dimension Window External. 

To edit a dimension (or all selected dimensions) using the Dimension 
Window:
o	 Select the dimension objects you’d like to edit.
o	 Select the Dimension Window in the Anchor Window.  
o	 Adjust the desired settings.

The selected dimensions will be automatically updated to reflect the new 
changes.

If the drawing scale or layer scale were changed before editing the 
dimensions, the dimensions will be automatically recalculated.

The Dimension Window provides access to the same optional settings as the 
Dimension Edit dialog.  

See Setting Dimension Defaults previously in this section for a complete 
description of each setting.

Using the Mouse Dimension text can be repositioned without disturbing the dimension line 
or its relationship to the text. 

To do this, place the cursor near the top edge of the text, press and drag the 
text to a new location. 

To constrain the dimension text parallel to the dimension line, press the 
Shift key while dragging the text. 

The size and font of dimension text may be modified using the commands 
under the Text menu.

To prevent the accidental selection of the dimension line itself, especially 
on a dimension whose text is on the dimension line rather than above or 
below, press the Command key while selecting dimension text for moving.  
Pressing the Command key allows you to temporarily deactivate snapping.

Anchor
[ModifyDimension]

Modify Dimension
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Lengthening an existing dimension line automatically causes the dimension 
text to change reflecting the new line length.  However, moving a line 
drawn with the Dimension Line tool does not change the dimension text 
or the length of the line. 

Pressing the Shift key while moving the dimension line set will constrain 
movement to the horizontal and vertical axis only.

Pressing the Shift key will constrain the dimension parallel to the line that 
you drew to specify the dimension points.

Pressing the Shift key while moving the dimension set will constrain 
movement to the horizontal and vertical axes only. 

Pressing the Shift key while moving dimension text will constrain the text 
movement along the length of the dimension line.

The Shift key constraint is very useful when you must dimension off of a 
construction line that is not exactly vertical or horizontal.

Dimensions previously created can be edited.

If you select the dimension and select one of the handles, the dimension can 
be moved within the leaders by dragging.

To resize the dimension, select the handle located on the end of the leader 
line and drag to extend or shorten the dimension.

When the dimension is released, the measurement will be recalculated and 
displayed on the line.

Dimensions may also be edited using the Edit Window.
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Supplementary Dimensioning Tools

PowerCADD includes supplementary dimension tools which quickly create 
industry standard drawing symbols for center and break lines.

Centerline Tool
This tool tool allows you to insert a centerline symbol in any circle, ellipse, 
arc, rectangle, or rounded rectangle.  These objects may be in a group or 
distinct objects in a drawing.

To use the Centerline tool:
o	 Select the Centerline tool from the Tool palette.
o	 Place the cursor on the object you wish to identify with a centerline 

symbol.
o	 Click and the centerline will be placed in the drawing.

The Centerline tool will remain selected until you click in a blank space or 
select another tool.  If you need several centerlines of many different sizes, 
you select each object which requires a centerline.  The Centerline tool takes 
care of creating the correct size centerline symbol for each object.

NOTE: To place a centerline on the corner of a rounded rectangle, use the 
Centerline tool found in the External Mechanical Tools palette.

💬💬
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Long Break Tool
This tool draws a long break using any attributes you specify.

To use the Long Break tool:
o	 Select the Long Break tool from the Tool palette.
o	 Place the cursor on one end of the object you would like to illustrate 

as being broken.
o	 Drag to the other end of the break and release.  Use the Shift key to 

constrain drawing the long break line to the preset snap angles.
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Symbol Tool
This tool allows you to place library symbols in any part of the drawing.
 
To use the Symbol tool:
o	 Choose Open from the File menu and a dialog will appear.

o	 From the Enable pop-up menu, choose the type of PowerCADD 
Symbol Library you would like to open.  If you are not sure what 
version of PowerCADD was used to create the symbol library choose 
All Readable Files.

o	 The symbol library selected in the Open dialog opens in its own 
window.

o	 In the symbol library window, click on the name of the symbol you 
want to insert into the drawing.

o	 Return to the drawing by either using the Window command under 
the Window menu, the Open Recent list or by placing the cursor in 
the drawing window and clicking.

o	 With the library open and the correct symbol selected in the library 
window, select the Symbol tool.

o	 Place the cursor in the location you want to place the symbol and click, 
or click and drag.

o	 To add additional symbols, simply place the cursor and click. The 
current symbol will remain in effect until you bring the library to the 
front and select another symbol.

Anchor
[SymbolTool]
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The following diagram describes the basic elements of a Symbol Library 
Window.

Symbol Library Window
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(1) Minimize Box: Click here to collapse the Symbol Library to the Dock.

(2) Close Box: Click here to close a Symbol Library or press Command-W.

(3) Find Button: Used to search for a specific symbol name in a library. To 
find a specific symbol type its name or portion of its name and click Find.

(4) Name Field: Data entry field to find, name, or rename symbols.

(5) Scroll Bars: Scroll up or down the Symbol Name List to see additional 
symbols in a library. If no scroll bars are displayed all symbols in the library 
are being displayed in the Symbol Name List.

(6) Symbol Name List: Displays the names of all symbols in a library.

(7) Symbol Name: Click on a symbol name to see a thumbnail of it in the 
Preview Pane.

(8) Rename Button: Used to Rename an existing symbol in a library you 
assign a name to a new symbol. To name a new symbol type the name in the 
Name Field immediately after pasting it into the library and click Rename. 
To rename an old symbol select the symbol from the Symbol Name List, 
type a new name in the Name Field Type and click Rename.

(9) Title Bar: Displays the name of the Symbol Library. Press the Command 
key and click on the name of the symbol library to display its file path.

(10) Scale: Check this box to have symbols automatically rescaled to match 
the scale of the drawing. When unchecked the symbols are inserted at their 
original scale (they are not scaled to match the drawing scale).

(11) Sort Button: Press this button to sort the Symbol Name List in 
A.S.C.I.I (similar to alphabetical) sort order.
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(12) Drawing Scale: Displays the drawing scale that the original symbol 
was created in.

(13) Preview Scale: Displays the relative size of the thumbnail shown in the 
Preview Pane. 100% is a full size preview.

(14) Preview Pane: Displays a thumbnail of the selected Symbol Name.

For more information on working with Symbols, see Symbol Palette in the 
Menu chapter.

NOTE: You can specify which version of PowerCADD or PowerDraw 
Symbol Libraries you would like to open.

Selecting a specific type of file will automatically filter the list of items 
displayed to match the specified type of file.  If a particular library you want 
to open is dimmed in the list, choose All Readable Files.

💬💬

For example, to see only Symbol Libraries created using PowerCADD 
2000, choose PowerCADD 2000 Symbols from the list.  Only symbol 
libraries saved in PowerCADD 2000 will be displayed; all other files will 
be dimmed.

For more information on symbol libraries, please refer to New Library in 
the Menus chapter.

!

!



Tools125

The Symbol palette floats on top of your drawing window and allows you to 
choose the symbols to place without leaving your drawing window. 

NOTE: The Symbol Palette is an External plug-in.  In order for this window 
to appear in the Window menu it must be checked on when PowerCADD 
is launches.  See ‘Preferences’, ‘Loader’ for more on turning External plug-
ins On and Off.

Symbol Palette

💬💬

The Symbol palette is an alternate to the Symbol tool for placing symbols in 
your drawing.  Symbols are no different if placed using the Symbol library 
dialog in conjunction with the Symbol tool than if placed by using the 
floating Symbol palette.  Before a symbol library has been opened, your 
floating Symbol palette appears with no symbols. 

When you have a symbol library open or you create a symbol library, the 
Symbol palette displays your symbols as a row of thumbnails.

When you choose a symbol in the Symbol palette, the Symbol tool is 
automatically selected. You may choose a different symbol by clicking on 
the picture of the symbol. You are ready to place your symbol by simply 
clicking in your drawing at the appropriate location.

You may also drag and drop a symbol into your drawing by clicking on your 
symbol and dragging it into the desired location.  The symbol will be placed 
about its center or its placement point.

Drag the window size box to adjust the palette size.
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To deselect the Symbol tool, double-click in the same location or select 
another tool from the Tool palette.

When you place a symbol, its center point appears at the cursor location 
and is used as the placement point.  For a point other than the center to be 
used for placement, a reference point must be the last object added to the 
symbol.  The reference point becomes the placement point.

The Door Insertion tool, which can also use symbols, ignores placement 
points.   It always places the bottom of the door on the wall line.

A symbol can be inserted in a drawing two ways:
o	 As a group
o	 As a symbol

A group is a grouped object.  Although PowerCADD treats a group as one 
object, each part of the group retains its own identity.  Each occurrence of 
the group requires a complete description of each part, and each description 
requires space in the file.

A symbol is merely a reference to a description of the symbol, therefore 
requiring less file space.  The description occurs only once, but references to 
the description can occur many times.

Advantage of groups:
Groups redraw faster than symbols and their object attributes may be 
changed (e.g. line weights and colors).

Advantages of symbols:
o	 Symbols use less file space than groups.
o	 Information (such as part number or size) attached to a symbol appears 

on reports generated by Symbol Report.  The Set Symbol Tags menu 
item is used to assign the information.

o	 Object attributes, such as line weight, color, etc. cannot be edited.

To set the default for the Symbol tool:
o	 Press the Option key and select the Symbol tool from the Tool palette.  

The following dialog will appear.

Groups and Symbols

Obsolete?

o	 Select Group or Symbol and click OK. 
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A key command must be assigned to Rotate in the Arrange menu (R is the 
default key assigned, but it can be any key or key combination you choose 
to assign).

To rotate a symbol during placement:
o	 Select a symbol from an open Symbol Library and click in the active 

drawing window.
o	 Select the Symbol tool from the tool palette and move the mouse into 

the drawing window.
o	 Press the mouse button.  A ghosted symbol appears.
o	 Enter the rotation mode by tapping the R key (or the key you have 

assigned).  A ghost symbol and the Rotation cursor appear.
o	 Drag to rotate the symbol.  The symbol rotates about its placement 

point and is constrained to the preset snap angles.  The Shift key 
releases the constraint. 

o	 When the correct rotation is achieved, press the F key to flip the 
symbol’s orientation or release the mouse button to insert the symbol.

o	 To exit the rotation mode, press and release the R key a second time. 

The symbol can then be dragged to another location or flipped.

A key command must be assigned to Flip Horizontal in the Arrange menu 
(F is the default key assigned, but it can be any key or key combination you 
choose to assign).

To flip a symbol during placement:
o	 Select the Symbol Tool and press the mouse button.  A ghosted preview 

appears of the symbol being placed.
o	 Press the F key (or the key you have assigned to Flip Horizontal).  A 

ghosted preview appears of the symbol in its new flipped position. 
o	 Keep pressing the F key to toggle through the symbol’s four horizontal 

and vertical orientations.
o	 When the symbol is in the desired orientation, press the R key to 

rotate the symbol to the desired angle or release the mouse to insert the 
symbol at its default rotation angle.

graphic below is terrible

Rotating Symbols

Flipping Symbols
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Point Tool
This tool allows you to establish reference points which can be snapped to 
during the drawing process or to specify the insertion point for symbols.

Sometimes it is difficult to position an object precisely on a given point in 
the drawing area.  By establishing a reference point, and selecting the object 
snap option in the Drawing Setup, Snap tab under the Layout menu, a 
drawn object can be placed with greater precision.

To place a reference point in the drawing:
o	 Select the Point tool from the Tool palette.
o	 Place the cursor in the drawing where you wish to locate a reference 

point and click.  You will see a “+” symbol appear which represents the 
insertion point. 

You may place as many points as you need by placing the cursor and clicking 
the mouse.

To deselect the Point tool, select another tool or place a reference point 
directly on top of the last placed point.

You can select the size and type of graphic to use as a reference point.

To set the default for the Point tool:
o	 Press the Option key and select the Point tool from the Tool palette. 

The Point Options dialog will appear:

o	 Select a radio button to choose the desired Point Style.
o	 Drag the Point Size slider to set the desired size, in pixels, of the 

Reference Point.
o	 Click OK.
o	 Click the mouse in the drawing window to insert the reference point.

These settings will remain in effect until you change them.

The X, Y location of reference points, like any other object, can be edited 

Anchor
[PointTool]
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with the Edit Window.  Reference points also act as normal snap points 
when Object Snap is selected.

Reference points are generally used as temporary markers or magnets 
to locate other items.  Points represent an excellent method of marking 
locations that will be snapped to.

By default, Reference Points do not print nor are they included when using 
Export from the File menu to create raster images for use on the internet or 
other image editing applications. 

Reference points can be left in the drawing indefinitely.

NOTE: Reference Points can be printed by enabling the Print Points 
option, in the PowerCADD print settings. See ‘Print’ in the menu chapter 
for more information on optional PowerCADD print settings.

To remove the reference points quickly and easily:
o	 Set the Selection Filter to points only.
o	 You may now select and delete reference points from an area without 

deleting other objects.

If you want to remove all reference points from the drawing, choose Select 
All from the Edit menu and then Select Clear.  

All reference points will now be removed from the drawing, and you have 
not lost valuable time looking for points. 

Be sure to reset the Selection Filter window to select all objects, otherwise 
you will only be allowed to select reference points and some snap commands 
will not work correctly.  

To reset the Selection Filter window, Option-click on the Points box or 
select All.  All items should now be activated.

💬💬
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When a Reference Point is the last object added before pasting a symbol 
into a library, the reference point will become the insertion point for that 
symbol.

By default, the center of a symbol is its insertion point.  However, in many 
drawing conditions, it may be beneficial to insert a symbol about a point 
other than its center.

For example, when inserting a toilet or vanity fixture into a plan, it may be 
more practical to have the insertion point be the minimum offset from the 
corner of a wall or counter top. 

When creating symbols for use in elevation and section drawings such as 
a street lamp, the logical insertion point is the bottom of the light fixture 
where it meets the ground.

To use a Reference Point to change a symbol’s insertion point:
o	 Draw the symbol using any type of PowerCADD object, collection of 

objects or drawing techniques. 
o	 Select the Reference Point tool from the Tool palette and click to insert 

the reference point in the desired location.

	 This location will be the insertion point for the symbol and does not 
have to touch the object.  It is critical the Reference Point be the top 
most object (i.e. the last object you add to the symbol).

o	 Select all the objects intended to be the symbol including the reference 
point and choose Copy from the Edit menu.

o	 Open a new or existing Symbols Library window and choose Paste 
from the Edit menu. 

o	 Rename your symbol and save the library. 

When you use the symbol tool, the Reference Point will be the insertion 
point for the symbol.  The insertion point is also the origin for all Flip or 
Rotate operations applied to the symbol as it is being inserted into the 
drawing.  Reference flipping and rotating symbols earlier in this section for 
additional information.

Changing a Symbol’s 
Insertion Point
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Attach Tool
This tool allows you to attach separate objects together into a new, single 
polygon, Bézier, or group of objects containing a new polygon.

While similar to the Attach menu item, the Attach tool allows you to either 
automatically select all adjoining items or to pick the specific items to be 
attached.  If the endpoints of the objects to be attached are close but do not 
meet exactly, short line segments are automatically added to connect them.

To use the Attach tool:
o	 Select the Attach tool from the tool palette.
o	 Click on the first object.

All adjoining objects are automatically selected and a new object is created.

Whether the Attach tool automatically selects adjoining objects, or requires 
you to click and drag to select objects to be attached, is determined by an 
optional tool setting described later in this section.

The Attach tool has optional settings which affect how it interacts with the 
objects in the drawing and the type of geometry created.  Settings made in 
the optional settings dialog remain in effect until you change them.

To change the settings for the Attach tool:
o	 Press the Option key and select the Attach tool from the Tool palette.  

The following dialog will appear:

	 Pick Items: Requires you to perform click and drag to select the 
objects to be attached.  Click on the first object, drag, and release on 
the second object: the two objects are attached.  The tool remains active 
and you may continue to attach additional objects to the result.

	 Adjoining Items: Allows the tool to work with a single click.  Click on 
the first object and all adjoining objects, or objects whose endpoints are 
within the specified Bridge Distance, are attached.

Anchor
[AttachTool]
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	 Bridge Distance: Allows you to specify the maximum distance between 
object end points in pixels.  Objects which are farther apart than the 
specified distance are not attached.

	 Convert to Polygons: All objects to be attached are converted to a 
polygon; the original geometry is changed.  For example, if the objects 
to be attached included a line and an arc, the result is a polygon.

	 Convert to Béziers: All objects to be attached are converted to a Bézier 
curve; the original geometry is changed.  For example, if the objects to 
be attached included a line and an arc, the original arc is replaced with 
a Bézier curve.

o	 Make the desired changes and click OK.
o	 Apply the Attach tool as described earlier.

CAUTION: When Conversion Options are set to Convert to Polygons or 
Convert to Béziers, higher level geometry such as arcs and elliptical arcs are 
replaced.  To retain the original higher level geometry, use the Attach menu 
item and set its options for No Conversion.

⚠
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Objects On Line Tool
This tool allows you to place Reference Points, or objects from the Clipboard 
or a Symbol Library along a linear path.

To use the Objects On Line tool:
o	 Select an object in the drawing and choose Copy from the Edit menu. 

	 See Optional settings below on how to insert a Reference Point or 
Symbol.

o	 Select the Objects On Line tool from the Tool palette.
o	 Click and drag in the drawing to specify a line. 
o	 A ghosted outline appears of the objects being inserted.
o	 Release the mouse: objects are inserted at their center points along the 

specified linear path. 
o	 The inserted items are automatically grouped and selected. 

NOTE: Press the Shift key to constrain the linear path to preset snap angles.  
Use object snapping keys to snap the linear path to existing geometry in 
the drawing.  Press the Tab key as you drag to specify the linear path; enter 
the desired length and angle in the Edit Window and press the Return or 
Enter key.

The Objects On Line tool has optional settings which affect how it interacts 
with the objects in the drawing and the type of objects inserted.  Settings 
made in the optional settings dialog remain in effect until you change them.

To change the settings for the Objects On Line tool:
o	 Press the Option key and select the Objects On Line tool from the Tool 

palette.  The following dialog will appear:

	 Point Objects: Inserts Reference Points into the drawing.

	 Point Options: Click to open the Point Options dialog and choose the 
desired point style and size.  Settings in this dialog are saved with the 

💬💬
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Objects On Line tool: they are separate to the Objects On Path and 
Reference Point tool optional settings.

Original object selected for  insertion

P lac ement Method:
R otate T o P ath A ngle 
checked

P lac ement Method:
R otate T o P ath A ngle 
NOT  checked

	 Clipboard Contents: Inserts the contents of the Clipboard into the 
drawing.  In the main drawing window, select the object and choose 
Copy from the Edit menu; the object is added to the Clipboard.

	 Current Symbol: Inserts the current symbol displayed in the active 
Symbol Library window.

	 Distribute: Evenly inserts the number of objects specified in the 
Objects field.  The spacing between objects is determined by the length 
of the path drawn with the Objects on Line tool.

	 Objects Field: Allows you to specify the quantity of objects inserted 
when using the Distribute placement method.

	 Space: Inserts objects based on the distance specified in the Apart field.  
The total number of objects is determined by the length of the path 
drawn with the Objects on Line tool.

	 Apart Field: Allows you to specify the spacing between objects inserted 
when using the Space placement method.

	 Rotate To Path Angle: Inserts objects so they rotate perpendicular to the 
path drawn with the Objects on Line tool. This option is only available 
when Object Type is set to Clipboard Contents or Current Symbol.

o	 Make the desired changes and click OK.
o	 Apply the Objects On Line tool as described earlier.
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Objects On Path Tool
This tool allows you to place Reference Points, or objects from the Clipboard 
or a Symbol Library using an existing object in the drawing as the specified 
path. 

To use the Objects On Path tool:
o	 Select an object in the drawing and choose Copy from the Edit menu. 

	 See Optional settings below on how to insert a Reference Point or 
Symbol.

o	 Select the Objects On Path tool from the tool palette.
o	 Click on the object in the drawing to choose the path the objects should 

be placed on.  The object may be a line, polygon, arc or Bézier curve.
o	 Objects are inserted at their center points along the chosen path. 
o	 The inserted items are automatically grouped and selected. 

The Objects On Path tool has optional settings which affect how it interacts 
with the objects in the drawing and the type of objects inserted.  Settings 
made in the optional settings dialog remain in effect until you change them.

To change the settings for the Objects On Path tool:
o	 Press the Option key and select the Objects On Path tool from the Tool 

palette.  The following dialog will appear:

	 Point Objects: Inserts Reference Points into the drawing.

	 Point Options: Click to open the Point Options dialog and choose the 
desired point style and size.  Settings in this dialog are saved with the 
Objects On Path tool: they are separate from the Objects On Line and 
Reference Point tool optional settings.
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	 Clipboard Contents: Inserts the contents of the Clipboard into the 
drawing.  In the main drawing window, select the object and choose 
Copy from the Edit menu; the object is added to the Clipboard.

	 Current Symbol: Inserts the current symbol displayed in the active 
Symbol Library window.

	 Distribute: Evenly inserts the number of objects specified in the 
Objects field.  The spacing between objects is determined by the length 
of the path chosen with the Objects on Path tool.

	 Objects Field: Allows you to specify the quantity of objects inserted 
when using the Distribute placement method.

	 Space: Inserts objects based on the distance specified in the Apart field. 
The total number of objects is determined by the length of the path 
chosen with the Objects on Path tool.

	 Apart Field: Allows you to specify the spacing between objects inserted 
when using the Space placement method.

	 Rotate: Inserts objects so they rotate perpendicular to the path chosen 
with the Objects on Path tool.

Original object selected for  insertion

P lac ement Method:
S pac e, R otate NOT  c hec ked

P lac ement Method:
S pac e, R otate C HE C K E D

	 Add Object Width: Works with both Distribute and Space placement 
methods to increase the spacing between the objects inserted by the 
width of the original object selected for insertion.  See  below:
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	 None: Uses no (zero) offset spacing; the objects are inserted directly 
along the path chosen with the Objects on Path tool.

Original object selected for  insertion:
1/4" diameter circle

1" 1" 1" 1"

P lac ement Method:
S pac e, 1"  A part, A dd Width NOT  c hec ked

P lac ement Method:
S pac e, 1"  A part, A dd Width C HE C K E D

1.25" 1.25" 1.25"

	 Interactive: Allows you to dynamically specify the offset for objects 
using a press and drag operation.  Using the target cursor, press on 
the object defining the path and drag to specify the offset; release the 
mouse to complete the operation.

o	 Make the desired changes and click OK.
o	 Apply the Objects On Path tool as described earlier. 

P lac ement Method:  S pac e 1"
Offs et:  None

path object chosen

	 Distance: Allows you to specify a numerical offset for the inserted 
objects based on the drawing units and scale.  Using the target cursor, 
press on the object defining the path; drag in the direction (up, down, 
left, right) the objects should be offset and release the mouse.

P lac ement Method:  S pac e 1"
Offs et:  Dis tanc e -1/4" path object chosen
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Modifier Tools

PowerCADD’s Modifier Tools consist of a suite of versatile, easy-to-use tools 
generally used to enhance existing objects in the drawing.  The tools enable 
you to create new derivative geometry from existing objects, apply special 
effects or perform Boolean operations to clip and combine objects.  Each 
tool is optimized to fit a particular part of your work flow.  The following 
section describes each of the PowerCADD Modifier Tools in detail.

Before describing each Modifier tool in detail, it is important to be aware 
of the following fundamental concepts which apply to all Modifier tools:
o	 In all cases, these tools interact with objects already in the drawing.  

How the tools interact and the results will vary with each tool.  In 
some cases the existing object geometry is deleted and replaced with a 
new object.  In other cases the existing geometry is modified or a new 
object is created.  The specifics of each tool are described in detail later 
in this section.

o	 Dynamic Snapping may be used to modify the start or end points of 
many tool operations.  For example, when using the Break tool, snap 
commands may be used to specify the precise location of the operation.

o	 Tools requiring dimensional data such as an offset or radius support 
direct entry of those values using the Edit Window.

o	 When working with Edit All Layers turned On, new objects are always 
created on the active drawing layer regardless of which layer the original 
objects were located.
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Offset Line Tool

This tool makes a new line which is offset from an existing object in the 
drawing. 

The Offset Line tool has optional settings and attribute settings which, 
once set, remain in effect until you change them.  The tool may be used 
repeatedly, remaining active until you select another tool or click in an 
empty area of the drawing.

To use the Offset Line tool:
o	 Select the Offset Line tool from the Tool palette.
o	 Place the cursor on the object to be offset, press the mouse button.
o	 Move the cursor in the direction you wish the offset to occur and release 

the mouse.  As soon as a direction is specified, the offset is performed.

The original, source, object

drag away
from this surface

a new line is
created which
is parallel to the
original surface

To change the default settings for the Offset Line tool:
o	 Press the Option key and select the Offset Line tool from the Tool 

palette.  The following dialog will appear:

	 Number: Determines how many new lines will be created with a single 
use of the tool.  If you know the number needed, and the offset is the 
same, they can be created in one step.

	 Offset: Determines the distance, based on the units scale of the drawing 
(or Layer Scale Attributes) the new line will be shifted from the original 
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object and is performed in the direction of mouse movement.  If Single 
Increment is chosen the offset distance will increase in multiples of the 
specified offset value.  Up to nine offset values are saved.  If more than 
nine offsets are entered, the oldest (value entered first) is deleted; the 
most recently added value appears at the top of the list.  To choose an 
offset click on the popup menu icon and select it from the list.

	 Single Increment: The offset will be limited to a single offset distance 
as specified in the offset value field. 

	 Multiple Increments: The offset distance will increase in multiples of 
the specified offset value the farther you drag the mouse.  For example, 
if the offset is set to 1/8 inch, the offset distance will increase in 
increments of 1/8 inch as you drag the mouse, creating a new object 
offset at 1/4, 3/8, 1/2 inch or more.  The final offset distance depends 
on how far you drag the mouse from the original object.  The current 
offset value is displayed in the Edit Window as you drag to offset.

	 Interactive: Determine the offset by dragging in the drawing window.  
If this is not selected, you type the desired offset in the Offset field 
described below.  When performing an interactive offset you may use 
snap commands to snap the offset to another object in the drawing.  
You may also press the Tab key during the offset operation and enter a 
specific distance in the Edit Window.

	 Get Object Attributes means the attributes of the new, offset, object 
will match the attributes of the original, source, object.  All attributes, 
as defined in the Attributes floating window, are matched including 
opacity and shadow settings. 

To assign default attributes to the Offset Line tool:
o	 Double-click the Offset Line tool in the Tool palette.
o	 Assign the desired attributes using the Attr menu or the Attributes 

floating window.

When the Get Object Attributes box is not checked, attributes assigned 
to the Offset Line tool are applied to the new offset line.  When the Get 
Objects Attributes box is checked, attributes assigned to the tool are ignored 
and the attributes of the source object in the drawing are applied to the new 
offset line.

Assigning Attributes
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You can specify the offset value on the fly during the offset operation by 
tabbing into the Edit Window.  Specifying the offset value in the Edit 
Window affects only the current offset operation.  The settings specified in 
the Offset Line dialog are not affected.

To specify an offset using the Edit Window:
o	 Select the Offset Line tool from the Tool palette. 
o	 Press and drag on the object to be offset.  Do not release the mouse. 
o	 Press the Tab key.  If the Edit Window isn’t already open, it will open 

automatically. 
o	 Type the offset value and press the Return key.

When working with Edit All Layers turned On, new objects are created on 
the same layer as the original, regardless of the active drawing layer when 
the Offset Line tool was applied.

You can create an offset line from objects inside of a group.  This includes 
symbols which are inserted into a drawing as a Group.  You cannot create 
an offset line from an object inserted from a Symbol Library as a Symbol.

Generally you can perform a offset line operation from any opened or 
closed object with a straight surface.  Objects from which a parallel line 
cannot be offset from are Béziers, smooth polygons, text, symbols, bitmaps, 
placed objects, and points.

Using the Edit Window

Edit All Layers

Groups and Symbols
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Parallel Offset Tool
This tool allows you to make a duplicate of an object offset from the original. 

The Parallel Offset tool has optional settings and attribute settings which, 
once set, remain in effect until you change them.  The tool may be used 
repeatedly, remaining active until you select another tool or click in an 
empty area of the drawing.

To use the Parallel Offset tool:
o	 Select the Parallel Offset tool from the Tool palette.
o	 Place the cursor on the object to be offset, press the mouse button. 
o	 Move the cursor in the direction you wish the offset to occur and release 

the mouse.  As soon as a direction is specified, the offset is performed. 

To change the default settings for the Parallel Offset tool:
o	 Press the Option key and select the Parallel Offset tool from the Tool 

palette.  The following dialog will appear:

	 Number: Determines how many new lines will be created with a single 
use of the tool. If you know the number needed, and the offset is the 
same, they can be created in one step.

	 Offset: Determines the distance, based on the units scale of the drawing 
(or Layer Scale Attributes) the new line will be shifted from the original 
object and is performed in the direction of mouse movement.  If Single 
Increment is chosen the offset distance will increase in multiples of the 
specified offset value.  Up to nine offset values are saved.  If more than 
nine offsets are entered, the oldest (value entered first) is deleted; the 
most recently added value appears at the top of the list.  To choose an 
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offset click on the popup menu icon and select it from the list.

	 Single Increment: The offset will be limited to a single offset distance 
as specified in the offset value field.

	 Multiple Increments: The offset distance will increase in multiples of 
the specified offset value the farther you drag the mouse.  For example, 
if the offset is set to 1/8 inch, the offset distance will increase in 
increments of 1/8 inch as you drag the mouse, creating a new object 
offset at 1/4, 3/8, 1/2 inch or more.  The final offset distance depends 
on how far you drag the mouse from the original object.  The current 
offset value is displayed in the Edit Window as you drag to offset.

	 Interactive: Determine the offset by dragging in the drawing window.  
If this is not selected, you type the desired offset in the Offset field 
described below.  When performing an interactive offset you may use 
snap commands to snap the offset to another object in the drawing.  
You may also press the Tab key during the offset operation and enter a 
specific distance in the Edit Window.

	 Get Object Attributes means the attributes of the new, offset, object 
will match the attributes of the original, source, object.  All attributes, 
as defined in the Attributes floating window, are matched including 
opacity and shadow settings. 

To assign default attributes to the Parallel Offset tool:
o	 Double-click the Parallel Offset tool in the tool palette.
o	 Assign the desired attributes using the Attr menu or the Attributes 

floating window.

When the Get Object Attributes box is not checked, attributes assigned to 
the Parallel Offset tool are applied to the new offset line.

When the Get Objects Attributes box is checked, attributes assigned to the 
tool are ignored and the attributes of the source object in the drawing are 
applied to the new offset line.

Assigning Attributes



Tools144

You can specify the offset value on the fly during the offset operation by 
tabbing into the Edit Window.  Specifying the offset value in the Edit 
Window affects only the current offset operation.  The settings specified in 
the Parallel Offset dialog are not affected.

To specify an offset using the Edit Window:
o	 Select the Parallel Offset tool from the tool palette.
o	 Press and drag on the object to be offset.  Do not release the mouse.
o	 Press the Tab key.  If the Edit Window isn’t already open, it will open 

automatically.
o	 Type the offset value and press the Return key..

When working with Edit All Layers turned on, new objects are created 
on the same layer as the original, regardless of which layer was the active 
drawing layer when the Parallel Offset tool was applied.

You can perform a parallel offset of objects inside of a group.  This includes 
symbols that are inserted into a drawing as a Group.  You cannot perform a 
parallel offset of objects inserted from a Symbol Library as a Symbol.

Generally you can perform a parallel offset on Bézier curves, circles, 
polygons, lines, rectangles and any other open or closed geometric shape.  
Objects which cannot be offset are text, the text block component of a 
leader line, (the leader line itself may be offset) symbols, bitmaps, placed 
objects, groups, points, dimension lines and hatches.

Using the Edit Window

Edit All Layers

Groups and Symbols
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Line Trim/Extend Tool
This tool cuts or extends lines at their intersection so they meet at a 
converging point in space. 

The Line Trim/Extend tool is an intelligent modifying tool; it will make a 
decision based on its settings, the objects selected and their position relative 
to each other.  The tool will remain active until you click in a blank area of 
the drawing or select another tool.  Default settings chosen in the dialog are 
remembered and remain in effect until you change them.

NOTE: A line outside a group may be trimmed or extended to an object 
inside a group. To trim or extend lines inside of a group, use the Edit Group 
command.

NOTE: The Line Trim/Extend tool will only trim or extend single lines; to 
trim or extend multiple lines at the same time use the Multi-Trim/Extend 
tool described later in this chapter.

NOTE: Lines may be trimmed or extended to Guidelines, open or closed 
polygons, rectangles, and rotated rectangles which are distinct objects in the 
drawing or part of a group of objects.

💬💬

💬💬

💬💬
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To set the behavior of the tool:
o	 Press the Option key and select the Line Trim/Extend tool.  The 

following dialog will appear. 
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The first line chosen will be either trimmed or extended to the intersection 
of the second line chosen.  If the lines overlap, the first line is trimmed to 
where it meets the second line and the trimmed piece is deleted.  If the lines 
do not overlap, the first line is extended to where it meets the second line.

Trim/Extend First

Both lines chosen will be either trimmed or extended to meet at their 
intersection.  If the lines overlap, they are trimmed where they meet and the 
trimmed pieces are deleted.  If the lines do not overlap, they are extended 
to where they meet.

Trim/Extend Both
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To Trim or Extend lines:
o	 Select the Line Trim/Extend tool from the Tool palette.
o	 Place the cursor on the first of the two lines to be trimmed or extended 

and press.
o	 Drag the cursor to the second line.  A blue construction line will 

connect the two lines to indicate the tool is active.  Release the mouse 
button to trim.
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The first line chosen will be either trimmed or extended to the intersection 
of the second line chosen.  If the lines overlap, both lines are trimmed and 
the overlapping portions become new lines.  If the lines do not overlap, the 
first line chosen is extended or trimmed to meet the second line.  If a trim 
operation occurred the line segment is not deleted; a new line is created at 
the intersection.

Cut At Intersection
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Arc Trim/Extend Tool
This tool cuts or extends arcs to their intersections so they meet at a 
converging point in space.

The tool will remain active until you click in a blank area of the drawing or 
select another tool.

The first object picked will be the object modified.  It will be trimmed or 
extended to meet the second object picked, at the intersection of the two. 
The first object picked can only be an arc.

The second object can be Guidelines, open or closed polygons, rectangles, 
rotated rectangles, and lines which are distinct objects in the drawing or 
part of a group of objects.

To Trim or Extend Arcs:
o	 Select the Arc Trim/Extend tool from the Tool palette.
o	 Place the cursor on the arc you wish to extend or trim and press the 

mouse button.  The end picked first is the end which will be retained.
o	 Drag the cursor to the second object.  A blue construction line will 

connect the two objects to indicate the tool is active.
o	 Release the mouse button.

The arc will extend or trim to the intersection of the second.
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Multi-Trim/Extend Tool
This tool may be used to trim or extend multiple lines at the same time to 
a single target object such as a line, rectangle, rotated rectangle, or polygon 
segment. 

To trim and extend multiple lines at the same time:
o	 Select the Multi-Trim/Extend tool from the Tool palette. 
o	 Place the cursor near the objects to trimmed and extended.
o	 Drag the swipe cursor across the objects to trimmed and extended then 

release the mouse.
o	 Drag the target cursor to the line you want the lines trimmed and 

extended to and release the mouse button.

The Trim/Extend tool will trim and extend the selected lines to their 
intersection point on the line.
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4_click

3_release

Original R es ult

NOTE: Using the Multi-Trim/Extend tool lines may be trimmed or 
extended to Guidelines, open or closed polygons, rectangles, and rotated 
rectangles which are distinct objects in the drawing or part of a group of 
objects.

💬💬

Anchor
[MultiTrimExtendTool]
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Break Tool
This tool allows you to create an opening in an object at any point along the 
perimeter of the object.  You may also slice through objects. 

To use the Break tool:
o	 Select the Break tool from the Tool palette.
o	 Place the cursor on the object to be broken and press.  This will specify 

the first point of the break.
o	 Drag the cursor in the direction you wish the break to occur.
o	 Release the mouse and the break will be inserted.

The Break tool will remain active until you select another tool or click in the 
drawing.  Break can be used repeatedly without having to preselect objects 
or tools; once a break is inserted, you are free to start a new break.

If the line you wish to break extends out of the current view, simply begin 
the break as described and drag the cursor off the screen to scroll the page.  
The break will continue until you stop the scroll and release.

NOTE: The Break tool always breaks the top-most object.  If you are 
working in a crowded drawing or working with Edit All Layers On, it can 
be difficult to determine which object is on top.

To select the object to be broken in a crowded drawing:
o	 Choose the Break tool from the tool palette.
o	 Press the Option key, the target cursor will appear, and click anywhere 

on the object to be broken.
o	 Release the Option key and place the cursor on the object to be broken 

and press the mouse button.  This will specify the first point of the break.
o	 Drag the cursor in the direction you wish the break to occur.
o	 Release the mouse and the break will be inserted.

This method ensures you are breaking the desired object and does not 
modify the objects layer position or object order.

💬💬
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The Break tool will cut along the circumference of circles and the around 
the corners of rectangles and polygons.  Simply place the cursor on the 
point where the break will begin, then press and drag the cursor to the 
desired end point.

Breaking Curves 
and Polygons

If you begin a break on an object and press the Option key, the break will 
toggle from the area you specified, to the remainder of the object leaving 
the section you specified.  For example, if you choose to break out one small 
section of a circle and press the Option key, the active break line would 
toggle to the remaining larger section of the circle.

A cut or snip may be made by simply clicking on an object in the desired 
location.

The Break tool may be used to slice through an object or several objects on 
the same layer; the results are very much like those when using the Cut with 
Line command.

To slice an object or objects:
o	 Select the Break tool.  Place the cursor on or above the object or objects 

to be cut.
o	 Press and drag.  A blue construction line will appear indicating the 

path of the cut. 
o	 Drag to the desired location and release.

All objects which were crossed by the cutting line will be cut and will 
remain selected. 

If Edit All Layers is On, all visible objects crossing the cutting line will be 
cut regardless of which layer they are on.  To cut only objects on the active 
layer, turn Edit All Layers Off.

You may also use the Break tool to slice bitmap images.  If the raster image 
was inserted using the Place command, it must be converted to a bitmap 
first using the Object to Bitmap command.

Snipping

Slicing
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To create a break of specific length in a selected line, you may use the Edit 
Window. 

To edit a break in a line:
o	 Make sure the Edit Window is active.
o	 Select the Break tool from the Tool palette.
o	 Place the cursor on the line to be broken and press.  This will specify 

the first point of the break.
o	 Drag the cursor along the line in the direction you wish the break to 

occur.  Press the Tab key, then release the mouse button.
o	 Tab to the Length field in the Edit Window. 
o	 Type the desired length of the line break, then click anywhere in the 

drawing or press the Enter key.  The section you specified will be 
highlighting on the line.  Click to complete the break.

NOTE: Break will not work on grouped objects.

Editing a Break

💬💬
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Eyedropper Tool
This tool allows you to copy the attributes of an object and apply those 
attributes to other objects.

To adopt an object’s attributes:
o	 Select the Eyedropper tool from the Tool palette.
o	 When you press the Option key the cursor will display as an empty 

eyedropper ready to pick up or copy the attributes of the object you 
select:

o	 Click on the object with the Eyedropper tool. 

The attributes will be picked up or copied.

The Eyedropper tool is now ready to apply those attributes to other objects.  
The tool will retain those attributes even if you select another tool and come 
back to it at a later time during your drawing session. 

Defaults can also be set for the Eyedropper tool as with the other 
PowerCADD tools.  Press the Control key and select the tool and choose 
the attribute settings you wish to use from the Contextual menu.

To apply an object’s attributes:
o	 Select the Eyedropper tool from the Tool palette.  The cursor will 

display as a full eyedropper:
o	 Click on the object with the Eyedropper.

The attributes will be applied from the Eyedropper tool to the object. 

NOTE: Attributes are not remembered from session to session and will use 
the default settings until changed.

You may modify the attributes of individual objects within a group.  Select 
the group, choose Edit Group from the Edit menu, then use the Eyedropper 
tool to change the attributes of one or more objects as desired.  Choose Exit 
Groups from the Edit menu when finished. 

The Eyedropper tool can also be used with text styles, hatch patterns, 
transparency, shadows, and gradient fills created by the Gradient tool.  

💬💬



Tools154

To specify which object attributes the Eyedropper tool should pick 
up and apply:
o	 Press the Option key and select on the Eyedropper tool in the Tool 

palette.  The following dialog will appear:

o	 Check the boxes corresponding to the object attributes you like to pick 
up and apply.

o	 Click OK and apply the Eyedropper tool.

The settings in this dialog remain in effect until you change them.
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Fillet Tool
This tool draws an arc tangent to two lines, circles, or circular arcs in any 
combination.

A fillet is a rounded-corner, which may be applied to connect intersecting 
or converging arc-arc, arc-line, line-line, line-circle, or arc-circle objects. 

Objects that do not intersect will be extended.

To set the behavior of the tool, press the Option key and select the 
Fillet tool from the Tool palette.  The following dialog will appear:

Inside Angle 
Checked On
(Inside Fillet)

Inside Angle 
Not Checked
(Outside Fillet)

o	 Inside Angle dictates the direction of the fillet.  You may create inside 
or outside fillets. 

o	 Interactive means the fillet is not a predetermined size; you will 
determine the size of the radius by dragging.  If Interactive is not 
selected, you type in the radius of the fillet.

The Trim Options determine the outcome of the fillet area:
o	 No Trim inserts a radius between the two objects and leaves the original 

lines intact. 
o	 Trim Only inserts a radius between the two lines and cuts the original 

lines at the tangent intersection of the lines and the fillet. This allows 
you to delete all or part of the line segments between the fillet and the 
original line intersection.

o	 Trim and Delete inserts a radius between the two lines and cuts the 
original lines at the tangent intersection of the lines and the fillet.  In 
the same operation, the trimmed line segments are deleted.  The sharp 
line intersection is converted to a smooth round corner.  Trim works 
with circles, but no pieces are deleted.  The arc or circle is cut at the 
tangent point.
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After setting the Fillet defaults, they remain in effect until you change them 
again.  The Fillet tool will remain selected until you select another tool or 
deselect by clicking on a blank area of the drawing.
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To use the Fillet tool:
o	 Select the Fillet tool from the Tool palette.
o	 Place the cursor on the first of the two lines to be connected by a fillet, 

press the mouse button.
o	 Drag to the second line.  A blue construction line will connect the two 

lines to indicate the tool is active.  Release the mouse button.  A small 
fillet will appear in the corner of the intersection.

o	 After releasing the mouse button, move the mouse to drag the fillet to 
the appropriate size.  Once an appropriate size has been reached, click 
to establish the fillet.  If Interactive is not selected in the dialog box, the 
fillet will snap to the preset radius.

Fillet results in three separate objects: the two sides and the rounded corner. 
Each object remains selected for further modification.

NOTE: When filleting objects which are part of a Group, No Trim settings 
are automatically applied regardless of the Fillet tools default settings. Trim 
Only and Trim and Delete are not available. The arc resulting from the fillet 
operation is not added to the Group.

Fillet can be used repeatedly without preselecting objects. You establish a 
bridge line between two lines and go on to the next filleting operation.

💬💬
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The following is an example of the possible combinations of tangents for 
inside angles.  Inside angles imply arcs with arc angles of less than 180 degrees.

The arcs or lines may be cut at the tangent point by setting trim on.  Trim cuts, 
but does not throw away.  Depending upon the desired end result, trimmed or 
cut arcs can later be reshaped, or alternately the unwanted arc can be deleted.

The following is an example of the possible combinations of tangents for outside 
angles.  Arcs with outside angles have sweep angles greater than 180 degrees. 

To create a fillet of specific radius or diameter you may use the Edit Window 
as you are creating the fillet.

To edit a fillet on the fly:
o	 Make sure the Edit Window is active.
o	 Press the Option key and select the Fillet tool from the Tool palette. 
o	 Click the Interactive radio button and click OK.
o	 Place the cursor on the first of the two lines, arcs or circles to be 

connected by a fillet, press the mouse button.
o	 Drag to the second line, arc or circle.  A blue construction line will 

connect the two objects indicating the fillet operation is active.
o	 As you drag to define the fillet length, the Edit Window’s radius and 

diameter fields display the current values.
o	 Tab to the radius or diameter field in the Edit Window.
o	 Type the desired radius of the fillet, then click anywhere in the drawing 

or press the Enter key. 

A fillet of the specified radius or diameter will be inserted in the drawing.

Editing a Fillet
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Chamfer Tool
This tool produces a beveled corner connecting two lines.

A chamfer can only be applied to two lines which intersect, or which will 
intersect if extended.  Non-intersecting lines will automatically be extended 
if needed.

A Chamfer results in three separate objects: the two sides and the chamfer 
line. Each object remains selected for further modification.

To set the behavior of the tool, press the Option key and select the Chamfer 
tool from the Tool palette.  The following dialog will appear:

Angle and Dimension allows you to create a chamfer that begins at a 
preselected distance from the intersection point on the last line created and 
extends out at a preselected angle to intersect with the second line. 

Two Dimensions allows you to create a chamfer which begins at a 
preselected distance from the intersection point on the two lines.  The 
dimensions you enter will specify how far from the intersection point the 
chamfer will begin on each line.  Length One specifies how far from the 
intersection on the most recent line.  Length Two specifies the distance from 
the intersection point on the second line.  A chamfer line is then created 
between the two points.

Trim Options determine the outcome of the Chamfer tool.

No Trim places a chamfer between two lines and leaves the original lines 
intact.

Trim Only places a chamfer between two lines and cuts the original lines 
at the intersections of the original lines and the chamfer line.  The trimmed 
line segments will not be deleted.

Trim and Delete places a chamfer between the two lines and removes the 
line segments that continue from the chamfer to the original intersection 
point.  The sharp line intersection is converted into a beveled corner.
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After setting the Chamfer defaults, they remain in effect until you change 
them again.  Chamfer will also remain active until you select another tool 
or deselect by clicking on a blank area.

To use the Chamfer tool:
o	 Select the Chamfer tool from the Tool palette.
o	 Place the cursor on the first of two lines to be connected by a chamfer, 

press the mouse button.
o	 Drag the cursor to the second line.  A blue construction line will 

connect the two lines to indicate the tool is active.  Release the mouse 
button.

When the mouse button is released, the chamfer will be placed in the 
drawing.
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When you select two lines by using the bridge line, the angle of the chamfer 
will measure the specified degrees from the most current line.  The length 
specifies where the angle will begin with respect to the line intersection. 

PowerCADD will find the most recent line of the two, measure the specified 
distance from the intersection and start the chamfer line at that point.  The 
chamfer line is then locked to the specified angle and drawn until it reaches 
the second line.
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Blend Objects Tool
This tool blends shapes and colors from one object to another in a specified 
number of steps.  In addition to blending color attributes, the Blend 
Objects tool will also blend dash patterns, line weights, pen patterns and 
fill patterns.

Blend objects may be used to add contour lines to a map or blend colors for 
a graduated fill for a variety of rendering effects.

NOTE: The Blend Objects tool is an External plug-in.  In order for this 
tool to appear in the Tool palette it must be checked on when PowerCADD 
is launches.  See Loader Preferences for more on turning External plug-ins 
On and Off.

To change the number of steps when blending objects: 
o	 Press the Option key and select the Blend Objects tool from the Tool 

palette.  The following dialog will appear:

💬💬

o	 Enter the number of steps desired and click OK.

This will remain the default number of steps until you change it.

To blend shapes:
o	 Draw the starting object and the ending object to be blended. 
o	 Select the Blend Objects tool.
o	 Select one of the two objects to be blended and drag a bridge line to 

the second object.  

Blend Objects will place the steps between the first object drawn and the 
last object drawn.

Blending Shapes
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NOTE: If the first object selected to be blended includes a shadow, that 
shadow is applied to all blended objects.  Opacity settings for object fill and 
pen attributes are also blended.

Blending fill patterns is done by filling the starting object with one pattern 
and the ending object with another pattern.  New objects are created which 
acquire their pattern based on the values in the fill and pen pattern palettes. 

Blending Colors Blending colors is done by filling the starting object with one color and 
the ending object with another color.  New objects are created which are a 
blend of the first object and last object’s color.  This is similar to how the 
Mix button works in the Color Edit dialog.  The colors applied to blended 
objects are independent of the current drawing color palette.

To get a more realistic range of colors, specify more steps in the Blend 
Objects dialog or adjust the color value of the first or last objects in the 
blend and reapply the tool.  The more shades between the starting color and 
ending color, the better final result will be.

NOTE: The Gradient Fill Tool may also be used to create complex gradient 
color blends.

Press Command-Period (.) to cancel a blend operation.

Blending Fill & 
Pen Patterns

💬💬

💬💬
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Paint Bucket Tool
This tool fills any enclosed area of a drawing.

It is a quick way to trace around the bounds of an enclosed space and add 
a new filled polygon to the drawing.  In many ways, it works like the Paint 
Bucket tool in most painting programs.  The enclosed space may be created 
by individual lines, polygons, arcs, or Béziers.  Dimensions, leaders lines, 
text and points are ignored.  

If it is used on an area that is not enclosed, it will leak, filling all connected 
objects, including the background.  Possible uses of the Paint Bucket tool 
include creating a poché filled wall effect, filling areas to perform quantity 
take-off’s for area and perimeter calculations, or to create color renderings.

To use the Paint Bucket tool:
o	 Select the Paint Bucket tool from the Tool palette. 
o	 Click in an enclosed area in the drawing. 
o	 If you click in an incorrect area, Command-period will abort the fill 

operation.

A polygon will be created that traces the edge of the enclosure and will be 
placed on the active layer.
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You can also manually thin a polygon generated with the Paint Bucket tool.  
To manually thin a polygon (reduce the total number of points used to 
describe its shape), select the polygon then choose Thin Polygon from the 
Polygon menu under the Tool menu.  In some instances better thinning 
results can be achieved by applying the Distribute Points command before 
choosing Thin Polygon.  See the Tool Menu, Polygon Menu for additional 
information.

NOTE: The Paint Bucket tool operates on the screen image, so the setting 
of Edit All Layers has no effect on the operation.  With Edit All Layers On, 
the Paint Bucket makes a new polygon on the Active layer.

💬💬
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Clip Tool
This tool removes the area from one object it shares with an overlapping 
object.  If the objects do not overlap, a warning beep will be issued.

Clipping, in this context, is the cutting or removing of one surface by 
another.  The cutting action is similar to a cookie-cutter effect.  The shape 
of the overlap dictates the shape of the cut on the lower surface.  The Clip 
tool remains active until you select another tool or deselect by clicking on 
a blank space.

To use the Clip tool:
o	 Select the Clip tool from the Tool palette.
o	 Place the cursor on the first of the two objects that will perform the 

clipping action, press the mouse button.
o	 Drag the cursor to the second object.  A blue construction line will 

connect the two objects to indicate the tool is active.
o	 When the mouse button is released, the clip will take place.

If two objects are arranged in such a fashion that the upper object fits 
entirely inside the lower object, clipping will not occur, and the tool will 
fall out.

CAUTION: The original object geometry (e.g. a circle) is always replaced 
with a new polygon reflecting the clipped shape.  If it is important to keep 
the original object geometry, always work on a copy of the object before 
performing a clipping operation.

NOTE: If Edit All Layers is On and the objects are on two different layers, 
the new clipped object is created on the Active layer. 

⚠

💬💬
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Combine Tool
This tool converts two overlapping objects into a single polygon.  The 
resulting shape is the outline of the two parts.

Combine is useful to create shapes which are difficult to draw directly.  The 
Combine tool takes two items and turns them into one object with the 
geometry of the combined outline.  The result is a polygon which can be 
reshaped or modified.

Objects to be combined must be contiguous or overlapping for Combine 
to take effect.  If the objects do not overlap or if one object is grouped, the 
tool will fall out.

To use the Combine tool:
o	 Select the Combine tool from the Tool palette.
o	 Place the cursor on the first of two objects to be combined, press the 

mouse button.
o	 Drag the cursor to the second object.  A blue construction line will 

connect the two objects to indicate the tool is active.  Release the 
mouse button.

When the mouse button is released, the selected objects are combined into 
a single polygon.

NOTE: When combining objects with different attributes (e.g. a blue 
rectangle and a red circle), the attributes of the first object clicked on are 
applied to the new combined object.

CAUTION: The original object geometry (e.g. a circle and rectangle) is 
always replaced with a new polygon reflecting the combined shape.  If it is 
important to keep the original object geometry, always work on a copies of 
the objects before performing a combine operation.

NOTE: If Edit All Layers is On and the objects are on two different layers, 
the new object is created on the active layer.

⚠

💬💬

💬💬
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Union Tool
This tool creates an object from the overlapping part of two overlapping 
objects.

As opposed to the Clip tool, the Union tool keeps the overlapping area and 
removes all material except the overlapping area.

The objects to be combined must be contiguous or overlapping for Union 
to take effect.  If the objects do not overlap or if one object is grouped, the 
tool will fall out.

To use the Union tool:
o	 Select the Union tool from the Tool palette.
o	 Place the cursor on the first of the two overlapping objects and press 

the mouse button.
o	 Drag the cursor to the second object.  A bridge line will connect the 

two objects to indicate the tool is active. 
o	 Release the mouse button.  The resulting object is the overlapping 

portion of the two initial objects.

NOTE: When objects have different attributes (e.g. a blue rectangle and a 
red circle), the attributes of the first object clicked on are applied to the new 
combined object.

CAUTION: The original object geometry (e.g. a circle and rectangle) are 
always replaced with a new polygon reflecting the combined union shape.  
If it is important to keep the original object geometry, always work on a 
copies of the objects before performing a union operation.

NOTE: If Edit All Layers is On and the objects are on two different layers, 
the Combined object is created on the Active layer.

⚠

💬💬
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Bitmap Effect Tool
This tool allows you enhance bitmap graphics in your drawings with a 
variety of QuickTime special effects.

The Bitmap Effect tool can only be applied to bitmap images.  To apply 
bitmap effects to normal PowerCADD object geometry, use the Object to 
Bitmap menu item in the Tool menu to convert any PowerCADD object 
or group of objects into a bitmap before applying the Bitmap Effect tool. 
The Bitmap Effect tool requires two bitmap images and creates a combined 
image based on the settings applied.

NOTE: The Bitmap Effect tool is part of the Bitmap Utils External plug-
in. In order for this tool to appear in the Tool palette Bitmap Utils must 
be checked on when PowerCADD is launches. See Loader Preferences for 
more on turning External plug-ins On and Off.

To use the Bitmap Effect tool:
o	 Select the Bitmap Effect tool from the Tool palette.  The cursor will 

change to a target cursor.
o	 Place the cursor on the first bitmap image and press the mouse button 

(the images do not need to overlap).
o	 Drag the cursor to the second bitmap object.  A blue construction line 

will connect the two bitmaps to indicate the tool is active.
o	 Release the Mouse button. 
o	 The QuickTime effects dialog box will open.  Select the desired effect 

and click OK.  A preview window allows you to sample various effects 
before clicking OK.

The second bitmap is replaced with a new bitmap.

NOTE: The Bitmap Effect tool requires a full installation of Apple’s 
QuickTime software on your computer however Apple has been making 
many changes and has introduced a number of new technologies to replace 
these capabilities.  Apple’s Core Image technology is now widely used in 
the latest MacOS as well as on the iPhone and iPad.  The Core Image Filter 
tool in PixelTools (in WildTools) provides modern replacements for these 
bitmap effects.

💬💬

💬💬
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The Bitmap Effect tool supports full color, gray scale or black and white 
bitmap images as source objects. Possible uses of Bitmap Effect include 
simulating window or water reflections in renderings, perform image 
transitions and compositions or adjusting the opacity of an object. 

NOTE: If the two bitmaps are different sizes, the first bitmap selected will 
be scaled to match the size of the second bitmap selected.

💬💬
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Bitmap Transformation Tool
This tool maps any bitmap to any four-sided closed polygon.  The polygon 
may be in any projection plane including isometric or perspective.

The Bitmap Transformation tool can only be applied to any full color, gray 
scale or black & white bitmap images.  To apply Bitmap Transformation 
tool to normal PowerCADD object geometry, use the Object to Bitmap in 
the Tool menu to convert any PowerCADD object or group of objects into 
a bitmap first. 

NOTE: The Bitmap Transformation Tool is part of the Bitmap Utils 
External plug-in.  In order for this tool to appear in the Tool palette Bitmap 
Utils must be checked on when PowerCADD is launches.  See Loader 
Preferences for more on turning External plug-ins On and Off.

To use the Bitmap Transformation tool:
o	 Select the Bitmap Transformation tool from the Tool palette.  The 

cursor will change to a target cursor.
o	 Place the cursor on the bitmap image and drag to a four-sided polygon.  

A blue construction line will connect the two objects to indicate the 
tool is active.

o	 Release the Mouse button. 

The bitmap is mapped to match the proportions of the polygon.

The aspect ratio of the bitmap is modified to match the aspect ratio of the 
polygon.  If the aspect ratio’s of the bitmap and polygon are significant, 
the bitmap may appear to be distorted as illustrated here.  This is normal 
behavior given the different aspect ratios of the objects.

In addition to creating interesting visual effects, the Bitmap Perspective 
tool can also be a significant time saving device.  For example, digital or 
scanned photographs may be mapped onto a polygon drawn in perspective 
as a backdrop for design and presentation drawings.  This technique saves 
drawing time and provides a much more dynamic presentation to the client.

💬💬
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Fence Cut Tool
This tool allows you to delete or copy information in a specific area of the 
drawing.  The Fence Cut operation can delete the data inside or outside the 
fenced area or copy the fenced area to the clipboard.

Performing a Fence Cut can be a fast and efficient means to use existing 
drawing content to create new drawing when only a portion of the original 
drawing is required.

NOTE: The Fence Cut Tool is an External plug-in.  In order for this tool 
to appear in the Tool palette it must be checked on when PowerCADD is 
launches.  See Loader Preferences.

To set the behavior of the tool:
o	 Press the Option key and select the Fence Cut tool from the Tool 

palette.  The following dialog will appear:

	 Snap Shot: Copies the portion of the drawing enclosed by the fence 
into the Clipboard, the original information in the drawing is not 
modified.  Layer information is not retained; objects on different layers 
will appear on the active layer when pasted.  Once in the Clipboard, 
the information may be pasted into a new drawing or into another 
location in the same drawing.  If Add Fence Lines was checked on, a 
new rectangle is added matching the fenced area.

	 Fence Cut: A Fence Cut is used in conjunction with Delete Outside 
or Delete Inside to remove information from the drawing.  Layer 
information is not retained; objects on different layers will appear on 
the active layer when pasted.  If Add Fence Lines was checked, a new 
rectangle is added in the drawing matching the fenced area.

	 Snap Shot and Fence Cut settings retain scale and layer information.  
Use Paste Special, At Scale, Through Layers, to automatically rescale 
the Fence Cut or Fence Snap Shot data when pasting into a new or 
existing drawing.  Layer Scale settings take precedent over Drawing 
Setup scale when performing the Fence Cut or Snap Shot operation.

💬💬
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	 Add Fence Lines: Used in conjunction with Snap Shot or Fence Cut, 
when checked, a rectangle is added defining the fenced area.  This can 
be particularly helpful when using Snap Shot if the operation needs to 
be repeated again after a drawing revision is made.

	 Delete: Used in conjunction with Fence Cut, there are two options for 
deleting objects from the drawing.  Delete Outside deletes everything 
outside the fenced area on the visible layers.  Delete Inside deletes 
everything inside the fenced area on visible layers.

To use the Fence Cut tool:
o	 Select the Fence Cut tool from the Tool palette. The cursor will change 

to a knife cursor.
o	 Hold the mouse button down and drag to draw a rectangle (fence) 

defining the area you want the Fence Cut tool to be applied. 
o	 Release the mouse.

The Fence Cut operation is completed using your specified settings.

The Fence Cut tool is smart and works in conjunction with Edit All Layers 
being On or Off.  If Edit All Layers is On, all visible information is affected 
by the Fence Cut tool as per the specified settings.  If Edit All Layers is Off 
only the active layer is affected by the Fence Cut tool.  This provides a great 
deal of drawing management flexibility.

There are unique conditions which apply when performing a Fence Cut or 
Snap Shot on groups, symbols or text with the Fence Cut tool as illustrated 
below.

Edit All Layers

Symbols, Groups 
and Text Objects
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NOTE: A Save or Save As is recommended on a drawing prior to performing 
a Fence Cut Delete Inside or Delete Outside operation.  While Undo may 
be applied after a Delete Inside or Outside operation, the results will vary 
depending on how many objects were affected by the Fence Cut operation 
and how many Undo Levels you have specified for the Undo menu item. 

💬💬
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Gradient Tool
This tool allows you to enhance your drawing with shaded linear or circular 
gradient fills.  Gradients may be applied to any PowerCADD object 
including Béziers, circles, arc, ellipses and rectangles.

NOTE: The Gradient Tool is an External plug-in. In order for this tool 
to appear in the Tool palette it must be checked on when PowerCADD is 
launches.  See Loader Preferences for more on turning External plug-ins 
On and Off.

The Gradient tool has optional user control settings to specify the colors 
and type of gradient being applied.  Any changes made in the Gradient 
Options dialog are remembered until you change them.

To set the behavior of the tool: 
o	 Press the Option key and select the Gradient tool from the Tool palette.  

The following dialog will appear.

Current Settings: The current settings pop-up menu allows you to save 
and recall gradient templates.  Using gradient templates is an efficient way 
to organize all the components of a particular gradient profile for reuse in 
any drawing.  To use a previously saved gradient, simply choose it from the 
list and the changes will be reflected in the Gradient Dialog.  To save a new 
gradient template, simply choose Save Gradient from the list, name the 
item and click OK.  To delete a template, Choose Delete Gradient from the 
list, choose the template name and click Delete.

Circular: Click the Circular radio button to apply a circular gradient to an 
object.  The center point of the gradient may be modified in the Preview 
Pane or in the drawing after the gradient has been applied to an object.

Linear: Click the Linear radio button to apply a linear gradient to an object.  
The angle of the gradient may be modified in the Preview Pane or in the 
drawing after the gradient has been applied to an object.

Color Point: Color Points are the building blocks of a gradient profile.  

💬💬
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Active Color Points are indicated by a solid black triangle, inactive Color 
Points are white triangles.  To activate a Color Point, click on it, then drag 
left or right to change its position and modify the gradients profile. To 
remove a Color Point, press on the color point, drag downward and release 
the mouse or press the Delete key.  To add a Color Point, click anywhere on 
the Color Bar.  To preview the effects of adding or removing a Color Point 
press on a color point then drag it on and off the Color Bar, the Preview 
Pane will update to reflect the changes.

Color Bar: The Color Bar is used to add, remove or modify the position of 
color points used to create a gradient profile.  You may have as many color 
points as you like on the Color Bar.  As new Color Points are added, the 
Color Bar and Preview Pane reflect those changes.

Distance: The Distance Field reflects the horizontal position of a selected 
Color Point on the Color Bar, allowing you to accurately specify a Color 
Point position in the gradient profile.  When specifying a Color Point’s 
position, 0% is the absolute left of the Color Bar, 100% is the absolute 
right.  To specify a specific position for a Color Point, select the Color Point 
then type the specific value in the Distance Field.

Color Square: The color of the currently selected Color Point is shown in 
the Color Square.  To change the color of the selected Color Point, click on 
the Color Square.  The MacOS color panel will be displayed allowing you to 
specify a color from any standard Mac OS color palette or to select a color 
from any item visible on screen.

Preview Pane: Any change made to a gradient profile is immediately update 
in the Preview Pane.  To set the center point for a circular gradient, click 
anywhere in the Preview Pane.  To set the angle for a linear gradient, click 
and drag the mouse in the Preview Pane.

To remove a gradient applied to any object, select the object and choose a 
pattern from the Fill Pattern menu in the Attr menu.  To change a gradient 
from Linear to Circular or Circular to Linear, assign the object a new fill 
pattern from the Attr menu first, then apply the new gradient fill. 

To edit the gradient profile currently applied to an object: 
o	 Select the Gradient tool from the Tool palette.  The cursor will change 

to a target cursor with two dots.
o	 Press the Option key and click the mouse on the gradient filled object. 
o	 The Gradient Options dialog will open.
o	 Adjust the gradient profile as desired and click OK.
o	 The object will reflect the new gradient fill settings.

Editing Gradients

Removing Gradients
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To edit the angle of a linear gradient currently applied to an object:
o	 Select the Gradient tool from the tool palette. 
o	 Click and drag on the linear filled gradient object.
o	 The angle you specify during the drag operation will specify the new 

angle.  Press the Shift key to have the gradient conform to the preset 
snap angles.

o	 Release the Mouse button.

To edit the center point of a circular gradient currently applied to an 
object:
o	 Select the Gradient tool from the Tool palette.
o	 Click inside the circular filled gradient object.
o	 The location you click on will be the new center of the circular gradient. 

NOTE: Gradient templates are saved in the User folder: Library: Preferences: 
PowerCADD: Gradients Folder.  You may share gradient templates with 
others simply by copying the appropriate file in the Gradients Folder.

To use the Gradient tool:
o	 Select the Gradient tool from the Tool palette.  The cursor will change 

to a target cursor.
o	 Click the mouse on the object to receive the gradient fill.

The object is filled with the specified gradient. 

💬💬
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Move Points Tool
This tool allows you move all selected vertices in a selected area to a new 
location.

One of the primary advantages of the Move Points tool is its ability to save 
you time by moving selected points of existing geometry as opposed to 
deleting the objects and redrawing.  For example, using the Move Points 
tool it is possible adjust the length of all the selected walls in a drawing, 
including their associated dimensions, and move them together to increase 
or decrease their length or change their angle.

Points may be moved any arbitrary length and angles, or specific lengths 
and angles using the mouse or a combination of the mouse and a dialog 
box.  Snap commands may also be used to define the start or end point of 
a Move Points operation.

NOTE: The Move Points Tool is an External plug-in.  In order for this tool 
to appear in the Tool palette it must be checked on when PowerCADD is 
launches.  See Loader Preferences for more on turning External plug-ins 
On and Off.

💬💬



Tools177

To use the Move Points tool:
o	 Select the Move Points tool from the Tool palette.  The cursor will 

change to a finger cursor.
o	 Click and drag to draw a rectangular marquee which encloses the 

vertices to be moved and release the mouse.
o	 Selected vertices are highlighted in red and the cursor changes to a 

move cursor.
o	 Drag the mouse to move the selected vertices.  Press the Shift key to 

constrain the move to the X or Y axis. 
o	 Release the mouse to complete the move points operation.
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In a drawing containing many objects it may not be practical to select the 
vertices to be moved using a rectangular selection.

To make a freehand selection using the Move Points tool:
o	 Select the Move Points tool from the Tool palette.  The cursor will 

change to a finger cursor.  Press the Option key, the cursor will change 
to a lasso.

o	 Click and drag to draw a freehand marquee which encloses the vertices 
to be moved and release the mouse.

o	 Selected vertices are highlighted in red and the cursor changes to a 
move cursor.

o	 Drag the mouse to move the selected vertices.  Press the Shift key to 
constrain the move to the X or Y axis. 

o	 Release the mouse to complete the move points operation.

Move Points 
Freehand Selection
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There are instances where you may know the precise length or angle the 
selected points should be moved.  For example, a building wall may need 
to be moved precisely 6” to the right or perhaps an entire parking lot may 
need to moved 11.25 meters up or down.

To move selected points a specified distance and direction using 
the Move Points tool:
o	 Select the Move Point tool from the Tool palette.  The cursor will 

change to a finger cursor.  Press the Option key and the cursor will 
change to a lasso.

o	 Click and drag to draw a marquee which encloses the vertices to be 
moved and release the mouse.

o	 Selected vertices are highlighted in red and the cursor changes to a 
move cursor.

o	 Begin dragging the mouse to move the points, then press the Tab key.
o	 The following dialog box will appear 

Move Points a 
Specified Distance

	 The Move dialog provides four move methods:

	 Absolute: allows you to specify the absolute X,Y coordinate location.

	 Relative: moves objects the specified amount relative to their current 
X,Y location.

	 Angle: moves objects the specified length and angle.

	 By Mouse: moves objects dynamically using the mouse and dragging 
on screen.

o	 Enter the specific values and click OK. 

NOTE: To move the vertices of objects which are different layers using the 
Move Points tool, open the Layers Window and select the Edit All Layers 
checkbox.

💬💬
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Arc Tools and Wall Heal/Join

NOTE: All tools in this row of the tool palette are External plug-ins.  In 
order for Arc Tools tool to appear in the Tool palette the Arc Functions 
External must be checked on when PowerCADD is launches.  The Wall 
Heal/Join tool requires the Wall Tools External to be loaded.  See Loader 
Preferences for more on turning External plug-ins On and Off.

Arc Tools provide specialized tools that extend the capability of PowerCADD 
for mechanical engineers, industrial designers or anyone who works with 
circles, circular arcs or arc tangent geometry.  They appear as the last row of 
tools in the main Tool palette.

For the purpose of describing the arc tools, circles and circular arcs will 
subsequently be referred to as arcs.  Elliptical arcs are not included in the 
reference to arcs.

Arcs can be drawn tangent to:
o	 Two arcs (Tangent Arc tool)
o	 Two parallel lines (Slot tool)

Circles can be drawn tangent to:
o	 Three arcs (Three-Circle Circle tool) 
o	 Three lines (Three-Line Circle tool)

💬💬
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Tangent Arc Tool
This tool draws an arc tangent to two arcs.

A simple technique is used to indicate where the tangent arc should intersect 
the arcs.  Imagine a line drawn through the centers of the arcs.  The line 
divides each arc into two sections.  To draw a tangent arc intersecting an arc 
in a particular section, simply click that section.  

The following examples show how this works:

With filled arcs, click anywhere in the section.  With unfilled arcs, select the 
perimeter of the arc.

The radius of the arc can be specified with the keyboard or interactively by 
dragging the mouse.  There is also an option of arcs greater or less than 180°.

To set the behavior of the tool:
o	 Press the Option key and select the Tangent Arc tool from the Tool 

palette. The following dialog will appear:

o	 Select Inside Angle to place arcs of less than 180° and deselect for arcs 
of more than 180°.

o	 If you know what the radius should be, deselect Interactive and enter 
the radius. If Interactive is selected, the radius of the ghost arc is 
changed by moving the mouse.

o	 When you enter a radius and only one position for an arc of that radius 
is possible, the tangent arc is placed immediately after you select the 
arcs. If more than one position is possible, the ghost arc snaps to each 
position as you move the mouse.
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o	 There are two options for trimming: Trim Only or No Trim.  Trim 
Only cuts both original arcs at the intersection points.  If No Trim is 
selected, the arcs will be left intact.

To use the Tangent Arc tool:
o	 Select the Tangent Arc tool from the Tool palette.
o	 Select the first arc by clicking one of its two sections.  A bridge line 

connects the arc with the cursor indicating the tool is active.
o	 Select the second arc by clicking one of its sections.  When the arc has 

been selected, a ghost tangent arc appears.
o	 Move the cursor to adjust the arc’s radius and position.
o	 Click to place the arc.
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Slot Tool
This tool draws a circular arc tangent to two parallel lines, creating a slot.

To set the behavior of the tool:
o	 Press the Option key and select the Slot tool from the Tool palette.  The 

following dialog will appear:

o	 There are three options for trimming: No Trim, Trim Only, and Trim 
And Delete. 

o	 If No Trim is selected, the lines will remain intact.  
o	 Trim Only cuts the lines at their arc intersections or extends the lines 

to the arc intersections. 
o	 Trim And Delete cuts the lines and deletes the line segments forming 

a slot.  

	 The following illustration shows an example of Trim And Delete.
Original R es ult

first click

third click
second click

No T rim

T rim Only

T rim &  Delete

lines are continuous 
(not trimmed)

third click

second click
first click

trim location

trim location

first click

third click

first clicksecond 
click second click

third click

To use the Slot tool:
o	 Move the cursor over the first of two lines defining the parallel lines 

which will create the slot.  The target cursor will appear.
o	 Click on the first line and drag to the second line.  A blue bridge line 

appears connecting the two points.
o	 Click on the second line; a ghosted circular arc appears. 
o	 Drag the mouse left and right to position the arc horizontally.  Drag 

the mouse up and down to set the direction of the arc.
o	 When the arc is in the desired location, click; a circular arc is inserted 

which is tangent to the two parallel lines.
o	 Repeat the process for the other end of the slot.
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Three-Line Circle Tool
This tool draws a circle tangent to three lines.

To set the behavior of the tool:
o	 Press the Option key and select the Three-Line Circle tool from the 

Tool palette.  The following dialog will appear:

o	 Select the Trim/Extend check box to trim or extend the lines at their 
intersections with the circle.

o	 Click OK.

To use the Three-Line Circle tool:
o	 Select the Three-Line Circle tool from the Tool palette.
o	 Move the cursor over the first of three lines required to define the 

tangent surfaces for the circle.  The target cursor will appear.
o	 Click on the first line and drag to the second line.  A blue bridge line 

appears connecting the two points.
o	 Click on the second line and drag to the third line.  A blue bridge line 

appears connecting all three points.
o	 Click on the third line; a ghosted circle appears.
o	 Move the mouse until the ghosted circle is in the desired quadrant and 

click. 
o	 A circle is inserted which is tangent to the three selected lines.

A circle is inserted which is tangent to the three selected lines.  Lines which 
were too short are extended.  Lines which were long enough are trimmed 
where the line and circle intersect.

Original R es ult
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first click
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third click

fourth click
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Three-Circle Circle Tool
This tool draws a circle tangent to three circles.

To use the Three-Circle Circle tool:
o	 Select the Three-Circle Circle tool from the Tool palette.
o	 Move the cursor over the first of three circles required to define the 

tangent surface for the circle.  The target cursor will appear. 
o	 Click on the first circle and drag to the second circle.  A blue bridge 

line appears connecting the two points.
o	 Click on the second circle and drag to the third circle.  A blue bridge 

line appears connecting all three points. 
o	 Click on the third circle.
o	 A circle is inserted which is tangent to the three selected circles.

Original R es ult

first click

third clicksecond
click



Tools187

Heal/Join Tool
This tool cleans up and edits a variety of lines and intersections.

It provides a simple and elegant way to edit, manipulate, and clean up 
parallel lines.  

The Heal/Join tool can be used in a variety of situations and has the 
intelligence to determine the action needed.  Diagonal lines, as well as 
horizontal and vertical lines, may be healed.

There is no need to pre-select an option, but there are five basic cleanup 
categories:

o	 Extend or trim T, X, and L intersections.
o	 Extend or trim lines.
o	 Join lines or heal lines.
o	 Remove or add caps.
o	 Clean up T, X, and L intersections.

To use to the Heal/Join tool:
o	 Select the Heal/Join tool from the Tool palette.
o	 Draw a selection marquee around the area to be manipulated.
o	 Continue selecting areas or click to quit.

NOTE: Heal/Join does not work on ambiguous selections.

NOTE: The Wall tool external must be loaded for the Heal/Join tool to 
appear in the main Tool palette.

💬💬
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The following chart illustrates some of the ways in which the tool can be 
used.  There are three columns of ‘before’ and ‘after’ examples.  Carefully 
examine the selected area in each Action box and compare it with the 
adjacent Result box.
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External Tool Palettes
This section describes the external tool Palettes.  Before proceeding, you 
should become familiar with the basics of PowerCADD.  See PowerCADD 
Tutorial.

External tool palettes are separate floating palettes which contain one or 
more related tools.

The external tool palettes are completely separate from the Tool palette and 
appear floating on the PowerCADD screen.  Each palette is a collection 
of tools designed for special needs or tasks.  Because these Externals are 
separate from PowerCADD, they can be loaded or unloaded by choosing 
Loader Preferences from PowerCADD Preferences. 

External Tool Palettes include:
o	 Mechanical Tools (requires the Mechanical External to be loaded).
o	 Wall Tools (requires the Wall Tools External to be loaded).
o	 Notation Tools (requires the Notations External to be loaded).

Before describing each External Tool Palette in detail, it is important to be 
aware of the following fundamental concepts, which apply to all External 
Tool Palettes:

o	 For an External Tool Palette to be available its corresponding External 
Plug-in must be loaded.

o	 The orientation of an external tool palette may be adjusted from vertical 
to horizontal by Control- or right-clicking on the External tool palette, 
and choosing Change Palette Orientation from the contextual menu.

o	 The settings for each palette may be customized by pressing Control- 
or right-clicking on the External tool palette, and choosing Palette 
Settings from the contextual menu.  For a complete description of all 
Palette Settings reference the detailed diagram at the start of the Tools 
chapter.

o	 Use the Commands tab in the Preferences dialog to assign custom key 
commands to any External tool.

o	 The size of all tool palettes may be adjusted using the View tab in the 
PowerCADD Preferences dialog.  For a complete description reference 
the detailed steps discussed at the start of the Tools chapter.
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Mechanical Tool Palette
The Mechanical Tool palette provides specialized tools for mechanical drafting 
and design, extending the capability of PowerCADD for mechanical engineers.

The Mechanical Tool palette consists of seven tools:
o	 Centerline
o	 S-Break
o	 Drilled Hole 
o	 Tapped Hole 
o	 Top View Tapped Hole
o	 Hex Bolt
o	 Hex Nut

Centerline Tool
This tool places a centerline on objects.  Centerlines can be placed on circles, ellipses, 
arcs, rectangles, rotated objects, etc.  Centerlines can also be placed on objects such 
as hex nuts, objects within groups, and the corners of rounded rectangles. 

A centerline can be modified by ungrouping it.  If there is not enough room 
in the drawing for a full centerline, part of the centerline can be deleted.

To use the Centerline tool:
o	 Select the Centerline tool from the Mechanical Tool palette.
o	 Place the cursor on the object on which the centerline is to be placed. 

Unfilled objects may be selected on their perimeter.
o	 Click, and the centerline appears. 

To place a centerline on the corner of a rounded rectangle, place the cursor 
on the rectangle and press.  Drag the centerline to the corner and release.

The Centerline tool remains selected until you click in a blank space or 
select another tool.  The tool creates the correct size centerline for each 
object selected.
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S-Break Tool
This tool draws an S-break.

The S-Break tool can be used to add an S-break to a shaft, pipe, or other 
cylindrical piece.

To set the behavior of the tool:
o	 Press the Option key and select the S-Break tool from the Mechanical 

Tool palette.  The following dialog will appear: (it does not)

second click

first click

second click

first click

second click

first click

Original R es ult

first click

second click

No T rim

T rim Only

T rim &  Delete

first click

second click lines are continuous 
(not trimmed)

trim location

trim location

o	 There are three options for trimming: No Trim, Trim Only, and Trim 
and Delete. 

o	 If No Trim is selected, the lines of the shaft are not changed. 
o	 Trim Only cuts the lines at the break. 
o	 Trim and Delete cuts the lines and deletes the line segments beyond 

the break.  When set to Trim Only or Trim and Delete, the attributes 
assigned to the S-Break tool are applied to the remaining lines of the 
shaft.

To use the S-Break tool:
o	 Select the S-Break tool from the Mechanical Tool palette.
o	 Place the cursor on the outside of the shaft.
o	 Drag to the other side and release.

NOTE: Using Perpendicular (P) snapping to start the drawing operation and 
Surface (S) snapping to end the drawing operation is an efficient way to draw 
S-Breaks accurately between any two parallel lines regardless of their angles.

💬💬
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S-breaks can be placed on either end of a shaft. To place a break on the right 
end of a horizontal shaft, begin the break at the top of the shaft.  To place 
a break on the left end of a horizontal shaft, begin the break at the bottom 
of the shaft. 

The S-Break is constrained to the preset snap angles.  Press the Shift key to 
release the constraint.
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Drilled Hole Tool
This tool draws multiple objects depicting a drilled hole.  The resulting 
drilled hole object is a group

Drilled holes can be drawn by
o	 Dragging with the mouse. 
o	 Entering the length or diameter, or both.

Both blind and through holes can be drawn.  The Drilled Hole determines 
from your actions when to draw a through hole.  In addition, centerlines 
can be drawn along with the hole.

When a dashing default for the tool has been set, hidden views are drawn.

To set the behavior of the tool:
o	 Press the Option key and select the Drilled Hole tool from the 

Mechanical Tool palette.  The following dialog will appear: (Not!)

o	 Select Centerline to place a centerline along with the hole. 
o	 Interactive means the drilled hole is not a predetermined size; you 

will determine the size of the diameter and length by dragging.  If the 
Interactive boxes are not checked, you enter the diameter and length. 

To use the Drilled Hole tool:
o	 Select the Drilled Hole tool from the Mechanical Tool palette.
o	 Place the cursor at the center of the hole.
o	 Drag to the hole depth and width.
o	 Release when the appropriate size is reached.

To draw a through hole, drag until the cursor is directly over a surface and 
release.  PowerCADD automatically recognizes the difference between a 
blind hole and a through hole.  To snap the hole perpendicular to a surface, 
press and hold the P key (Perpendicular Snapping) when starting the hole.
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Tapped Hole Tool
This tool draws multiple objects depicting a tapped hole.  The resulting 
tapped hole object is a group.

Tapped holes can be drawn by:
o	 Dragging with the mouse.
o	 Entering the length or diameter, or both.

The length is the depth of the thread.  The diameter is the thread diameter.
Both blind and through holes can be drawn.  The Tapped Hole determines 
from your actions when to draw a through hole.  In addition, centerlines 
can be drawn along with the hole.

When a dashing default for the tool has been set, hidden or section views 
are drawn. For section views, the tool dashes the thread form only. 

To set the behavior of the tool:
o	 Press the Option key and select the Tapped Hole tool from the 

Mechanical Tool palette.  The following dialog will appear: (Not!)

o	 Select Centerline to place a centerline along with the hole. 
o	 Select Dash Threads Only to dash only the thread form. This option is 

only available when the tool has been set for dashed lines. 
o	 Interactive means that the tapped hole is not a predetermined size; you 

will determine the size of the diameter and length by dragging. 
o	 If Interactive is not checked, you enter the diameter and length.

To use the Tapped Hole tool:
o	 Select the Tapped Hole tool from the Mechanical Tool palette.
o	 Place the cursor at the center of the hole.
o	 Drag to the thread depth.
o	 Release when the appropriate size is reached. 

To draw a through hole, drag until the cursor is directly over a surface and 
release.  To draw a hole from an angled surface, use Perpendicular snap 
when starting the hole.
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Tapped Hole Top Tool
This tool draws a top view of a tapped hole.

Top view holes can be drawn by
o	 Dragging with the mouse.
o	 Entering the diameter.

The diameter is the thread diameter, or the bolt size. 

To set the behavior of the tool:
o	 Press the Option key and select the Tapped Hole Top tool from the 

Mechanical Tool palette.  The following dialog will appear: (Not!)

o	 Select Centerline to place a centerline along with the hole. 
o	 Select Dash Threads Only to dash the thread form only. This option is 

only available when the tool has been set for dashed lines. 
o	 Interactive means that the tapped hole is not a predetermined size; you 

will determine the size of the diameter by dragging. 
o	 If Interactive is not checked, enter the diameter in the dialog. 

To use the Top View Tapped Hole tool:
o	 Select the Top View Tapped Hole tool from the Mechanical Tool 

palette.
o	 Place the cursor at the center of the hole.
o	 Drag to the outside diameter.
o	 Release when the appropriate size is reached.
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Hex Bolt Tool
This tool draws tool draws a hex bolt.

Hex bolts can be drawn by
o	 Dragging with the mouse.
o	 Entering the length or diameter, or both. 

To set the behavior of the tool:
o	 Press the Option key and select the Tapped Hole Top tool from the 

Mechanical Tool palette.  The following dialog will appear:

o	 Select Centerline to place a centerline along with the bolt. 
o	 Select Show Threads to draw bolts with ASA schematic threads.  If this 

is not checked, the thread form is shown.  If this is not checked and a 
dashing default has been set for the tool, the thread form only is dashed. 

o	 Interactive mean that the hex bolt is not a predetermined size; you will 
determine the size of the diameter and length by dragging.

o	 If Interactive is not checked, you enter the diameter and length.

The bottom of the head appears at the point where you press the mouse button.

To use the Hex Bolt tool:
o	 Select the Hex Bolt tool from the Mechanical Tool palette.
o	 Place the cursor at the bottom-center of the head. 
o	 Drag to the end of the bolt.
o	 Release when the appropriate size is reached.

To draw a bolt from an angled surface, use Perpendicular snap when starting 
the bolt.
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Hex Nut Tool
This tool draws tool the top view of a hex nut.

Hex nuts can be drawn by
o	 Dragging with the mouse.
o	 Entering the diameter of the threads.

To set the behavior of the tool:
o	 Press the Option key and select the Hex Note tool from the Mechanical 

Tool palette.  The following dialog will appear: (Not!)

o	 Select Centerline to place a centerline along with the nut. 
o	 Select Dash Threads Only to dash only the thread form. This option is 

only available when the tool has been set for dashed lines. 
o	 Interactive means that the hex nut is not a predetermined size; you will 

determine the size of the diameter by dragging. 
o	 If Interactive is not checked, you enter the diameter.

The diameter is the outside thread diameter.  Centerlines can be drawn 
along with the nut.

To use the Hex Nut tool:
o	 Select the Hex Nut tool from the Mechanical Tool palette.
o	 Place the cursor at the center of the nut.
o	 Drag to the outside diameter.
o	 Release when the appropriate size is reached.
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Wall Tool Palette

The Wall Tool palette provides specialized tools for walls in architectural 
drafting and design. 

With the Wall Tool Palette you can
o	 Place doors (Door Insertion tool).
o	 Place windows (Window Insertion tool).
o	 Extend, trim, and heal wall lines (Wall Heal/Join tool).

The Door Insertion and Window Insertion tools draw doors and windows 
to your specifications.  The walls are cut and healed automatically.  These 
tools can also use symbols from symbol libraries.

Wall Heal/Join cleans up T, X, and L intersections.  It performs other tasks 
also, such as restoring lines that have been broken and capping wall ends.  If 
you delete a door or window, the Wall Heal/Join tool may be used to repair 
the open wall lines.
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Door Insertion Tool
This tool inserts doors into walls (two parallel lines), cuts, and heals the 
walls.  It makes it easy to place doors into a drawing.

Doors can be inserted by
o	 Entering their specifications.
o	 Using doors from symbol libraries

To set the behavior of the tool:
Press the Option key and select the Door Insertion tool from the Wall Tool 
palette.  The following dialog will appear:

o	 You can specify the door thickness and width.  The jamb and centerline 
options control the minimum distance from the door to the end of the 
wall.  The tool automatically prevents you from moving the door closer 
to the wall end than the distance set.

o	 When you select Trim Wall, the wall is automatically cut and healed as 
the door is placed.  This is extremely useful when exchanging files with 
less capable CAD systems that cannot hide lines.  Trim Wall can be 
used with both the parametric and symbol method of inserting doors.  
These settings will remain in effect until you change them.

Door Insertion measures the distance from the door to the end of the wall, 
allowing the door to be positioned in exactly the right place.  It can insert 
doors in diagonal, horizontal, and vertical walls.  The walls are automatically 
cut and healed, making door insertion virtually effortless.

NOTE: Selecting the Door Insertion tool can automatically switch you to 
the Door Layer (or another layer name of your choosing) if the Layer Tools 
feature is checked in the Layout Menu.  If the Layer Tools feature is not 
checked, doors are inserted on the active layer.

To use the Door Insertion tool:
o	 Select the Door Insertion tool from the Wall Tool palette.
o	 Select one of the wall lines.  A bridge line will connect the wall line and 

the cursor, showing the tool is active. 

💬💬
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o	 Select the second wall line.  A ghost door will appear. 
o	 Move the cursor to move the door to location.  To reverse the direction 

of swing, bump the door against one of the wall ends.  To change the 
side of the wall on which the door opens, move the door to the other 
side of the wall. 

o	 Click to insert the door.

To start over if an incorrect line is selected, press the Enter key.  The tool 
will remain active.

The Door Insertion tool can also be used to insert doors (or other symbols) 
from a symbol library between two parallel lines.

Correct orientation of the door in the symbol library is mandatory to 
achieve predictable results.  The door must open up, and to the left, as 
shown in the illustration.

The symbol is automatically rotated when used with vertical and diagonal 
walls. 

Symbols can be inserted as instances or groups.  Door Insertion uses the 
settings of the Symbol tool to determine whether to place a symbol as an 
instance or a group.

When placing the door as a symbol, placement points are ignored. The 
bottom of the symbol is always placed on the door line.

Some symbol libraries were designed with an opaque rectangle. When 
these are used with the regular Symbol tool, this rectangle covers-up the 
wall lines. Since these symbols normally have placement points for correct 
placement, they will be unsatisfactory in their placement location.

Both the parametric method and the regular Symbol tool placement 
method (which covers up the wall) are perfectly acceptable. They are just 
different techniques.

To use the Door Insertion tool with symbols:
o	 Press the Option key and select the Door Insertion tool from the Wall 

Tool palette.

Using Symbols with 
Door Insertion



Tools201

o	 Select the symbol button in the dialog.
o	 Set the options desired and click OK. 
o	 Open a library containing door symbols.
o	 Select the door symbol to use.
o	 Click in the drawing window to make it active.
o	 Select the two wall lines.
o	 Position the door symbol and click to place.

NOTE: Doors can only be inserted into two parallel lines, not polygons.💬💬
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Window Insertion Tool
This tool inserts windows into walls (two parallel lines), cuts, and heals the 
walls.  The tool makes it easy to place windows into a drawing.

Windows can be inserted by
o	 Entering their dimensions.
o	 Using windows from symbol libraries.

The Window Insertion tool can measure the distance from the window to the 
end of the wall, allowing the window to be positioned in exactly the right place.  
It can insert windows in diagonal, horizontal, and vertical walls.  The walls are 
automatically cut and healed, making window insertion virtually effortless.

NOTE: Selecting the Window Insertion tool can automatically switch you 
to the Window Layer (or another layer name of your choosing) if the Layer 
Tools feature is checked in the Layout Menu.  If the Layer Tools feature is 
not checked, windows are inserted on the active layer.

To set the behavior of the tool:
Press the Option key and select the Window Insertion tool from the Wall 
Tool palette.  The following dialog will appear:

o	 You can specify sill overhang and window width.  The jamb and 
centerline options allow the minimum distance from the end of the 
wall to the window to be specified.  The tool automatically prevents 
you from moving the window closer to the wall end than the distance 
set.

o	 When you select Trim Wall, the wall is automatically cut and healed as 
the window is placed.

To use the Window Insertion tool:
o	 Select the Window Insertion tool from the Wall Tool palette.
o	 Select a wall line.  A bridge line will appear, connecting the wall line 

with the cursor.
o	 Select the second wall line, and a ghost window will appear.
o	 Move the cursor to move the window to the desired location.

💬💬
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o	 Click and the window will be inserted.

To start over if an incorrect line is selected, press the Enter key.  The tool 
will remain active.

The Window Insertion tool can also be used to insert windows (or other 
symbols) from a symbol library between two parallel lines.

The symbol must be designed for a horizontal wall.  The symbol is 
automatically rotated when used with vertical and diagonal walls.

To use the Window Insertion tool with symbols:
o	 Press the Option key and select the Window Insertion tool from the 

Wall Tool palette. 
o	 Select the symbol button in the dialog.
o	 Set the appropriate options and click OK.

Using Symbols with 
Window Insertion

o	 Open a library with window symbols.
o	 Select a symbol designed for a horizontal wall.
o	 Click in the drawing window to make it active.
o	 Select the two wall lines.  A ghost of the window symbol will appear.
o	 Position the window symbol and click to place.

NOTE: Windows can only be inserted into two parallel lines, not polygons.💬💬
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Wall Heal-Join Tool
This tool cleans up and edits a variety of wall lines and intersections. 

The tool provides a simple and elegant way to edit, manipulate, and clean 
up walls and lines.  Although the tool is named Wall Heal/Join, it is not just 
for architects.  Any professional who needs to trim, extend, or join lines will 
quickly find this tool useful.

The Wall Heal/Join tool also appears in Row 14 of the Tool palette.  To learn 
more about the Wall Heal/Join tool please see the descriptions provided for 
tools in Row 14 of the Tool palette.
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Notation Tool Palette

With the Notation Tool palette you can place notation symbols in a drawing 
with customized text.  Notations can be used for a variety of specialty 
labeling tasks ranging from revision clouds and detail keys to door, window, 
or furniture labels for schedules. 

Since all the Notation Tools share the same basic method of operation and 
optional settings, we will use the Circular Notation tool for illustration and 
demonstration purposes below.  Notation Tools which operation differently 
will be clearly noted.  Each Notation Tool, as diagramed below, inserts a 
bubble note in the drawing with a shape corresponding to the tools name 
and icon.  For example, the Circular Notation tool inserts circular shaped 
bubble notes, and Diamond Notation tool inserts diamond shaped bubble 
notes.

Each notation tool has optional settings which allow you to specify the type 
of leader line, the size of the bubble note and whether dividers for multiple 
text fields should be used. 

Optional Settings

To specify the optional settings for any Notation Tool: 
o	 Press the Option key and select a notation tool.  A dialog box will 

appear:

	 The name of the dialog box will match the name of the tool.  In this 
example pressing the Option key while selecting the Circular Notation 
tool the dialog changes to Circular Options. 

Circular Notation

Square Notation

Diamond Notation

Upward Triangle Notation

Hexagon Notation

Revision Notation

Oval Notation

Rectangle & Round Rectangle Notation

Downward Triangle Notation
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	 Straight Line Leader: Click this icon to insert bubble notes with a 
straight leader line.

	 No Leader: Click this icon to insert bubble notes with no leader line.
	 Smooth Polygon Leader: Click this icon to insert bubble notes with a 

smooth polygon leader line.
	 Straight Polygon Leader: Click this icon to insert bubble notes with a 

straight polygon leader line.
	 No Divider: Click this icon to insert bubble notes with only one text 

block.
	 Divider Line: Click this icon to insert bubble notes with two text 

blocks.  Each text block is separated by a horizontal line.
	 Width Field: Enter the default width for bubble notes here in metric or 

imperial units.  The sizes are for 1:1 or full print size, drawing or layer 
scale is ignored when specifying this value.  The width is fixed and does 
not change if the font size or amount of text entered is larger than the 
width specified.

	 OK button: Click to confirm your changes and close the dialog box.  
The settings are remembered and remain in effect until you change 
them.  Existing bubble notes in a drawing are not affected.  The settings 
for each Notation Tool are distinct; for example Circular Notations 
may have different settings than Diamond Notations.

	 Cancel Button: Click to close the dialog box and abort the setting 
changes.  Any changes made in the dialog box are ignored.

o	 Make the desired changes and click OK.

The selected Notation Tool will now draw bubble notes with the specified 
settings.  These settings are in effect until you change them.

Setting the default line weight, arrow style, dash, color, fill and text style 
for a notation tool is just like setting default attributes for any other 
PowerCADD tool.  You may use the Attr menu, Attributes window, Text 
Attributes Window, Text menu or Contextual Menus (or any combination 
thereof ) to set default attributes.  Refer to the start of the Tools chapter, 
Change a Tool’s Default Attributes for additional information.

NOTE: The default text justification for Notation tools is centered.  However 
you may adjust the justification using the Text Attributes Window, or the 
Text menu...

Setting Notation Tool 
Default Attributes

💬💬
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All Notation Tools follow the same basic method of operation.  We’ll use 
the Circular Notation tool to illustrate the various methods for inserting a 
notation bubble and text in a drawing.  However, the same methods apply 
for all other Notation Tools. 

To use a Notation Tool to draw a Straight Line Leader:
o	 Select a Notation tool from the Notation Tool palette.
o	 Press the Option key and select the tool to open the optional settings 

dialog and select the Straight Line Leader icon.  Click OK. 
o	 Place the cursor in the drawing window where you want the leader to 

start and click.
o	 Drag to set the length and angle of the straight line leader.  Click the 

mouse button.
o	 The text field will automatically activate.  Type the desired text and 

press the Enter key.
o	 The notation is inserted in the drawing. 

Using the Notation Tools

first click

drag second click

A

first click

drag second click

text field
activates

type text and press 
the Enter key or click 
the mouse to 
complete the notation

A 1

B 2

text field 
activiates 

after first click

Type text and press 
Enter key. Lower 
text field will activate

Type the desired text 
in the lower field and 
press the Enter key to 
complete the notation

Drawing Straight Line 
Leader Notations

NOTE: The width of the notation bubble is fixed.  Text that is too large to 
fit will extend beyond the width of the notation.  Pressing the Return key 
when entering text will insert a new line which could extend past the width 
of the notation bubble.

Drawing No Leader 
Notations

💬💬

To use a Notation Tool to draw No Leader with two divided text fields:
o	 Select a Notation tool from the Notation Tool palette.
o	 Press the Option key and select the tool to open the optional settings 

dialog and select the No Leader icon.  Click OK. 
o	 Place the cursor in the drawing window where you want the notation 

to appear and click the mouse button.
o	 The upper text field will activate.  Type the desired text and press the 

Enter key.
o	 The lower text field will activate.  Type the desired text and press the 

Enter key.
o	 The notation is inserted in the drawing.
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To use a Notation Tool to draw a Straight Polygon Leader with one 
text field:
o	 Select a Notation tool from the Notation Tool palette.
o	 Press the Option key and select the tool to open the optional settings 

dialog and select the Straight Polygon Leader icon, select the No 
Divider icon and click OK. 

o	 Place the cursor in the drawing window where you want the leader to 
start.  Press the mouse button.

o	 Drag to position the bend in the leader line and release.
o	 Move the cursor horizontally to position the leaders endpoint and 

click.
o	 The text field will automatically activate.  Type the text associated with 

the notation.  To insert more than one line of text in a note press the 
Return key.

o	 Press the Enter key or click to complete the notation.

NOTE: The same technique applies to create a notation using a Smooth 
Polygon Leader.  Simply select the Smooth Polygon Leader in the optional 
settings dialog before starting your notation.

1_press here

2_drag

3_release 4_drag

5_click

6_text field activates

type text and press 
the Enter key or click 
the mouse to 
complete the notation

reshape
handle bars

Drawing Straight Polygon 
Leader Notations

NOTE: Upward and Downward Triangle Notation tools cannot have 
dividers.  The Divider option is dimmed in their optional setting dialog boxes.

Reshaping Existing 
Notations Leader Lines

💬💬

To reshape an existing notation leader line: 
o	 Select the notation with the leader line to be reshaped.
o	 Selection handles appear.
o	 Move the mouse over a selection handle and drag to reshape the leader 

line.
o	 Release to complete the reshape operation.
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There are two methods for editing the text associated with a notation already 
in a drawing.  Directly in the drawing window using the Text tool or using 
the Text Edit window.

To edit existing notation text using the Text tool: 
o	 Select the Text tool from the main PowerCADD Tool palette.
o	 Click the notation text to be edited.  A text insertion point will appear.
o	 Make the desired changes and click outside the notation. 

To edit existing notation text using the Text Edit Window:
o	 Select the notation containing the text to be edited.
o	 Choose Edit from the Edit menu.  The Text Edit window will open. 
o	 Make the desired changes and close the Text Edit window. 
o	 The notation text is updated in the drawing. 
o	 Click the notation text to be edited.  A text insertion point will appear.
o	 Make the desired changes and click outside the notation.

Also, see Text Tool, and Edit Text Window, discussed earlier in this 
chapter for more information on working with Text in PowerCADD.

Editing Existing 
Notation Text

💬💬
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Revision Tool
This tool creates a Bézier curve in an open or closed shape with a circular, 
scalloped, edge.  Traditionally these types of shapes were used to identify 
areas of drawings which had been revised.  However, the shapes can also 
be used to illustrate areas of plant material such as trees, shrubs, or other 
illustrative effects.

To set the behavior of the tool:
o	 Press the Option key and select the Revision tool from the Notation 

Tool palette.  The following dialog will appear:

	 Fixed Repeat: With this setting, the scalloped edges are drawn at fixed 
repeat distance which cannot be changed for this drawing method.  
The farther you drag between segments the larger the curves will be.

	 Freehand: Select this icon to draw revision clouds using an 
unconstrained freehand stroke.  As you drag the revision cloud is 
drawn.  A custom repeat distance may be specified.

	 Variable Repeat: With this setting the scalloped edges are drawn at a 
user specified repeat distance.  The farther you drag the more scallops 
repeat along the segment at the interval specified in the Repeat Distance 
field. 

	 Repeat Distance: Enter the default distance the mouse must move 
before the pattern repeats.  The distance may be specified in metric or 
imperial units.  The values are for 1:1 or full print size, drawing or layer 
scale is ignored when specifying this value.  Shorter distances create 
smaller scalloped edge. 

o	 Make the desired changes and click OK.

The Revision Tool will now draw with the specified settings.  These settings 
are in effect until you change the tool settings.
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To use the Revision Tool with a Fixed Repeat setting:
o	 Press the Option key and select the Revision tool from the Notation 

Tool palette.
o	 Select the Fixed Repeat icon and click OK.
o	 Place the cursor in the drawing window where you want the revision 

bubble and click.
o	 Drag to begin defining the first segment.  A ghosted curve will appear.
o	 Release the mouse button to complete defining the first segment.
o	 Drag to position the next segment.  The farther you drag the mouse the 

larger the curves will be.
o	 Click to define the new segment.
o	 Repeat the process until you have defined the desired number of 

segments.
o	 Double-click to complete the drawing operation.

Fixed Repeat

To use the Revision Tool with a Variable Repeat setting:
o	 Press the Option key and select the Revision tool from the Notation 

Tool palette.
o	 Select the Variable Repeat icon, enter a distance in the Repeat Distance 

field (example: 1 inch) and click OK.
o	 Place the cursor in the drawing window where you want the revision 

bubble and click.
o	 Drag to begin defining the first segment.  A ghosted curve will appear.  

Dragging left or right sets the length of the segment.  Dragging up or 
down sets the angle.

o	 Release the mouse button to complete defining the first segment.  The 
farther you drag the more scallops repeat along the segment at the 
interval specified in the Repeat Distance field. 

o	 Drag to position the next segment.
o	 Click to define the new segment.
o	 Repeat the process until you have defined the desired number of 

segments.
o	 Double-click to complete the drawing operation.

Variable Repeat
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NOTE: Entering a smaller Repeat Distance value will create a scalloped 
edge with smaller curves.

A Repeat Distance of 1"

A Repeat Distance of 0.25"

To use the Revision Tool with a Freehand setting:
o	 Press the Option key and select the Revision tool from the Notation 

Tool palette.
o	 Select the Freehand icon, enter a distance in the Repeat Distance field 

(example: 0.5 inch) and click OK.
o	 Place the cursor in the drawing window where you want the revision 

bubble to begin and click.
o	 Drag to draw the revision cloud.  The edges are drawn as you drag the 

mouse. 
o	 Release the mouse button to complete the drawing operation. 

Freehand

NOTE: Entering a smaller Repeat Distance value will create a scalloped 
edge with smaller curves.

A Repeat Distance of 1"

A Repeat Distance of 0.25"

💬💬

💬💬



Menus



Menus214

This chapter will describe the menu commands and functions in 
PowerCADD including External menu items. 

Generally, all menu items require one or more objects to be selected before 
applying the menu item.  Some menu items are Externals and the particular 
external must be loaded in order for the items to appear in the appropriate 
menu.

Menu Bar The Menu bar located at the top of the screen contains various pull-down 
menus of PowerCADD options and commands which you can choose with 
your mouse.

NOTE: The three dots (…) following some of the menu commands 
indicate special commands.  When you choose these commands, a typical 
Macintosh dialog box will appear, automatically. 

A typical example is the Print and Page Setup menu items as shown on 
the left.  When chosen by the Selection cursor, a dialog will appear.  This 
and other dialogs will contain various parameters which must be set before 
PowerCADD will perform a task.

Option Key 
Commands

💬💬

Many PowerCADD commands have optional features which are accessed 
by pressing the Option key while selecting a command.  Any command 
followed by three periods (…) will present you with a dialog box, if selected 
while pressing the Option key.  If you select the command without pressing 
the Option key, PowerCADD will use the last settings assigned in the dialog.

The use of the Option key with the triple-period commands gives you 
access to additional advanced features.  An example of how a menu display 
changes can be seen in the Edit menu with Undo and Undo Options… as 
shown on the left. 

If you assign a custom key command which includes the Option key, an 
additional item appears in the menu.  In the example shown here, a custom 
key command of Shift-Option-V was was assigned to the Paste Special 
menu item.  Notice the additional entry in the Edit menu.

Menus
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The Edit menu is an excellent illustration of keyboard shortcuts.  The 
commands shown at the left are common to most Macintosh software.  
Although the commands may be changed, you should attempt to keep the 
command keystroke sequences as standard as possible with other Macintosh 
programs.  Command keystroke sequences may be added to blank menu 
items or you may change existing commands as explained later in this 
chapter.

Contextual Menus

Drawing Window 
Contextual Menu

Many PowerCADD menu items may be accessed by pressing the Control 
key and clicking (or right-clicking) in various areas of the drawing window 
or on an object.  They provide access to a range of features, some of which 
appear in other PowerCADD menus or floating windows, and others which 
appear exclusively in a contextual menu.

Contextual menus are intelligent in that they recognize the type of object 
you are Control- or right-clicking and the menu items presented are adjusted 
accordingly.  For example, the contextual menu for lines has appropriate 
items for adjusting line weight, color and other typical object attributes. 
The contextual menu that appears for Dimensions includes menu items 
for adjusting text size and font type in addition to typical object attribute 
items.  In this section we’ll describe the most common contextual menu 
items which appear when you Control- or right-click on an object or in the 
drawing window.

To access the Drawing Window contextual menu:
o	 Control- or right-click in a blank drawing area. 
o	 Choose an item from the contextual menu.

Hide Rulers: Turns off the drawing rulers in the active drawing.  If the drawing 
rulers are currently hidden (off) this menu item will change to read Show Rulers.

Save: Stores the current PowerCADD file to a specified disk under the most 
recently designated file name.  If the drawing has not been previously saved 
you will be prompted for a file name and location.

Print: Sends the active drawing to output devices such as ink jet or laser 
printers.

Revert: Replaces the active drawing with the version last saved under the 
same file name. If the drawing has never been saved this item is dimmed.

Drawing Setup: Opens the Drawing Setup dialog for the active drawing 
where you may set specific drawing parameters.



Menus216

Quit PowerCADD: Closes all drawings and exits PowerCADD.

For more information on working with a drawing, see The Layout Menu 
later in this chapter.  For more information see Print, Save, Revert and Quit, 
in The PowerCADD Menu.

Drawing Rulers 
Contextual Menu

To access the Drawing Rulers contextual menu:
o	 Control-click on the horizontal or vertical drawing ruler.  If drawing 

rulers are turned off, this contextual menu item is not available. 
o	 Choose an item from the contextual menu.

Hide Rulers: Turns off the drawing rulers in the active drawing.

Show/Hide Guidelines: If guidelines are hidden, choose Show to display 
them.  If guidelines are showing, choose Hide to turn them off.

Drawing Setup: Opens the Drawing Setup dialog for the active drawing 
where you may set specific drawing parameters.

See “The Layout Menu” later in this chapter for more information on 
working with Drawing Setup and Guidelines.

Typical Object Attribute 
Contextual Menu

To access the attribute menu for Lines and other objects:
o	 Control- or right-click on a Line in the drawing (contextual menu 

pictured left).
o	 Choose an item from the contextual menu.
o	 If a line is not selected the change is applied to the item you Control-

clicked on.  If multiple objects are selected the change is applied to all 
selected items.

All objects have access to typical attributes which may be set via a contextual 
menu:

Styles: Allows you to select from a list of user defined Attribute Styles.  If no 
custom styles are available, choose New to define a new attribute style (see 
“Making New Attribute Styles” later in this chapter).

Line: Allows you to change the line weights of objects.

Arrow: Allows you to change the arrow attributes of objects.

Anchor
[TypObjContexualMenu]
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Dash: Allows you to change the dash patterns of objects.

End Caps: Allows you to change the type of end cap used at the ends of 
lines or other open ended geometry.

Pen Pattern: Allows you to assign a pattern to lines and borders that outline 
objects.

Pen Color: Allows you select a color or gray scale value for lines and borders 
that outline objects from the PowerCADD color palette.

Pen Color… (three dots): Provides direct access to the MacOS Color Panel 
to select a color or gray scale value for lines and borders that outline objects.

Move To Layer: Allows you to select which visible drawing layer an object 
should be moved to.  The layer the object is currently on, and hidden layers, 
are dimmed (unavailable) in the list.  The list of layers presented is from the 
active drawing.  Moving an object removes it from its current layer onto the 
selected layer in the same X,Y location. 

Go to “Layer 1” Layer: Allows you to change the active drawing layer 
to match an existing objects layer.  The layer name of the object will be 
displayed instead of “Layer 1” if it is not on the current active drawing layer.

NOTE: Go to “Layer 1” Layer is available from a contextual if an object is 
selected.

For more information on working with object attributes, see The Attr Menu 
later in this chapter.

💬💬

!
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To access the Attributes menu for closed or complex geometry objects such 
as rectangles, Bezier curves, polygons, circles and arcs:
o	 Control- or right-click on an object in the drawing.
o	 Choose an item from the contextual menu.
o	 If an object is not selected, the change is applied to the item you 

Control- or right-clicked on.  If multiple objects are selected, the 
change is applied to all selected items.

In addition to typical object attributes, some objects also display additional 
attribute choices:

Fill Pattern: Allows you to assign a pattern used to fill an area defined by 
the borders of a closed or open object.

Fill Color: Allows you select a color or gray scale value for fill patterns from 
the PowerCADD color palette.

Fill Color… (three dots): Allows you select a color or gray scale value for fill 
patterns from the MacOS Color Panel.

Hatch: Allows you to assign a vector based pattern to fill an area defined by 
the borders of a closed or open object.

Hatch Settings: Allows you to control various hatch attributes of associative 
hatch patterns, including hatch origin, pen color, line weight and scale.

Live Area: Allows you to insert a smart text object in the drawing displaying 
the area and/or perimeter of an object.

See Live Area and pen, fill and hatch attributes in the Attr Menu later in this 
chapter for more information on working with these attributes.

Additional Object 
Attributes Contextual 

Menu

Anchor
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To access the contextual menu for text objects:
o	 Control- or right-click on a text object in the drawing.
o	 Choose an item from the contextual menu.
o	 If no text object is selected the change is applied to the item you 

Control-clicked on.  If multiple text objects are selected the change is 
applied to all selected items.

In addition to the typical object attributes such as pen color and fill pattern 
(see Typical & Additional Object Attribute Contextual Menus), special 
contextual menu items related to Text are also displayed:

Font: Allows you to select the font family that you want used for your text. 
You may select from any active font installed in MacOS.

Size: Allows you to select the size, in points, of the text.

Style: Allows you to select the style of a font to be used.  For example bold 
or italic.  You may also select the case of text, for example lower, UPPER 
or Title Case.

Spacing: Allows you to control the vertical distance between lines of text 
from a standard list of line spacing, incremental leading, or custom leading 
amounts.

Alignment: Allows you choose from Left, Center, Right or Full justified 
text alignments.

Advanced Text Options…: Allows you to control how text is displayed 
when it is mirrored, or flipped vertically or horizontally.  Choosing this 
contextual menu item opens the following dialog.

Text Attributes 
Contextual Menu

Click on the Flip Behavior icon to select the desired option.

For more information on working with text, see the Text Menu later in this 
chapter.!
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Blossom is a special contextual menu which brings up the standard 
PowerCADD tool palette anywhere on screen when you assign a custom 
key command to Blossom. 

You can also create your own custom tool palette which appears instead of 
the default PowerCADD tool palette

To use a custom Blossom tool palette:
o	 Choose Preferences from the PowerCADD menu and the Preferences 

dialog will open.
o	 Select the Commands Tab.
o	 From Single Commands choose Misc., XTNL Misc., Blossom.
o	 Press the desired key command sequence then click OK to close the 

Preferences dialog.
o	 In the drawing window, press your custom key command sequence; the 

Blossom tool palette will appear displaying the standard PowerCADD 
Tool Palette.  If you created a custom Blossom tool palette (described 
later in this section), your custom Blossom tool palette is displayed.

o	 Tools selected from the Blossom tool palette function just like tools in 
the regular PowerCADD Tool palette.

TIP: Some multi-button mice allow you to assign a key command sequence 
to a specific button. If your hardware has that capability try assigning your 
custom key command one of the special mouse buttons for even easier 
access to Blossom.

For more information on working with custom key commands, see 
Commands Preferences later in this chapter.

To create a custom Blossom tool palette:
o	 Choose New Custom Palette from the Layout menu.
o	 In the New Custom Palette dialog, name the palette Blossom.  The 

name is case sensitive; notice there is an upper case ‘B’ and the rest of 
the text is lower case.

o	 A new, empty, custom tool palette will appear on screen.
o	 Press the Command key while dragging a tool from any tool palette 

onto the new Blossom tool palette.

The next time you press your custom command sequence in the drawing 
window, your custom Blossom tool palette will appear instead of the 
standard PowerCADD tool palette.

TIP: A custom Blossom tool palette can be a very effective way to manage 
tools you use on a regular basis.  For example, you could create a Blossom 
tool palette which contains any standard PowerCADD tools and any 

Blossom

💡💡

💡💡

👌👌 ✌

👍👍❤
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External tools (for example WildTools) you use regularly.  This can save 
a significant amount of time when compared to moving in and out of 
multiple tool palettes during a typical drawing session.



Menus222

The PowerCADD menu tracks important information about the 
application, computer memory usage, drawing statistics and allows you to 
set application preferences. 

PowerCADD Menu

About PowerCADD contains your software serial number.  Choose About 
PowerCADD from the PowerCADD menu, the serial number is displayed 
in the bottom left of the splash screen as pictured above.

PowerCADD Profile provides a Software Profile (information about the 
application) and a Drawing Profile (information about your drawing).

To use PowerCADD Profile:
o	 Choose PowerCADD Profile from the PowerCADD menu and the 

following dialog will appear:

Software Profile: Contains your PowerCADD serial number, the 
application version number and your operating system version number. 
This information can be helpful when requesting technical support.
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Drawing Profile: Contains a general profile about the current active 
drawing including the drawing name, number of objects on the current 
active layer, total number of layers in the drawing and total number of 
objects in the drawing.  This information is provided to assist you in 
managing your drawings.

Preferences Preferences allow you to customize PowerCADD’s general behavior to suit 
your drawing and working style.  Preference settings are saved with the 
application and apply to all drawings.  To set particular drawing settings, see 
Drawing Setup described later in this chapter.

Within the Preferences tabbed dialog, you are able to set and control 
PowerCADD’s preferences, from how you view your document, changing 
your Command keys to deciding which Externals will be loaded the next 
time you open PowerCADD.

To use Preferences:
o	 Choose Preferences from the PowerCADD menu and the Preferences 

dialog will open.
o	 Each tab contains groups of options you can set.  Select a tab to see the 

different options.
o	 Check a box or specify a particular value for the desired settings and 

click OK.
o	 The preference settings are set and will affect all drawings.

The General preferences tab allows you to specify the behavior of general 
PowerCADD features.

General Preferences

WYSIWYG Font Menu: Allows you specify whether the font menu displays 
items in their true font style or in a generic font.  Changes made to this 
preference do not take effect until the next time you open PowerCADD.

Anchor
PreferencesGeneral
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WYSIWYG Font Menu not checked:
o	 The font menu displays all fonts in the same, default font.  Generally 

this method of font display is faster and may help increase performance 
on slower computers or when many fonts are loaded.

WYSIWYG Font Menu checked:
o	 The font menu displays all fonts in their particular style.  This method 

can make it easier to determine which font you might want to use.

Hierarchical Font Menu: Allows you specify whether the font menu 
displays any styles available for font in an associated submenu.  Changes 
made to this preference do not take effect until the next time you open 
PowerCADD.

Hierarchical Font Menu not checked:
o	 The font menu displays the name of the primary font family.

Hierarchical Font Menu checked:
o	 The font menu displays all font styles available for specific font family 

in a submenu.

Global Attributes allows you to share a common set of attribute menu items 
across all drawings.  When checked, the menu display for seven attributes 
are changed: Pen (line weights), Color (fill and pen), Hatch patterns, Fill 
Patterns, Arrows, Dashes, and Attribute Styles.  Menu choices displayed 
when using the Attribute menu, Defaults Window, Contextual Menu, or 
Attributes Window are affected for all new or existing drawings.  When 
unchecked the attributes saved with the document are displayed in the 
menus.

Before exploring the specifics of using Global Attributes, it is important to 
understand some fundamental rules regarding object attributes and Global 
Attributes in general:
o	 Global Attributes are stored in the Defaults Table file found in the 

PowerCADD Preferences folder in your User Library Folder.  Once 
this file is seeded with global attributes, it may be shared with others.  

o	 When Global Attributes is on (checked), attributes displayed in menus 
are from the Global Attributes Default Table.

o	 When Global Attributes is off (not checked), attributes saved with the 
specific document are displayed in the menus.

o	 When you assign an attribute to an object in PowerCADD, that 
attribute is saved with the object.  Turning Global Attributes on or off 
will never change the attributes of objects already in a drawing.

o	 When Global Attributes is on, attributes you add to a particular 
drawing are only appended to the Global Attributes Default Table. 

Global Attributes

Anchor
GlobalAttributes
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These attributes are then available in all other drawings.  If you later 
turn Global Attributes Off, attributes you added will not appear in the 
documents Attribute menu.

o	 When Global Attributes is Off, attributes you add to a particular 
drawing are available only in that drawing.  They are not appended to 
the Global Attributes Default Table. 

o	 Turning Global Attributes Off returns a drawing’s attribute menus to 
their original state before Global Attributes was turned On.  That is, 
the drawing behaves as if Global Attributes was never used.

Turning Global 
Attributes On

To use Global Attributes in all drawings:
o	 Open the drawing containing the attributes for Pen (line weights), 

Color (fill and pen), Hatch patterns, Fill Patterns, Arrows, Dashes, and 
Attribute Styles.  This is the drawing used to seed the Global Attributes 
Default Table.

o	 Choose Preferences from the PowerCADD menu and select the 
General tab.

o	 Check the Use Global Attributes box and click OK.
o	 A dialog appears asking you to confirm, click OK. 
o	 The Global Attributes Default Table has been seeded. 
o	 The items displayed in Attribute menu, Attributes window, Default 

window and Contextual menus in all old and new drawings will 
display the same Global Attributes.

Updating Global 
Attributes

To add a new Global Attribute which will be available in all old and 
new drawing:
o	 Open any existing drawing or create a new drawing. 
o	 Add the desired attribute. 
o	 The new attribute is appended to the Attribute menu and is now 

available in all drawings.

The same process holds true for deleting or modifying a Global Attribute.  
Making the change in any open drawing will update the Attribute menu 
display in all drawings.

NOTE: Even though updates to Global Attributes are displayed immediately 
in all drawings, changes are not saved to the Global Attributes, Default 
Table file until you Quit PowerCADD.

💬💬

User Library Folder

Anchor
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In MacOS Sierra and later, the user library files are hidden among many 
others, however you can show and hide the hidden files with the new key 
command of Command-Shift-.(period) and avoid having to use Terminal 
to show hidden files.



Menus226

Sharing a Global Attributes Default Table file can be an effective method to 
share standard attributes in a multiple-user environment.  In this scenario 
we’ll presume Global Attributes was already on for both users and user one 
has Global Attributes they want to share with user two.

To share Global Attributes:
o	 User one: Quit PowerCADD.  Any recent changes to the Global 

Attributes Default Table file are saved to disk.
o	 Open the PowerCADD preferences folder (in your User: Library 

folder) and copy the Default Table file to your desktop.
o	 User two: Quit PowerCADD and copy the Default Table file into the 

PowerCADD Preferences folder on your computer.
o	 Both copies of PowerCADD will now display the same Global 

Attributes the next time a drawing is opened.

Sharing Global 
Attributes

Turning Global 
Attributes Off

Global Attributes vs 
Stationary Drawings

Turning Global Attributes Off will only modify the items displayed in 
attributes menus.  Attributes added to a menu while Global Attributes was 
on will not appear in the menus.  Object attributes already in the drawing 
are not changed.  The attribute menus in each drawing will now display 
their original choices.

Both Global Attributes and Stationery Pad Drawings are powerful methods 
to manage your workflow and drawing environment.  Given the broad 
range of types of drawing and design disciplines PowerCADD is used in, 
we don’t offer a cut-and-dry recommendation as to which method might be 
best for your particular situation. 

Some items to consider when deciding whether to use Global 
Attributes or Stationery Pad Drawings include:
o	 Do you have multiple custom Stationery Pad Drawings, each with 

different attributes (perhaps different line weights, color palettes or fill 
pattern palettes)?  Global Attributes may not be the best solution since 
all drawings share common attributes.  Using a Stationery Pad may be 
a better solution.

o	 Do you use a single Stationery Pad for everything?  Global Attributes 
may be worth considering.

o	 Are you in a multi-user environment?  While sharing Global Attributes 
can be an effective way to keep everyone on the same page, it doesn’t 
prohibit each user from adding their own items to their local Global 
Attributes Default Table file.  Those changes will not be available unless 
the Default Table file is copied to all computers.  Stationery Pads can 
be stored on a central server and can contain custom attribute files 
which may be worth considering.

o	 Do you share files with other PowerCADD users?  If everyone 
doesn’t have the same Global Attributes Default file, the menu items 
available will not be the same across all computers.  Working with 
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Global Attributes off always saves any attribute menu changes with the 
drawing so menu selections are the same on all computers. 

Those are just some of the broader stroke items to consider.  Take the time 
to explore the workflow and production management methods available to 
both Stationery Pads and Global Attributes.  Each method will have pros 
and cons which vary with your particular workflow.

Share Usage Statistics: Enables automatic logging of which tools, menu 
commands, and general types of objects you typically use.  This information 
is automatically shared with Engineered Software to help fine-tune 
PowerCADD performance and features.

Save Prompt: Allows you to specify how many minutes will pass before 
PowerCADD prompts you to save the drawing.  Note, drawings are not 
automatically saved, you will be presented with a dialog asking you to proceed 
or cancel the Save operation.  The Save prompt dialog appends as a sheet to 
the documents title bar.  If multiple drawings are open, each drawing may 
have its own Save Prompt Sheet appended to its document window. 

Save Window Positions: When checked, PowerCADD will remember the 
position and size of your drawing window when it is saved and closed.  
When unchecked all drawing windows open with the window in the top 
left corner of the screen (the default location) and fill the entire screen.  
When Save Window Positions is checked, PowerCADD also remembers 
up to ten MacOS User Names when saving the window size and position.

During the course of drawing production, it is common for a drawing to 
be opened by different users.  It is also common for each of those users 
to have different computers which may have different monitor sizes.  This 
typically results in each user having a different preference for both the size 
and location for the drawing window.

By remembering who (the MacOS User ID) last saved the drawing, 
PowerCADD can open the drawing window in your preferred size and 
location.  The next time someone else opens the same drawing on their 
computer, it will be in their preferred location and size.  This process allows 
for a drawing to make multiple round trips while still remembering each 
person’s preferred window size and location. 

NOTE: A drawing window can never be saved or opened in a position that 
will leave it entirely off screen.  If a screen is too small to display the last 
saved location, the drawing will be positioned in the top left corner and 
sized to fit the maximum screen area.  Any subsequent customization as to 
size and location is remembered when the file is saved.

💬💬
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Window Fading controls whether floating windows and tool palettes can 
automatically fade.  When checked, the Auto-Fade settings associated with 
each floating window or tool palette are enabled.  When unchecked the 
auto-fading is disabled for all floating windows and tool palettes.  Window 
fading can be an excellent work space saver, allowing you to see more of 
your drawing.  Each window can have unique window fading properties.

Color Elevation Rendering

Window Fading checked on: Floating Windows 
and Tool Palettes are see through to show you 
more of your drawing.

Magnetic Windows controls whether floating windows and tool palettes 
can interact with each other or the edges of the computer screen.  When 
checked, the Magnetic Edges settings associated with each floating 
window or tool palette are enabled and the windows will stick together 
when touching.  Moving one window will move all windows that are stuck 
together.  When unchecked the Magnetic Edges settings are disabled for 
all floating windows or tool palettes.  To release windows which are stuck 
together press the Command key and move the window.  Each window can 
have the magnetic property turned on or off.

For more information on Auto-Fade and Magnetic Edge settings for tool 
palettes, see The Tool Palette in the Tools chapter.  For more information on 
Auto-Fade and Magnetic Edge settings for floating windows, see Floating 
Windows in the PowerCADD Tutorial.

Show Toolbar controls whether the toolbar on the top of the drawing 
window is visible when opening drawings. When Show Toolbar is checked 
all drawings display the toolbar by default. When Show Toolbar is 
unchecked the toolbar is hidden by default. You can change the visible or 
hidden status of any drawing window toolbar by clicking the oval button in 
the top right corner of a drawing window.

!
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For more information on working the drawing window Toolbar, see The 
Document Window in the PowerCADD Tutorial.!
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The View preferences tab allows you to specify how objects in the drawing 
are viewed on screen.

View Preferences

TIP: The Preference setting for High Quality Drags found in PowerCADD 
8 has been discontinued.  By default, dragging to move multiple objects 
will always display all selected objects.  The Control key may be used to 
temporarily toggle High Quality Drag Off.  For example, pressing the 
Control key during a move by dragging operation will temporarily show 
only the object you first selected. (check ???)

Use Transparent Drawing when checked, objects with a solid fill or line 
pattern are transparent when dragging them. When unchecked, solid 
patterns render as opaque when dragging them.

Hide Reshape Fill allows you to hide the fills for Béziers, polygons, arcs 
and circles while reshaping an object.

Quick Handles shows four object handle for selected objects instead of 
eight.

💡💡

Hollow Line Handles allows you to display a handle at the end point of 
objects drawn with line tools.  The hollow line handle indicates the end point 
of the line.  The start point of a line is fixed when entering new line lengths 
using the Edit Window; the hollow line end point indicator will be moved.

Grid Behind Objects allows you to display the drawing grid lines either in 
front or behind objects.  When checked on, objects will be rendered on top 
of (in front) of the drawing grid lines.  When unchecked, the drawing grid 
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line renders on top of all objects, including objects with solid fill patterns.

Original: Point Size 10 pixels , Zoom 100%

Result: Scale Points on 
Zoom Out OFF
Zoom 50% = Point Size 
of 10 pixels

Result: Scale Points on 
Zoom Out ON
Zoom 50% = Point Size 
of 5 pixels

Page Breaks Behind Objects allows you to display page breaks either in 
front or behind objects.  When checked On, objects will be rendered on top 
of (in front) of page breaks.

Guidelines In Front allows you to display Guidelines either in front or 
behind objects.  When unchecked, objects will be rendered on top of (in 
front) of Guidelines.  When checked, Guidelines are rendered on top of 
all objects.  In previous versions of PowerCADD this was accessed by an 
Option-click on a drawing ruler. 

Scale Points on Zoom Out: When checked (On), Points in the drawing 
inserted using the Reference Point tool will be rescaled smaller as you zoom 
past normal zoom.  When not checked (Off), Points in the drawing are not 
rescaled, they retain their original size in pixels as specified in the Point tool 
settings dialog.

Display Accuracy Specified makes the Edit Window and other dialogs 
reflect its numerical information rounded to the accuracy set in Drawing 
Setup, Units.  Placed dimensions are also rounded.  For example, if the 
drawing setup accuracy is ¼’’, a object with a length of 1 1/8’’ in the 
drawing would be rounded off when displayed in the Edit Window to 1’’ if 
Display Accuracy Specified is checked.  An alert dialog will appear requiring 
you to confirm this action.

Show Thousands Separators includes a comma when displaying values in 
the Edit Window.  For example, with Show Thousands Separators checked 
one thousand is displayed as 1,000.  With Show Thousands Separators not 
checked one thousand is displayed as 1000.

Show Layer Color In Name affects the display of layer names in the 
floating Layers Window for those layers with a Layer Color Attribute 

Anchor
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assigned.  When unchecked, only the layer status indicator is displayed in 
the specified layer color.  When checked, the entire layer name and the layer 
status indicator is displayed in the specified layer color.

Hilite Selection enables you to change the color of the object and its 
handles while it is selected.  Click on the color wheel to pick a Hilite color 
from the MacOS color picker.  If Hilite Selection is checked the Hilite color 
affects both the handle color and hilite color of a selected object.  If Hilite 
Selection is not checked, the Hilite color affects the color of any object’s 
selection handles only.

TIP: Even though you may not choose Hilite Selection, the Hilite color is 
used throughout the program in many places.  WildTools uses the Hilite 
color when tools pick objects in the drawing.  To see this in action, try using 
a bright green as the Hilite color and notice how the color is used as you 
use the program.

Snap Color allows you to specify any color for the snap indicators used on 
screen and in the Dynamic Snap Indicator floating window.  To change the 
snap color click the Snap Color button and choose a color from the MacOS 
Color Panel.

Background Color allows you to specify any color for the drawing 
background.  The background color doesn’t print.  To change the color 
click the Background Color button and choose a color from the MacOS  
Color Panel.

Construction Lines allows you to specify a color for the construction lines 
which appear when creating and editing objects.  This color is also applied 
to Guidelines. To change the construction line color,  click the Construction 
Line Color button and choose a color from the MacOS Color Panel.

Handle Size allows you to adjust the size of the selection handles displayed 
when an object is selected.  Drag the slider bar to the right to increase the 
handle bar size.

Page Scroll allows you to specify, as a percentage how far the page will scroll 
each time the area between the scroll arrows is clicked.  For example, if the 
page scroll is set to 75%, only 75% of the drawing visible on the screen will 
scroll in one step.  This does not affect the amount of scrolling per scroll bar 
arrow (see Line Scroll below).

Line Scroll allows you to specify how far, in pixels, the drawing will move 
each time you click on a scroll arrow.

💡💡

Hilite Color

Anchor
ConstructionLinesColor

Anchor
HandleSize
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Greek Text allows you to specify the text point size threshold where text 
is redrawn to screen as a gray box instead of normal text.  Greeking occurs 
when text will render equal to or smaller than the specified point size on 
screen, it is not linked to the font size you specify when entering text.  For 
example, if greeking is set to 6 points and text entered as 12 points, the 
text will render as a gray box when the drawing is viewed at 50% zoom.  
Greeking does not affected printing, all text will print at the specified font 
size based on the page setup settings.  Greeking text can help increase redraw 
performance, particular in drawings containing large amount of small text.

Commands Preferences The Commands preferences tab allows you to assign a key sequence to any 
tool or menu item in PowerCADD.

Keys displays the actual key sequence assigned to the function selected in 
the Active Commands list.  You may have more than one key sequence 
assigned to any Active Command.

Active Commands displays all functions that presently have an assigned 
key sequence. Multiple Command Sequences always appear at the top of 
the list.

The Choose Command section contains choices for creating single or 
multiple command sequences which can be assigned to key command 
sequence you specify.

Anchor
[CommandsPreferences]
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Each PowerCADD Tool, Menu item, or special Miscellaneous items can 
have a custom key sequence assigned.

Tools is a pop-up menu which allows you to specify the tool to which you 
wish to assign a key sequence.

Menus is a pop-up menu which allows you to specify the menu item to 
which you wish to assign a key sequence.

Miscellaneous is a pop-up menu which allows you to specify the 
miscellaneous functions to which you wish to assign a key sequence.

Keys displays the actual key sequence assigned to the function selected in 
the Defined Functions window.  You may have more than one key sequence 
assigned to any Defined Function.

Single Commands

To create a single command key sequence:
o	 Click the Menus, Tools or Miscellaneous pop-up to choose an item.
o	 The Get Command dialog appears; press the desired keys you want 

assigned to the selected item.  The keys must be pressed one at a time 
and held until all keys to be assigned are down.

Adding a Single 
Command

o	 The key assignment is displayed in the Keys list.
o	 Click OK.  The key assignment is complete and is remembered unless 

you change it.

You may add key stroke assignments to as many items as you wish before 
you leave the dialog box.  To use the assigned key command return to a 
drawing window and press the custom assigned key sequence.

Multiple Command 
Sequence

Multiple PowerCADD menu items can be sequenced together and assigned 
to a single custom key sequence.  A multiple command sequence can save 
significant time by taking a series of repetitive tasks in a workflow and 
linking them into one step.
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To create a multiple command key sequence:
o	 Click Create, the Multiple Command dialog options appears.

Create Multiple 
Command Sequence

o	 Click the Menus pop-up to choose a menu item to be included in the 
multiple command sequence.

o	 Continue to choose Menu, Tools or Misc. items from their respective 
pop-up menus.  Each new item is added sequentially to the list.

o	 Click OK; the Get Command dialog appears.
o	 Press the desired keys you want assigned to the command sequence.  

The keys must be pressed one at a time and held until all keys to be 
assigned are down.

o	 The key assignment is displayed in the Keys list.
o	 Click OK.  The key assignment is complete and is remembered unless 

you change it.

You may create additional multiple command key sequences and key stroke 
assignments to as many items as you wish before you leave the dialog box.  
To use the multiple command sequence, return to a drawing window and 
press the custom assigned key sequence.

TIP: We recommend tools included in multiple command key sequences 
be the last item in the sequence. 💡💡

Change Order or Delete 
an Item in a Multiple 
Command Sequence

To change the order or delete an item in a Multiple Command 
Sequence:
o	 Select the item name in the Multiple Command Dialog.
o	 Click the Up Arrow icon to move the item up the list.  Click the Down 

Arrow icon to move the item down the list
o	 Click the Trash Can icon to delete an item from the sequence.
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To edit an existing multiple command key sequence:
o	 Select the Multiple Command Sequence from the Active Commands 

list.  Multiple commands are always displayed at the top of the list.
o	 Click the Edit button; the Multiple Command dialog appears.
o	 Click the the Up Arrow icon to move the item up the list.  Press the  

Down Arrow icon to move the item down the list.
o	 Click the Trash Can icon to delete an item from the sequence.
o	 Click OK to save the changes and return to the Commands dialog.
o	 Click OK to return to the drawing window. 

Editing a Multiple 
Command Sequence

Deleting 
Command Keys

To delete a single or multiple command key sequence:
o	 Select the item from the Active Commands List.
o	 Select the key commands in the Keys list.
o	 Click the Delete (-) icon.
o	 Click OK.  The key assignment is deleted from the list.

If multiple key commands have been assigned to an Active Command, 
all the key sequences must be deleted to remove the item from the Active 
Command list.  To see the change, you must open and close the Preferences 
dialog.

To add an additional command key sequence to an existing item in 
the Active Commands list:
o	 Select the item from the Active Commands List.
o	 Click the Add (+) icon; the Get Command dialog appears.
o	 Press the desired keys you want assigned to the command sequence.  

The keys must be pressed one at a time and held until all keys to be 
assigned are down.

o	 Click OK to return to the drawing window. 

NOTE: To set an F-key like F1 through F15 which appear across the top 
of most keyboards, press the F-key itself as opposed to the letter F and then 
the number.

CAUTION: When choosing key commands for PowerCADD you should 
also consider which custom key commands are assigned as global keyboard 
shortcuts in MacOS.  For example F1 is typically assigned to Exposé.

If you find the commands you have set are not as you had expected or 
if you need to return to the original command key settings, open the 
PowerCADD Preferences Folder located inside the User Library Folder in 
MacOS.  Locate and throw away the PowerCADD Commands file.  The 
next time PowerCADD is opened, a new Commands file will be created.

If you wish to view or print a list of the current command key defaults, open 

Adding Command 
Keys

💡💡

⚠
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the PowerCADD Key Defaults file located in the PowerCADD Preferences 
folder.  This document can be opened by word processing packages.  The 
document will give you an alphabetized list of the functions and their 
associated key sequences.  PowerCADD will update this file each time a 
change is made, therefore the listing is always current. 

Seeing and 
Printing the List of 

Command Keys

The PowerCADD Key Defaults file contains all the PowerCADD standard 
key commands and your custom key command are saved in a single file 
which may be opened and printed for reference.  The PowerCADD Key 
Defaults file is updated each time it is changed so the listing is always 
current.

To see or print the PowerCADD Key Defaults file:
o	 Navigate to the following folder: User/Library/Preferences/

PowerCADD (which may be hidden)
o	 Select the file named PowerCADD Key Defaults and drag it onto the 

application icon of any word processing application.  For example: 
drag the icon onto the Text Edit application icon in the Applications 
folder or in the Dock.

o	 The PowerCADD Key Defaults file will open.

Backing Up Custom 
Command Keys

It is likely that over time you will create various customized command key 
sequences to suit your particular workflow.  To make backup of the custom 
command keys simply make a copy of the PowerCADD Key Defaults file 
to another location on your hard drive or to other backup media.  If you 
are using the MacOS Time Machine, the Key Defaults file will be included 
with that backup by default.  Restoring a lost or damaged Key Defaults 
file is as simple as quitting PowerCADD, locating the backup copy of the 
Key Defaults file and copying it back to the User/Library/Preferences/
PowerCADD folder which may be hidden.
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The Tools preferences tab allows you to set the general behavior of the 
drawing tools.

Tools Preferences

Tool Click allows you to specify what type of mouse action you like when 
using the drawing tools.  Choose the tool click style that works best for you.

Click-Click: Requires two mouse clicks to draw an object.  You do not have 
to keep the mouse button pressed when drawing an object.

To draw using the click-click method: 
o	 Pick a drawing tool from the tool palette, for example the Line tool. 
o	 Click where you want to start the line.  The line follows you as you 

drag.
o	 Drag the mouse to specify the length of the line.
o	 Click where you want the line to end.

Click-Drag: Drawing with a click and drag operation requires a single 
mouse click and is much like drawing with a pen on a piece of paper.

To draw using the click-drag method: 
o	 Pick a drawing tool from the tool palette, for example the Line tool.
o	 Click where you want to start the line.
o	 Drag the mouse to specify the length of the line.
o	 Release the mouse where you want the line to end. 

Hybrid Click-Click is the default setting allows you to draw with either a 
click-click or click-drag method with any tool. 

Drag Distance allows you specify a distance in pixels you have to drag 
when using hybrid-click before the tool provides visual feedback.  For 
example, a drag distance setting of 72 would require dragging with the line 
tool approximately one inch before you started to see a preview of the line. 

Tool Click

Anchor
[ToolPreferences]
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A value of two pixels (the default) means dragging only a short distance will 
begin to show the object’s preview.

Quick Click allows you to specify the speed of a mouse click 
PowerCADD will use when working with tools.  Dragging the slider 
bar to Faster tells PowerCADD to consider a fast mouse click as a valid 
operation.  Dragging the slider bar to Slower tells PowerCADD to only 
consider slower mouse clicks as valid operations.  For example, with the 
slider set to Slower and the Text tool chosen, a fast mouse click inside of 
an existing text block will have no effect.  To edit the text block, either 
set the Quick Click slider to faster or click the mouse slower (a longer 
pause) when clicking inside the text block.

Mouse Wheel Options Mouse Wheel Options allows you to customize the behavior of a mouse 
scroll wheel or the touch pad.  If you are using a touch pad on a laptop 
please reference the MacOS help files for information on how to set up 
System Preferences, Trackpad Gestures.

Scroll: When enabled, a mouse scroll wheel or touch pad will scroll the 
drawing or overview windows. 

Zoom: When enabled, a mouse scroll wheel or touch pad will zoom in or 
out of the drawing or overview windows.  The zoom in or out behavior can 
be changed by choosing Invert or adjusting the Acceleration slider.

Invert: When unchecked, rolling a scroll wheel forward will zoom in, rolling 
a scroll wheel backward will zoom out.  When checked the behavior is 
reversed: rolling a scroll wheel forward will zoom out and rolling backward 
will zoom in.  The settings behave the same if you are using a touch pad on 
a laptop.

Acceleration: The acceleration slider allows you to adjust how fast the zoom 
in and zoom out occurs when mouse scroll wheel zooming is enabled.  The 
degree of control this slider provides will vary with the type of mouse and 
any MacOS system level drivers installed.

You can choose to have the Selection Arrow tool behave two 
fundamentally different ways.
o	 Select Touching will pick all objects which touch a selection marquee.
o	 Select Enclosing will pick only those objects which are entirely inside 

the selection marquee.  You can also temporarily switch on the fly 
between the two selection modes by pressing the Command key when 
dragging with the Selection Arrow tool.  See the Tools section of this 
manual for more information.

Selection Tools

Anchor
[AccelerationSlider]
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Palette Size allows you specify the size of PowerCADD tool palettes. Select 
Small to display all tool palettes at approximately 30 pixels wide. Select 
Large to display all tool palettes at approximately 45 pixels wide.

Tools Deactivate allows you to specify what should happen after you’ve 
used a drawing tool. 

Tool Deactivate not checked:
o	 After you draw an object, the tool remains active allowing you to draw 

another object with the same tool.  The tool remains active until you 
select a different tool or Shift-click on the screen (See Tools Fall Out on 
Shift Click below for more information).

Tools Deactivate checked:
o	 After you draw an object, the tool automatically deactivates and the 

Arrow Selection tool is activated.

Enable Tool Tips displays the name of a tool when you hold the mouse 
over its icon in the tool palette.

Show All Tools displays all the tools in the palette when you select any tool. 
When unchecked only a tool’s row is displayed when you select a tool.

Tools Fall Out on Shift Click will allow you to press Shift key and click the 
mouse to cause a tool to fall out and the Arrow Selection tool to activate. 

Long Crosshair allows you to turn the long crosshair On or Off.  The 
crosshair is a gray line running the entire length and width of the drawing 
window and can be useful when you must align an object with another that 
is not adjacent.

Snap Crosshair works in conjunction with the Long Crosshair in the Tools 
tab.  With snap crosshair checked On, the crosshair will move in response 
to snap commands.

Snap Distance is the distance in pixels in which an automatic snap will take 
place when your mouse is near a basic snap point.

Palette Size

Tools Deactivate

Enable Tool Tips

Show All Tools

Tools Fall Out on 
Shift Click

Long Crosshair

Snap Crosshair

Snap Distance
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The Loader preferences tab allows you to specify which PowerCADD 
Externals should load.

Loader Preferences

A checkmark precedes the names and version numbers of all currently loaded 
(active) Externals.  All of the Externals can be activated or deactivated by 
clicking Select All or Select None respectively.  To return to the status they 
had before the dialog appeared, click Revert.

NOTE: Choose Quit from the File menu and launch PowerCADD again 
for the changes made in Loader to take effect.

To turn an external on or off, select the checkmark next to the external’s 
name.  After you’ve specified which externals you want on and off, you can 
save those settings as Group.  

To make a custom external Group: 
o	 Click on the Groups pop-up menu. 
o	 Choose New Group. 
o	 Name the group and click OK

To load a saved External Group simply choose it from the Groups pop-up 
list.  You will need to quit then relaunch PowerCADD to load that group 
of externals.  The default groups (PowerCADD, Architectural, Engineering, 
Translators, Drawing, Modifying, Other) cannot be edited or deleted from 
the list.  

To Delete a custom external Group choose the Delete Group menu item, 
select the group name and press Delete.  

If you have installed third party PowerCADD Externals, choose 
PowerCADD to see only the standard PowerCADD suite of tools and 
menu options.

💬💬

Anchor
[LoaderPreferences]
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Services is an Apple menu item.  All items listed in the Services menu and 
submenus pertain to Apple MacOS level features and are unavailable when 
in PowerCADD.

Services

Hide PowerCADD

Hide Others

Show All

Quit PowerCADD

Hide PowerCADD will hide all PowerCADD drawing windows, tool 
palettes and floating windows.  The application and drawings are still 
running but are hidden from view.  To bring the PowerCADD windows 
back, click on the PowerCADD icon in the Dock or choose Show All from 
any other application menu.

Hide Others is an Apple menu item.  Choosing Hide Others will hide 
windows and palettes associated with all other applications currently 
running in MacOS except PowerCADD.

Show All is an Apple menu item. Choosing Show All will show all windows 
and palettes associated with all applications currently running in MacOS. If 
another application was hidden it will be come visible.

Quit PowerCADD leaves the current drawing and closes PowerCADD.

To quit PowerCADD and the current drawing:
o	 Choose Quit PowerCADD from the PowerCADD menu. 
o	 If you have not saved the current drawing, you will be asked to do so 

before proceeding to Quit.

If you have multiple drawings open which have changed, a warning dialog 
will open listing the number of open documents and request the next course 
of action.

Will close all open drawings without saving any changes. All changes made 
to a drawing since it was last saves are lost.

Will abort the Quit operation and return you to the drawing session.

Will allow you to review each drawing and confirm whether changes should 
be saved or ignored.

Discard Changes

Cancel

Review Changes

Anchor
[QuitPowerCADD]
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The File menu consists of PowerCADD commands for working with a 
drawing file as a whole as compared to other menus which allow you to 
work with specific objects in a drawing.

File Menu

New

Using Stationery

Opening Stationery

New creates an original, unused PowerCADD document from either a 
customized Default Stationery pad or a default untitled document.

To create a new document:
o	 From the File menu choose New.
o	 A default untitled document is opened to being drawing in.

Using Stationery allows you to choose a custom start-up document when 
choosing New from the File menu.  Think of a stationery drawing as a 
template to quickly get you started.  The stationery drawing may contain 
common drawing elements such as sheet size, a drawing title block and 
other common attributes such as line weights, colors or drawing scales. 

To open a custom stationery pad:
o	 Add a PowerCADD drawing to the Stationery folder as described later 

in this section.
o	 Choose New from the File menu or press Command-N and the New 

Document dialog will open.
o	 Select the desired stationery file from the Name list and press Choose 

or double-click on the file name in the list.
o	 A copy of the selected stationery file opens to begin drawing in.

NOTE: Pressing the Option key and choosing New from the File menu will 
temporarily override stationery choices in the New Document dialog and 
open a default untitled document (*Blank as shown in the New Document 
window).

💬💬
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Click  the help button to read additional information about this dialog.

The body of the window displays a list of available files in the Stationery 
folder specifying the Kind of document, the document Name, the Date 
Modified, and the documents Size.  To resize columns, click and drag the 
line dividing the column heading names.  To change the position of the 
columns press Option and drag the column name.  Clicking a column 
name will sort the list based on that column; click on the same column 
name to switch the sort between ascending and descending order. 

NOTE: If there is only one item in the Stationery folder, that file will open, 
and if there are no items in the Stationery folder choosing New from the 
File menu will open the default blank, 8.5x11 inch untitled document.

Open an Existing File…: Click to display a standard MacOS Open dialog 
and open an existing file.

Close: Click this button to close the dialog and not open a stationery 
drawing.

Choose: This button will be activated when a stationery drawing is selected 
in the list.  Click Choose or double-click a file name to open it.

Open New 
Document Dialog

💬💬
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Custom stationery files are saved in the PowerCADD Application folder, 
Stationery folder.

To create a custom stationery pad and have it appear in the New 
Document dialog:
o	 Start with any PowerCADD drawing that contains the standard sheet 

size, layers, line weights, colors and objects you would like to use at the 
start of every drawing.

o	 Save and close the drawing. 
o	 In the Finder, move the PowerCADD drawing file you want added 

to the New Document list into the PowerCADD Application folder, 
Stationery folder. 

o	 The next time you choose New from the File menu the file will appear 
in the New Document dialog.

To remove a stationery drawing from the New Document simply remove 
the document from the PowerCADD application folder, Stationery folder.   
The Blank file is a generic Untitled document and cannot be removed 
from the list.  The Stationery folder may contain PowerCADD documents, 
PowerCADD Symbol Libraries, or any other type of file PowerCADD can 
open.  Changes made to the Stationery folder are immediate, you do not 
need to quit and relaunch PowerCADD to see the change.

If you are in a network environment and want to keep your stationery 
drawings on a network server or networked hard drive, use an alias (pointer) 
to the file.  For example, to use a file on your network server, connect to the 
share point and make an alias of the file into your local PowerCADD folder, 
Stationery Folder.

CAUTION: Use extreme caution when working with stationery which is 
stored on a server.  An existing stationery open file can be overwritten, that 
is, a stationery file can replace an existing stationery file of the same name.  
To be safe, always make a backup of your stationery in locations other than 
the server.

Adding Stationery

Working with Stationery 
in a Networked 
Environment

⚠❗❗
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New Library creates an original unused library suitable for storing symbols.New Library

Symbol Library A Symbol Library will allow you to create frequently used objects and save 
them in a library format for later use.  The symbols you paste in a library are 
available anytime you are using PowerCADD.  Once the symbol is created 
and pasted in a library you will never have to draw the object again; all you 
need to do is open the library, choose a symbol and insert it into your drawing.

To create a Symbol Library:
o	 Create an object on the screen using standard PowerCADD methods.
o	 Select the items you wish to save as a symbol.
o	 Choose Copy from the Edit menu.
o	 Choose New Library from the File menu and a new Symbol Library 

will open. 
o	 Choose Paste from the Edit menu and the items you selected in the 

drawing area will be grouped and displayed in the right-hand field of 
the window.

o	 A name has been given to the symbol which is highlighted in the left-
hand side of the window.  To rename the symbol, type in a new name 
while both fields are still highlighted and click the Rename button.  
The name you entered will be assigned to that symbol.

o	 While the Symbol Library window is active, choose Save from the File 
menu.  Choose PowerCADD 9 Symbols from the Format pop-out as 
the following dialog shows:

o	 Enter the name of the new library and click Save.  The library has now 
been saved as a file that may be recalled later.

o	 Click in any portion of the drawing window that is visible to return to 
the drawing area.

o	 Create another symbol and select all items that pertain to the symbol.
o	 Choose Copy from the Edit menu.
o	 To bring the open library window to the front, choose the name you 

assigned to the new library from the Window’s menu.  The library 
window will be brought to the front, and you may paste in the second 
symbol as described above.

You may place as many symbols in the Symbol Library as you wish. The 
larger the library becomes, the more memory it takes to open it. 

Anchor
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To Delete a symbol from a Symbol Library:
o	 With the Symbol Library window active, select the symbol you wish 

to delete.
o	 Choose Cut or Clear from the Edit menu.  A warning message will 

appear.
o	 Click OK and the symbol will be deleted.

NOTE: If the symbol to be deleted is part of another symbol, creating a 
nested symbol, it cannot be deleted.  The original (nested) symbol must be 
deleted first.

NOTE: If the objects you copy reside on two or more different layers, 
which have different layer scales, the objects will be pasted into the library 
according to the current Drawing Scale.  A message will display letting you 
know the objects are at a different scale.  If all objects selected have the same 
scale, the objects will pasted into the library at their scale.  If the active layer 
has a Layer Scale set and all objects are on that layer, the symbol will be 
inserted into the library at the layer’s scale.

For more information on Layer Scale, see Layers.

Deleting Symbols

💬💬

💬💬
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An alternative method of placing symbols is with the Symbol palette.  Since 
it is an External, it must be loaded in order for it to appear.  The Symbol 
palette displays your library as a row of thumbnail views of your symbols 
as illustrated.

For more information on Symbol Palette, see Symbol Tool in the Tool 
chapter.

To recall a symbol from a Symbols Library:
o	 Choose Open from the File menu and a dialog will appear:

Symbol Palette

o	 Locate and select the desired library.  From the Enable pop-up menu, 
choose the type of PowerCADD Symbol Library you would like to 
open.  If you are not sure what version of PowerCADD was used to 
create the symbol library, choose All Readable Files.  Click Open (or 
double-click on the library name.)

o	 The Symbols Library window will appear with the first symbol selected.
o	 Select the correct symbol by using the scroll bar and clicking on the 

name or use the Find option.
o	 Once the correct symbol is visible in the right-hand box click on an 

exposed section of the drawing window to return to the drawing area. 
o	 Select the Symbol tool from the Tool Palette. 
o	 Place the cursor in the general location you wish to place the symbol 

and click.  The symbol will be placed in the drawing according to its 
reference point.

o	 You may continue to place additional symbols in the drawing by simply 
clicking in the correct location.  Every symbol placed will be the same 
until you bring the Symbol Library window to the front and change 
the symbol that is showing in the right-hand field.

Anchor
[SymbolPalette]

!



Menus249

When several items are selected in a drawing and pasted in the library 
as a symbol, the items are automatically grouped.  The symbol may be 
ungrouped after being placed in the drawing to allow for modification.

Symbols are inserted in the drawing by the symbol’s center.  A reference 
point may be used as the symbol insertion point.  For example, each time 
you create a symbol, place a Reference Point at a strategic location in the 
symbol.  If the Reference Point is the last item created in the symbol, the 
point in the symbol will correspond the insertion point.  The Reference 
Point will show on the screen, but it will not plot or print. 

The symbol is inserted with a click or a press and drag action.  A symbol will 
show a ghost rectangle while being placed. Holding the Option key while 
placing allows you to see all of the objects in the symbol.

For more information on working with symbols, points and flipping or 
rotating symbols see Tool chapter, Point Tool and Symbol Tool.

Open presents you with a dialog allowing you to retrieve documents in 
other formats, depending upon which Externals are in the Plugins folder.

To open previously created and saved PowerCADD documents:
o	 From the File menu choose Open.
o	 A dialog will appear.

Open...

o	 Double-click on a file to open it or click once on the file and click 
Open.

!
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Legacy PowerCADD drawings and symbol libraries are automatically 
upgraded to the most current PowerCADD file format when opened.

To open legacy PowerCADD documents or symbol libraries:
o	 Open the file as described above in this section.  The following dialog 

will appear:

Legacy PowerCADD 
Drawings and Symbol 

Libraries

o	 Click Cancel to abort the operation.  The legacy file is not opened.
o	 Click OK and the file is opened and a copy of the legacy file is automatically 

saved in the same location as the original legacy drawing or symbol library.  
There is no need to choose save.  You can just close all windows.

PowerCADD 9 files and PowerCADD 9 Symbols are the normal method 
of storing drawings for subsequent use within PowerCADD.  Library 
files are Symbol Libraries which can be opened in the drawing to add 
previously created symbols.  You may also open documents and libraries 
created from older versions of PowerCADD or PowerDraw by selecting the 
corresponding file type from the list.

PDF documents (*.pdf ) are files created in Adobe Acrobat PDF format.  By 
default, the content of a PDF file cannot be edited.  To convert a PDF for 
editing, choose PDF To Objects from the Tool menu.

EPSF files (*.eps) are Encapsulated Postscript Files created by many desktop 
publishing and illustration applications.  By default, the content of an EPSF 
document cannot be edited.  To convert an EPSF file for editing, choose 
PDF To Objects from the Tool Menu.

Postscript (*.ps) is a page description language commonly used for printing 
high quality text and graphics.  Postscript files which are saved (as opposed 
to sending to a physical printer) can be opened but by default cannot be 
edited.  To convert a Postscript file after opening it, choose PDF To Objects 
from the Tool menu.

The Alpha Channel (transparency) of bitmap images imported is retained.  
Imported PDF (*.pdf ), EPSF (*.eps), illustrator (*.ai) or Postscript (*.ps) 
files may be converted to objects for subsequent editing.

Bitmap Image files (*.bmp, *.pict, *.jpg, *.tif, *.psd, etc.) are raster (pixel 
based) image files created by various image editing applications.

❤ 👍👍 !
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PICT Vectors (*.pict or *.pct) files are generally restricted to screen 
resolution and represent a somewhat universal method for transferring data 
between most drawing programs and other applications.

If you have QuickTime installed and have the Graphics Export External 
loaded, you can also open the following raster file formats: SGI, PhotoShop, 
BMP, JPEG, PICT Bitmap, PNG, MacPaint, TIFF, TGA, JP2 and 
QuickTime Image format.

DXF, dwg and the other translating options are Externals included with 
PowerCADD designed to open those specific file types.  These Externals 
must be checked in Preferences, Loader for them to be available for use.

Network Servers If your files are saved and opened from a network server, open and saving 
performance will vary with your network configuration. See your local 
network administrator for particular procedures regarding working with 
files across the network or stored on your network server.

Open Recent Open Recent lists the last files which have been opened and saved by 
PowerCADD.

To open a recently saved file which has been closed:
o	 Choose Open Recent from the File menu.
o	 Select the file name from the list.

To clear the list of recently opened items:
o	 Choose Open Recent from the File Menu.
o	 Choose Clear Menu from the Open Recent submenu.

Clearing All 
Recent Items

To clear selected items from the list of recently opened items:
o	 Choose Open Recent from the File Menu.
o	 Choose Clear Selected… from the Open Recent submenu.  The Clear 

Selected dialog will appear.
o	 Select the file name(s) to be deleted and click Delete.  To delete 

consecutive files, Shift-click on the file names.  To delete non-
consecutive files, Command-click on the file names.

o	 Click OK to close the dialog box.
o	 The selected file names are removed from the list of recent files.

Deleting items from the list cannot be undone. To add an item back into 
the list of recent files open and save the file. 

Clearing Selected 
Recent Items

Anchor
[NetworkServers]
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Import allows you to import a variety of file formats into an existing 
drawing.

File formats available for import include all the file types listed in the Open 
command with the exception of Symbol Libraries.

To import a file into a drawing: 
o	 Open an existing drawing or make a new PowerCADD drawing. 
o	 Choose Import from the File Menu. 
o	 The Import dialog box will open. Navigate to the file to be imported.
o	 Double-click on the file to be imported or click on the file name and 

click Open.
o	 The selected file is imported into the drawing.

The type of editing you can perform on the imported file will depend on the 
type of file.  For example, an imported PowerCADD or .dwg file will have 
objects which may be edited.  

An imported PDF or QuickTime Raster formats such as JPEG may only 
be cropped or rotated.  Bitmap effects may be applied to imported raster 
images by first using the Objects to Bitmap command in the Tool menu.

When Importing .dwg, .dxf or PowerCADD files which contained 
information on multiple layers, all data on visible and invisible (hidden) 
layers is imported into the current active drawing layer.

The Alpha Channel (transparency) of bitmap images imported is retained. 
Imported PDF (*.pdf ), EPSF (*.eps), illustrator (*.ai) or Postscript (*.ps) 
files may be converted to objects for subsequent editing.

Import

💬💬
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Export allows you to save a drawing, or portions of the drawing in a variety 
of QuickTime raster file formats or generate reports for data in a drawing.

To use Export:
o	 Choose Export from the File Menu and the following dialog will 

appear:

Export

o	 In the Save As field type a name for your file.  As a default, the word 
‘Export’ is automatically appended to the name.

o	 Click on the Format pop-up menu to choose a file format.  The correct 
suffix for the file format is automatically appended to the file name.

o	 From the Where pop-up specify the location you’d like to save your 
file.

o	 If you’d like to set optional settings click Options, otherwise click Save. 

	 If the Options button is dimmed then no options are available for the 
selected export format. 

o	 The export operation is completed, and you are returned to the active 
drawing window.
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Drawing Area settings allow you to specify how much of a drawing is 
exported.

All Objects will export every visible object including objects off the drawing 
page except point objects.

Selected Objects will export all visible objects which fall within the 
bounding box of the selected object or objects.  For example, with one 
rectangle selected, all visible objects which are inside the selected rectangle 
are exported.  This method is an excellent way to export only a portion of a 
drawing for use on a web page, emailing or use in a report.

Drawing Page will export all visible objects which fall on the white drawing 
area. 

Dimensions are listed detailing the size of the drawing area being exported. 
Dimension units are as specified in Drawing Setup, Units.  For example, if 
the drawing is setup for millimeters the dimensions are listed in centimeters.  
If the drawing setup is for feet and inches the dimensions are listed in 
decimal inches.  Reviewing the dimensions is an excellent method to cross 
check just how large the area is you are exporting.

Exporting Raster 
File Formats

The Graphic Export External must be loaded in order to export a drawing 
or portions of a drawing, in a raster file format.  Some raster file formats 
are linked to Apple’s QuickTime software on your computer.  If some of 
the raster file formats shown here do not appear in your list then visit Apple 
Computers website to learn more about installing any required updates to 
QuickTime.

The raster file formats have several optional settings providing additional 
control over the file size, resolution, and quality of the exported file.   
Optional settings are remembered until you change them.  To access 
optional settings, click Options in the Export dialog box and the following 
dialog will appear:
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Image Size settings allow you to specify how many pixels are exported 
which affects the images physical dimensions and file size.

Width is expressed in pixels matching the width of the exported area. 
Changing the width value will automatically update the Height and 
Resolution fields to maintain the correct aspect ratio.  Not all export formats 
support changing this value.

Height is expressed in pixels matching the height of the exported area. 
Changing the height value will automatically update the Width and 
Resolution fields to maintain the correct aspect ratio. Not all export formats 
support changing this value.

Resolution is expressed in Dots Per Inch.  Changing the Resolution value 
will automatically update the Height and Width fields to maintain the 
correct aspect ratio.  A value of 72 DPI will export the image at 1:1 (e.g. 
an 8.5 x 11 page will be 8.5 x 11 inches).  A value of 144 DPI will export 
the image twice as large and there will be twice as many pixels.  A value of 
36 DPI will export half the size with half as many pixels.  Not all export 
formats support changing this value. 

Estimated Memory will display the estimated memory required to export 
the file based on the Resolution, Height and Width Settings.  If you have 
insufficient memory, the entire file may not be written or the file may not 
open correctly.  It is always a good idea to preview the Estimated Memory 
to gain a sense of how large the file will be when exported and saved to disk.  
This can be particularly important if you are exporting graphics for web or 
email or other situations where large file sizes may not be practical.

The Advanced Settings button provides access to additional settings which 
are unique to each export format.  Options include changing the bit depth 
or amount and type of compression applied to the exported image.
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PowerCADD provides various methods to add text based descriptions to 
individual objects, grouped objects, or symbols in a drawing using Symbol 
Tags.  Think of these descriptions as special data tags you might assign to 
objects to generate cost estimate, bills of materials, quantity take-offs or 
perhaps even use for facility management purposes.  Once the data tags 
have been assigned you can use Export to generate a plain text file report 
which can be opened in other applications to complete your value added 
analysis.

It may be helpful to think of PowerCADD as a graphical front end to a 
database.  It is often faster, easier and in some cases more accurate to make 
changes graphically, then export a report and import that data into your 
spread sheet or other third party application.  If you use standard templates 
on various projects, it is even possible to have graphs or other detailed 
calculations automatically update when you import an updated report.

All this is obsolete?

Exporting Drawing 
Formats

Exporting Symbol 
Reports

Symbol Report creates a text file listing all symbols or groups in a drawing.  
The report includes a count of the objects, their name, and up to five 
additional text fields.  The Set Symbol Tags External must be loaded for this 
export option to be available.

The report lists items:
o	 Inserted as symbols from a Symbol Library
o	 Inserted as groups from a Symbol Library
o	 Normal groups in a drawing that have been assigned names or text 

attributes using the Set Symbol Tags command
o	 Items inserted from a Symbol Library as a group or symbol that had 

previously been assigned additional data tags using the Set Symbol 
Tags command 

The report heading consists of the title of the drawing and whether the 
reported items are from all layers or only visible layers.  Only items on 
visible layers are reported.

The remainder of the report is divided into two sections: Symbols and 
Groups. The group section lists items inserted from a Symbol Library as 
groups and groups that have been assigned names or additional Symbol 
Tags in the drawing. For each item, the name and number of occurrences 
is given.  Any information attached to instance symbols is also reported. 

To export a Symbol Report:
o	 Choose Export from the File menu.  The following dialog will appear:
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o	 Choose Symbol Report from the Format pop-up menu.
o	 Enter a name for the report and click Save. 

To access the optional settings:
o	 Choose Export from the file menu and click Options. 
o	 The Symbol Report Options dialog will appear.
o	 Checking Write Headers will write all data fields assigned with Set 

Symbol Tags and a description at the start of the report. 
o	 Click OK to close the dialog box.

These settings remain in effect until you change them.  Examine the 
examples below of reports with Write Headers checked and unchecked, 
then opened in Excel.

Symbol Reports 
Optional Settings

Write Headers 
Not Checked

Write Headers 
Checked

To export a symbol report for only selected objects in a drawing:
o	 Use any combination of selection techniques to the select the objects 

to be reported.
o	 Choose Export from the File menu.  Choose Symbol Report from the 

Format pop-up menu and click Save. 
o	 A confirmation dialog appears as pictured here. 

Exporting a Symbol Report 
for Only Selected Objects
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o	 Click OK to export a report for only the selected objects.  Click Save 
All to export a report for all visible layers in the drawing; the selected 
objects will be included in the report. Click Cancel to abort the export 
symbol report operation.

If no objects are selected all visible layers are automatically included in the 
exported report and the confirmation dialog will not appear.
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Place allows the placement of PICT, Encapsulated PostScript (EPSF), paint 
(bit image) files, Adobe PDF files and QuickTime supported file formats 
into PowerCADD drawings.  A placed graphic can be changed in a limited 
number of ways.

Place provides an efficient way to put various graphic files, including 
company logos, site plans, details, maps or digital photos into a drawing.

A placed graphic may be reduced to fit a standard sheet size and transferred 
into a word processing document while maintaining its high degree of 
accuracy.  Placed graphics are also useful for view-only projects, for which 
modifications are not desirable.

Placed graphics cannot be edited.  However, they can be scaled (resized), 
moved, printed, cropped, and rotated.  Scaling and moving are done with 
standard PowerCADD techniques.  To scale a graphic proportionally, press 
the Shift key while resizing or use the Scale command from the Edit menu.

While the Placed graphic cannot be edited, you may apply Bitmap effects 
by first using Convert to Bitmap from the Tool menu.  If the Placed object 
has been cropped, converting it to a bitmap makes the crop operation 
permanent.  New cropping and uncropping operations may be performed 
on the new bitmap.

Place has several major advantages including:
o	 Place saves memory.
o	 Place protects graphics from editing.

A placed PICT file uses about eight times less memory than an imported 
PICT file.  For instance, a one-megabyte file may occupy only 150K when 
placed.  Therefore, with Place, scanned images that could otherwise not be 
opened due to memory restrictions are accessible.

When a placed graphic is scaled, its text—not just the text location—is 
scaled also.  With this feature, an E-size drawing can be saved as PICT (??? 
obsolete???), placed, and scaled to fit an 8-1/2 x 11” sheet of paper.  Details 
can also be isolated, placed, and printed on a single sheet.

Since internal changes to a placed graphic are not possible, most accidental 
and unauthorized alterations are prevented.  Thus, Place can be used to 
create view-only documents.  You can also combine a series of pictures into 
a single document in order to view a project at various stages.

Place...

Anchor
[Place]
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To use Place:
o	 Choose Place from the File menu.  A dialog appears.

o	 Choose a PICT, Paint, EPSF, PDF or any QuickTime format file and 
click Open.  A cursor representing the upper-left corner of the graphic 
will appear.

o	 Move the cursor to the desired location and click.  The graphic appears.

EPSF files are often saved with a preview image, which is used to display 
the file on the screen.  For EPSF files that do not contain a preview image, 
a gray box represents the graphic on PowerCADD’s screen.  To view the 
graphic, print the drawing.
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Unlike scaling, cropping does not resize a graphic.  Instead, cropping trims 
the graphic.  When you crop a graphic, the entire graphic is retained.  The 
cropped portion can be restored at any time.

To crop a graphic:
o	 Select the graphic. 
o	 Press the Command key, place the cursor on an edit handle, and the 

Crop cursor appears.
o	 Drag to start.  A ghost rectangle appears and a preview of the cropping 

operation is shown.
o	 Drag the corner of the rectangle to crop the picture.  When you 

release the mouse button, the graphic is cropped along the edges of 
the rectangle.

To restore a cropped portion (uncrop), hold the Command key and drag 
a corner of the rectangle until the rectangle is large enough to include the 
cropped portion.

TIP: Cropping is constrained to maintain the original aspect ratio of the 
image.  To unconstrain the operation, press Shift-Command while dragging 
a corner handlebar of the selected object.  To crop an object about a mid-
point handle bar, press Shift-Command. 

TIP:  The Alpha Channel (transparency) of bitmap images is retained when 
using Place to insert bitmap images.  Placing PDF (*.pdf ), EPSF (*.eps), 
illustrator (*.ai) or Postscript (*.ps) files may be converted to objects for 
subsequent editing using PDF to Objects from the Tool menu.

TIP: You can also crop bitmap objects using the same technique as described 
for Placed objects.

Cropping

💡💡

💡💡

💡💡
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Close shuts the current window.

To close a PowerCADD document:
o	 Choose Close from the File menu, or press Command-W, or click the 

drawing close button in the top left corner.
o	 If you have not saved the current file immediately before closing, a 

dialog will appear asking if you would like to save before closing.  The 
file is saved to the same location from which it was opened.

o	 If the file had been previously saved, pressing the Return key or clicking 
Save will save the file and close it.  If this was a new document, pressing 
the Return key or clicking Save will open a dialog prompting you to 
name the file and specify a location prior to saving.

Close

Formats for saving depend upon which Externals are checked in Preferences, 
Loader.  The standard formats include PowerCADD 8 and PowerCADD 9.
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Save stores the current PowerCADD file to a specified disk under the most 
recently designated file name. 

After a document is saved, the current drawing is left open for further use.

To Save a PowerCADD file to the file folder from which the document 
was opened:
o	 Choose Save from the File menu.

NOTE: PowerCADD will prompt you periodically to remind you to save 
the current drawing.  Save is not automatic, and you will have to respond 
Yes or No by selecting the appropriate buttons.

TIP: PowerCADD 9 files are saved with a Preview which may be viewed 
in the MacOS Finder using Quick Look.  The preview presented in Quick 
Look is the last saved state of your PowerCADD 9 drawing.  Legacy 
PowerCADD drawings will need to be opened and saved as PowerCADD 
9 to take advantage of Quick Look.  For more information on using Quick 
Look see Apple’s help and support files included in MacOS.

Save

💬💬

💡💡

Save As...

Revert

Save As allows you to store the current PowerCADD document under a 
new file name, or in a different file format.

To save a current drawing under a different file name.
o	 Choose Save As from the File menu.
o	 Choose the file format in which you wish to save.
o	 Name your document and click Save.

You may choose any file format available from the list.  Choose PowerCADD 
9 to create a file which may be read only by PowerCADD 9.  Choose 
PowerCADD 8 to create a file which may be read only by PowerCADD 
version 7 and version 8.  Versions of PowerCADD older than version 7 
cannot open PowerCADD v7 or v8 files.

For more information on .dwg and .dxf files, see DXF & DWG Translators.

Revert removes the current drawing and replaces it with the drawing last 
saved under the same file name.

To Revert to the last saved drawing under the current file name:
o	 Choose Revert from the File menu. 

When Revert is used, all undos are cleared.

Anchor
[Save]

Anchor
[Revert]!
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Page Setup sets the printing parameters.

To use the Page Setup options:
o	 From the File menu choose Page Setup.  The following dialog will appear:

Page Setup...

Settings allows you to pick from Page Attributes (shown above), custom 
sheet sizes or displays a summary of your page settings.

Format for allows you to specify the type of printer you want to use.  Each 
printer has unique features including color or different sheet sizes or ink 
adjustment settings.

Paper Size lets you pick from various sheets sizes based on the type printer 
picked in the Format for pop-up.

Orientation allows you to set the page to be portrait (vertical) or landscape (horizontal).

Scale allows you to specify a percentage to enlarge or reduce the printed 
output.  A value of 100% is considered ‘normal’ or 1:1 printing and typically 
used to print your drawings at the scale specified in Drawing Setup, Units.

The first time you choose Page Setup and click OK, the Drawing Setup Size 
dialog box will appear allowing you to set various options.  PowerCADD 
supports page sizes up to 200 x 200 inches and provides a preview of your 
drawing in the Drawing Setup Size dialog. 

For more information on Drawing Setup, Drawing Size and Print options 
see Layout Menu.  For more information on choosing page sizes and 
working with margin or tiled sheets of paper, see How to Get Started in the 
PowerCADD Tutorial.

Anchor
[PageSetup]

!
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Print sends drawing file information to output devices like ink jet or laser 
printers or may be used with features native in MacOS to send a fax or save 
an Adobe Acrobat PDF formatted file.

You may print the active drawing at normal size or print to fit your printer’s 
current page size. 

To use the Print command:
o	 Once you have established the page setup parameters, choose Print 

from the File menu.  Choose PowerCADD Settings from the pop-up 
menu and the PowerCADD options will appear:

Print...

Printer lets you select the printer to use.  The printer selected here should 
match the printer you selected in Page Setup.

Presets let you save and select from preset printing setups which can 
include a variety of variables including color ink settings and sheet sizes. 
PowerCADD specific print settings are not saved with presets.

The Optional Settings pop-up allows you to specify various optional settings 
which vary with the printer you have selected. With the latest MacOS, the 
PowerCADD Optional Settings are displayed automatically when choosing 
Print.

Save Settings for Standard. When checked, choices set for Print Area, Print To, 
Fit to Page, Print Time Stamp, print Points, and Gray Pen Pattern for Dimmed or 
Transparent Layers will be remembered and applied each time you choose Print.

PowerCADD Optional 
Settings

Anchor
[Print]
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Normal will print normally; all visible objects in the drawing are printed. 
This is the default setting for each printing session.

Selection will print selected items.  This setting is off by default but is 
remembered between printing sessions.  Details of Print Selection are 
described later in this section.

Window will print the area of a drawing displayed in the active drawing 
window.  To print a drawing window, adjust the desired view by zooming, 
scrolling, and resizing the drawing window or use a preset view.  When 
your window is set, choose Print and click Window.  This setting may also 
be used in conjunction with Fit to Page and Print To setting options.  This 
setting is off by default and is not remembered between printing sessions.

Print Partial Pages when selected will print all pages of your document 
even if there is only a sliver on a page.

NOTE: When printing a window to fit, the current orientation of the 
drawing and the shape of the window you specify will affect how much 
of the printed page is used. For example, if your drawing is landscape and 
the windowed area you set is a little taller than it is wide, the printed result 
will be smaller than if the current orientation was portrait. To optimize the 
printed page, temporarily set the orientation (Page Setup in the File menu) 
of the drawing according to the shape of the window you have set.

NOTE: The Fit and Window checkboxes will return to their inactive 
settings and Normal will be selected by default when the print session is 
complete.

Print Area

💬💬

💬💬
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The Print To settings affect the position of items on the printed page.  The 
selected Print To setting is remembered between print sessions and affects 
all documents. Center of Printable Area and Center of Paper are particularly 
useful when using Print Selection, Print Window or Fit to Page optional 
settings.

Default will print objects based on the default margins and positioning as 
defined by the selected print driver.  When selected in conjunction with Fit 
to Page, Print Window or Print Select, the top left corner of the drawing 
window is the anchor point for the printed items.  This setting is on by 
default and is remembered between printing sessions.

Center of Printable Area prints objects in the center of the printable area 
as defined by the page margins.  For example, if an 8.5 x 11 inch page has 
margins of 1 inch left, right and bottom but 3 inches top, the center of the 
printable area is not equal to the center of the paper because of the larger 
top margin.  Objects will be printed relative to the center of the printable 
area and may appear off center relative to the physical paper size.  This 
setting is off by default and is remembered between printing sessions.

Center of Paper prints objects in the center of the physical paper size 
as defined in page setup; page margins are ignored.  For example, if an 
8.5 x 11 inch page has margins which are 1 inch left, right and bottom 
and 3 inches top, the objects will be printed in the center of the 8.5 x 11 
paper size and may appear off center relative to the printable area due 
to the unequal margin dimensions.  This setting is off by default and is 
remembered between printing sessions.

If your page margins are equal dimensions or the differences between them 
are very small you may not perceive any difference between selecting Center 
of Printable Area or Center of Paper.

TIP: To see the different effects of various combinations of Print Area, Print 
To, and other optional settings use the MacOS Preview button found in the 
Print dialog.  The previewed drawings may be saved as PDF files for detailed 
review and kept on file for later reference.

Print To

💡💡
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Fit to Page will force the contents of the active drawing to print on the 
available paper size.  For example, you may print an E-sized drawing onto 
a letter size (8.5” x 11”) page.  This setting is Off by default and is not 
remembered between printing sessions.

Time Stamp prints the file name, date, and time at the top center of the 
page.  If the document is tiled on multiple pages, a time stamp will be 
printed on each page.  This setting is Off by default and is remembered 
between printing sessions.

Print Points prints the reference points in the drawing — this is Off by 
default and is not remembered between printing sessions.

Gray Pattern for Dimmed or Transparent Layers is an application-
wide setting to help address Postscript and PDF workflows and flattening 
of transparent objects.  Due to limitations in how transparent content is 
rasterized at the operating system level during the Postscript and PDF 
printing process, the output may appear to become fuzzy or less sharp.

When enabled, the WYSIWYG relationship between screen display and 
printed output is affected for objects with a Dimmed layer status or objects 
residing on layers with a Layer Opacity setting other than 100%.  Filled 
patterns are not printed, and text, bitmaps and placed objects are printed as 
if their opacity were 100% (solid); objects on these layers are printed with 
a gray pen pattern instead.  Settings applied for Color printing options in 
Drawing Setup, Print tab still apply.

When off or disabled, the transparency setting set when a layer status is 
Dimmed or Layer Opacity settings are changed will be applied to all objects 
when rendered to screen and when printed.  In the case of non-postscript 
printers, leaving this box unchecked (Off) is recommended to maintain the 
WYSIWYG relationship between the screen display and printed output.

Additional Options
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The buttons along the bottom of the Print dialog will vary depending on 
which version of the MacOS you are running.

Help button opens Apple’s Help View application with additional 
information on using the Print dialog box.

PDF taps into the MacOS feature set for saving or faxing PDF files or 
saving PDF as Postscript.  The list of options available with vary with your 
version of MacOS and any third party applications you may have installed.  

To learn more about how to take advantage the various MacOS system level 
features for creating and working with PDF files search the MacOS help 
files in the Finder for ‘PDF Services’.

Preview opens your file in Apple’s Preview application (or the application 
you have specified to display PDF files) for viewing prior to printing or 
saving as PDF.

Supplies launches your web browser and takes you to an online store.

Cancel aborts the printing operation and returns you to the PowerCADD 
drawing.

Print proceeds with sending the data to the specified printer based on your 
chosen printing options.

For more information on additional drawing specific print options see 
information in this chapter on Drawing Setup, Print tab and Drawing Size.

Button Row

!
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Print Selection prints all selected objects based on settings in the Print 
dialog box.  The extents of the selected objects define a clipping area of 
information that will be printed.  All visible objects inside the clipping area 
are printed.

To use Print Selection:
o	 Select the objects in the drawing you want to print and choose Print 

from the File menu and the following dialog will appear: 

Print Selection

o	 Note the status of the Print Area, Selection radio button is remembered 
between printing sessions. 

o	 Choose any additional options and click Print. 

Print Sheets Print Sheets prints....
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The Edit menu contains items that allow you to change the physical 
appearance or location of an object.  You may also duplicate objects or 
create arrays of many forms.

Some menu items such as Undo, Paste Special, Duplicate, Mirror and Move 
have special optional settings.  Press the Option key when selecting the 
Edit menu will show three dots beside menu items with optional settings.  
Pressing the Option key when you choose those menu items will present a 
dialog box.

Paste Special, Select Special, and Select Adjoining are Externals and must be 
loaded in order to appear in the Edit menu.

Edit Menu
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Undo restores the drawing to its status before the last change to the 
document.

There are multiple levels of undo, which can help you correct mistakes you 
make while drawing.  You can even undo an operation after you have chosen 
the Save command (but not if you have reverted or closed and reopened the 
file).

To undo the last action:
o	 Choose Undo from the Edit menu.
o	 You should immediately see the last command issued be reversed or 

undone.

To set the number of undo/redo levels:
o	 Press the Option key while choosing the Edit menu and Undo changes 

to Undo Options.  Choose Undo Options and the Multiple Undo 
dialog will appear. 

Undo

o	 Enter the levels of Undo and click OK.

When you change the levels of Undo, any previous changes will be cleared 
from the Undo buffer, so you will be able to undo only the actions you 
perform after you had changed the Undo levels.

CAUTION: If Revert is used to restore your drawing to the one last saved, 
all undos will be cleared.

The default number of undos is set to sixteen.  A larger quantity of undos 
requires more memory.  If you find performance feels sluggish or if you are 
running into low memory conditions, reduce the number of undo levels.

Redo Redo reverts the last undo made to the document.

Redo, like Undo, has multiple levels which can help you when you 
mistakenly used Undo several steps back and have now changed your mind. 
The number of levels set for Undo is also applicable to Redo.

⚠

💡💡
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Cut

💬💬

Copy

Cut removes and places the currently selected object on the Clipboard. This 
has the effect of removing the object from the current layer of the drawing.

To cut an object from the current layer of a drawing:
o	 Select the desired object from the drawing.
o	 Choose Cut from the Edit menu.

The selected objects will be removed from the drawing.

The method for moving an object between layers is by cutting (or copying) 
and pasting.  Cutting an object, changing layers, and pasting causes the 
object to be pasted in exactly the same coordinates from which it was cut/
copied.  The object can then be moved by dragging or other means.

NOTE: To recover from an accidental Cut, choose Undo or Paste from the 
Edit menu before going any further.  Undo or Paste will re-insert the objects 
which were mistakenly removed from the drawing.

💬💬

Copy makes an exact copy of a selected object and places the copy on the 
Clipboard.  The original object is not modified.

To copy a selected object from the current layer of a drawing:
o	 Select the desired object from the drawing. 
o	 Choose Copy from the Edit menu.

An exact copy of selected objects will be made and placed on the Clipboard 
for your further use.

Copy has the effect of leaving the selected object in the drawing area and 
placing a duplicate copy of the object on the Clipboard for further use, 
whereas Cut actually removes the object from the drawing area and places 
a copy on the Clipboard.

NOTE: Objects Cut or Copied and Pasted between PowerCADD drawings 
will retain Shadow and Opacity attributes.  Shadow and Opacity attributes 
may be lost when pasting data into other applications.
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Paste places the contents of the Clipboard onto the drawing area.

To paste the contents of the Clipboard onto the drawing area:
o	 First, make sure the objects you wish to place in the drawing are on 

the Clipboard by selecting the objects and performing a Cut or Copy 
operation.

o	 Choose Paste from the Edit menu. 

An exact copy of the contents of the Clipboard will be placed on the 
drawing. 

Objects are pasted in the exact same coordinate location from the drawing 
which they were cut/copied.  As they remain selected, you may immediately 
reposition them.

An object can be moved between layers or between drawings by cutting, 
copying, and pasting.

NOTE: Paste ignores layer information and objects are always pasted 
onto the current active layer.  To have Paste operations remember layer 
information use Paste Special.

Paste
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The Paste Special optional dialog box allows you to paste an object from 
the Clipboard to a point specified by the mouse, paste at another scale, and 
paste multiple objects through layers.

Choosing Paste Special allows you to position objects and control certain 
object attributes when they are pasted into the drawing.  

Choosing Paste Special while pressing the Option key allows you specify 
the specific behavior of the pasting operation.  Changes made in the Paste 
Special dialog remain in effect until you change them.

Paste Special...

At Mouse pastes the selected objects relative to the mouse, instead of pasting 
them at their original x,y location.  The rectangle in the upper right of the 
dialog box is used to set the position of the objects relative to the mouse; the 
black box indicates the active position.  To set the position, click on a white 
box and it will become black confirming the new active position.

Through Layers maintains layer information when pasting the selected 
objects.  For example, if you copy a group of objects, in which each object 
is on a separate layer, the objects will be placed on the separate layers.  If the 
layers associated with the object do not exist in the drawing, Paste Special 
will create the layers to accommodate the pasted object.

At Scale maintains the dimensions of the selected objects when pasting 
onto another layer or drawing with a different scale.  It will enlarge or 
reduce their physical size according to the new scale.  For example, you can 
copy an 8’ x 8’ square from a drawing at 1/4” = 1’0” scale and paste it into a 
drawing at 1/8” = 1’0”.  The square will be 8’ x 8’ at 1/8” = 1’0” scale.  This 
option is extremely useful if you need to copy a portion of your drawing and 
paste it into another drawing to make an enlarged detail.

At Scale Text will rescale text along with the drawing objects.  For example, 
you can copy text with a font size of 12 points from a drawing at 1/4” = 1’-
0” and paste it into a drawing at 1/8”=1’-0”.  The font size will be 6 points 
after pasting (one half the size in this example).  If Scale Text is not checked 
the font size is not changed.

🎖🎖 🎪🎪🥁🥁🕺🕺

Anchor
[PasteSpecial]
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Line Weights will rescale the line weight attribute along with the drawing objects.  
For example, you can copy an object with a line weight of 4 points from a drawing 
at 1/4” = 1’-0” and paste it into a drawing at 1/8”=1’-0”.  The object will be rescaled 
and its line weight will also be changed to 2 points (one half the size in this example).  
If Line Weights is not checked the line weight attribute is not changed.

To use the Paste Special options:
o	 Copy the desired object using the Copy command.  The Cut command 

may also be used.
o	 Press the Option key and choose Paste Special from the Edit menu.  A 

dialog appears

o	 Click one of the placement point locations.  The black box indicates 
the selected point.

o	 Click At Scale and Through Layers as desired. 
o	 Click OK.  The object will appear as a bounding box on the screen. The cursor 

will be positioned on the object according to your specified placement point.
o	 Position the object on your drawing by moving the mouse and using a 

Dynamic Snap, if desired.
o	 Click in your drawing where you wish the object to be pasted.

Once you have established a placement point in the Paste Special dialog, 
the setting will remain until you change it.  At Scale and Through Layers 
will also remain.  You will not need to use Option key when activating Paste 
Special unless you want to change or verify a setting.  The settings in the 
Paste Special options will become the default for Paste Special. 

NOTE: The Fence Cut tool supports layers, drawing scale and scaling line 
weights when using Paste Special.

CAUTION: Objects which were created in a drawing on scale-assigned layers 
will not create new layers with the same attributes when pasted through layers 
into a new or existing drawing; therefore, if At Scale is also active, layer-scaled 
objects will be rescaled when pasted.  If the new or existing drawing does contain 
layers identical in name and layer-assigned attributes as the object’s origin, and 
Through Layers is active, the objects will retain their scale. 

For more information on editing layer scale, see Layer, “Advanced Layer 
Attributes” and “Layer Scale”.

💬💬
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Clear removes the currently selected object from the drawing area without 
placing a copy of it on the Clipboard.

To clear a selected object from the current layer of a drawing:
o	 Select the desired object from the drawing.
o	 Choose Clear from the Edit menu.
o	 The selected object will be removed from the drawing.

Clear has the effect of permanently removing the object from the currently 
selected layer of the drawing.

A selected object can also be removed by pressing the Delete or Backspace 
key.

NOTE: To recover from an inadvertent Clear, choose Undo from the Edit 
menu before going any further.  The Undo command will replace the 
objects which were mistakenly cleared from the drawing.

Clear

💬💬
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Duplicate allows you to create exact duplicates of selected objects in a 
variety of locations, patterns or arrays.

To use Duplicate:
o	 Select the object(s) to be duplicated.
o	 Choose Duplicate from the Edit menu. 
o	 When you release the mouse button, the duplicate of the item will be 

placed directly on top of the original.

NOTE: The direct placement is a powerful feature allowing you to accurately 
move objects between layers. 

Offsets for duplication may be set dynamically using the mouse.  Each 
successive duplication will use the previous offsets.  The offsets are reset to 
zero by selecting a new object.

Duplicate

To dynamically specify an object’s duplication offset:
o	 Draw a small rectangle or pick an existing object. 
o	 Press the Option key and drag the object.  Dynamic snapping may be 

used to specify a precise location if desired.
o	 The duplication cursor appears, release the mouse to duplicate the 

object in the new location.
o	 Press Command-D three more times, and you will have five equally 

spaced objects. 

NOTE: Duplicate has three periods beside it in the Edit menu when you 
press the Option key.  If you press the Option key and choose Duplicate, 
the following dialog will appear.  You may place multiple duplicate objects 
in a linear, rectangular, or circular array.

💬💬

💬💬
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Linear duplication will duplicate objects and space them evenly apart in a 
straight line.  This line of objects can be set at any angle or in a flat plane.

To perform a Linear duplication:
o	 Select the object(s) to be duplicated.
o	 Press the Option key and choose Duplicate from the Edit menu.
o	 Select Linear in the dialog, and enter the number of duplications.
o	 Select a method of duplication:

Abs - Absolute allows you to specify an absolute location where the 
center of the first duplicate will be placed.  The remainder of the 
objects will be placed according to the change in distance and angle 
from the original.

Rel - Relative allows you to specify the distance from the original, the 
first duplicate will be placed.  The remainder of the objects will be 
placed according to the change in distance and angle from the original.

Ang - Angle allows you to specify where the first duplicate will be 
placed by specifying the distance and the angle/direction from the 
original.  The remainder of the objects will be placed according to the 
change in distance and angle from the original.

Next Mouse - Allows you to specify where the first duplicate will 
be located by placing the cursor on the desired insertion point and 
clicking.  The point specified refers to the upper left hand corner of 
the object.  If you hold the mouse button when selecting the point, 
you will be able to see a dimmed object which will aid in placement.  
The point will not be established until the mouse button is released.  
The remainder of the objects will be placed according to the change in 
distance and angle from the original.

o	 When you click OK, the duplication will take place unless you selected 
Next Mouse.

Linear
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A Rectangular duplication will place duplicated objects in rows and 
columns, evenly aligned vertically and horizontally.  You specify the number 
of rows and columns needed.

To perform a Rectangular duplication:
o	 Select the object(s) to be duplicated.
o	 Press the Option key and choose Duplicate from the Edit menu. 
o	 Select Rectangular in the dialog and enter the number of rows and 

columns.
o	 Select a method of duplication:

Abs - Absolute allows you to specify an absolute point where the center 
of an alignment object will be placed. The alignment object represents 
the object on the second row and the second column. This object will 
be diagonal from the original, but it specifies the spacing between 
columns and rows.

Rel - Relative allows you to specify the distance, in X,Y coordinates, 
from the original object’s center to the center of the alignment object. 
The alignment object represents the object on the second row and the 
second column. This object will be diagonal from the original, but it 
specifies the spacing between columns and rows.

Ang - Angle allows you to specify the location of the center of the 
alignment object with respect to the center of the original. This point is 
determined by specifying the distance from the original object’s center 
to the alignment object’s center and the angle/direction of the move. 
The alignment object represents the object on the second row and the 
second column. This object will be diagonal from the original, and it 
specifies the spacing between columns and rows.

Next Mouse - Allows you to manually select a point which will 
represent the upper left hand corner of the alignment object. This point 
is specified by placing the cursor in the desired location and clicking. 
As soon as the location is selected, the rows and columns are created. 
The alignment object represents the object on the second row and the 
second column. The point will not be established until you release the 
mouse button. This object will be diagonal from the original, but it 
specifies the spacing between columns and rows.

o	 When you click OK, the duplication will take place unless you selected 
Next Mouse. 

Rectangular
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A Circular array will duplicate objects around the perimeter of a circle with 
their centers aligned with the circle’s circumference line.  You specify the 
number of objects and the angular increments that separate them.

To perform a Circular duplication:
o	 Select the object(s) to be duplicated.
o	 Press the Option key and choose Duplicate from the Edit menu. 
o	 Select Circular in the dialog and enter the number of objects to be 

created.
o	 Enter the spacing you wish to have between the objects.  If the array 

will cover 360˚ and you are not sure of the increments, enter 360˚/the 
number of objects.  The calculation will be done internally.  A positive 
value will rotate the objects counterclockwise while a negative value 
will result in a clockwise rotation.

o	 Select a method of duplication:

Abs - Absolute allows you to specify a point on the screen, using X,Y 
coordinates, that represents the center of a circle where the object’s 
center lies on the circle perimeter.  The remainder of the objects will be 
placed counterclockwise according to the angle increments you specify 
unless the angle increments were negative, which would result in a 
clockwise rotation.

Rel - Relative allows you to specify the circle center by entering X,Y 
coordinates which represent the distance from the object’s center 
to the circle center.  The remainder of the objects will be placed 
counterclockwise for positive angles.

Ang - Angle allows you to specify the circle center by determining how far 
and at what angle/direction the circle center is from the object center.  The 
remainder of the objects will be placed counterclockwise for positive angles.

Next Mouse - Allows you to specify the center of the circle by manually 
selecting with the cursor.  If you hold the mouse button down after 
selection, you can move the mouse and see where the circle will be placed.  
The point will not be established until you release the mouse button.  The 
remainder of the objects will be placed counterclockwise for positive angles.

o	 When you click OK, the duplication will take place unless you selected 
Next Mouse.

o	 There is a Rotate Item option, which determines if the object will be 
rotated as it is duplicated around the circle or if it will remain in its 
horizontal position as it is duplicated.

The settings will remain in effect until you change them. 

Circular
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Math can be performed in any dialog box which accepts keyboard-typed 
input.

To use math in the dialog boxes to create a Circular array:
o	 Select the object(s) you wish to duplicate.
o	 Press the Option key and choose Duplicate from the Edit menu.
o	 Select Circular and enter 15 in the number field. 
o	 If you do not know the exact increments to place 15 objects evenly 

around a circle, enter an equation instead of angular increments: 
360/15.

o	 When you click OK, PowerCADD will calculate the equation and 
place the duplicate items in the correct location.

You may also enter equations having primary and secondary functions 
such as (2+4)-(3*6) or items of different measurement systems such as: 
34”/66mm. 

Here are some possible combinations of mathematical equations:
	 17/256 + 1/8
	 15"*(3"+24mm)
	 2.549/12mm
	 13/254 + 16mm - .2568 / 56mm

The abbreviations are:
	 ' = feet
	 " = inches
	 mm = millimeters
	 M = miles
	 cm = centimeters
	 m = meters
	 km = kilometers

Parentheses may be used to specify priority. Multiply and divide are 
evaluated before add and subtract.

Math in Dialog Boxes
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Select All selects all objects contained in the current layer of a PowerCADD 
document.  If Edit All Layers is active, all objects on every visible layer will 
be selected.

Select All

Select Special...

o	 Set the attributes by placing the cursor on pop-up menu beside the 
attributes and pressing.  The appropriate palette will appear.  Attributes 
which are not desired for a selection can be deactivated by clicking an 
active checkbox.

o	 Once the attributes are set, click OK.  All matching objects will be 
selected.

Pen Color, Pen Pattern, Fill Color, Fill Pattern, Pen Size, Dash, Arrows, 
and End Caps allow you to specify attributes by which objects are selected. 

To set an attribute, press and choose from the pop-up menus.

Get Object Attr sets the attribute options according to a selected object. 
This will allow you to use an object as a model.

Select Special will automatically select all objects whose attributes match 
specified attributes or according to a selected model.  Objects can be 
selected by pen color, pattern; fill color, pattern; or line weight, dash, and 
arrow attributes.  You may also select objects by type.

Select Special will make selecting and editing objects quick and easy.  By 
specifying attributes common to certain objects, you can locate and make 
global changes to many objects at once.  You may specify object attributes 
individually or use a selected object as a model.  Additionally, you may use 
the Selection Filter window to select only certain object types with specific 
attributes. 

Select Special can be used with Edit All Layers On to search an entire 
drawing or Off to isolate the search to the active layer. 

To use Select Special: 
o	 Choose Select Special from the Edit menu. The following dialog will 

appear:

Anchor
[SelectAll]

Anchor
[SelectSpecial]
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You may also use a selected object as a model by which other objects are 
selected. 

To use a selected object as a model:
o	 Select an object.
o	 While pressing the Option key, choose Select Special from the Edit 

menu.  When the dialog appears, click Get Object Attr.  The attribute 
options will reflect the selected object’s attributes.

o	 Click OK.  All objects whose attributes match the specified model will 
be selected.

NOTE: If more than one object is selected, the Get Object Attr button will 
appear dimmed and is unavailable.

Using a Selected Object 
as a Model

Selecting Objects by 
Type

Select Adjoining

Select Special may be used to select objects according to type by first 
checking the appropriate object type in the Selection Filter Window.  This 
will allow you to be very specific; for example, you can find all red-filled, 
dashed rectangles.  Select Special does not look inside of groups or symbols.

Select Adjoining selects a path along objects having touching endpoints.  It 
works with lines, arcs, and polygons.

Select Adjoining is an efficient way to select the entire perimeter of a 
machine part or wall.  You select one object, and Select Adjoining selects 
the rest. 

Select Adjoining selects only one path.  When it has a choice between more 
than one object, it selects the object that was created most recently.

Objects selected with Select Adjoining are ready for further manipulation. 
For instance, they can be grouped or attached.

To use Select Adjoining:
o	 Select a line, arc, or polygon. 
o	 Choose Select Adjoining from the Edit menu.  The adjoining objects 

are selected.

💬💬
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The optional settings for Select Adjoining allow you to specify what the 
maximum bridge distance between object endpoints is when performing 
a Select Adjoining operation.  For example, a value of zero means the 
endpoints of the objects must be snapped together exactly.  A value of two 
pixels means the endpoints can range from zero to two pixels apart and still 
be selected when choosing Select Adjoining.

To access the Select Adjoining optional settings: 
o	 Press the Option key and choose Select Adjoining from the Edit menu. 

The following dialog will appear:

Select Adjoining 
Optional Settings

o	 Enter a numeric value in the Bridge Distance field and click OK.
o	 These settings remain in effect until you change them.

Select With Object selects all objects whose extents reside entirely within a 
selected object.

Select With Object is an efficient way to select objects using a fence or 
boundary.  You select the boundary object and Select With Object selects all 
the other objects inside the boundary for you.  This can be a very efficient 
way to remove objects from specific areas of a drawing.

To use Select With Object:
o	 Draw an object to be used as the selection boundary or select an 

existing object in the drawing.
o	 With the object selected, choose Select With Object from the Edit 

menu.
o	 All items inside the object will be selected and the original object used 

as the selection boundary will be deselected.

If Edit All Layers is On, all objects on visible layers inside the selection 
boundary will be selected.  If Edit All Layers is Off, only objects on the 
active layer will be selected.

Select With Object

Select Inverse

Deselect All

Choose Select Inverse to reverse the current selection set of objects.  Objects 
that were selected will be deselected.  Objects that were not selected will be 
selected.

Choose Deselect All to deselect all currently selected objects.
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Edit Group allows you to edit the individual objects within a group without 
disrupting the grouping characteristics. 

Exit Groups allows you to back out of a single or nested group.

Pressing the Option key and choosing Exit Group will take you back to the 
first level without stepping though nested groups.

Edit Group makes it very easy and convenient to modify objects which are 
contained in a group because you do not have to upset the group’s order or 
relationship.  You can even edit objects which are nested several levels into a group.

Once you have entered a group, you can modify, add, or delete objects as 
needed.  Any additional objects created while in the Edit Group mode will 
be added to the group when the editing session is complete. 

Edit Groups will also allow you to move objects from one group to another 
group within a nesting.  When editing a group, all other data in the drawing 
is temporarily hidden and the Layer Window will display ‘Editing Group’.

To use Edit Groups:
o	 Select a group.
o	 From the Edit menu choose Edit Group.  All other objects in the drawing will 

be hidden temporarily.  This will reduce clutter while editing the selected objects. 
o	 Edit the objects as needed.  You may add or remove objects.  Objects 

added will become part of the group.
o	 When finished, choose Exit Groups from the Edit menu.  You are returned 

to the drawing window and all previously hidden objects are shown.

You may use all available tools and menu items while editing a group.  You 
can even ungroup objects and create new groupings.  This is useful when it 
is necessary to move an object from one group to another within a nesting. 

To edit nested groups: 
o	 Select a nested group.
o	 Choose Edit Group from the Edit menu.  This will take you down 

into the nested group one level.  Select another group inside this level 
and choose Edit Group again.  Continue to select groups and the Edit 
Group command as needed to get to the desired object.  All other 
objects will be hidden temporarily as you edit further into the nesting.

o	 Make changes as needed.  When finished, you may step back to a previous level 
by choosing Exit Groups.  Objects will reappear as you step back through the 
groups.  Continue choosing Edit Groups to step back to see the entire drawing. 

Pressing the Option key and choosing Exit Group will take you back to the 
first level without stepping though nested groups.

Edit Group

Exit Groups

Need New Image
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Edit... opens a text edit window, a dimension editing window or a dialog 
where you can perform additional editing of the selected object.

To edit a dimension (or multiple dimensions):
o	 Select the dimension(s) to be edited.
o	 Choose Edit from the Edit menu.
o	 The Dimension Edit dialog will open.
o	 Make the desired changes and click OK.
o	 If a single dimension is selected, the change is applied to that specific 

object.  If multiple dimensions were selected the change is applied to 
all selected objects.

For additional information on working with and editing dimensions see the 
Tool chapter and Dimension Window discussed later in this chapter.

To edit a text block:
o	 Select the text block or leader line object to be edited.
o	 Choose Edit from the Edit menu.
o	 A Text Edit window will open.
o	 Make the desired changes and close the text edit window. 

For additional information on working with and editing text, see the Tool 
chapter, Leader tool, Text tool, and Advanced Text tool.

Edit...

Anchor
[Edit]
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Reshape places edit handles on the selected object so the shape can be 
modified.

Reshape works directly on arcs, circles, lines, polygons, Béziers, and 
smoothed polygons (B-Splines).  All other objects, such as rectangles, must 
first be Converted to Polygons before they can be reshaped.

For elliptical arcs, Reshape allows you to change the length of the arc, but 
will not allow you to change the radii.

For circular arcs, both the radius and the length of the arc can be altered.

For a line, Reshape allows you to change the length of the line without 
changing its angle.

For a circle, Reshape allows you to change the radius.

To reshape an object:
o	 Select the object to be reshaped.
o	 Choose Reshape from the Edit menu.
o	 When you release the mouse, you will notice the original object now 

has edit handles at critical points which will allow you to redefine the 
shape of the object. 

o	 Select one or more of the edit handles and drag them with the mouse in 
the appropriate direction to bring about the desired change.

o	 Exit reshape by clicking on the Tool palette or clicking in the drawing 
window or press the Enter key.

1_Edit handle bars appear after 
choosing Edit menu > Reshape

2_drag an edit handle to 
change the objects shape

original polygon result

Reshape

To reshape a line:
o	 Select the line you wish to reshape. 
o	 Choose Reshape from the Edit menu.
o	 The line will display edit handles at each end. 
o	 Select one of the edit handles and drag to reshape the line.  The line will 

remain at its current angle.  To remove the angular restraint, press the 
Shift key while dragging the edit handle.

o	 Exit reshape by clicking on the Tool palette, in the drawing, or pressing 
the Enter key. 

Anchor
[Reshape]
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To reshape a Bézier curve:
o	 Select the Bézier curve you wish to reshape. 
o	 Choose Reshape from the Edit menu.
o	 The Bézier curve will display all control points and telescoping handles.
o	 You may move anchor points and control points by selecting them and 

dragging to a new location.
o	 You may independently change the control rod lengths by selecting 

each control point and moving it.  Changing the length of the control 
rods changes the degree of pull on the curve.  The longer control rod 
will have a stronger pull on the curve than a short control rod, therefore, 
the longer the control rod the more the curve will pull toward that side 
of the anchor point.

o	 You may remove anchor points by holding the Option key and selecting 
the anchor point you wish to delete.

o	 You may break a control rod by pressing the Command key and 
clicking on a control rod. 

o	 You may add anchor points by holding the Option key and clicking on 
a curve segment.  The anchor point will be inserted with the control 
rods set to zero. 

o	 The curve may be visually observed during the modification process.
o	 You may set a control rods length to zero by holding the Option key 

and selecting the rod you wish to set to zero length. 
o	 When you have finished the reshape process, press the Esc key to exit 

the Reshape command.

B-Spline curves can be reshaped in a similar manner to Bézier curves.

Polygon Reshape is a powerful feature.  Missing points can be added to a 
shape, or points can be duplicated.  Lines can be moved, and points can be 
lassoed and moved. 

During polygon reshape, the following operations can be performed:
o	 Vertices can be added or deleted by holding the Option key while 

clicking on a handle to remove it or clicking on a line to add a vertex.
o	 Select All is available for selecting all vertices. 
o	 Line segments may be individually selected for moving.
o	 Multiple handles may be selected by holding the Shift key.
o	 Multiple handles may be selected by pressing the Option key and 

lassoing.
o	 Multiple handles may be moved simulating complex mechanical 

movement.  You might check for interference during movement of a 
single part in a complex design mechanism. 

o	 Regular polygons may be turned into a parallelogram.
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When you reshape a polygon or curves, you may move points or lines.  If 
you choose to move a line, it will retain its present angle and length during 
the move, but the lines intersecting with either end will stretch to allow 
placement.  If you select a vertex, you may stretch the two intersecting lines 
to any location. Option-click on a vertex to delete the vertex.  Press the 
Option key and click on a line to add a vertex to the line.

To reshape an object, you select lines and vertices just as you select items in 
the drawing page.  You may use a Selection Rectangle, a Lasso, or randomly 
select points by the Shift key and clicking.

Reshape allows you to change the diameter of circles.  When you reshape a 
circle, a single handle will appear on the perimeter of the circle.  If you select 
and drag the handle, you can change the diameter of the circle. 

Reshape allows you to change the length and radius of an arc, up to the point 
where the arc becomes a circle or an ellipse.  To change any characteristic 
other than the arc length, you must first convert the arc to a polygon.
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Scale is used to change the size of selected objects and/or text in a drawing.

Generally you would scale an object about its center.  

An individual part, grouped objects, or a selection of objects will usually be 
scaled about their center or some other specific point.  

Scaling about the next mouse is more intuitive if accurate placement is not 
needed.  

Scaling can be used to mirror objects or groups.

Changing the scale in the Drawing Setup dialog does not automatically 
scale objects.  The scale menu item physically changes the sizes and spatial 
relationships between objects in a drawing.  

The entire drawing, or any individual part of it, can be scaled up or down, 
using the Scale command, including text and dimensions.  When scaling 
an object and dimensions, the dimension is automatically recalculated to 
reflected the new scaled size.  

A drawing can have details at different scales.  Anything drawn or changed 
will be at the current scale.  This is a very powerful feature, but it is also a 
case where you are not protected from yourself.

Scale is used to change all or part of a drawing.  Scaling here is independent 
of the drawing scale.  A ratio of 1/2 reduces the size by one half.  A ratio 
of two makes the selected objects twice as large as the original.  The X,Y 
coordinates shown are the center of the selected material.

Scaling with a minus-one on one axis will mirror the selection. 

Scaling can be useful if you started a drawing on the incorrect size “paper”. 

To scale an object:
o	 Select the object (or multiple objects) to be rescaled larger or smaller.
o	 Choose Scale from the Edit menu.
o	 The Scale dialog will appear.

Scale...
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Scale X: The amount to scale the data in the horizontal axis.  Entering a 
value in this field automatically enters the same value in the Scale Y field.

Scale Y: The amount to scale the data in the vertical axis.  The value 
entered in the Scale X field is automatically entered here.  To scale a 
drawing with two different ratios, enter the unique Scale Y amount in 
theist field and the Scale X value is not modified.

User Point: Lets you type in the coordinate defining the point about 
which to perform the scaling.

Next Mouse: Lets you use the next mouse click in the drawing area 
to define the point about which to perform the scaling.  When scaling 
about the mouse, the target cursor is presented.  Surface and intersection 
snapping are available.  Scaling is performed when the mouse is released.

Absolute: The absolute point about which to perform the scaling.  The 
initial values in the X,Y boxes are the distance from the current origin.

Relative: The relative offset with respect to the center of the selected object.

Scale Text: Allows you to scale text along with objects.  If this item is 
checked, the text is rescaled.  If this item is not checked the text font 
size remains the same.

Scale Line Weight: Allows you to scale the line weight attribute along 
with the drawing objects.  For example, an object with a line weight of 2 
points that is scaled 2 times larger will have a new line weight of 4 points.  
If Line Weights is not checked the line weight attribute is not changed.

Ratio numbers larger than one scale up; ratios smaller than one scale 
down.  For example, a ratio number of two makes the object twice 
as large; a ratio of 0.5 makes object half as large.  You may also enter 
mathematical equations in the dialog box.  For example, entering 
2/1.25 in the Scale X field would scale the drawing by a factor of 1.6 
times.

o	 Unless changed, this dialog will scale an object about the center of the 
object selected.

o	 Enter the appropriate values for each field based on the descriptions 
below and click OK.

o	 The selected objects are rescaled and remain selected.

To set the Drawing Scale, see Drawing Setup under the Layout menu.!
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Mirror allows you to create a mirror image of selected objects.

Mirror can create a duplicate mirror image of selected objects about a 
specified line or you may draw a mirror line or specify an existing one.

To Mirror about a mouse-drawn line.
o	 First, select the objects to be mirrored.
o	 Press the Option key while choosing Mirror from the Edit menu.  The 

following dialog will appear:

Mirror

o	 Select Copy Items if you want to mirror a duplicate set of the selected 
object.  With Copy Items off, the selected objects will be moved to the 
mirrored position. 

o	 Click OK and a target cursor will be presented, which you will use to 
draw the mirror line.  You must draw a line or click on an existing line 
as the mirror line.  Remember, the space between the mirror line and 
the selected objects will also be mirrored.

o	 The line will constrain to the preset angles.  Pressing the Shift key will 
unconstrain the line.

o	 The selected object will be mirrored about the line drawn and the line 
will disappear.

You may also select an existing line to act as a mirror line.  When the target 
cursor appears, click on an existing line to be used as the mirror line.  If 
the dimensions of the mirroring line are known in advance, they may be 
entered by the keyboard.
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Move allows you to relocate objects by typing in location coordinates, or 
dynamically by dragging the mouse in the drawing window.

One method of moving is to select the object to be moved and drag it to the 
desired location.  The Move command is an alternative method of moving 
the selected object to an exact location.

Move allows you to place items in a drawing with great precision.  You can 
move single items, or every item in the drawing, regardless of layers.  To 
activate the Move dialog, press the Option key while selecting Move and the 
following dialog will appear. 

Move

If the Move Window External is loaded, choosing Move while pressing the 
Option key will present you with a floating Move window which floats on 
top of your drawing for ready access. 

See the Window Menu section of this chapter for more information on the 
Move Window External.

Move offers several methods of moving objects. 
o	 Absolute allows you to place the center of the item on an exact X,Y 

coordinate with respect to the Drawing Origin.
o	 Relative allows you to move the object an exact X,Y distance with 

respect to its current location. 
o	 Angle allows you to move items a specified distance at a specified angle. 

You enter the distance and angle.
o	 By Mouse allows you to determine the distance and angle moved by 

drawing a line with the mouse. You may use the snap keys at any time.
o	 By Line allows you determine the distance and angle moved by clicking 

on an existing line in the drawing.  This move option is only available 
in the Move Floating Window (the Move External must be loaded).

There are several ways to move objects with the By Mouse option.  The 
movement can be an offset amount determined by the length of the line 
and angle at which it is drawn.  You can use the By Mouse option when you 
want the center of one object to be moved to the center of another object.  
You might also want the vertex of one object to move to the center of a line. 

The following illustration demonstrates two rows of screws, the right hand 

!
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screws we want to duplicate and move the duplicated screws so all three sets 
of screw have an equal distance between them.

o	 Select the three right-hand screws.
o	 Choose Duplicate from the Edit menu.  This will duplicate the objects 

on top of each other and look like the following illustration. 

o	 Press the Option key and choose Move from the Edit menu.  
o	 Choose By Mouse as your Move option and click OK.
o	 Move the cursor to the left-hand side of one of the screws in the first 

row.
o	 Drag to the same position on one of the screws in the second row, as 

the following illustration shows.

The duplicated objects will now be moved into the proper location. The 
three rows are equally distanced, as the following illustration shows.

To move an entire drawing, you will need to ensure Edit All Layers is 
checked in the Layers window.
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Shear allows you to convert normal images into the distorted images used 
in isometric, diametric and oblique drawings; what most people call ‘three-
dimensional drawings’. 

Select an object and choose Shear from the Edit menu.  A dialog will appear.

Shear...

Shearing in X or Y skews the drawing.  To observe this action, type an angle 
in either X or Y and notice the behavior of the rectangle in the example 
window to the right.  The angles may be positive or negative, and shear has 
a limit of 80˚—so objects cannot be pushed flat.

If you set the X shear angle to 30˚, notice the vertical lines are tilted to the 
right, but the new polygon is still the same overall height as the original 
rectangle.  This is a simple shear and causes the vertical lines of the rectangle 
to become longer.  This is not correct for drawings which have a three-
dimensional appearance.  To keep tilted lines from becoming longer, click 
in the Isometric box, and notice the change in the example window.

Because shear in X tilts the Y-axis, many people find the computer-graphics 
terminology difficult.  To protect you from this, PowerCADD provides a 
cube control.  Click on one of the three sides of the cube to make the 
appropriate settings for X, Y and the Isometric box.

The axes of the three-dimensional presentation may be changed by choosing 
from the Shear Setups pop-up menu. 

To create your own axis setup, choose New Setup from the Shear 
Setups menu, and a dialog will appear.
o	 Type the desired axis angles and notice the change in the cube in the example 

window.  A diametric drawing has two axis angles which may be symmetrical 
or asymmetrical.  A standard isometric is a diametric drawing in which both 
axis angles are 30˚.  In an oblique drawing, only one axis is tilted.

Isometric                Diametric               Oblique

o	 Type a name for the setup, then click OK.
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To use Shear:
o	 Select the object you wish to shear.
o	 Choose Shear from the Edit menu.  The shear dialog will appear.
o	 If the cube is not drawn in the desired axes, choose another setup from 

the Axis Setup pop-up menu or create a new axis setup.
o	 Click on the cube for the desired view.
–or–
o	 Make the appropriate settings by typing the desired angles in X and Y 

and clicking on the Isometric box.
o	 Select Next Mouse or Specified Point.  Shearing about the next mouse 

location may seem more intuitive, but in most cases the image must be 
moved after shearing, so it is normally not necessary.  The initial X,Y 
values represent the geometric center of the selected object.

o	 Click OK.  If Specified Point was selected, the object will be 
immediately sheared.

o	 If Next Mouse was selected, you will be presented with a target cursor.  
Click on the location to shear about.

To create views from below, think of the cube as two-walls-and-a-ceiling.  
The shear settings for the “ceiling” are the same as would be required for a 
floor.

Once created, three-dimensional views can be flipped horizontally, flipped 
vertically, scaled, mirrored and rotated like any other objects to create any 
desired presentation.
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The Tool menu consists of special operations which may be applied to 
selected objects in the drawing window. 

Prior to using the Tool menu commands, the object must first be selected. 
If no items are selected before choosing a command from the Tool menu, 
the computer will issue a warning beep.  Also, a warning will be sounded 
if too many items are selected for the command, or if the selected object is 
incompatible with the command.

When you press the Option key, you will notice the addition of three dots 
beside Convert to Lines, Convert to Polygons, Parallel Polygon, Objects to 
Bitmap and Place Area.  By pressing the Option key when you choose the 
Tool menu these menu items will present a dialog with additional options.

Tool Menu

Convert to Lines

Original Hexagon C onvert to L ines

Convert to Lines converts objects into their individual line components. 

This powerful tool allows you to create a complex polygon, for example, and 
subsequently “convert” — or break — it into its individual line components 
for further line-by-line modification.

To convert a polygon into its individual line components:
o	 Select the polygon you wish to convert.  For example, here is a hexagon 

drawn with the Regular Polygon tool.
o	 To convert the hexagon into its individual line segments, choose 

Convert to Lines from the Tool menu.
o	 The selected object is now broken into its component line parts. 
o	 Each line segment of the original object remains selected for further 

modification.

The following diagram shows a line segment moved from the original 
hexagon after it was converted to lines.  This action would not be possible 
without the Convert to Lines command.

CAUTION: Exercise caution in using this command.  Once an object is 
converted to lines and modified, the individual lines may be difficult to put 
back together again!  Higher level geometry such as circles, once converted 
to lines, cannot be turned back into a circle.  Attached the lines would 
create a polygon shaped like a circle.

Grouped objects must be ungrouped before converting to lines.  Rectangles, 

⚠

Anchor
[ConvertToLines]
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circles, Béziers, B-Splines, and ellipses can be converted to lines directly 
without being converted to polygons first.

You may find for some situations the number of line segments which result 
from Convert to Lines to be higher than needed.  To adjust the conversion 
accuracy, press the Option key while choosing Convert to Lines.  A dialog 
appears.

Click the desired setting and click OK.  This setting will remain until 
changed.  A Low accuracy settings uses the least number of line segments 
to recreate the object’s shape.  A setting of High uses the greatest number 
of line segments.

It is recommended you use the lowest resolution that will meet your needs.  
Curves, arcs, and circles which are converted at a high resolution will 
produce lots of short line segments and require more memory. 

NOTE: Immediately after converting an object to lines, the entire set of 
lines remains selected for further modification.  To select an individual line 
from the entire set, you must first deselect the entire set of line segments.

⚠
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Convert to Polygon turns an object into a polygon for subsequent reshaping.

You might want to convert an ellipse or circle, for example, to a polygon 
and then use Reshape for further object modification. 

To convert an object to a polygon:
o	 Select the object to be converted into a polygon.
o	 Choose Convert to Polygon from the Tool menu.
o	 Next choose Reshape from the Edit menu.  You will notice the original 

ellipse now has multiple selection handles available for use in reshaping. 
o	 Selecting individual edit handles (or groups of handles while pressing 

the Shift key), allows modification of the newly created polygon.

Convert to Polygon

Original E llips e C onvert to P olygon R es haped P olygon

Grouped objects must be ungrouped before converting to polygons.

Like Convert to Lines, the conversion accuracy settings will control the 
number of points or segments created with Convert to Polygon.  To set 
the Accuracy, press the Option key while choosing Convert to Polygon.  
The same rules apply when setting the conversion accuracy for Convert to 
Polygons; use the lowest setting that will do the job.

NOTE: The Accuracy settings affect both Convert to Lines and Convert to 
Polygons.  It is the same function accessible from two different locations.  
For example, if you set Accuracy to be Medium before using Convert to 
Lines, and then later use Convert to Polygons, the object will be converted 
to a polygon with Medium Accuracy setting.

CAUTION: Use Convert to Polygons with caution.  Once an object 
is converted to a polygon, it no longer retains the characteristics of the 
original object.  For example, a converted circle is no longer a circle; it is a 
multi-segmented polygon.

⚠

💬💬
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Convert to Objects converts placed images and hatches into editable objects. 

Convert to Objects will allow you to convert placed images, dynamic 
hatches, and PICT files into PowerCADD objects which can be edited.

To convert to Objects:
o	 Select a placed image.
o	 From the Tool menu, choose Convert to Objects.  The selected object 

will be converted into editable objects. 

Vector-based images such as PowerCADD objects which were hatched 
will convert to vectors and may be edited using standard PowerCADD 
techniques.  Use Convert to Bitmap instead of Convert to Objects for 
placed images such as JPEG, PhotoShop or other supported QuickTime 
file formats to edit the images using the Apply Bitmap Effects tools and 
commands.

NOTE: When Convert to Objects is used on some images, the converted 
objects may not be as accurate as the original images.

TIP: If you Placed a PDF file, EPSF, Illustrator or other Postscript-based 
file formats, use PDF to Objects.

Convert to Objects

💬💬
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Convert to Bézier will convert selected objects into a Bézier path.  The 
objects selected may be lines, arcs, circular arcs, circular ellipses, ellipses, 
rotated ellipses, circles, rectangles, rotated rectangles, round rectangles, and 
open or closed polygons.

To use Convert to Bézier:
o	 Select an object in the drawing, for example an elliptical arc.
o	 From the Tool menu choose Convert to Bézier.
o	 The original object is converted to a Bézier whose path exactly matches 

the original object shape.
o	 The resulting Bézier path may be edited using standard Bézier reshaping 

and editing methods.

Convert to Bézier

E lliptic al A rc C onverted to B ézier

When used in conjunction with the Attach Tool or Attach menu item, 
Convert to Bézier can be used to create complex, smooth curve, paths from 
standard objects in your drawing.

To create a complex Bézier curve path from objects in the drawing:
o	 Draw path using the desired combination of standard object drawing 

tools or menu commands.
o	 Select all the objects in the path.
o	 From the Tool menu choose Convert to Bézier.
o	 Each object is converted to a unique Bézier path and automatically 

selected.
o	 With the objects still selected choose Attach from the Tool menu to 

create one contiguous path.

Using the Convert to Béziers and Attach menu items is just one method to 
create complex smooth curve paths.  Another method it to use the Attach 
Tool with its optional settings set to Convert to Bézier.  Additional methods 
also exist using a combination of tools and menu items to select, attach, 
convert and reshape a variety of objects types.

CAUTION: Use Convert to Bézier with caution.  Once an object is 
converted to a Bézier, it no longer retains the characteristics of the original 
object.  For example, a converted circle is no longer a circle; it is changed 
to a Bézier.  If you need the original geometry, duplicate the objects to be 
converted first.

💡💡

⚠
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Polygon allows you to convert a polygon to a Bézier curve; you may also 
optimize a polygon by removing excess points or by distributing a polygon’s 
points evenly along its path.  Additionally, you may trace a bit image with 
polygon paths, automatically.

Polygons with many points require lots of memory when redrawing and 
printing, not to mention extra effort when editing.  Examples of memory-
intensive polygons include those created by smoothing curves, tracing 
scanned images, drawing maps, and so on.  By removing excess points from, 
or distributing points, you improve performance and efficiency. 

Converting a polygon to a Bézier curve is another way of optimizing.  Not 
only does the resulting Bézier shape contain fewer points, but it can be 
reshaped using Bézier editing conventions.

Polygon Menu

Thin Polygon Thin Polygon allows you to remove excess points from a selected polygon.

Many times, a polygon will have more points than needed to define a 
particular shape, especially if the polygon is created by smoothing a path or 
by freehand tracing a scan.  Thin Polygon will make polygons easier to edit 
on screen and less likely to cause memory problems. 

To use Thin Polygon:
o	 Select a polygon.
o	 From the Polygon submenu, choose Thin Polygon.

Smoothing has the effect of rounding the corners of polygons into a shape 
known as a B-Spline — a type of mathematical curve, much like a French 
curve used in the manual drawing process.  This curve generates curve 
sections which are continuous slopes so they may fit together smoothly.

Smooth

Anchor
[PolygonMenu]
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Unsmoothing has the effect of returning a B-Spline to the original polygon.Unsmooth

Fit Bézier Fit Bézier applies a Bézier to the polygon points.  Bézier curves are smoothed 
mathematical curves that go through the control points.

To use Fit Bézier to automatically construct a Bézier from a polygon:
o	 Select a polygon. 
o	 From the Polygon submenu, choose Fit Bézier.  The original polygon is 

replaced with a new Bézier curve.  The resulting Bézier may be reshaped 
using normal Bézier editing conventions.

For more information on editing or adjusting Bézier curves, see Bézier Tool.

Distribute Points allows you to arrange a polygon’s points evenly along the 
entire length of the path.

This will provide a more uniform shape and make editing easier.

To use Distribute Points:
o	 Select a polygon.
o	 From the Polygon submenu, choose Distribute Points. 

Distribute Points

!
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Open Polygon puts a break at the selected point. Once opened, you may 
drag the segment’s endpoint to create an open polygon path.

To use Open Polygon:
o	 Select a closed polygon.
o	 From Edit menu, choose Reshape or press Command-R.
o	 Click to select a vertex.  The selected vertex will be the location where 

the polygon will be opened.
o	 From the Polygon submenu, choose Open.
o	 The polygon is broken at the selected vertex.  Click and drag to open 

the polygon or press the Option key and click on the vertex to delete it.

Original Polygon Result after choose Close

Open Polygon

Close Polygon Close Polygon places a line segment between the starting and ending points 
of an open polygon.

To use Close Polygon:
o	 Select an open polygon. 
o	 From the Polygon submenu, choose Close.
o	 A new segment is added to close the polygon.
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Fillet Polygon will insert a fillet (rounded corner) at a selected vertex, 
multiple selected vertices, or to all vertices simultaneously.

To use Fillet Polygon on a selected vertex or multiple selected 
vertices:
o	 Select an open or closed polygon.
o	 Choose Reshape from the Edit menu or press Command-R.
o	 Click to select the vertex to be filleted.  Multiple points can be filleted 

at the same time by pressing the Shift key and selecting the additional 
vertices.

o	 Choose Fillet Polygon from the Polygon submenu and the Poly Fillet 
dialog will appear DOES NOT WORK. 

Fillet Polygon

o	 Set the desired radius and click OK.  When Inside Angle is active, 
a typical rounded corner will be inserted; when inactive, a rounded 
cutout will be placed.

Original Polygon Result

select the verties
to be filleted

To fillet all vertices on a polygon simultaneously:
o	 Select an open or closed polygon.
o	 Choose Fillet Polygon from the Polygon submenu and the Poly Fillet 

dialog will appear.  
o	 Set the desired radius and click OK.  When Inside Angle is active, 

a typical rounded corner will be inserted; when inactive, a rounded 
cutout will be placed.

Inside Angle Not Checked Inside Angle Checked

NOTE: The current Convert to Polygon accuracy setting will affect the 
number of points which are used to create the fillet.  Low settings will 
produce fewer points and result in a more jagged fillet.  High settings will 
produce more points and a smoother curved appearance.  The more points 
that are used, the more memory is required to store and edit the shape; 

💬💬
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use the lowest setting which will produce the desired results.  For more 
information on editing polygons and Conversion Accuracy, see Convert to 
Lines, and Convert to Polygons.
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Attach

No Conversion: If the items to be attached include arcs, this setting 
will not change the original arc geometry.  The results will be a Group 
containing the original objects and a new polygon (pen pattern: None) 
which is the bottom most object in the group.  This setting has no affect 
when attaching lines or polygons; the result will always be a polygon.

Convert to Polygons: All objects to be attached are converted to a 
polygon; the original geometry is changed.  For example, if the objects 
to be attached included a line and an arc, the original arc will be 
replaced with a polygon. 

Convert to Béziers: All objects to be attached are converted to a Bézier 
curve; the original geometry is changed.  For example, if the objects to 
be attached included a line and an arc, the original arc is replaced with 
a Bézier.

Bridge Distance: Allows you to specify the maximum distance between 
object end points in pixels.  Objects which are farther apart than the 
specified distance are not attached.

o	 Make the desired changes and click OK.

Changes made in this dialog remain in effect until you change them.

The Attach command allows you to join the end points of lines, arcs, and 
polygons to form a new, single polygon.

Attach joins separate objects to form a closed polygon or an open polygon for 
easier manipulation.  You may also reattach objects previously converted to lines.

To change the settings for the Attach command:
o	 Press the Option key and choose Attach from the Tool menu.  The 

following dialog will appear:

Anchor
[Attach]
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To use the Attach command:
o	 Select all objects to be attached.
o	 Choose Attach from the Tool menu.
o	 The selected objects will be attached to form a single polygon or group.

CAUTION: When Conversion Options are set to Convert to Polygons or 
Convert to Béziers, higher level geometry such as arcs and elliptical arcs are 
replaced.  To retain the original higher level geometry, use No Conversion.

⚠
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Trim All Lines Trim All Lines allows you to cut two or more lines at their intersection 
points.

To use Trim All Lines:
o	 Select the lines you wish to trim.
o	 Choose Trim All Lines from the Tool menu.

Upon release of the mouse button, all lines selected will cut each other at 
their intersection points.

This feature will be helpful for preparation of data to be used in finite 
element stress analysis software. 

Trim All Lines does not throw away any parts.  All parts are retained for 
further modification.

Trim All Lines only works with lines.  If you attempt to trim through 
polygons, groups, or fills, the command will only cut any single lines 
present and leave the other objects intact.
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Cut with Line is a feature which allows one selected line to act like a knife 
to cut or trim every object below it on the same layer of the drawing.  The 
width of the line is ignored; it cuts along its center.  All of the cut parts are 
retained.  If more than one line is selected, a warning beep is issued.  The 
unwanted parts must be selected and deleted.

The following rules apply to Cut with Line. 
o	 Only the cutting line may be selected.
o	 The selected cutting line may be above or below the objects being cut.
o	 Cut with Line will not cut groups, symbols or text.
o	 With Edit All Layers On, all visible objects will be cut.  Cut segments 

will remain on the original layers.  To cut objects on the active layer 
only, turn Edit All Layers Off.

o	 Cut with Line will cut bitmaps but cannot cut Placed objects.  To cut 
a Placed object, use Convert to Bitmap first.

To use Cut with Line:
o	 Select the cutting line.  The line must pass entirely through the objects 

being cut.
o	 Choose Cut with Line from the Tool menu. 

Cut with Line

after applying Cut With Line
to a bitmap and moving one segment

cutting line

Circles are turned into arcs when cut.  If the cutting line intersects a circle 
once, the circle turns into a 360˚ arc.  If the cutting line intersects the circle 
twice, two arcs are created.  Regular arcs and elliptical arcs may also be 
trimmed or cut with a line.  Trimming a smoothed polygon first converts 
the smoothed shape to a normal polygon.
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Parallel Polygon allows you to offset a duplicate of any polygon to both sides 
of the original polygon. 

This is helpful when constructing roads.  You construct a polygon that 
represents the centerline of the road, and Parallel Polygon will place the 
outer boundaries of the road at the offset you specify.

To specify an offset:
Press the Option key while choosing the Parallel Polygon command from 
the Tool menu.  The following dialog will appear:

Parallel Polygon

o	 Type the desired offset.  This setting will remain in effect until you 
change it.

o	 When you click OK, the offset will take place.  There will be a duplicate 
offset placed on both sides of the original.
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Place Area calculates the area and perimeter of a polygon or other objects 
and inserts a text object in the drawing with the corresponding calculation. 

Calculations will be given for area and perimeter based on your drawing 
units.  Multiple objects can be calculated simultaneously with each objects 
unique area and perimeter calculation being placed at the center of the 
respective object.  Area will calculate separate lines and arcs.  It will also 
calculate polygons that have been created with attached lines and arcs.

To set the behavior of Place Area:
o	 Press Option and choose Place Area from the Tool menu, the Area 

dialog will appear:

Place Area inserts the area of selected objects into the drawing.  Text is 
inserted at the center of the object.  If multiple objects are selected and 
Cumulative Total is not checked, the area of each object is inserted.

Place Perimeter inserts the perimeter of selected objects into the 
drawing.  Text is inserted at the center of the object.  If multiple objects 
are selected and Cumulative Total is not checked, the perimeter of each 
object is inserted.

Cumulative Total allows you to insert the cumulative calculation for 
multiple objects into the drawing.

To find the area of a single object:
o	 Select the object to be calculated.
o	 Choose Place Area from the Tool menu.
o	 The area and perimeter of the selected object is inserted into the 

drawing.

To insert the area and perimeter of a single object or multiple objects 
into the drawing:
o	 Select the object(s) to be calculated.
o	 Choose Place Area from the Tool menu.
o	 The calculated values are inserted in the drawing using the text style 

assigned to the dimension tools.

Place Area
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CAUTION: Complex polygon areas will not be correct.  A complex 
polygon is one which crosses back over itself. 

NOTE: For survey work, please verify the calculations to determine the 
degree of accuracy required by your application.

⚠

💬💬
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Allows you to insert a smart text object in the drawing displaying the area 
and/or perimeter of an object.  It appears as a contextual menu item.

To insert a Live Area smart text object in the drawing:
o	 Control- or Right-click on circle, rectangle, polygon, or Bézier in a 

drawing. 
o	 The menu choices are:

Show Area: Inserts a text block at the center of the selected object 
displaying its area in the current drawing units.

Show Perimeter: Inserts a text block at the center of the selected object 
displaying its perimeter in the current drawing units.

When selected the area and/or perimeter of the object is inserted into the 
center of the object.

Resizing or reshaping the object will dynamically update the displayed 
value.

To change the optional settings of Live Area:
o	 Control- or right-click on circle, rectangle, polygon, or Bézier in a 

drawing.
o	 Select from the menu items as shown above left.  The optional setting 

choices are:

Area Units: Allows you to specify the unit of measure used to display 
the area of the object.  These units may be different than the units 
specified in Drawing Setup.

Area Accuracy: Allows you to specify the number of decimal points 
used to display the area of the object.  This accuracy may be different 
than the units specified in Drawing Setup.

Font: Allows you to specify the font used for displaying area and 
perimeter.

Size: Allows you to specify the font size used for displaying area and 
perimeter.

The optional settings for the Live Area command are used until you 
change them.

Live Area

Anchor
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This allows you to apply a variety of filters to any bitmap object using 
QuickTime’s built-in effects.  To apply a bitmap effect to placed or normal 
PowerCADD object geometry, use Convert Object to Bitmaps first.

The ability to apply QuickTime special effects to bitmaps within 
PowerCADD allows you take technical drawings and renderings to a whole 
new level.  Effects can be applied which create unique and interesting visual 
effects, sharpen a scanned image or provided feathered edges to digital 
photographs.

To use Apply Bitmap Effect:
o	 Select a bitmap or multiple bitmaps.
o	 Choose Apply Bitmap Effect from the Tool menu (if the menu item is 

dimmed then the objects you selected are not bitmaps).
o	 The Bitmap Effects dialog will open as illustrated below.

Apply Bitmap Effect

Scrolling list
of Effects

Components

Effect
Preview

Area

Load or Save
Effect Settings

Effect
Parameter

Controls

o	 Choose the desired effect and click OK.

The selected bitmaps are modified to reflect the specified settings.  To apply 
multiple effects select the bitmap and choose Apply Bitmap Effect again. 
Using Undo will revert the bitmap to its previous state.

The Apply Bitmap Effects dialog is tapping directly into Apple’s QuickTime 
technology.  Much like the MacOS color panel, when you are seeing this 
dialog, you are working directly with the MacOS, in this case QuickTime.

Effects Components are listed in a scrolling list.  Clicking on a reveal 
triangle displays a list of effects available in a particular effects category.

Effect Parameter Controls are displayed when you select a particular Effect 
Component.  The controls to adjust a parameter may be a slider, check box, 
radio button, editable text field or any of several other interface elements 
depending on the type of Effect Component selected.
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The Effect Preview Area provides real time feedback based on adjustments 
made to the Effect Parameter Controls and on the chosen Effect Component. 
This allows you to fine tune your effect before applying it.

Load allows you to Load a previously saved effect setting.  This saves time 
if you have to apply the same effect to multiple objects or would like to use 
an effect created by a co-worker.

Save allows you to save the effect settings which can be loaded and applied 
to bitmaps again later.  This saves time if you have to apply the same effect 
to multiple images or would like to share an effect with a co-worker.

Clicking Cancel aborts the apply bitmap effect operation without modifying 
the original bitmap.  The effects dialog is closed, and you are returned to the 
drawing window.

Clicking OK applies the specified effect to the selected bitmap.  The effects 
dialog is closed, and you are returned to the drawing window.

To save a bitmap effect setting:
o	 Select a bitmap or multiple bitmaps.
o	 Choose Apply Bitmap Effect from the Tool menu (if the menu item is 

dimmed then the objects you selected are not bitmaps).
o	 The Bitmap Effects dialog will open.
o	 Choose the effect and make the desired parameter adjustments.
o	 Click Save, the following dialog will appear.

o	 Name the file and specify a location (the .qfx is appended automatically).
o	 The effect settings are saved in the location you specified.  Effects may 

be stored on your local hard drive or a network server to share with 
co-workers.

To load a previously saved bitmap effect:
o	 Select a bitmap or multiple bitmaps.
o	 Choose Apply Bitmap Effect from the Tool menu (if the menu item is 

dimmed then the objects you selected are not bitmaps).
o	 The Bitmap Effects dialog will open.
o	 Click Load, a dialog will appear.
o	 Navigate to the *.qfx file and click Open.
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o	 The preview area updates to reflect the previously saved effect 
component and parameters.

o	 Click OK to apply the effect.

NOTE: To use Apply Bitmap Effects, a full installation of Apple’s QuickTime 
software is required.  For more information on QuickTime visit Apple’s web 
site at http://www.apple.com/quicktime.

💬💬
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Converts selected objects to Bitmaps.  The source objects may be any type 
of PowerCADD object geometry, placed item or symbol.

Using Object to Bitmap allows you to take advantage of various advanced 
PowerCADD bitmap tools and commands including Applying Bitmap 
Effects, using the Bitmap Transition tool or the Perspective Bitmap tool. 
Remember, any PowerCADD object can be converted to a bitmap to take 
advantage of these advanced features.

CAUTION: Use Object to Bitmap with caution as higher level PowerCADD 
object geometry is lost when the objects are converted to bitmaps.  While 
you can Undo the Object to Bitmap operation, we recommend working on 
copies of your data.

To use Objects to Bitmap:
o	 Select any object or multiple objects.
o	 Choose Objects to Bitmap from the Tool menu (if the menu item is 

dimmed you have not selected any objects).
o	 The following dialog will appear:

Object to Bitmap

⚠

o	 Your choices are:

Bitmap Resolution: Enter the number of dots per inch (DPI) you 
want the converted object to be.
Smooth Converted Objects: When checked anti-aliasing is applied to 
create a smoother, less jaggy, edge.

o	 Click OK.  The selected object is converted to a bitmap.

You can now apply any PowerCADD Bitmap Effect menu item to the 
converted object.  A bitmap may be cropped or uncropped.  

For more on cropping, see File menu, Place earlier in this chapter.

Anchor
[ObjectToBitmap]

!
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Auto Alpha allows you to remove a specified color from a raster (bitmap) 
image.  Once removed the previously colored pixels become transparent or 
‘see-through’.

To use Auto Alpha:
o	 Select a bitmap image in the drawing.
o	 Choose Auto Alpha from the Tool menu.

	 If the menu item is dimmed you have not selected a bitmap object, use 
Convert to Bitmap described earlier in this section).

o	 The MacOS Color Panel will appear.
o	 Click on the Magnifying Glass icon and move the cursor over the 

bitmap.
o	 Click the mouse when the cursor is over the desired color to be 

removed.
o	 The chosen color is displayed in the MacOS Color Panel.
o	 Click OK in the MacOS Color Panel.
o	 The specified color is removed and the previously colored pixels are 

now transparent or ‘see-through’.

HINT: Auto Alpha may be applied multiple times to remove more than 
one color, or range of colors, from a single bitmap image.

Auto Alpha

💡💡
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Allows you to convert PDF files which have been Placed, Opened, or 
Imported into PowerCADD into editable bézier curves and text.

To use PDF To Objects:
o	 Select a PDF object in the drawing. 
o	 Choose PDF To Objects from the Tool menu (if the menu item is 

dimmed you have not selected a PDF object).  The following dialog 
will appear:

PDF To Objects

o	 Press OK. 

The object is converted to editable bézier curve and text objects.

HINT: PDF To Objects can be used to convert object files based on the 
Postscript language to editable objects.  Examples of Postscript-based files 
include EPSF, Illustrator, and Adobe Acrobat PDF.

💡💡

Anchor
[PDFToObjects]
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Replace Symbol replaces all occurrences of a symbol instance or group with 
another symbol. 

With Replace Symbol, there is no need to change symbols manually. 
Replace Symbol finds and replaces symbols for you.

For example, all 3’-0” doors can be replaced with 2’-8” doors.

To use Replace Symbol:
o	 Open a symbol library or bring to the front the symbol library window 

you want to use.
o	 Click in the drawing window to make it active. 
o	 Activate a layer containing a symbol to replace.
o	 Select one of the symbols to replace.  This symbol must be on the active layer.
o	 Choose Replace Symbol from the Tool menu.  A dialog like the 

following example will appear. 

Replace Symbol...

	 The dialog box represents the topmost library window.

o	 Select the replacing symbol from the list.
o	 Click OK, and the symbols will be replaced.

To find a symbol in the dialog box quickly, type a full or partial name in the 
name box and click Find. 

To scale the symbol to your drawing scale, select the Scale checkbox. If a 
scaling factor was applied when the original symbol was inserted, the same 
scaling factor is applied to the replaced symbol.

NOTE: When Edit All Layers is On,  Replace Symbol operates on all layers, 
including hidden layers.  Otherwise, Replace Symbol replaces items on the 
active layer only.  Symbols that are part of other symbols are not replaced.

NOTE: If you have placed the same item as a group and as a symbol, 
Replace Symbol will only replace the common groups or the symbols and 
not both.  To replace both, apply Replace Symbol twice, once to replace the 
symbols and once to replace the groups.

💬💬

💬💬
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Set Symbol Tag allows you assign unique data attributes for up to five fields 
to a symbol or other PowerCADD object.  Symbol Tags may be used to 
create bills of materials and schedules for a variety of design disciplines.  
Examples include door and window schedules, furniture schedules, plant 
material lists or lighting design schedules.

To assign a Symbol Tag to an object:
o	 Select an object in the drawing.  The item selected may be a single 

object or a group. 
o	 Choose Set Symbol Tag from the Tool Menu.  The Set Tags… dialog 

appears.

Set Symbol Tag

o	 In the Tag Name field, type a name for this object tag.
o	 Press Tab to jump between fields and enter any additional information 

in the remaining fields, Field 1 through Field 4).  In our example we 
created a tree symbol but the object and data could be for anything 
from a desk, door or pump component.

o	 Click OK.
o	 If the object you selected was a single object, it is automatically 

converted to a group with a non-printing point at its center.

The object may now be added to a Symbol Library.  The next time the 
object is inserted into the drawing using the symbol tool, all the preset 
symbol tags will be present.

You may change an object’s Symbol Tags at any time simply by selecting the 
object and choosing Set Symbol Tags from the Tool Menu.

One to Many Relationships The real power of Symbol Tags comes in being able to generate a ‘one 
to many’ relationship between all symbols which share the same Symbol 
Tags.  A one to many relationship allows you change the Symbol Tag of one 
symbol and automatically update all related symbols in the drawing. 

To create a one to many relationships between symbols and their 
symbol tags:
o	 Create a graphic element you’d like to use as a symbol.
o	 Set the Symbol Tags as previously described. 
o	 Copy or cut the object and paste it into a new Symbol Library. 
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o	 Option-click the Symbol tool and select the Symbol radio button.
o	 Click the mouse to insert several of the symbols into the drawing. 
o	 With one of the symbols selected, choose Set Symbol Tags from the 

Tool menu.  The Set Tags dialog will open.

o	 Notice the Symbol field displays the name of our symbol as it appears 
in the Symbol Library and cannot be edited. 

o	 Edit the data in any Field and Click OK.  In our example we edited 
the data in field 1 to increase the value from 3’’ to 6’’ and increased the 
cost from 300.00 to 600.00.

o	 Select any of the other symbols, and you’ll notice the values have 
automatically been updated.

Setting up a one-to-many relationship using Symbols and Symbol Tags is a 
fast and efficient method of updating drawings and cost estimates.  Once the 
Symbol Tags have been updated in the drawing, the Save As Symbol Report 
feature may be used to create an updated report that may be imported 
into a database or spreadsheet application where additional calculations or 
analysis may be performed.

For more information about creating symbols, see New Library.  For more 
information on Saving Symbol Reports see ‘Symbols’.  For more information 
on inserting symbols, see Symbol Tool elsewhere in this manual.

NOTE: Only Symbol Tags, when used in conjunction with Symbols, can 
have a one-to-many relationships as described earlier.  In all other cases, 
Symbol Tags are a one-to-one relationship; changing the data in a symbol 
tag field only updates the data for the selected item.

💬💬

!
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Verify Drawing options allow you to globally delete objects defined by type 
and size.  It also allows you to delete stacked multiple duplications and 
objects that are off the page.

Verify Drawing clears special objects that you define.  You can specify 
objects by type and size.  You can isolate lines and arcs in your specification 
along with empty text blocks.  Lines and arcs can also be defined as general 
objects like polygons, circles, and rectangles.  Objects and lines .015” or 
larger and arcs with an angle of one degree or more can be defined.  Points 
and text are not included.  You can search for objects on the current layer or 
all visible layers if Edit All Layers is On. 

Verify Drawing will find and delete stacked multiple duplications.  These 
are objects copied using the Duplicate command and left stacked directly 
over each other.  Executing Verify Drawing will automatically search for and 
display the number of extra duplications on the current layer.  If Edit All 
Layers is On, Verify Drawing will automatically search for and display the 
number of extra duplications on each individual layer. 

Verify Drawing will locate and delete objects that have been accidentally 
thrown completely off the page.  Executing Verify Drawing will automatically 
search for and display the number of objects that reside off the page on the 
current layer.  If Edit All Layers is On, all layers will be searched.

NOTE: Verify Drawing works on visible layers only.  Objects that fit 
specifications, but reside on hidden layers, will be ignored.  Verify Drawing 
does not look inside of groups or symbols.  To have Verify Drawing look 
inside of a group or symbols, use the Edit Groups menu item or Ungroup 
the items first.

NOTE: To apply Verify Drawing to all visible layers, make sure to turn Edit 
All Layers On.  If Edit All Layers is Off, then Verify Drawing will be applied 
to the active layer only.

The Clear options provides a fast clean-up tool for removing small stray 
marks on your drawing before you plot, and it is a good way to clear odd 
objects from translated files.  More importantly, it is an analytical tool that 
allows you to examine all cleared objects found before permanently deleting 
them.  Each time a deletion is made, the deleted objects are pasted into a 
new drawing.  If you realize an object has been found that should not be 
deleted, you may paste it back into the drawing.

Verify Drawing...

💬💬

💬💬
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Verify Drawing is a powerful tool. It is important to know how it calculates 
the objects you specify so that it removes only the objects you want removed. 
Below is an explanation of the calculations it executes and the relationship 
between Found and Total Found. 

Suppose you have a drawing containing the following 25 objects:
10	 Lines 		  1”
5	 Circles		  1.5” dia.
5	 Squares		  .75” x .75”
5	 Arcs		  40°, .5” x .5”

Under Type, in the dialog, there are four item specifications: Lines, Arcs, 
Empty Text Blocks, and Objects.  If you select all of the objects and specify 
1” lines to be deleted, clicking Calculate will display the following:

Found		  Total 
10		  10

This indicates when you click OK, a total of 10 items will be deleted and 
that of those 10 items, all are lines 1” in length or shorter.

If, before clicking OK, you also specify 1” Objects to be deleted, clicking 
Calculate will indicate:

Found		  Total 
10		  20

This indicates you have found 10 objects whose bounding box is 1” or 
less, and when you click OK, a total of 20 items will be deleted.  Of those 
20 items, 10 are lines 1” in length or shorter and 10 are objects whose 
bounding box is 1” or less, which represents the 5 squares and the 5 arcs.

Each time you specify a new type of object and click Calculate, Found 
refers to the last additional items specified.  Total Found indicates the total 
number of objects that will be deleted when OK is clicked.

If you choose Objects first instead of Lines, and specify a size of 1”, Calculate 
will include all lines, arcs that fit the specification along with squares, circles, 
polygons; it will treat all items as Objects. You will see:

Found		  Total 
20		  20

Found and Total
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If, before you click OK, you choose Lines and specify 1”, Calculate will 
indicate:
Found		  Total 
10		  20

This indicates that 10 lines with a length of 1” or less have been found 
among the 20 objects.  Starting with Objects and moving up the list of 
Types will give you a breakdown of the number of each type of object fitting 
the specification.

The above explanations indicate that choosing Lines will delete lines only. 
Choosing Objects will delete all objects, including lines and arcs, if size 
specifications fit.

You may specify items to be deleted by selecting a Type.  You may specify 
lines, arcs, empty text blocks, or objects.  Objects includes all objects 
regardless of what they are—lines and arcs, as well as polygons, and circles 
or groups.  An empty text block is defined as any text character that is 
invisible on the screen.  This includes spaces, tabs, and carriage returns.

To delete or clear a specific type of item: 
o	 Use a selection rectangle to define the search area or use the Select All 

command.
o	 From the Tool menu choose Verify Drawing.  A dialog appears.

Specifying Type

o	 Click the check box beside the desired item.  A numerical field will 
appear to the right of Lines, Arcs, and Objects when each is selected.

o	 Enter the size of the item you want removed.  You may specify lines or 
objects with a length of .015” or more and arcs with an angle of one 
degree or larger.  For example, if you select Objects and enter .5”, all 
objects whose largest dimension (height or width) is .5” or less will be 
deleted.

o	 Click Calculate.  If any items fit your specifications, the number found 
will be displayed.
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o	 Click OK.  A new drawing titled Cleared Pieces will be created.  The 
items deleted will be pasted into the new drawing and will remain 
selected.

Once the new drawing appears, you may examine each deleted piece 
individually.  Click in the drawing to deselect the objects.  Activate the 
Edit Window.  Press the left bracket key ( [ ) one time.  One object will be 
selected and reported in the Edit Window.  Using the bracket keys, you can 
step through the objects in the order they were created.

CAUTION: Verify Drawing abides by the active layer’s scale.  If your 
drawing has scaled layers, you should turn Edit All Layers Off and check 
layers one at a time.  Failure to do this will result in the deletion of objects 
which are the correct size at their layer’s scale, but which are smaller than the 
size specified at the active layer’s scale.

NOTE: If you specify a type and size of object and then click Cancel, Verify 
Drawing will retain the specified information until you change it.

⚠

💬💬

Off Page Objects will search for and delete all objects that reside completely 
off the page.  A page is defined as the white drawing area seen on screen 
as defined in the Page Setup dialog and in the Drawing Setup, Size dialog.

To delete using the Off Page Objects function:
o	 Double-click in the drawing area to deselect everything.
o	 From the Tool menu choose Verify Drawing.  A dialog appears.
o	 Click the Off Page Objects checkbox and click Calculate.  The number 

of off-page objects found will be displayed.
o	 Click OK.  A new drawing titled Cleared Pieces will be created.  The 

items deleted will be pasted into the new drawing and will remain 
selected.

Off Page Objects

❗❗
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Empty Text Blocks will search for and delete all text blocks in the drawing 
which do not contain any characters.

Empty text blocks are blocks of text which do not contain any characters 
and are most commonly seen when importing DWG or DXF files due to 
how many other drawing applications handle text.  Empty text blocks can 
create unexpected printing results and serve no practical purpose in the 
drawing.

To delete using Empty Text Blocks:
o	 Double-click in the drawing area to deselect everything.
o	 From the Tool menu choose Verify Drawing.  A dialog appears.
o	 Select the Empty Text Blocks check box and click Calculate.  The 

number of empty text blocks will be displayed.
o	 Click OK.  A new drawing titled Cleared Pieces will be created.  The 

items deleted will be pasted into the new drawing and will remain 
selected.

Duplicate Objects Duplicate Objects will search for and delete all stacked multiple duplications.

Stacked multiple duplications are objects that have been duplicated on one 
layer using the Duplicate command, but not distributed.  They will appear 
as one item because they are stacked directly over each other.

To delete using the Duplicate Objects function:
o	 Double-click in the drawing area to deselect everything.
o	 From the Tool menu choose Verify Drawing.  A dialog appears. 
o	 Select the Duplicate Objects check box and click Calculate.  The 

number of duplicate objects will be displayed.  The original object that 
was duplicated will not be deleted.

o	 Click OK.  A new drawing titled Cleared Pieces will be created.  The 
items deleted will be pasted into the new drawing and will remain 
selected.

Objects that are drawn directly above each other, but on separate layers, are 
not considered multiple duplications.  For example, if you draw a square, 
duplicate it and then cut and paste it onto another layer directly above 
the original object, Verify Drawing will consider these as single objects on 
separate layers and not multiple duplications.

Empty Text Blocks
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Lines will search for and delete all lines in a drawing smaller than a specified 
length.

To delete using the Lines function:
o	 Double-click in the drawing area to deselect everything.
o	 From the Tool menu choose Verify Drawing.  A dialog appears.
o	 Select the Lines checkbox, enter a line length in the Line field and click 

Calculate.  The units used to specify line length match the Drawing 
Setup, Units. 

o	 The number of lines smaller than the specified line length will be 
displayed. 

o	 Click OK.  A new drawing titled Cleared Pieces will be created.  The items 
deleted will be pasted into the new drawing and will remain selected.

Lines

Arcs

Objects

Arcs will search for and delete all arcs in a drawing smaller than a specified 
arc angle.

To delete using the Arcs function:
o	 Double-click in the drawing area to deselect everything.
o	 From the Tool menu choose Verify Drawing.  A dialog appears.
o	 Select the Arcs checkbox, enter an arc angle in the Arcs field and click 

Calculate.  The units used to specify arc angle match the Drawing 
Setup, Units.

o	 The number of arcs smaller than the specified arc angle will be displayed.
o	 Click OK.  A new drawing titled Cleared Pieces will be created.  The items 

deleted will be pasted into the new drawing and will remain selected.

The Arcs function only finds arcs smaller than a specified arc angle.  To 
search for arcs smaller than a specific radius use the Objects function.

Objects will search for and delete all objects in a drawing smaller than a 
specified size. 

The Objects function will search for all object types including groups, symbols, 
rectangles, circles, arcs, lines and Béziers which are smaller than a specified size.

To delete using the Objects function:
o	 Double-click in the drawing area to deselect everything.
o	 From the Tool menu choose Verify Drawing.  A dialog appears.
o	 Select the Objects checkbox, enter a size in the Arcs field and click 

Calculate.  The units used to specify size match the Drawing Setup, Units.
o	 The number of objects smaller than the specified arc angle will be 

displayed.
o	 Click OK.  A new drawing titled Cleared Pieces will be created.  The items 

deleted will be pasted into the new drawing and will remain selected.
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The Arrange menu is used to arrange objects in relation to each other and 
the drawing itself.  From this menu, you can move objects from within 
levels of the current layer of the drawing and multiple selected objects can 
be grouped and treated as one object.  

Once drawn, objects can be protected from further modification by locking 
them.  

In addition, other commands give you the ability to align objects with 
respect to themselves or specified points on the drawing. 

Finally, objects can be rotated with great precision and ease. 

The following section describes each of the Arrange menu commands in 
detail.

PowerCADD remembers the order in which objects were drawn, essentially 
stacking objects one upon the other as they are drawn on the active layer.   
Objects drawn first are considered to be on the bottom-most level (bottom 
of the stacking order).  Objects drawn last (most recent) are considered to 
be on the top level (top of the stacking order).  The object stacking order is 
unique for each layer in the drawing. 

The commands Bring to Front, Send to Back, Bring Forward, and Send 
Backward give you the capability to move objects within levels of the 
currently selected layer of the drawing.  For example, in a drawing, the most 
recently drawn object will, on occasion, cover other previously constructed 
shapes.  This may require shifting the covered objects to a higher level so 
they can be modified.  

When objects are moved up or down a level you are adjusting their stacking 
order.  

When choosing Bring Forward or Send Backward, an object moves up or 
down the object stacking order, one position at a time, relative to other 
objects on the same layer.  When choosing Bring to Front or Send to Back, 
an object moves to the top-most or bottom-most position in the layer stack 
relative to objects on the same layer.

Arrange Menu
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The following diagram illustrates the relationship between levels and layers 
in a drawing.

TIP: The following items in the Arrange menu also appear in the main 
drawing window toolbar: Bring to Front, Bring Forward Send to Back, 
Send Backward, Group, Ungroup, Lock, Unlock, and Show/Hide Shadows.

NOTE: It is important to understand the difference between drawing layers 
(as they appear in the Layer Window) and how objects are layered relative to 
each other as they are drawn.  Objects may be moved forward or backward 
relative to other objects on the same layer.  Layers may be moved up or 
down relative to other layers in the drawing.

💡💡

💬💬

Bring to Front Bring to Front brings the selected object to the top level of the active layer. 

The most recently drawn object is always in the top level of the current 
layer of the drawing.  Each object subsequently drawn replaces the original 
position of the objects drawn earlier, thus forcing them down a level in the 
object stacking order.

To manually bring objects to the top level of the active drawing layer:
o	 Select the object to be brought to the front (top) level of the active 

drawing layer. 
o	 Choose Bring to Front from the Arrange menu.
o	 The selected object will now be placed ‘on top’ of previously drawn 

objects, becoming the top-most object in the stacking order on that 
layer.

If you bring more than one object to the front, those objects will retain the 
order with respect to each other, but they will be moved to the top of the 
current layer.
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Bring Forward/Send Backward allows you to change the stacking order of objects 
up or down one level at a time relative to other objects on the same layer. 

To use Bring Forward/Send Backward:
o	 Select the object you wish to rearrange.
o	 Choose Bring Forward or Send Backward from the Arrange menu.
o	 The selected object will be moved up or down the object stacking order 

depending on which command you select.

Bring Forward
Send Backward

Move To Layer

Send to Back puts the selected item at the bottom level of the active layer. 

To send an object to the back (bottom) level of the current layer:
o	 Select the object to be sent to the back level of the drawing.
o	 Choose Send to Back from the Arrange menu.
o	 The selected object will now be placed ‘behind’ all previously drawn objects.

When you send items behind a large filled object, the object sent to back 
will no longer be seen.  Therefore, if you need to bring it back to the front 
later, you must move the obstructing objects or not fill them.

If you need to send an object to the back that you know must be brought forward 
later, draw a small object to the side of the drawing and group it with the object 
you wish to move and send the group to the back.  To bring the object back to the 
front, select the object you grouped with it and choose Bring to Front.  This way, 
you are able to retrieve the object without disrupting the drawing.

Send to Back

Allows you to select which visible drawing layer an object should be moved to.  
The layer the object is currently on, and hidden layers are dimmed (unavailable) in 
the list.  The list of layers presented is from the active drawing.  Moving an object 
removes it from its current layer onto the selected layer in the same X,Y location. 

To send an object to a specific drawing layer:
o	 Select the object to be moved to a new layer.
o	 Choose Move to Layer from the Arrange.
o	 Select a layer name from the list of layers.

The selected object will now be moved to the new layer in their original 
X, Y location.  If multiple objects were selected, they are all moved to the 
same chosen layer.  If Edit All Layers is on, and the objects selected were on 
different layers, they are all moved to the chosen layer.

TIP: Move to Layer is also available from a contextual menu when you 
Control- or right-click on an object. The contextual menu also includes 
a special menu item, Go To Layer, which allows you to change the active 
drawing layer.  See Contextual Menus earlier in this chapter for information.

💡💡
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Group takes several selected objects and groups them into one object.

Grouping objects allows you to manipulate more than one object at a time 
as a single item.  

NOTE: This command is not the same as using the Combine tool.

Group collects items together in the PowerCADD drawing and locks their 
relationship together.  Grouped items cannot be individually changed until 
first ungrouped or by using the Edit Groups menu item.  Grouped items 
are moved and stretched together.  Stretching modifies all of the items in 
the group proportionally to each other.  Groups may be stretched in both 
the X and Y direction in unequal proportions.  Stretching X and Y does not 
have to be the same amount.

To group multiple selected objects:
o	 Select the objects to be grouped.
o	 Choose Group from the Arrange menu. 
o	 The objects will now be grouped and considered as one object. 

There is no limit to the number of objects that can be grouped.  Groups 
may also be nested within groups.  If Edit All Layers is On, only selected 
objects on the same layer will be grouped.

Grouped objects may be ungrouped with the Ungroup command.

When objects are grouped, the resulting group takes the level position of 
the uppermost object.  For example, if the top-level object is grouped with 
the bottom level object, the resulting group will be present on the top level 
on the current drawing layer.  Undo does not work with Group.  Therefore 
once the objects have been grouped, and the level placement is lost, you 
must return them to the correct level individually if level placement is 
critical.

NOTE: Attributes such as line weight and dashes for grouped objects are 
not specified by checkmarks in the menus.  Although all objects in the 
group may be modified in unison (color, line weight, etc.), you cannot 
select a group and look at the group attribute, because each object in the 
group maintains its own unique attributes.

Group

💬💬

💬💬
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Ungroup separates previously grouped objects so they can be treated as 
individual objects again. 

To Ungroup previously grouped objects:
o	 Select the object to be ungrouped.
o	 Choose Ungroup from the Arrange menu.
o	 The object will now be ungrouped into its original objects. 
o	 If group contained multiple nested groups, continue applying the 

Ungroup menu item until you hear a beep, indicating all items have 
been ungrouped.

Ungroup

Lock/Unlock Lock allows you to lock objects so they cannot be altered until you Unlock 
them. 

To use Lock:
o	 Select an object to be locked.
o	 Choose Lock from the Arrange menu. 
o	 The object can no longer be resized or moved.

To Unlock:
o	 Select an object to be unlocked.
o	 Choose Unlock from the Arrange menu.
o	 The object has now been returned to a normal state.

If you attempt to move, rotate, scale or other wise manipulate locked 
objects, the following dialog box will appear asking you to confirm the 
operation.  Clicking OK allows you to complete the operation and the 
objects are automatically locked again when the operation is complete.

Moving Locked Objects
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Temporarily: Checking this box will unlock the objects, clicking OK will 
complete the current operation.  The objects are then locked again when 
the operation is complete.  For example, if you attempt to move multiple 
objects, one of which is locked,  Temporarily will unlock the objects to 
complete the move then lock it again in its new location.

Permanently: Checking this box will unlock the objects, clicking OK will 
complete the operation.  The objects remain unlocked when the operation 
is complete.

Cancel: Click to abort the current operation, any locked objects will remain 
locked.

This capability is helpful when working under crowded conditions.  If 
you have trouble selecting an object because of objects in close proximity, 
lock those objects.  Once locked, these objects cannot be moved until you 
unlock them. 

If you attempt to modify a locked object (examples: change attributes, scale, 
or rotate an object), the following dialog box will appear asking you to 
confirm the Unlock operation.

Modifying Locked Objects

Hide allows you to hide selected objects in a drawing.  This can be helpful if 
you are working in a crowded drawing and need to temporarily hide objects 
to speed up the drawing or editing process.

To use Hide:
o	 Select the objects.
o	 Choose Hide from the Arrange menu.
o	 The selected objects are not drawn on screen. 
Objects remain hidden until you choose Show All from the Arrange menu.

Hide
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Show All allows you to show all hidden objects in a drawing. 

To use Show All:
o	 Choose Show All from the Arrange menu.
o	 All objects hidden using Hide from the Arrange menu are displayed 

on screen.

If there are no hidden objects in a drawing this menu item is dimmed. 

To globally Show or Hide only Shadows, see View Menu, Hide/Show 
Shadows discussed later in this chapter.

NOTE: Choosing Print from the File menu when objects are hidden will 
bring up a warning dialog.  Clicking OK will continue the print operation 
and the hidden objects will not be printed.  To print the hidden objects, 
click Cancel to abort the print operation.  Choose Show All from the 
Arrange menu and print the drawing.

CAUTION: The hidden state of objects is remembered when a drawing 
is saved and closed.  The next time you open the drawing, the objects will 
be still be hidden.  If you think information is missing in your drawing 
missing don’t panic!  Check the Arrange menu and choose Show All to see 
all previously hidden objects.

Show All

💬💬

⚠

!
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Align allows you to line up two or more drawing objects with respect to 
their centers, sides, bottoms, and tops.

To align two or more selected objects:
o	 Select the objects you wish to align.
o	 Choose Align from the Arrange menu.  The align submenu appears as 

shown on the left.
o	 Choose the alignment you desire and release the mouse button.
o	 The selected objects will be redrawn according to their new alignment 

orientation. 

Align

Original R es ult

A lign T ops

A lign Middles

Original R es ult

Original R es ult

A lign L eft S ides

A lign C enters

Original R es ult

TIP: Locked objects do not move during an align operation.  Selected 
objects are realigned relative to the anchored (locked) object.💡💡
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Align to Grid snaps all selected objects to the grid, when the grid is turned 
on.

To align objects to the grid:
o	 Select the object(s) to be aligned to the current grid.
o	 Choose Align to Grid.

See Drawing Setup, Snap in the Layout menu to turn Grid snap Off and 
On.

CAUTION: Align to Grid aligns all corners (vertices) of the selected object 
to the grid.

Align to Grid

Align...

o	 Choose the desired alignment by selecting the appropriate buttons, 
then click OK.

o	 Align will shift the objects into place.

In the dialog box you have many options from which to choose.  You may 
align objects horizontally, vertically, or a combination of the two.  The 
objects can also be aligned to the grid, to an object, to a point, or to the 
next mouse click.  The example window provides immediate visual feedback 
based on your specified options.

Align gives you a precise method of lining up and distributing objects.

To use Align:
o	 Select the objects you wish to align.
o	 Choose Align from the Arrange menu and the following dialog will 

appear:

⚠

!
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The vertical alignment radio buttons are located along the right side of the example 
window.  These buttons allow you to distribute, cancel vertical alignment, or align 
tops, centers, and bottoms.  These options apply only to the vertical alignment 
but can be used in conjunction with the horizontal alignment.

Distribute allows you to place the alignment points an equal distance apart along 
the vertical axis.  For example, if you specify the objects are to be aligned by tops, 
the tops of the objects will be aligned in such a manner they are equally spaced.  
An easy way to view the function of Distribute is to select four objects.  Align the 
objects and Distribute tops.  Measure top to top of each object starting at the top-
most object.  You will find the tops of all objects are spaced evenly apart.

None allows you to cancel an alignment.  This is helpful when you wish to 
align only one axis.

Top allows you to align the tops of all selected objects.  If you are aligning 
multiple objects to the top, all objects will be aligned with the upper-most 
selected object.  This upper object will not move and all other objects will 
snap into alignment with it.

Center allows you to align the object’s top/bottom centers.  All selected 
items will form a bounding rectangle.  PowerCADD will calculate the 
centerline of this bounding box and align all selected items to the centerline.

Bottom allows you to align the bottoms of all selected objects.  If you are 
aligning multiple objects to the bottom, all objects will be aligned with the 
lower most selected object.  This lower object will not move and all other 
objects will snap into alignment with it.

Height allows you to align objects so the free space between the selected 
objects is equalized.  When aligning multiple objects, the top-most and 
bottom-most objects do not move vertically.  In the example below notice 
the free space between the original object locations are not the same.  The 
free space between the realigned objects is equal.

Vertical Alignment

equal

equal

equal

original object
locations

Horizontally: No Distribution, Left Align
Vertically: Distribute, Height

original left most rectangle

realigned
objects

baseline
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The horizontal alignment radio buttons are located along the bottom of the 
examples window.  These buttons allow you to distribute, cancel alignment, 
or align left, centers, or right sides.  These options apply only to the horizontal 
alignment, but can be used in conjunction with the vertical alignment.

Distribute allows you to place the alignment points an equal distance apart. 
For example, if you specify the objects are to be aligned by left, the objects will 
be distributed in such a manner the left side is equally spaced.  An easy way 
to view the function of distribute is to select four objects.  Align the objects 
and Distribute left.  Measure the left to left of each object, starting with the 
left-most object on the page.  You will find the lefts are spaced evenly apart.

None allows you to cancel an alignment.  This is helpful when you wish to 
align only one axis.

Left allows you to align the left sides of the selected objects.

Center allows you to align the objects’ left/right centers of the selected 
objects.  All of the selected items will form a bounding rectangle.  
PowerCADD will calculate the vertical centerline of this bounding box and 
align all selected items to the centerline.

Right allows you to align the right sides of all selected objects.  If you are 
aligning multiple objects to the right, all objects will be aligned with the 
object located to the extreme right.  This object will not move and all other 
objects will snap into alignment with it.

Width allows you to align objects so the free space between the selected 
objects is equalized.  When aligning multiple objects, the left most and 
right most objects do not move horizontally.  In the example below notice 
the free space between the original object locations are not the same.  The 
free space between the realigned objects is equal.

Horizontal Alignment

Horizontally: Distribution, Width
Vertically: No Distribution, Bottom Align

original object locations

eq
ua

l

eq
ua

l

eq
ua

l

original right most and bottom most object
realigned objects
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When you align objects to center on both axes, PowerCADD will calculate 
a bounding rectangle encompassing all selected objects.  The exact center of 
the bounding rectangle will be found and the centers of all objects will be 
aligned to the center of the bounding rectangle.

When you are aligning objects to a specific point, all objects will be aligned 
to that point.  For example, if you align all objects to the top left point, all 
objects will be aligned with the upper left most object on the screen.  This 
upper left most object will not move and all selected objects will snap into 
alignment with the specified point on that object. 

The Example Window

The Example Window allows you to view the type of alignment before it is 
executed.  If you disable one axis and select the different alignment buttons, 
you can get a better idea of how the items are aligned.  For example, if you 
disable the horizontal alignment and select the left align, all example objects 
will move to the left.  Center and right work the same way as the buttons on 
the horizontal alignment, if the case is reversed.  If both axes are activated, 
all of the example objects align to the specified point on both the vertical 
and horizontal axis.

Align Menu To Each Other will align the objects as specified by the location table in 
the dialog box.

To Next Mouse works the same as point alignment except instead of 
entering X,Y coordinates, you specify the point of alignment by clicking on 
the drawing in the location of desired alignment.

To Specified Point will align the objects as specified by the location table, 
but you specify the exact location of the alignment point by entering X,Y 
coordinates

To Grid allows you to align all selected objects to the grid.  To align to grid, 
specify the alignment point of the objects using the buttons below and to 
the right of the example window.  The point you specify, such as bottom 
right, will snap to the nearest grid division intersection.  For example, if the 
grid is set to one inch, there will be a grid division intersection at every one-
inch increment on the screen.

Objects are aligned by their bounding rectangle.  When you align an object 
to a single axis, you are aligning either a side of the bounding rectangle 
or a line running through the center of the bounding rectangle on the 
perspective alignment axis. (Center aligns to the centerline.)  When you 
align an object to both the vertical and the horizontal axes, you are aligning 
either specific handles of the bounding rectangle or the center point of the 
bounding rectangle.  This is most apparent when you align the top left 
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points of a circle and a rectangle. The exact corners of the objects are not 
aligned, but the top left handles of their bounding rectangles are.

When you activate Distribute on both the vertical and horizontal axes, the 
specified alignment points will be spaced evenly apart both vertically and 
horizontally.

Rotate Rotate permits the rotation of selected objects by dragging the rotation 
cursor in the desired direction.

To rotate a single object or grouped objects:
o	 Select the object to be rotated.
o	 Choose Rotate from the Arrange menu or press R.
o	 When you see the rotation target cursor in the drawing area, click to 

set the center of rotation.
o	 Click to grab the objects to be rotated from a specified point.
o	 Drag the mouse to rotate the items.  The original objects are also shown 

for context.

o	 When object is positioned as desired, release the mouse.  The object 
will be rotated to the new position.

o	 Pressing the Tab key when dragging to rotate the objects will take you 
into the Edit Window.  Release the mouse, type the desired angle or 
rotation and press the Enter key.  The objects are rotated the angle 
specified in the Edit Window.

Dynamic snapping is in effect for all portions of the rotation operation.  
You may use the snap command to specify the center of rotation, where 
you grab an object for rotation or to complete the rotation operation.  This 
makes it very easy to dynamically rotate objects to match existing drawing 
geometry without having to calculate or know the rotation angle.
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The following keyboard commands can modify the degree of 
rotation:
o	 The Shift key constrains the rotation to the snap angles defined in 

Drawing Setup.
o	 Command performs a free rotation with no preset angle increments.
o	 If no key is pressed the rotation automatically steps in one degree 

increments.
o	 The Tab key suspends the rotation operation and enters a specific value 

in the Edit Window as described above.

Rotate... Rotate permits the rotation of selected objects by specifying a precise angle 
using a dialog box.  You can rotate objects about their centers, next mouse 
click or a known x,y coordinate point in the drawing.

To specify a rotation angle:
o	 Select the object to be rotated.
o	 Press the Option key while choosing Rotate from the Arrange menu.
o	 The Rotate dialog will appear.

o	 Type the number of degrees, minutes, and seconds you wish the 
object to be rotated.  A positive value rotates objects counterclockwise; 
negative values produce a clockwise rotation. 

o	 In addition, specify the point about which you prefer the object 
to rotate, such as the center.  If you wish to specify a specific X,Y 
coordinate, click User Point and enter values in the X and Y fields.

Degrees, minutes, and seconds may be entered as an angle, even though unit 
accuracy is set to decimal degrees.  For example, these are all valid entries:

12˚ 30’ 30”

12 30 30

12 30’

12 30 30”

360/5
Decimal degrees may be entered when unit accuracy is set to degrees, 
minutes, and seconds.  Any dialog box expecting angular dimensions may 
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be used as an angle conversion calculator, for example in a drawing setup 
for degrees, minutes and seconds, you can enter angles in decimal degrees.   
When the dialog box is opened again the angle will be converted to the 
degrees, minutes and seconds.

o	 Type in the X,Y values you wish to be the center of rotation.
o	 Type in the rotation angle.  The value of the angle may be entered in 

either decimal degrees or degrees, minutes, and seconds, depending 
upon your preference.  Objects can be rotated by angle or by pitch.  
Pitch is rise over run (slope) and is used in the construction trades.

o	 You may rotate the object about the next mouse click in the drawing 
area.  Snap commands may be used to specify a precise location for the 
center of rotation.

o	 Upon specifying the requested values, press the Return key or click 
OK.  The object will be redrawn according to the specifications you 
provided in the dialog.

For rotating multiple items, follow the directions above, but first; select 
all the objects to be rotated.  Rotating multiple items about object center 
will rotate all items about the center of their extended bounding box (i.e. it 
rotates all objects as if they were grouped).  A new bounding box center is 
calculated each time an item is rotated.  Successive rotation can appear to 
be about a different center depending upon the object. 

TIP: To have objects retain their position relative to each other and rotate 
about their individual centers, use ‘Rotate by Centers’ discussed later in this 
chapter.

Pitch is a common term in the construction industry.  Pitch represents the 
slope (X/Y) and is usually expressed as a ratio (5/12), but may be expressed 
as the decimal equivalent.

💡💡



Menus346

When working with rotated objects, you may use the Edit Window to 
realign the objects.

To align objects through the Edit Window:
o	 Make sure the Edit Window is open.
o	 Select the object you wish to rotate.
o	 Press the Tab key to activate an edit field.  The selected cell is indicated 

by a border.  The Tab key will move you through the cells.
o	 Tab to the Angle field.
o	 Enter an angle of 45˚.
o	 Press the Return or Enter key and the object will snap to 45˚.

This method can be used to rotate objects to any angle.  The angle you enter 
will correlate with the currently active measurement system: Cartesian, 
Gradient, etc.  For example, if you have a rectangle rotated to 314˚, and you 
edit-rotate it 315˚, there would only be a change of one degree.  (The object 
is not rotated from its present location; it is rotated from zero degrees.)  
This makes rotating objects very simple because you do not have to figure 
out how many degrees, positive or negative, you need to move to reach the 
desired point.

Editing Rotated Ellipses, 
Arcs and Objects
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Rotate by Centers permits the rotation of multiple objects about their 
unique object center points.  Rotate by Centers is only available if two or 
more objects are selected.  To rotate a single object about its center use the 
Rotate or Rotate To menu items.

To rotate multiple objects about their unique center points:
o	 Select the objects to be rotated and choose Rotate by Centers from the 

Arrange menu.
o	 The cursor changes to a target cursor.
o	 Click the mouse anywhere in the drawing window and drag to 

dynamically specify a rotation angle.  The Edit Window will display 
the current rotation angle.  Click to complete the rotation operation.

o	 To constrain the rotation to preset snap angles, press the Shift key 
when dragging to specify the rotation angle.

o	 To specify an exact rotation angle, press the Tab key when dragging 
to specify the rotation angle.  The Edit Window will activate.  Type a 
rotation angle and press the Return key.

Rotate by Centers

Rotate To Zero

Rotate Left

Rotated Ellipse Rotate to Zero

Rotate to Rotate to is a submenu for rotating to 0˚ or 90˚, left, and right.

Rotate to Zero rotates rectangles, arcs, ellipse, and text to zero degrees.

To rotate a rectangle, arc, ellipse, or text to zero degrees:
o	 Select the object(s) to be rotated.
o	 Choose Rotate to Zero from the Arrange menu.
o	 The object’s orientation will place it at zero degrees.

A polygon, for example, cannot be rotated back to zero degrees.  You can 
use Undo to counteract an unintended rotation. 

Rotate Left rotates the currently selected object 90˚ to the left— 
counterclockwise.

To rotate an object 90˚ to the left:
o	 Select the object(s) to be rotated.
o	 Choose Rotate Left from the Arrange menu.

Rotate Right rotates the currently selected object 90˚ to the right—
clockwise.

To rotate an object 90˚ to the right:
o	 Select the object(s) to be rotated.
o	 Choose Rotate Right from the Arrange menu.

Original Object Rotate Left

Original Object Rotate Right

Rotate Right
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Flip Horizontal reverses drawn objects horizontally.

To flip an object horizontally:
o	 Select the object(s) to be flipped.
o	 Choose Flip Horizontal from the Arrange menu.

Flip Vertical reverses drawn objects vertically.

To flip an object vertically:
o	 Select the object(s) to be flipped.
o	 Choose Flip Vertical from the Arrange menu. Original Object Flip Vertical

Flip Horizontal

Original Object Flip Horizontal

Flip Vertical
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The Layout menu permits the setup and modification of your drawing 
environment, including:

o	 Layers, Sheets and other drawing layer management options
o	 Guidelines
o	 Drawing Units
o	 Custom tool palettes
o	 Drawing Setup parameters including scale, units, drawing size and 

others

Layout Menu

Layer... Layer allows you to create, arrange, and edit layers.  You can specify a 
variety of layer parameters including changing layer status (hidden, visible, 
dimmed) and layer attributes (scale, color, locking, transparency).

Layers are the electronic equivalent of overlays or acetates used in manual 
drafting.  Traditionally, when using these transparent or semi-transparent 
sheets, the draftsperson would trace objects from previously drawn pages 
onto a new page and then add additional information to the tracing.  For 
example, a set of architectural floor plans generally consists of a series of 
overlays of the basic floor plan.  Once the floor plan is established, the 
walls are traced and used as a base for plumbing, electrical, heating, ceiling, 
foundation plans, and so on.

While manually tracing was traditionally more convenient than measuring 
and redrawing, an efficient use of layers in PowerCADD will far surpass all 
manual drawing overlay conventions.

Layers should be used for two important reasons:
o	 Speed. Organizing the elements of a drawing with layers allows you to 

hide layers that are not being used.  Since only the visible layers will 
redraw on the screen as changes are made, the extra time, which would 
normally needed to redraw everything, can be significantly reduced.  
Planning for and using layers requires a bit more thought in the short 
term, but will be very beneficial as your drawings get larger and more 
complicated.

o	 Drawing Management. Using a separate layer for elements like, walls, 
dimensions, doors, windows, notes, and so on will allow you to hide 
or dim elements which might otherwise be in your way while drawing.  
Using separate layers, Sheet Setups can be saved which remember 
your layer order and status, allowing you to print only specific layers 
at a time; an entire set of working drawings can be stored in a single 
drawing file but separated using many layers.

Anchor
[Layer]

Anchor
[LayoutMenu]
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A single PowerCADD file can have almost unlimited layers, depending 
upon drawing complexity and the memory capacity of the Macintosh 
computer.

Objects can only be created on the active layer.  Only one layer may be 
active at one time.  The active layer’s name will be displayed in the drawing 
window’s title bar beside the drawing’s name.

Editing objects on layers other than the active layer can only take place 
when Edit All Layers is On.

For more information on Edit All Layers, see Edit All Layers.

NOTE: To access and modify layers, you must have the Layer Window 
External loaded. If you do not, Layers will not appear under the Layout 
menu.

💬💬

Creating and Re-
naming Layers

To create a layer: 
o	 Choose Layers from the Layout menu and the floating Layers window 

will appear. 
o	 Click New.  A new layer will appear in the list.  The new layer’s name 

will appear in the name immediately below the layer list.
o	 Rename the layer as desired by typing the layer name you wish to use. 

As you enter the layer name, the modification appears in the layer list.

To add more layers, continue to click New and name them.  New layers are 
always appended to the top of the layer stack and made the active drawing 
layer, but can be moved to any position as described later in this section.

To change the name of an existing layer:
o	 Select the layer name in the Layers window.
o	 Use the mouse to highlight the text in the layer name field and type 

the new text.
o	 The changes are reflected instantly in the Layers window.

Locked layer names cannot be edited until unlocked.  See the Layer 
Attributes section of this chapter for more on setting layer attributes and 
locking/unlocking layers. 

!
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When you choose Layers from the Layout menu or select Layers from the 
Windows submenu of the File menu, the following window will appear:

The Layers window floats on top of your drawing and can be moved and 
resized.  

To adjust the Auto-Fade settings for the Layers window, Control- or right-
click anywhere in the body of the Layer window except the Layer List.  The 
following sheet will be appended to the Layer Window.  

Auto-Fade

Make the desired changes and click Done.
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The layer list displays the order and attributes of the layers.  Layers can be 
completely visible, hidden, or dimmed.  Many layers can be visible at one 
time.  Layers may be rearranged, locked, assigned colors, or assigned scales.

The order of the layer list indicates the top-to-bottom stacking order in the 
drawing.  This is more obvious when adding a new layer, because it goes to 
the top of the list.  Similarly, objects drawn on the top layer will appear in 
front of the objects on layers below.

NOTE: If your mouse has a scroll wheel, you may use the scroll wheel to 
move up and down the layer list if it is too long to display in the current 
Layer Window.  If you do not have a scroll wheel mouse use the scroll 
arrows or drag the scroll bar to move up and down the layer list.

Layer List

💬💬

Layer List Column Display You can customize which columns are displayed in the Layer List.  

To select which columns are visible:
o	 Control- or right-click in the layer list. 
o	 Choose the name of the column from the contextual menu to show or 

hide a column.  Checked items in the list are displayed.

The layer Name Column cannot be hidden
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The active layer is indicated by a checkmark in the Active Layer Column. 

To set the active layer:
o	 Click in the Active Layer Column beside the desired layer. 

Active Layer

💡💡

Other ways to change the active layer is are to click on the Layer Up or 
Layer Down arrows in the lower left corner of the document window, or 
use their keystroke equivalents, selecting the layer name from Layers in the 
Set Layer, Layout menu or from the Layer list located at the bottom left of 
the drawing window. 

A padlock appears in the Active Layer Column for layers with a Locked 
attribute setting.

TIP: When setting the Command keys, you might want to consider the 
convenience of the L key, the Comma key and the Period key, which are located 
together, for calling up the Layer window and toggling the active layer.

Visibility Column

The Visibility Column contains bullets indicating a layers status as visible, 
dimmed, or hidden.  A visible layer is indicated by a bullet.  A dimmed or 
dotted bullet indicates a dimmed layer; if no bullet is displayed, the layer 
is hidden or invisible.  Repeatedly clicking these bullets will cycle through 
visible, dimmed, and hidden settings.  A hidden layer will become visible 
automatically if it is made active.  Sheet setups remember a layers visibility 
status.

To modify a layer’s visibility status:
o	 Choose Layers from the Layout menu and the floating Layers window 

will appear.
o	 Set the status by clicking in the Visibility Column next to the layer 

name.

To set the visibility status of multiple layers at the same time Shift-click to 
select sequential layers, or Command-click to select multiple nonsequential 
layers, and click in the visibility column next to a selected layer name.

NOTE: Filled objects on dimmed layers will appear transparent.💬💬
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The Snap Column allows you to specify whether you can snap to objects on 
the specified layer.  If snap indicator icon next to a layer name indicates you 
can snap to objects on that layer.  No icon indicates objects on that layer 
cannot be snapped to.  By default all new layers have the snap status turned 
on.  Sheet setups remember a layers snap status.

To set the snap status of multiple layers at the same time:
o	 Shift-click to select sequential layers, or Command-click to select 

multiple nonsequential layers, and click in the snap column next to a 
selected layer name.

Snap Column

The Print Column allows you to specify whether information on a specific 
layer should be printed.  A printer icon next to a layer name indicates the 
layer will print.  No icon indicates the layer will not print.  By default all 
new layers have their print status turned on.  Sheet setups remember a layers 
print status.

To set the print status of multiple layers at the same time:
o	 Shift-click to select sequential layers, or Command-click to select 

multiple nonsequential layers, and click in the print column next to a 
selected layer name.

Print Column

Name Column

The Name Column displays the name of a layer as entered in the Layer 
Name field.  Layer scale or color attribute settings are reflected in the 
displayed layer name. 

To set the Layer Attributes for multiple layers at the same time:
o	 Shift-click to select sequential layers, or Command-click to select 

multiple nonsequential layers, and double click on a selected layer 
name.

Moving Layers To move a layer to a different position in the stack, place the cursor on the 
layer’s name and press.  When the cursor changes drag the layer to the new 
position in the list.

Moving layers up and down in the stack is just like setting the overlay order 
in manual overlay drafting.  Sheet setups can be used to save the layer order 
allowing you to use a single file for more than one drawing.  See Sheets later 
in this chapter for more information.
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The advanced layer attributes setting including Layer Locking, Layer 
Color, and Layer Scale are intended to let you set certain parameters for a 
drawing before you begin the drawing process.  You should plan ahead and 
thoroughly understand the advanced features.  Take time to consider how 
these layer attributes will be used in your office and how they will affect 
others who may receive your drawings.  Establish standards and inform 
everyone.

TIP: To set the Layer Attributes for multiple layers at the same time Shift-
click to select sequential layers, or Command-click to select multiple 
nonsequential layers, and double-click on a selected layer name.

TIP: Layer Attribute settings, with the exception of Layer Scale, are 
remembered with Sheet Setups.  For example a layer could be locked, 50% 
opacity with Sheet Setup 1 and be unlocked, 100% opacity with Sheet 
Setup 2. 

NOTE: If you have been using the Smart Layers External in previous 
versions of PowerCADD to control Layer Pen Color and Layer Scale in your 
drawings, you can quickly reset the drawings for use with Layer Attributes.  
Simply follow the instructions for setting Layer Pen Color and Layer Scale 
for the appropriate layers in your existing drawings as needed. 

CAUTION: When using the advanced layer attributes, they will control 
such things as pen color and scale—automatically.  Therefore, you should 
be alert to the conditions that will exist when drawing in this smart 
environment.  We have indicated, where applicable, some of the conditions 
you should be aware of when using these powerful layer attributes.  Because 
we cannot begin to address all of the possible conditions, which could exist 
in your drawing environment, it is up to you, the user, to be aware of the 
settings of the layer attributes when drawing and editing, especially pen 
color and scale.

Modifying Layer 
Attributes

Editing Layer Attributes To edit a layer’s attributes:
o	 Choose Layer Window from the Window menu and the Layers floating 

window will appear.
o	 Select the layer name and click Edit (or double-click the layer name) 

and the Layer Attributes dialog will appear.
o	 Set the desired layer attributes and click OK.

The name column in the Layer window will update to reflect the attribute 
setting.  If a layer color was specified, the drawing window will update to 
reflect the color change.

💡💡

⚠

💬💬

💡💡
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Locked will lock all objects on the selected layer.  When a layer is locked, you 
will not be able to add, delete, or modify its objects in any way.  However, 
you will be able to snap to objects on a locked layer when drawing on other 
layers.

To lock the selected layer:
o	 Click Locked. A checkmark will appear in the checkbox indicating the 

layer is locked.
o	 Click OK.

A padlock icon will be displayed beside the layer’s name in the layer list.  
Also, an “L” will be displayed beside the layer’s name when the layer list 
is accessed from the Set Layer menu.  The status of a locked layer may be 
changed to visible, dimmed or hidden by clicking in the status column next 
to the layer name.

Locking/Unlocking 
Layers

To unlock a locked layer:
o	 Select the locked layer and click Edit.
o	 Uncheck the Locked box and click OK. 

NOTE: The active layer cannot be locked.  When the active layer is selected, 
the Locked attribute will be unavailable.💬💬
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Color will assign a specified pen color to a layer.  Once a layer’s pen color is 
established, objects drawn on the layer will assume the layer’s color attribute 
automatically.  The Layer Visibility Status indicator will display in the 
selected color.  To also display the Layer Name in the selected color check 
Show Layer Color in Name.

NOTE: Layer color attributes override tool attribute settings for pen color, 
fill colors are not modified.  If you can’t seem to change an object’s pen color, 
check to see if a layer color has been assigned to the layer the object is on.

Individual layer color can be helpful for large drawings where color-coding 
for clarity is necessary, like wiring diagrams, facility plans, and so on.

Layer Pen Color

To assign a color to the selected layer:
o	 Click Color.
o	 Place the cursor on the square color swatch to the right of Color and 

click.  The current PowerCADD color palette will appear.
o	 Select a color and click OK.

CAUTION: Colors displayed in the PowerCADD color palette are affected 
by Preferences, Global Attributes. 

To assign a color to the selected layer from the MacOS color panel:
o	 Select Color. 
o	 Select the colored circle next to Color.  The MacOS color panel will 

appear.
o	 Select a color and click OK.

You may also change the existing pen color of a layer; for example, if a layer 
has been given a color of red, you may change the layer to blue by using the 
same process for setting the color.  When you return to the drawing window, 
all objects which exist on the layer in the previous color will change to the 
new layer color automatically.

NOTE: Pen color attributes are saved with the object.  Turning a Layer 
Color Attribute off will revert object pen colors to their original attributes 
prior to assigning a Layer Color Attribute.  For example, Layer 1 has a 
rectangle with a blue pen color and circle with a black pen color.  Assigning 

💬💬

⚠

💬💬

Layer Color Swatch
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a Layer Color Attribute of red to Layer 1 will change the pen color for both 
the circle and square to red.  Unchecking the Layer Color Attribute for 
Layer 1 will restore the original pen color attributes of blue to the rectangle 
and black to the circle. 

Copy/Pasting Objects

Layer Scale

Objects can be copied or cut from one color-assigned layer and pasted into 
a another color-assigned layer of a different color.  Once pasted, the object 
will assume its new layer’s color.

Scale will assign a drawing scale to the selected layer.

CAUTION: The DXF and DWG Translators will abide by the drawing 
scale set in Drawing Setup.  Layer Scale information will be ignored.  See 
“DXF and Layer Scale” and “Externals” for more information.

Once a layer’s scale is set, all objects constructed on the layer will assume its 
scale.  When layers are changed, the drawing scale will change automatically.

Different layer scales can make complex, multi-detail drawings much easier 
to manage; you can give each detail its own layer. Because changing layers 
automatically changes the scale, you can work with confidence knowing 
your details are scaled correctly.

You may assign a different scale to each layer or to only a single layer. Layers 
which do not have a scale assigned will assume the drawing’s global scale set 
in the Drawing Setup dialog.

To assign a scale to the selected layer:
o	 Click Scale.
o	 Drag to choose a predefined scale, or press Tab and type the desired 

scale in the numerical field.
o	 Click OK.

NOTE: When a layer with no layer scale assigned is activated, the drawing 
scale set in the Drawing Setup dialog will be used.💬💬

⚠
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The Edit Window will ALWAYS reflect the scale of the layer of the selected 
item.  The Show Location Bar will ALWAYS reflect the scale of the active 
layer.  

Therefore, you must remain alert when working on scaled layers with Edit 
All Layers On.  

For example, if your active layer is at 1:1 scale, and you select a 4’ x 4’ square 
object on a layer with 1:48 scale, the Edit Window will indicate the object 
is 4’ x 4’.

STOP & THINK: Because the Edit Window and Show Location Bar will 
ALWAYS report according to the active layer, you must be completely aware 
when working with Edit All Layers On.  Make sure you are working on the 
correct layer, especially when creating and editing objects.

Edit All Layers 
and Layer Scale

⚠
Dimensions and 

Layer Scale

❗ ❗
Drawing Dimensions.  Dimension layers must have the same scale as the 
layer objects being dimensioned.  For example, if your floor plan is drawn 
at 1/4” = 1’ 0” scale, the layer containing the dimensions for the floor plan 
should also be set to 1/4” = 1’ 0” scale. 

Editing Dimensions.  When stretching dimensioned objects, the dimension 
will recalculate based on its layer’s scale, regardless of which layer is active.  
If no layer scale is specified the drawings default scale specified in Drawing 
Setup is used.

Rescaling Dimensions.  If you wish to rescale a dimensioned object, but 
not change its drawn dimension, use the Paste Special External’s Paste At 
Scale option.

You may also change an object’s drawn dimensions without changing the 
physical size of the object.  Suppose you are creating an architectural model 
of a house plan drawn at 1/4” = 1’ 0” scale, and you need full size patterns 
for cutting the foam core and balsa materials for the model.  Simply copy 
the dimensions and paste them onto a layer scaled at 1:1.  While the pasted 
dimensions are still selected, choose Edit from the Edit menu.  When the 
dialog appears, just click OK.  You will end up with full scale patterns for a 
1:48 model without having to measure again.

For more information see Paste Special in the Edit menu section.

Anchor
[EditAllLayers]

!
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The DXF and DWG translator will abide by the current drawing scale, 
instead of each layer’s scale.  For example, if objects are drawn at a layer scale 
of 1:48, and translated with a drawing scale of 1:1, the resulting file will 
have to be scaled up by a factor of 48.

STOP & THINK: Because of the potential for confusion, using layer scale 
in drawings which will be converted to DXF or DWG is not recommended, 
especially drawings with dimensions.

If you must communicate via DXF or DWG:
o	 Hide all layers except those with the same scale. 
o	 Set the Drawing Scale to match the visible layers’ scale.  
o	 Use the option for saving only visible layers found in the DXF or 

DWG translator and create a DXF or DWG file. 
o	 Repeat this process for all the layer scales in the drawing. This will 

result in multiple DXF or DWG files for the same drawing.
–or–
o	 If the drawing is a sheet of separate details or elevations, indicate the 

different scales on the drawing with each detail.
o	 Set the Drawing Scale to be 1:1, or to match the layer scale used most 

frequently in the drawing.
o	 Let the person receiving the file know which details will be correctly 

scaled, and which will need a scale factor applied to be true full scale.

DXF or DWG 
and  Layer Scale

⚠❗ ❗
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100% opacity 75% opacity 50% opacity 25% opacity

L ayer Opac ity 
100%

Objec t L evel F ill and P en Opac ity A ttribute S ettings

L ayer S tatus
ON

L ayer Opac ity 
50%
L ayer S tatus
ON

L ayer Opac ity 
50%
L ayer S tatus
Dimmed

Opacity Opacity allows you to specify to what degree information is hidden or 
revealed below the layer.  For example, a layer opacity of 100% hides all 
information below the layer.  A layer set to 10% opacity would appear 
almost invisible, allowing you to see through to objects below.  Adjusting 
layer opacity affects all objects on a layer, areas with no objects or objects 
with no fill or pen pattern are not affected.

To adjust the opacity attribute for layer:
o	 Drag the opacity slider bar shown below or enter a number in the 

opacity field.

o	 Click OK. 

NOTE: The effects of adjusting both an objects opacity attribute and its 
layers opacity are cumulative.

In the example shown below, compare the cumulative results when object 
level opacity settings are changed in conjunction with layer opacity and 
layer status.  The circles are on the top-most layer and the horizontal line 
is on the bottom most layer with a layer opacity of 100% and pen and 
fill opacity attributes of 100%.  The circle layer has objects with pen and 
fill opacity attributes as shown and the layer opacity and layer status are 
adjusted.  Notice how the horizontal line becomes more or less visible as 
opacity attributes are combined.

💬💬
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There are eight buttons which allow you to create, modify, and delete layers.

New allows you to create a new layer. When a new layer is added, it will be 
selected so that a name can be immediately typed in without any further 
selection.

Delete allows you to remove an existing layer. If you select Delete, the 
selected layer will be removed and will be unrecoverable.

The last remaining layer cannot be deleted.  However, if you need to remove 
all items from the last layer, choose Select All from the Edit menu and then 
choose Clear from the Edit menu.

Show makes all layers in the drawing visible. The active layer is not changed.

Hide makes all layers but the active layer hidden.

Edit allows you to edit the attributes of a selected layer. You may set pen 
color, scale, locking attributes and transparency. 

Purge deletes all empty layers, except the active layer.

Dup creates a new layer which copies the layer attributes of the currently 
selected layer. Objects on the selected layer are ignored. The new layer name 
has ‘copy’ appended to the end. 

Sort changes the physical stacking order of all layers to display all layers in 
the drawing layer list in an A-Z type order. The sorting is not case sensitive. 
Numbers appear before letters and special characters such as ‘•’ or ‘-‘ or 
spaces appear before numbers. This operation cannot be undone; we 
recommend saving the unsorted layer list as a Sheet Setup prior to pressing 
Sort. The Sort operation cannot be undone; if the current layer order is 
important save a Sheet Setup before sorting.

Scale allows you to assign a specific scale to a layer as described in Layer 
Scale earlier in this section.

Color allows you to assign a specific color to a layer as described in Layer 
Pen Color earlier in this section.

Layer Buttons
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The fold-up icon allows you to fold or unfold the Layers Window. When 
the window is folded, the layer buttons and layer name field disappear. 
Click the icon to fold or unfold the window.

Fold-Up Icon

The Sheets submenu may be used to perform the various layer management 
tasks of Saving, Deleting or Resetting Sheets.  Picking a saved sheet from 
the list will adjust the layer stacking order and layer status based on their 
state when the Sheet was created.

For more information on managing sheets see the Sheets section later in 
this chapter. 

Sheets Submenu
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Select the Edit All Layers checkbox to select or deselect the Edit All Layers 
option.

Edit All Layers allows all layers to be active at one time if checked.  Edit 
All Layers boosts speed and productivity by giving you an efficient way to 
modify objects without switching layers.

Move, Delete, Edit, Reshape, and Mirror are just a sample of the editing 
capabilities available to objects on multiple layers.  It also provides an easy 
method of working on a drawing with which you are not familiar.  With 
Edit All Layers, modifying an older drawing, where layer set-ups may have 
been forgotten, is less frustrating and more efficient.  When Edit All Layers 
is On, objects on all visible layers can be selected.  It can be used with all 
tools and menu commands.

The following rules apply: 
o	 The Show Location Bar will ALWAYS reflect the scale of the active layer.
o	 All drawing occurs on the active layer.
o	 Modification of an object occurs on the object’s layer.
o	 Objects created by using objects that are on the same layer appear on 

the objects’ layer.
o	 Objects created by using objects on different layers appear on the active 

layer.
o	 Attach moves all of the objects to the active layer and attaches them.
o	 Select All and then Cut and Paste will place all objects on the active 

layer.

Edit All Layers
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Sort Layer List changes the order in which layer names are displayed in 
the Layer List window.  The physical stacking order of the layers are not 
changed (see Sort button).  This list is displayed in an A-Z type order.  The 
sorting is not case sensitive.  Numbers appear before letters and special 
characters such as ‘•’ or ‘-’ or spaces appear before numbers.  To undo this 
operation, uncheck the Sort Layer List box; the layer list is restored to the 
previous state.

Sort Layer List

Hide Invisible Hide Invisible removes all layers with a hidden status from the Layer List. 
The layers are not deleted from the drawing.  To restore the full list, uncheck 
the Hide Invisible box.

Size Box The Layer Window can be stretched both horizontally and vertically with 
the use of the size box.  Stretching horizontally allows larger layer names to 
be viewed without truncation.  Stretching vertically allows a greater range 
of layer names to be viewed at a glance.  Although stretching takes up more 
screen space, the “roll-up” box can easily be used to roll up the window, 
preserving working screen space.

Please see Floating Windows in the PowerCADD Tutorial for a complete 
description of features special to floating windows.!
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For best results, use the following Layering Tips:
o	 USE LAYERS! While you may have to force yourself in the beginning 

to remember to change layers while you work, you will benefit greatly 
from having and using layers.  Eventually, using layers will become a 
natural extension of your design process.

o	 Hide layers which are not in use.  Hidden layers do not redraw which 
shortens redraw time.

o	 Dim layers which do not need to be fully visible.  Dimmed layers 
display as grayed outlines.  This is useful when a layer needs to be 
visible but not in the way.  The currently active layer can be dimmed.  
Additionally, layers which are dimmed will print gray.

Layering Tips

Set Layer Set Layer allows you to change the active layer without opening the layer 
window.  You may also set the display attributes.

Choosing Set Layer will activate a secondary menu, listing all layers in the 
drawing.

To make a layer active, drag to the layer’s name and release.  If you select a 
hidden layer, it will become visible when selected.

To hide a visible or dimmed layer, press the Command key while choosing 
the layer. 

To dim a hidden or visible layer, press the Option key while choosing the 
layer.

🕺🕺 ❗ !
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In addition to picking layer names from the Set Layer menu, you have 
several other methods of layer navigation.

Layer Window: As discussed in the Layer menu item section of the manual, 
you can change the active drawing layer or change a layer status by clicking 
in the appropriate column in the layer window.

Layer Navigation Arrows: Clicking on the layer navigation arrows in 
the bottom left of the drawing window (or assigning key commands to 
those items) can be a very fast way to navigate through layers or change the 
active drawing layer.  The Toggle Layer Up and Down arrows can be a very 
effective way to review drawings prepared by others or imported via DXF 
or DWG to determine their organizational structure or for presentation 
purposes such as slide shows.

toggle layer up

layer up

layer down

toggle layer down

displays a list of
drawing layers

List of layers:
Displays same content
as Set Layer menu. See
Set Layer for more
information on setting
layers.

Layer Navigation

Toggle Layer Down moves you down the layer stack and hides the 
previously viewed layer.  Locked layers with a hidden status are skipped 
when toggling through layers. 

Toggle Layer Up moves you up the layer stack and hides the previously 
viewed layer.  Locked layers with a hidden status are skipped when toggling 
through layers.

Layer Down moves you down the layer stack and the previously viewed 
layer’s status is not changed from visible or dimmed.  Hidden layers are 
skipped.

Layer Up moves you up the layer stack and the previously viewed layer’s 
status is not changed from visible or dimmed.  Hidden layers are skipped.
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Sheets allows you to organize a drawing into different arrangements of 
layers and save each arrangement as a Sheet.

To understand the Sheets concept think about the contents of a set of 
working drawings for a house.  A plan set may include a plot plan, floor 
plans, foundation, floor and roof framing, electrical, plumbing, and so 
on.  Each “plan” is a sheet of paper which includes elements of the project 
needed for each stage of construction.  Many of the sheets usually contain 
some of the same information.  For example, an electrical plan will usually 
include the walls as well as the electrical symbols and legends. 

Or think of it as a layer arrangement, like a flower arrangement, where 
the position of the roses, daffodils and tulips (the layers), stay in the same 
locaton but vary in color, line weight or opacity.

Layer Sheets

Switching Sheets With Sheets, you simply make visible the layers you wish to have on a 
sheet, then name and save the settings as a Sheet.  You can use the sheets to 
organize a project for printing, or drawing.

To switch sheets, choose Sheets from the Layout menu, then drag to a 
sheet’s name in the submenu and release.  The status and stacking order 
of the layers will change according to the selected sheet.  The active sheet 
will be indicated with a checkmark to its left.  If the layer settings do not 
conform to any sheet settings, no sheet will have a checkmark.

The active sheet will be indicated with a checkmark to its left.  If the 
layer settings do not conform to any sheet settings, no sheet will have a 
checkmark.

Managing Sheets In addition to the Sheets menu, you have several other methods of accessing 
sheet management features.

Layer Window: Select the Sheet pop-up to the right of the layer name field 
to access sheet management features as shown here.
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Drawing Window: Select the Sheet pop-up in the bottom left corner of the 
drawing window to access the sheet management features as shown here.

Layout Menu, Sheets submenu: Choose Sheet from the Layout menu to 
access sheet management features.

Each sheet management feature, Save, Delete, Rename, or Reset Sheets 
provides access to the same features whether accessed the Sheets menu 
item, the Layer Window or the drawing window Sheet pop-up.  Review 
the sections on Save Sheet, Delete Sheet, Rename Sheet, and Reset sheet for 
more information on sheet management using those menu items.

Save Sheet... To save a sheet:
o	 Set each layer to the desired display status (visible, dimmed, or hidden), 

layer attribute settings, and to the correct top-to-bottom order for the 
new sheet in the Layer Window.

o	 Choose Sheets from the Layout menu. 
o	 Choose Save Sheet from the Sheets pop-up menu and a dialog appears.
o	 Type a name for the sheet and click OK.  The sheet name will be added 

to the Sheets pop-up menu.  Once set, the sheet can be chosen from 
the Sheets pop-up menu.

The active drawing layer, layer stacking order, layer status, and layer 
attributes including scale, color, locked status and opacity are all saved with 
each sheet setup.  For example, the ‘Door Layer’ could have a blue color and 
locked attributes for the ‘Plumbing Plan’ sheet and then have a green color 
and unlocked attributes for the ‘Floor Plan’ sheet.
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To delete a sheet:
o	 Choose Delete Sheet from the Sheets pop-up menu.  A dialog appears.
o	 Select the sheet to be deleted.  Click Delete.  To delete multiple sheets 

at the same time Shift-click to select sequential sheets, or Command-
click to select multiple nonsequential sheets.

o	 A dialog will appear requesting you to confirm the Delete operation.  
Click OK to delete the selected sheets.  Click Cancel to keep the sheets 
and cancel the operation.

Delete Sheet...

Reset Sheet... Existing sheets can also be modified.  This is useful, especially on drawings 
which have several layers and you only need to make a couple of changes.

To modify an existing sheet:
o	 Select the sheet to be modified from the Sheets pop-up menu. 

Alternately, you may start from your present layer arrangement if it is 
closer to the desired sheet setting.

o	 Make the desired changes to the layers.  You may hide, dim, or make 
visible the layers as needed, or rearrange their order.

o	 Choose Reset Sheet from the Sheets pop-up menu.  A dialog will 
appear.

o	 Select the sheet to be modified.
o	 Click Reset.  A message will appear, to make sure you have selected the 

correct sheet.
o	 Click OK.  The sheet will adopt the new settings.

Layers and Resetting Sheets When new layers are added to a drawing they are always appended to the 
top of the layer stack with a visible status.  New layers are never appended 
automatically to existing sheets.

To append new layers to an existing sheet, simply drag the layers to their 
desired location in the layer stack and use Reset Sheet as described earlier.
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To rename an existing sheet:
o	 Select Rename Sheet from any of the three standard locations noted 

earlier.
o	 Select the sheet to be renamed.
o	 Type the new name in the Please-name-this field at the bottom of the 

dialog box.
o	 Select the sheet to be modified.
o	 Click OK.  The name of the sheet will be updated in all locations.

Rename Sheet...

Renaming Sheets Options

Press 

Option

To rename an existing sheet:
o	 Click on the Sheet pop-up menu.  A list of current sheet names is 

displayed. 
o	 Press the Option key and Rename is added to the start of each existing 

sheet name. 

o	 Select the sheet name to be renamed.  The Rename dialog appears. 
o	 Enter the new name and click OK.
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To set up layers:
o	 Choose Layer from the Layout menu and the Layers Window will 

open.
o	 Click the New button in the Layers Window.
o	 Enter the appropriate layer name or names.

Setting up Layers

Layer Tools Layer Tools will allow you to activate specific predefined layers by choosing 
a tool. All objects created with the tool will be placed on the correct 
predefined layer.

When Layer Tools is active, specific tools will automatically place objects 
drawn by them onto predefined layers regardless of which layer is active 
when the tools are chosen. If the layer does not exist, or if Layer Tools is 
deactivated, the tool will place objects on the active layer. 

To specify the layers to be used when Layer Tools is active:
o	 Press the Option key while choosing Layer Tools from the Layout 

menu.  The dialog on the left will appear.
o	 Enter a Layer Name to be activated for each Tool listed and click OK.

When setting up drawing layers, the layer name in the Layer Window must 
match the name entered in the Layer Tools dialog.  Layer names are not case 
sensitive (MyLayer is the same as mylayer) and spaces count (MyLayerName 
is not the same as My Layer Name).

Anchor
[LayerTools]
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To use Layer Tools:
o	 Verify Layer Tools is activated in the Layout menu.  A checkmark 

appears next to its name when active. 
o	 Select a tool from the Tool palette that is associated with a layer.  For 

example, if you have set up Text Layer, select the Text tool.
o	 The associated layer will automatically become the active layer.

NOTE: If a layer name field is blank in the Layer Tools setting dialog, then 
the currently active layer will be used by the selected tool.  For example, if 
Dimension tool layer name field is blank then selecting a dimension tool 
will not change drawing layers and the dimensions will be inserted on the 
active drawing layer.

NOTE: In order to see the layer change, set a layer other than a tool-
associated layer to be active.

NOTE: The Survey Dimension tool will not activate the Dimension Layer 
automatically.  If you wish to put survey dimensions on the Dimension 
Layer, you will have to activate the Dimension Layer before drawing them.

Using Layer Tools

💬💬

💬💬

💬💬
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Guidelines menu allows you to create a custom grid system and allows you 
to globally delete existing Guides.

The Guidelines command allows you to set orthographic (horizontal and 
vertical) or axonometric (angular) grids, which appear on the screen as 
Guides.  Once your custom grid is set, Grid snap can be used to snap your 
objects to the custom grid.  You may also drag single Guides from the rulers 
and place them to your custom grid.

The following general rules apply to guidelines:
o	 Snap commands may be used to position guidelines or to snap objects 

to a guideline.
o	 Guidelines do not print.
o	 Guidelines will display with rules turned on or off.
o	 To turn guidelines on or off use Drawing Setup, Show and uncheck 

Guidelines.
o	 Guidelines may be moved or deleted at any time without affecting the 

objects in the drawing.
o	 Guidelines may set to any angle, be any color and be displayed in front 

or behind objects.

Guidelines

Adding a Guideline Guidelines may be added one at a time by dragging them off the ruler 
and positioning them anywhere in the drawing.  Horizontal guidelines are 
added by dragging off the horizontal ruler.  Vertical guidelines are added by 
dragging off the vertical ruler.

To add a guideline to your drawing: 
o	 Position the mouse over the ruler.  The cursor while change to a 

guideline cursor.
o	 Drag into the drawing window.  The cursor changes to a target cursor. 
o	 Drag the mouse to the desired location and release to insert the 

guideline.

Guidelines may be moved at any time by clicking and dragging on the 
guideline.  To have a guideline match the angle of an object in the drawing, 
Option-click on the object when dragging the guideline.

Anchor
[Guidelines]
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There are two methods to remove an individual guideline from a drawing.

By dragging: 
o	 Drag the guideline from the drawing to the vertical or horizontal 

drawing ruler.
o	 The guideline is removed.

By the Contextual menu: 
o	 Place the cursor on the guideline to be removed.
o	 Control- or right-click on the guideline.
o	 Choose Remove Guideline from the Contextual menu. 

To remove all guidelines with a single action choose Remove Guidelines 
from the Guidelines submenu.

The Guidelines submenu provides a variety of advanced methods for 
managing guidelines and creating guideline grid patterns.

Removing Individual Guidelines
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To change the color of a guideline: 
o	 Choose Guideline Color… from the Guidelines submenu and the 

MacOS Color Panel appears.
o	 Choose a color and press OK. 
o	 The selected color is now used for guidelines.

If the guideline colors do not immediately change to reflect your new color, 
hide, then show, the guidelines to force them to refresh.  This setting also 
affects the display of Construction Line colors.  See Construction Line 
Color.

Guideline Color

Making Grids To create an orthographic grid: 
o	 Choose Make Grid from the Guideline submenu and the Guideline 

Grid Spacing dialog will appear. 
o	 Set the horizontal and vertical spacing as desired.  Spacing is tied to the 

units and scale specified in the Drawing Setup, Units tab.
o	 Click OK and your custom grid will appear.

To eliminate confusion when snapping, you may wish to deactivate the 
Show Grid function under Drawing Setup.  This will turn off the standard 
PowerCADD grid and leave only your custom grid.

To create an axonometric or 3D grid:
o	 Set the horizontal and vertical spacing as desired.
o	 Set the desired angle.  Entering an angle of 30 degrees, for example, 

will produce a standard isometric grid.

If a color has been set for the guides, your grid will assume the attributes 
you have chosen.
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The Guidelines submenu allows you to remove guides globally.  You may 
remove only the Guidelines, which are pulled from the rulers, only the 
Guidegrids, which is your custom grid, or you may remove all guides.  To 
remove guides, choose the desired menu command.

Removing Guides

Undo can be used to replace removed guides.  This will allow you to 
momentarily see your drawing without the gridlines, and replace them to 
continue drawing.
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New Custom Palette provides a method for you to customize a tool palette, 
specific to your own requirements.

A new custom tool palette may contain any tool in the main PowerCADD 
Tool palette, tools from external tool palettes and external tools residing in 
the main Tool palette. 

New Custom Palette

Add Tools to Custom 
Palette

Create Custom Palette

Delete Tools from Cus-
tom Palette

Custom palettes are designed to look and perform like any PowerCADD 
tool palette.  Custom palettes can be created for use as office standard tool 
sets or to create custom palettes for special design or drawing situations.

To create a custom palette: 
o	 Choose New Custom Palette from the Layout menu and the New 

Custom Palette dialog box will appear.
o	 Enter the name for your palette and click OK.

Your new empty palette will appear in the upper left hand corner of the 
document window.  You may now add tools to the custom palette.

To add tools to your custom tool palette:
o	 Press the Command key and select the tool you wish to add.
o	 Drag the tool to the custom palette and drop it over the blank space. 

Additional tools can be added to the same row of tools by dragging and dropping 
additional tools directly on the row.  All tools added to a row are placed in the 
front of the row.  Plan ahead for your most convenient set of tools.

Additional rows can be added by dragging the tool to the empty slot.  New 
rows can be inserted between existing rows by dragging the tool to the row 
and pressing the Control key.  When you press the Control key, you will see 
the rows drop down to their new location.

To delete tools from your custom tool palette:
o	 Press the Command key and select the tool you wish to delete.
o	 Drag the tool from the custom palette and release the mouse button.

The cursor will change to a trashcan as you move the tool from the palette.  
You can release the mouse when you see the trash can icon.  The tool is now 
deleted from the custom palette.  Remember, it only deletes the tool from 
the custom tool palette. 

Attributes can be assigned to these tools just like other tools.  Multiple copies 
of a tool can be added to the palette and each instance of the tool assigned a 
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different attribute.  For example, multiple instances of the Line tool can be 
assigned different attributes; line weights, color, dash, and arrows. 

NOTE: Dialog box settings for tools cannot be independently assigned.  
Dialog box settings are assigned to all occurrences of the tool.

Command keys can be assigned to tools in the custom palettes; however, 
they are assigned according to the row and column position of the tool.  
If you modify your tool palette after setting the Command keys, the 
Command keys will be incorrect and will need to be reset.  After building 
or modifying your custom tool palette, it is a good idea to quit and restart 
PowerCADD before assigning Command keys.

NOTE: Assigning Command keys should be done after all modifications to 
the palette have been completed. 

NOTE: Command keys are set to the position of the tool in the custom 
palette, not the tool itself. 

When you quit PowerCADD, custom palettes are stored in the Custom Tool 
Palettes folder in your PowerCADD Preferences folder.  The PowerCADD 
preferences folder is located in your user domain, Library folder, Preferences.

Custom palettes containing tools from External Tool palettes require the 
Externals to be loaded when you launch PowerCADD.  If your custom 
palette contains a tool from an External Tool palette not loaded, the custom 
palette will be unavailable until PowerCADD is restarted with the tool 
available.  An alert dialog will appear detailing the name of the custom tool 
palette affected by the missing Externals.

Custom palettes containing tools from External tools, which reside in the 
PowerCADD main Tool palette, also require the Externals to be loaded 
when you launch PowerCADD.  These External tools include Survey 
Dimension, Blend, Arc Functions, and Trim/Extend tool (Wall tools).

When you include these Externals in your custom palette, your custom 
palette will open, but if the External tools are not loaded, they will be 
unavailable from the custom palette.

💬💬

💬💬

💬💬
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To reload an External tool into your custom palette:
o	 Choose Preferences from the PowerCADD menu and select the Loader 

tab.
o	 Select the External tool you need for your custom palette and click 

OK.
o	 Choose Quit from the PowerCADD menu.
o	 The next time PowerCADD is opened the External tool will appear in 

the custom palette.

Since generally you work with the same set of tools, reloading an External 
tool will not be used often, but as custom tool palettes can be created and 
shared with others, this method can keep all custom palettes the same.

Reload an External Tool
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Drawing Setup allows you to set specific drawing parameters particular to 
your drawing and working style.  Drawing Setup parameters are saved with 
the particular drawing, they do not affect overall application behavior.  To 
set overall application preferences, see Preferences.

Within the Drawing Setup tabbed dialog box, you are able to set and 
control drawing specific items ranging from sheet size, units, scale, and 
object snapping to dimension preferences and the drawing log.

To use Drawing Setup:
o	 Choose Drawing Setup from the Layout menu and a dialog box will 

appear.
o	 Each tab contains groups of options you can set.  Click a tab to see the 

different options.
o	 Check a box or specify a particular value for the desired settings and 

click OK.
o	 The Drawing Setup parameters are set for the specific drawing.

NOTE: To save time, after you’ve set all your drawing setup parameter, 
consider adding your standard title block or layer structure to the drawing.   
Then, save the customized drawing as a Stationery Pad.  Each time you 
open a stationery pad drawing, all your custom parameters are set.  You can 
even have PowerCADD use your custom stationery as the default drawings 
opened when using New from the File menu.  See the section on Preferences 
for more information on how to have PowerCADD automatically open 
your own custom stationery.

Drawing Setup

💬💬

Anchor
[DrawingSetup]
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The Size parameters tab allows you to specify the orientation and size of 
your drawing area.

Drawing Size

Drawing Size parameters reflect the page size you specified using the Page 
Setup dialog.  While PowerCADD supports page sizes up to 200 x 200 
inches, the actual printable area is controlled by your printer driver and 
limited to the physical size of paper the output device can accept.  The Size 
tab displays the options available for specifying the drawing page area and 
provides several features which allow you accurately setup and preview your 
drawing for any output device.

PowerCADD always displays the actual printable area based on the page 
size you chose in Page Setup.  For example, the printable are on an 11x17 
sheet of paper is only 16.5 inches on some printers and a full 17 inches on 
others.  As long as everything you draw is on the white page, it will fit when 
printed on the chosen printer.

Preview Pane

Zoom Slider

The Preview Pane provides you with feedback based on the printer and 
page size specified.  Each page break line represents one sheet of paper or 
tile in the size specified during the Page Setup.  Select one tile to select a 
single sheet, drag on multiple tiles to select multiple sheets of paper of the 
specified size.  The preview pane also provides you with a thumbnail view 
of your drawing to help you determine where it will be on the printed page.

Dragging the Zoom Slider up or down allows you to zoom in and out to see 
more or fewer tiles.  This is much like zooming in or out in your drawing to 
see more drawing area.  To see the maximum page size of 200 x 200 inches, 
drag the slider down to the maximum zoom out position at the bottom 
of the zoom slider.  If Preview Current Drawing is checked, adjusting the 
zoom level will also redraw the preview.

Anchor
[DrawingSize]
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When Whole Pages Only is checked (the default setting) clicking in the 
Preview Pane will select full page sizes.  For example, if Page Mode is set 
to Tiled Printable Areas, clicking on a tile in the Preview Pane selects only 
whole page tiles.  If Whole Pages Only is not checked you can click and drag 
to select a random page size.

Whole Pages Only

Preview Current Drawings

Printer Settings

Page Mode

Work Area

Preview Current Drawing allows you to turn the drawing preview on or 
off in Preview Pane.  When checked (the default setting) a preview of the 
current drawing is displayed in the Preview Pane.  Adjusting the Zoom 
Slider up (zooming in) will display a larger preview.

Printer Settings provides a summary of the drawing paper size based on the 
options selected during the Page Setup operation.  To change any of these 
options, including page orientation, click Page Setup.

Page Mode options allow you to draw on Tiled Printable Areas of multiple 
sheets of paper, or on a single sheet of paper displayed as a Full Page with 
Margins.  The Preview Pane provides confirmation of these radio button 
options.

Work Area indicates the physical drawing area you have available to work 
on.  This value will change depending on the Page Mode selection and on 
the information displayed in Printer Settings.  To change the Work Area 
select a different page mode or click Page Setup to change page size options.

Please see How to Get Started in the PowerCADD Tutorial for a complete 
description of how Printer Settings, Page Mode settings and Work Area 
work in together.

!
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The Units parameters tab allows you to set the drawing scale and units used 
when creating objects in your drawing. 

Units Preferences

Units parameters are just like the triangular scales used in manual drafting.  
The settings you make here determine what scale your drawing will be when 
creating objects and when printed at 100%.  The drawing rulers will update 
to reflect your scale and units settings.

Architectural contains selections for Engineering or Landscape.  Choosing 
a particular pop-up automatically loads typical presets for the most 
commonly used scales in that design field.  You may also set your user 
defined values for any item regardless of the preset you selected.

Units contains selections allowing you to choose the type of drawing units.  
Choosing a particular pop-up automatically loads typical presets for unit 
accuracy.  For example, choosing feet & inches loads fractions for accuracy, 
choosing meters loads decimals for accuracy.

The units specified here are also automatically applied to the dimension 
tools and to the sheet size.  For example selecting millimeters as units will 
display the drawing sheet sizes in centimeters.

Although dimension units are set to automatically match drawing units, 
you may override the dimension tool settings.  This would allow you to 
perform dual dimensioning or to draw in one set of units and dimension 
in another.  See the Tools Chapter, dimensions, for additional information.

Predefined Scales contains selections of predefined scales based on your 
units and setting of Architectural, Engineering or Landscape. To set your 
drawing scale, choose an item from the list. The value is displayed the Scale 
fields. User defined scales are also permitted, see Scale for more information.
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Unit Accuracy contains selections allowing you to choose the smallest value 
to be displayed. The unit accuracy is related to the type of units specified 
(e.g. settings units to decimal inches yields decimal accuracy choices to set 
the number of decimal points).

Area Area parameters allow you to specify units of measure and accuracy for 
area calculations separate from your drawing units.  The units and accuracy 
specified here are displayed in the Edit Window and used by the Area menu 
item to insert area and perimeter calculations into a drawing.

Units contains selections allowing you to choose the type of area units. You 
may specify area units which are different than drawing units.  For example, 
if drawing units are set to feet & inches, area units may be set to acres or 
square meters.

Area Accuracy contains selections allowing you to choose the smallest 
area value to be displayed.  Area accuracy is independent of drawing unit 
accuracy. 

Scale

Grid Spacing

Scale parameters indicate the values chose in predefined scales or you may 
specify a user defined scale if an appropriate preset scale is not available.   
Scale may be entered in plain language matching traditional drawing scales 
(e.g. 1/4’’ = 1’) or may be expressed as a ratio (e.g. 1 = 48).

Grid spacing allows you specify how fine or coarse the invisible drawing 
grid will be. For example, with a drawing scale of 1/4’’ = 1’, a grid spacing 
of 3’’ will cause an object to grow in 3’’ increments as it is drawn.
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Angle parameters allow you specify units of measure and accuracy for 
angular drawing.  The units and accuracy specified here are displayed in the 
Edit Window.

Cartesian contains additional pop up selections allowing you specify the 
type of angular measurement.

Cartesian allows you to construct angles in a plane where 0˚ is East (right), 
90˚ is North (up), 180˚ is West (left), 270˚ is South (down), and 360˚ is 
East (right).  Positive angles are counterclockwise.

Azimuth allows you to construct angles in a plane where 0˚ is North (up), 
90˚ is East (right), 180˚ is South (down), 270˚ is West (left), and 360˚ is 
North (up).  Positive angles are clockwise.

Bearing allows you to construct angles with respect to direction.  Up is 
North and down is South.  The angle is specified by degrees North or South.  
You may reset the North orientation on the drawing when working in 
Bearing and Distance.  To change the direction of North, type a new value.  
The value you type is based upon Cartesian coordinates.  This will allow you 
to specify North any degree to the right or left of the default North location.

Gradian allows you to create angles in a plane where a circle is broken into 
400 parts instead of 360˚.  The increments of the gradian circle begin and end 
at the extreme right hand side.  Positive increments are counterclockwise.

Angular Unit Accuracy allows you to specify the smallest displayed 
measurement.  These options can be set by selecting the desired items from 
the pop-up menu.

North allows you specify a particular north angle bearing.  To set the north 
angle choose bearing then type the value in the north field.

Angle Preferences
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The Dimensions parameters tab allows you to alter the way dimension lines 
are placed in the drawing.  This option allows you to specify the length of 
leader lines, extension line offset, stack dimension line offset, text rotation, 
text location, and so on.  All values entered are at normal print size (i.e. 
100% or 1:1).

Dimensions 
Preferences

You may force dimension line extensions to be short by entering a negative 
extension line offset.  When set, dimension tools which draw extension 
lines will create short extension line segments, regardless of the distance 
between the object being dimensioned and the dimension line itself.

Dim Text Above/Below Offset allows you to specify the amount of 
space between the bottom of the dimension text and the dimension line 
for dimension text set to Above/Below only.  A positive value moves the 
dimension text farther (higher) from the line.  A negative value moves it 
closer (lower) to the line.

Remove Zeros allows you to specify how leading and trailing zeros are 
displayed when dimensioning in decimal units.

Anchor
[DrawingSetupDimensions]
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The Snap parameters tab allows you to specify various dynamic snap settings 
in your drawing. 

Snap Preferences

Snap governs the following snapping preferences.

Object allows you to find basic snap points on objects more easily.  The basic 
snap points are: circle and ellipse centers, arc radius points, line midpoints 
and endpoints, and all polygon and freehand vertices.  When you drag an 
existing object, or start to draw a new object near a snap point, the object 
will act much like a magnet; it will pull away from the cursor and attach 
itself to the point.

Grid allows you to turn the normal grid snap On or Off.  With Grid Snap 
On, the object being created or moved will snap to the grid setting rather 
than the screen location.  With grid snap On, pressing the Command key 
will temporarily disable grid snap in the drawing.

All Visible Layers allows you to utilize the Snap functions on all layers that 
are visible rather than just the active layer.

Active Layer Only allows you to restrict the snapping function to just the 
currently active layer. 

CAUTION: Snapping can also be turned off for a specific layer using the 
Layer Window, Snap Column.  Turning off snapping at the layer level 
overrides the choice to snap to All Visible Layers or Active Layer.

⚠

Anchor
[DrawingSetupSnap]
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Nudge Settings allow you to specify the distance selected objects will be 
moved right, left, up or down when the arrow keys are pressed.  A total of 
ten nudge amounts are remembered.  Nine may be custom values, one value 
(1 pixel or 0.01389’’) is always included in the nudge amount list.  When 
more than eight custom nudge amounts are used, the oldest amount (the 
one entered first) is removed from the bottom of the list and the newest 
(most recently entered) amount is added to the top of the list.

TIP: Nudge settings automatically adjust for layer or drawing scale settings.

The accuracy of the nudge setting is independent of the drawing setup 
accuracy.  For example, if the drawing setup accuracy is set to two decimal 
points (X.XX) or to fractional units, you may enter a nudge value to any 
number of desired decimal points (X.XXXX).  The units of a nudge setting 
are also independent of the drawing setup units.  For example, if the drawing 
setup units are fractional inches, you can enter nudge values in centimeters 
and to any desired accuracy.  Changing the drawing setup units or accuracy 
will not modify the units or accuracy of previously entered nudge values.

Nudge Settings

💡💡

👍👍❤ !
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Constrained Angles allows you to specify the angles to which objects will 
snap while drawing.

For example, when you draw a line with the Multi-Angle Line tool, you 
will notice the line seems to jump to certain angles while you drag the line 
to length.  These jumps, which are normally the standard drafting angles of 
30, 45, and 60 degrees, can be set.  PowerCADD measures positive angles 
in a counterclockwise direction and negative angles in a clockwise direction 
as illustrated here.

Constrained Angles

180º 00' 00'' 00º 00' 00''

90º 00' 00''

270º 00' 00''

positive angles
move counter-
clockwise

+45º 00' 00''

negative angles
move counter-
clockwise
-135º 00' 00'' is the
same as +225º 00' 00"

-135º

+225º
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Default: Checking this box allows you to snap to the preset snap angles.  
Each angle is available in all four quadrants of a coordinate system.  For 
example, a setting of 30 degrees snaps to 30, 120, 210 and 300 degrees 
measured counter clockwise from horizontal (zero degrees).  Default snap 
angles may be used by themselves or in conjunction with Custom and Step 
snap angles.

Default Snap Angles

When checked, the snap angle preview panel shows a solid black line for 
each quadrant a default snap angle appears in as shown here:

Custom Snap Angles Custom: Checking this box allows you to snap to custom snap angles 
specified in the Custom Snap Angle Fields.  Custom snap angles may 
be used by themselves or in conjunction with the Default and Step snap 
angles.  The angle specified is added to the root angles of 0, 90, 180 and 
270 degrees.  For example, a custom angle of 15 degrees would snap to 15, 
105, 195, and 285 degrees.

If +/- is not checked, the custom angle is added to the base angles of 0, 90, 
180 and 270 degrees.

+/-: Checking this box allows the custom snap angles to be both added and 
subtracted from the root snap angles of 0, 90, 180, and 270 degrees.  For 
example, when checked, a custom snap angle of 15 degrees would snap to 
15, 75, 105, 165, 195, 255, and 285 degrees as illustrated below.
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Custom Snap Angle Fields: You may specify a maximum of four custom 
snap angles.  Each field is a unique color with a matching color displayed 
in the preview panel.  Each angle field calculates four complementary 
snap angles.  When used in conjunction with the +/- checkbox, each field 
calculates a total of eight snap angles.

Custom snap angles can be useful in adding additional snap angle 
increments to the Default angles.  They can also be very helpful any time 
you need to draw relative to an arbitrary baseline angle.  For example, many 
site planning projects require a site plan to be drawn relative to a property 
line which is typically not at zero (horizontal) or 90 degrees (vertical).  By 
using custom snap angles you maintain the ability to quickly and easily 
draw geometry which is parallel and perpendicular to the arbitrary baseline 
angle.

TIP: When entering custom snap angles it is not necessary to enter the 
degree, minute, and second marks.  For example a custom angle of 22 
degrees, 32 minutes, 48 seconds, could be entered as 22 32 48 (simply 
insert a space between each value).

Preview Panel: The preview panel provides instant feedback for all Default, 
Custom and Step snap angle settings.  Default angles are black lines, each 
custom angle is rendered in a separate color, and the step angle appears as a 
tick mark around the perimeter of the circle.

Step Angle: Allows you to set an angle which works incrementally around a 
360 degree circle (an ‘angle grid’ if you like).  Step snap angles may be used 
in combination with Default and Custom snap angles.

Custom Snap Angle Fields

💡💡

Preview Panel

Step Angle
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The Show preferences tab allows you to customize the look and feel of your 
drawing environment.

Show Preferences

Units, if checked, the drawing units are displayed in the Edit Window. 
When this is not checked, drawing units are not displayed for any decimal 
or metric drawing units.  If show units was not checked, setting the drawing 
units for fractional inches or feet & inches will automatically check show 
units.

Rulers, if checked, shows the rulers in the drawing window.  Rulers must 
be turned on to drag guidelines off the ruler.  When rulers are not checked, 
no rulers are displayed in the drawing window but any guidelines will still 
be displayed.  This item may also be turned On or Off using the contextual 
menu, which appears when you Control- or right-click in the drawing 
window.

Gridlines, if checked, shows a dimmed reference grid in the drawing 
window.  The grid may be displayed in front or behind objects using the 
settings in the Preferences, View tab.

Location displays the exact location of the cursor on the drawing page with 
respect to the Drawing Origin and allows you to measure both linearly and 
angularly from one point to another.  

The Show Location Bar at the bottom of the document window shows the 
location of the mouse in three methods: absolute, relative and angle-and-
length.  

When the absolute method is used, the mouse location is given as “X=... 
Y=...” where the values for X and Y are from the origin of the drawing.  

When the relative method is used, the mouse location is given as “∆X=... 
∆Y=...” where the location is relative to the last mouse click, thus you can 
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easily measure coordinate change from one point to another by simply 
clicking on a point and moving the mouse to the next point.  

To measure distance angularly and linearly, place the cursor at a starting point 
and click.  this will set the linear display to zero and the angular display to 90˚.  
Move the cursor to the second point and read the display.  To toggle between 
the three methods, simply click in the Show Location Bar.

Guidelines, if checked, can be created by dragging from the horizontal 
and vertical ruler.  Unchecking Show Guidelines will hide all drawing 
guidelines.  Guidelines are not deleted and can be shown again by checking 
show guidelines.

Page Breaks will place grayed lines on the screen to indicate where page 
breaks would occur if a large drawing were printed on standard sheets of 
paper.  These lines will not print or plot.  They are a visual aid and are visible 
only on the screen.  You can choose to display objects in front or behind 
page breaks by setting the appropriate settings for Grid Behind Objects.

Flip Vertical Axis changes the direction of the positive–Y coordinates from 
positive up to positive down. 

WYSIWYG Line Weights, if checked, displays objects on screen with the 
line weight attributes you specified.  When zoomed in more than 6,400 
percent, WYSIWYG line weights is temporarily disabled.  Zooming out 
will automatically enable WYSIWYG line weights again. 

Simulate Thin Lines improves the screen rendering quality to better 
simulate thin line weights in your drawings.  Moving the slider bar left 
renders the thin lines light on screen.  Moving it right renders them darker. 
Moving the slider bar to the right-most position turns Simulate Thin Lines 
Off.  The Lighter/Darker slider does not affect printing.
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Black Background, if checked, changes the drawing color background to 
black.  The black background doesn’t print.

CAUTION: If black background is On, and you have chosen Black and 
White Printing in the Drawing Setup, Print tab, the white lines will be 
printed white and your printed sheet will look empty.

⚠

Local Origin Local Origin allows you to specify X, Y coordinates as the drawing origin.   
The coordinate units are the same as the drawing units and may be entered 
as positive or negative values.  You may also specify a local drawing origin 
dynamically by dragging the origin from the top left corner of the rulers in 
the drawing window.

This is the normal way of drawing for almost all situations.
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Global Origin allows you to establish a common set of coordinates between 
different drawings.

For example, if you have a proposal for a campus, which consists of a drawing 
describing the campus and individual drawings for each building on the 
campus, Origins allows you to set an origin common to each drawing.

Since each drawing in a project may show a different section of the whole 
project from the origin, you can set the offset for each drawing. 

To set the offset of the origin check the Global Origin box and enter the 
desired X and Y coordinates.  You may enter positive or negative coordinate 
values.

Once the offset has been established, you may find the origin of any point 
in your drawing. Essentially, the origin offset is the origin of the place you 
selected.  It takes the drawing’s coordinates and adds the offset amount.   
On your campus project, for example (which has north as up), if the origin 
of the building you are drawing is 500 feet south and 1500 feet west of 
the main drawing’s origin, you would set the origin offset as X=1500’ and 
Y=500’.

When Show Coordinates is checked, the information in the Edit Window 
will reflect the global values.  The Show Location Bar will reflect the global 
values if the absolute method of location is used.  Otherwise, the local 
values will be used in the Edit Window and the Show Location Bar.

NOTE: The origin offset is a physical point on your drawing and is 
independent of scale.

REALITY CHECK: While there is no question that a global origin is vitally 
essential when working over large areas and also that it is an important 
addition to PowerCADD, it is also extremely difficult to calculate.  The 
industry standard way of doing this is to identify a point in the drawing 
as location XXXXX,YYYYY and have the original calculated back from 
that.  There are tools in Paolo Rossi’s Topography Tools and in TopoTools 
in WildTools that make this very easy.

💬💬

Global Origin

❗
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The Print parameters tab allows you to specify some of the printing options 
for your drawing.

Print Preferences

Layout Direction will allow you to specify the print order when printing a 
large drawing to a small printer.  You may arrange the pages to print from 
left to right or from top to bottom.  Note the numbers in the page sequence 
icons.  To set the page sequence, simply click the appropriate icon.

Crop Marks places crop marks on the four corners which define the 
document size and adds a 1/4” margin around your document.  For 
example, if your original document is 8.5”x11”, your printed document 
will be 9”x11.5”.  If your available paper size is only 8.5”x11”, four pages 
will be required for printing.

Full Color allows you to print in full color.

Grayscale allows you to print in grayscale only.

Black and White allows you to print in black and white only.

See the section on the File Menu, Print and Page Setup menu items for 
information regarding additional printing options.  See How to Get Started 
in the PowerCADD Tutorial for additional information on working with 
page sizes and margins.

Anchor
[PrintPreferences]
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The Log will keep a cumulative tally of the time the drawing is open.Log Preferences

The Log is a useful option and can be used by architects, drafters, and other 
professionals who charge by the hour for their work.  When turned on, the 
log runs continuously even when the drawing is in the background so care 
should be taken if you are using the log for time-billing purposes. 

The log file is written to disk in the same location as the drawing file 
which logs all drawing open and save operations.  This file can be opened 
into an Excel spreadsheet by double-clicking on the Log file.  The log is a 
tab-delimitated text file and can also be read into most word processing, 
spreadsheet or database programs.  The log file will be updated each time 
the drawing is opened or saved.

To use the log:
o	 The Log On checkbox allows you to turn the Log On or Off.
o	 Current Time tells you exactly how long the drawing has been open 

since it was originally created.
o	 The Reset button allows you to set the log to zero.

The following is an example of the log file after opening in Microsoft Excel.
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The View menu allows you to choose zooms and views.  Frequently used 
views and zooms may also be stored and recalled from the Views menu.

In addition to the zoom and view features offered in the View menu, deep 
zooming while drawing and zooming and navigation using the Overview 
Window are also available.  

For more information on deep zooming see Tools chapter Deep Zoom & 
Zoom on the Fly While Drawing.  

For information on using the Overview Window see the Windows section, 
Overview later in this chapter.

Zoom In and Zoom Out allow you to magnify part of the drawing for 
greater detail or show a greater area of the drawing on the Macintosh screen.

View Menu

Zoom In

Zoom Out

To use the Zoom In command:
o	 Choose Zoom In from the View menu. 
o	 The drawing area will be zoomed in by a factor of two.

With each execution of the Zoom In command, you magnify the drawing 
by two. 

Select the Arrow Selection tool to cancel Zoom In.

The Zoom tool located in the Tool palette performs the same operation as 
Zoom In except you specify the area that will be shown on the screen.  This 
tool may save time by eliminating screen redraws when zooming in on small 
objects from a full drawing view.

To use the Zoom Out command:
o	 Choose Zoom Out from the View Menu.
o	 Upon selection of Zoom Out, the drawing area will be zoomed out by 

a factor of two.  The center of the current view area will be the center 
of the zoom-out operation.

NOTE: Zoom In and Zoom Out also work inside the Edit Text Window. 
See the Tool chapter, Text tool, Edit Text Window for more information.💬💬
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Normal Size returns your drawing zoom to normal size (100%).

When zoomed in, Normal Size displays the drawing in the center of the 
screen at the scale you have chosen to be the drawing scale.  If you have 
already chosen the Reduce To Fit command, Normal Size will take you to 
the center of the viewing area.

Normal Size

Reduce To Fit

Display Selection

Reduce To Fit reduces the entire drawing page size to fit in the Macintosh 
window.

This brings the drawing from any zoom status to fit within the current 
drawing window.

Display Selection takes you to a zoom that displays the currently selected 
object regardless of your location or zoom on the drawing page.

Display selection brings the selected material very close to the center of the 
screen.  The selected material can be larger than the screen at the current 
zoom.  The zoom is adjusted so the selected material takes up a reasonable 
portion of the screen.

Store View To use Store View: 
o	 Position the drawing window location and zoom level to the view you 

wish to store. This view might be an actual drawing view such as “right 
side”, a detail such as “framing detail”, or simply a location that will 
need much detail drawing.

o	 Choose Store View from the View menu. The Set View dialog will 
appear.

o	 You may use your cursor and keyboard to change the name.  For 
example, you might want to call “View 1” the “Front View” to be 
more descriptive.

o	 Press the Return key to enter a name or click Cancel to go back to the 
drawing.

Also, before any views are stored, selecting a view will put you at home view 
(the upper left corner of the page and at normal size).



Menus401

Delete View allows you to delete views that are no longer needed.

To delete a previously stored view: 
o	 Choose Delete View from the View menu.  The Delete View dialog 

box will open. 

Delete View

o	 Select which view you wish to delete.  Click Delete to remove the view 
or Cancel to return to the drawing.  To delete multiple views at the 
same time, Shift-click to select sequential views or Command-click to 
select multiple nonsequential views.

Views Views allows you to recall a saved view. 

A saved view is like a bookmark.  Just as a bookmark lets you quickly return 
to a place in a book, a view lets you return to a place in a drawing.  Views 
are created with the Store View command.

When you choose Views, a submenu appears listing the views that have 
been set for the drawing.  Views are listed in the order they were saved, the 
first saved view is at the top of the list, the last saved view at the bottom. The 
submenu lets you recall a particular view.

To use Views:
o	 Choose Views in the View menu.  The Views submenu appears.

o	 Choose a view in the submenu and release the mouse button.  The 
selected view will appear in the drawing window.

Previous View is always available, even if no views have been set for the 
drawing.  Previous View returns you to your last location in the drawing.  
The previous zoom will also be recalled.
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Hide Shadows: Choose this menu item to temporarily turn off all shadow 
attributes in a drawing. 

Choosing Show Shadows will turn all shadow attributes back on. 

CAUTION: Hidden Shadows do not print. 

Hide/Show Shadows

⚠

Anchor
[HideShowShadows]
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The Attribute menu allows choosing the attributes for line, fill, fill color, 
pen and pen color. 

Patterns may be modified or added.  

A variety of pen widths may be specified including several weights of 
hairlines.  

Colors may be edited or added.  

Arrow types and sizes may be customized and dashes may be set-up to suit 
your individual drawing style.

Items in the Attribute menu are also available using contextual menus. 
Control- or right-clicking on an object in the drawing will bring up the 
Attribute menu items. 

The Defaults Window or the Attributes Window may also be used to access 
items in the Attribute menu.

CAUTION: If Global Attributes has been turned On, the choices displayed 
for Pen (line weights), Color (fill and pen), Hatch patterns, Fill Patterns, 
Arrows, Dashes, and Attribute Styles are affected.  See Global Attributes for 
additional information. 

Attribute Menu

⚠

Anchor
[AttributeMenu]
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Line submenu allows you to change the line weights of objects.

To set the default of the Line menu:
o	 Select the Line tool by double-clicking on the Tool palette.  Clicking 

twice insures no objects in the drawing are selected.
o	 Choose Line from the Attribute menu. The Line menu will appear.
o	 Choose the desired line weight.
o	 Place the cursor on the drawing area and create a line.  The line will 

have the weight you just specified.

These changes will remain in effect in the menu until the tool is changed.

If you want to set the default of objects with a specialized line weight, follow 
the same steps shown above, except select the object’s tool you want to set.

To change existing lines:
o	 Select the line or object you wish to change.
o	 Choose the line weight from the Line menu you want.

When changing the appearance of an object, such as changing line weights 
in existing objects, the Tool palette setting is not changed.  You may change 
several objects at a time by selecting all of them and then making the change.

You may change the line thicknesses listed in your Line submenu by 
choosing Lines[…] under the Attribute menu or press the Option key when 
choosing a line weight.

Changing the available line thicknesses does not change any existing objects 
in the drawing.

Line Submenu
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Arrow allows you to add arrows, nodes, and backslashes on either or both 
ends of a line.

To add arrows to existing lines:
o	 Select the line to which you want to add arrows by double-clicking on 

the Line tool.
o	 Choose the location and type of arrow you want from the Arrow menu.
o	 When you release the mouse button, the arrows will placed on the line 

as part of the object. 

When changing the appearance of an object, such as adding arrows to 
existing objects, the tool defaults are not changed.  You may change several 
objects at a time by selecting them and then making the change.

To set a tool default to Arrows:
o	 Select the Line tool from the Tool palette.
o	 Choose Arrow from the Attribute menu.  A menu will appear.
o	 Select the location of the arrow by choosing one of the top four lines.  

These lines specify if the arrow will appear at the start of the line, the 
end of the line, or on both ends of the line.

o	 Select the type and size of arrow you wish to use.
o	 When you release the mouse button, the arrow will be placed on any 

line you draw until you change it.

When changing Arrow, remember the arrow changes are additions to the 
Line menu changes made earlier.  If the line is set to a 10-point dashed 
line, and you set the Arrow for any reason, the outcome will be a 10-point 
dashed line with the original size arrows.  The end-markers are a fixed size, 
but you may design additional end-markers to fit the 10-point lines. 

You may change the arrows available in the Arrow submenu by choosing 
Arrows[…] under the Attribute menu or press the Option key when 
choosing a line weight.

Arrow Menu

Anchor
[ArrowMenu]
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Dash allows you to change the line forms (dashes) of lines or objects.

To set a tool default to dashes:
o	 Select the Line tool from the Tool palette by double-clicking on the 

Line tool.
o	 Choose Dashes from the Attribute menu.  A dashes menu will appear.
o	 Choose the desired line type.
o	 Place the cursor on the drawing area and draw a line.  The line will have 

the dash type you just specified.

These changes will remain in effect in the menu until you change them 
again.

If you want to set an object’s default line to dashes, follow the same steps 
shown above, except select the object you want to set instead of the Line 
tool.

To change existing lines:
o	 Select the line or object you wish to change.
o	 Choose a line type from the Dashes menu.
o	 When you release the mouse button, the change will occur. 

When changing the appearance of an object, such as changing line types in 
existing objects, the change is made to the object.  Defaults are not changed 
and must be reselected for each item changed.  You may change several 
objects at a time by selecting all of them and then implementing the change.

You may change the line types available in your Dash submenu by choosing 
Dashes[…] under the Attribute menu or press the Option key when 
choosing a dash pattern.

TIP: The Line, Arrow and Dash menu items will automatically scroll if the 
list is too long to be displayed on screen. 

Dash Menu

💡💡
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End Caps allows you to specify what style of end cap is applied to open end 
objects such as lines, arcs, polygons and Bézier curves.  You may select from 
None, Round or Square whose differences are noted in this diagram. 

End Caps Menu

None

R ound

S quare

Dashed Baseine shown for reference.
Note round and square end caps
project beyond this baseline.

To set the default end cap for a tool:
o	 Double-click on a tool in the Tool palette (e.g. the Line Tool).  Clicking 

twice insures no objects in the drawing are selected. 
o	 Choose End Cap from the Attribute menu.  The End Cap menu will 

appear.
o	 Choose the desired End Cap.
o	 Place the cursor on the drawing area and create a line.  The line will 

have the end cap you just specified.

To change end caps of existing lines:
o	 Select the line or object you wish to change. 
o	 Choose an end cap type from the End Cap menu.
o	 When you release the mouse button, the change will occur.
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The Fill menu is used to choose a fill pattern for the various objects that 
define an area as described earlier. 

The standard default fill is white.  When white is assigned to an object, it 
acts as a blocking object.  When plotted, the white object blocks out objects 
below it in the drawing.  Its outline is plotted, but the white fill will remain 
the color of the paper with every object behind it eclipsed.  The fill pattern, 
“None”, is used for drawing an object outline, and its center will be treated 
as transparent.  None is different from white in that items behind the object 
are visible through a None fill where they are not through a white fill.

When you choose a fill pattern, first select the object to be filled.  From the 
Fill menu, choose the desired fill.

To assign a fill to a drawing tool for repeated use:
o	 Select a drawing tool from the Tool palette.
o	 Choose Fill from the Attribute menu and a submenu will appear.
o	 Choose the desired fill and release the mouse.

Each time you create an object with that tool, it will be filled with the fill 
pattern you specified until you change it. 

We recommend that you do not use objects filled with a white pattern to hide 
unwanted sections in the drawing unnecessarily.  Tools such as Break, Clip, and 
Cut with Line are much better alternatives for eliminating drawing sections.

Fill patterns are excellent means to provide a variety of textures in your 
drawings while maintaining a very small file size when compared to using 
hatch patterns. 

You may change the fill patterns available in your Fill submenu by choosing 
Pattern[…] under the Attribute menu or by pressing the Option key 
when choosing a fill pattern. The first nine fill pattern positions in the first 
column, starting from None and going down, are reserved and cannot be 
edited.  Any changes made to the Fill Pattern palette will also affect the Pen 
Pattern palette.

TIP: Editing an existing PowerCADD fill pattern will not affect the fill 
patterns of objects in the drawings to which the previous pattern had been 
applied.  To update the old objects, use Select Special to select the objects 
with the old fill pattern then choose the edited (new) fill pattern from the 
Pen Pattern menu.

TIP: When Global Attributes is Off, editing a fill pattern position affects 
the PowerCADD pen and fill pattern palettes for the specific drawing.  If 

Fill Menu

💡💡

💡💡
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[PenMenu]
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Global Attributes is On, editing a fill pattern position affects all drawing 
pen and fill palettes.

TIP: Fill patterns are saved with the object.  Copying and Pasting an object 
with a custom pattern from drawing 1 into drawing 2 will retain the objects 
pattern and the custom pattern is added to the PowerCADD Pen and Fill 
pattern palettes.

NOTE: Fill patterns are unique to the MacOS.  As such, if you save your 
drawing as a DXF or DWG file, the fill patterns are not included, objects 
will have a fill of None when translated.  If it is important to have your 
patterns included with a DXF or DWG file, consider using hatch patterns 
instead of fill patterns.

💡💡

💬💬
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A hatch is a vector-based pattern rather than a bit image fill.  Originally they 
were fills used by plotters.

Hatch patterns are assigned to objects in the same manner as Fill patterns.

To hatch an object:
o	 Select the object you wish to assign a hatch pattern. You may select the 

individual lines or arcs which make up a complex shape, or you may 
select polygons.

o	 Choose Hatch from the Attribute menu (or Control- or right-click on 
an object) and select the desired pattern.

o	 Upon selection of the desired pattern, release the mouse.  The hatch 
pattern will be assigned to the selected object.

Hatch patterns are associative and behave much like fill patterns.  If 
you resize or reshape a hatched object, the hatch pattern automatically 
recalculates to reflect the new shape. 

Hatch patterns are different from fill patterns in that they are composed 
of true object geometry such as lines.  As such, hatch patterns translate 
correctly via DWG or DXF while fill patterns do not.  However, hatch 
patterns are similar to fill patterns in that they are associative.  If you resize 
or reshape a hatched object, the extents of the hatch are also be recalculated 
similar to how a fill patterns behave.

NOTE: Hatch patterns may be made from any object in the drawing 
including pixel based (raster) images which behave like Fill patterns.  Fill 
patterns are unique to the Apple Macintosh computing platform.  As such, 
if you save your drawing as a DXF or DWG file, the fill patterns are not 
included, objects will have a fill of None when translated.  If it is important 
to have the patterns included with a DXF or DWG file, consider using 
object (vector) based hatch patterns instead of raster based hatch patterns.

TIP: When Global Attributes is Off, copying an object with a custom hatch 
pattern from drawing one and pasting it into drawing two will add the custom 
hatch to the hatch palette in drawing 2.  If Global Attributes is On, a custom 
hatch pattern added to drawing 1 automatically appears in all drawings.

TIP: You may assign both a Hatch and Fill attribute to an object.  The 
hatch attribute will be layered above the fill attribute.  Adjusting the fill 
opacity attribute affects the hatch and fill patterns equally.

TIP: Hatch patterns are not drawn to screen when the zoom exceeds 6400 
times.  Zoom out to less than 6400 times and the hatches are drawn to 
screen.

Hatch Menu

💡💡

💡💡
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💬💬
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It is possible to ‘harden’ a hatch after it has been applied to an object.  
Hardening a hatch pattern breaks the associative link between the hatch 
pattern and the object and allows attributes to be assigned (e.g. changing 
pen color, line weight, etc.).  A hardened hatch pattern behaves like hatch 
patterns in early versions of PowerCADD and PowerDraw.

To harden a hatched object:
o	 Select the hatched object in the drawing.
o	 Choose Convert to Object from the Tool Menu.
o	 The association between the object and the hatch pattern is broken.  A 

separate hatch object is created in the drawing.
o	 Change the attributes of the hatch pattern by choosing the desired 

attributes from the Attribute menu for pen color, line weight, etc.

Harden Hatches

Hatch Settings Menu Hatch Settings allow you to control various hatch attributes of associative 
hatch patterns.  Attributes may be adjusted without having to first harden 
the hatch pattern.

The Hatch Settings submenu contains the following choices which may be 
applied to a hatched object:

Line allows you to change the line weight of a hatch pattern.
Color allows you to select a pen color for a hatch pattern from the 
PowerCADD color palette.
Color… allows you to select a pen color for a hatch pattern using the 
MacOS color panel.
Origin allows you to change the starting point (origin) of a hatch pattern.
Scale… allows you to specify a scale factor to enlarge or reduce the size of 
a hatch pattern.
Rotate… allows you to specify a rotation angle of a hatch pattern.

CAUTION: If Global Attributes has been turned On, the choices displayed 
for Line (line weights), and Color in the Hatch Settings menu are affected.  
See Global Attributes. 

⚠

Anchor
[HatchSettingsMenu]
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To set the line weight of a hatch for an object: 
o	 Select the hatched object in the drawing.
o	 Choose Hatch Settings, Line, from the Attribute menu.
o	 Choose the desired line weight from the list.

The line weights in the list match all other Line menu choices in the drawing. 

Hatch Line Weight

Hatch Pen Color

Set Hatch Pen Color.

To set the pen color of a hatch for an object from the PowerCADD 
color palette: 
o	 Select the hatched object in the drawing.
o	 Choose Hatch Settings, Color from the Attribute menu.
o	 Choose the desired hatch pen color from the list.

The color choices in the list are from the PowerCADD color palette and 
match all other pen and fill color menu choices in the drawing. Hatch pen 
color settings are independent of the object pen and fill color settings.

To set the pen color of a hatch for an object from a MacOS system 
color: 
o	 Select the hatched object in the drawing.
o	 Choose Hatch Settings, Color… from the Attribute menu.
o	 Choose the desired hatch pen color from the MacOS color panel and 

click OK.

You have complete access to all MacOS color selection options and 
management features. Hatch pen color settings are independent of the 
object pen and fill color settings.

To select a hatch pen color that matches an existing color in the 
drawing:
o	 Select the hatched object in the drawing.
o	 Choose Hatch Settings, Color… from the Attribute menu.
o	 Click on the magnifying glass in the MacOS color panel.
o	 Move the mouse over the color you want to match and click.  The color 

is displayed in the color panel.  Click OK

Select Hatch 
Pen Color
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Many hatch patterns such as brick or tile, often require their origin or 
starting point to be in a specific location to accurately represent the intended 
material in the drawing.

To set the origin of a hatch for an object: 
o	 Control- or right-click on the object.
o	 Choose Hatch Origin from the contextual menu or choose Hatch 

Settings, Origin from the Attribute menu.
o	 Choose the desired origin from the list.

When you apply a hatch it will start at the specified origin. If no origin is 
specified, the default origin is used.  Each origin (LT, MT, etc.) is represented 
by a red square in the list of choices.

Original Hatch Scale Result of applying a 
2.0 scale factor

Result of applying a 
0.5 scale factor

Depending on the scale of the your drawing, some hatch patterns may be 
too large or too small to represent the selected material.  Rescaling a hatch 
pattern is a quick way to correct that condition.

To change the scale of a hatch for an object: 
o	 Select the hatched object in the drawing.
o	 Choose Hatch Setting, Scale[…] from the Attribute menu.
o	 Enter a numeric value in the Scale field and click OK.

When entering scaling factors, a value of 1.0 will not rescale the hatch.  A 
value of 0.5 will make the hatch half as large.  A value of 2.0 will make the 
hatch twice as large.  You may enter any whole or decimal number in the 
Scale field.

To change the rotation angle of a hatch for an object: 
o	 Select the hatched object (or multiple hatched objects) in the drawing.
o	 Choose Hatch Setting, Rotate[…] from the Attribute menu.
o	 The Rotation settings dialog will open.
o	 Enter a numeric value in the Rotation field and click OK.

The hatch pattern for the selected items is rotated.  To return a hatch pattern 
to its original rotation either reverse the rotation angle or simply assign the 
original hatch to the object.

Hatch Origin

Hatch Scale

Hatch Rotation 
Angle
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Styles is a time-saving feature allowing you to save specific attribute setting 
combinations as an Attribute style.  These Attribute styles can then be 
applied by selecting them from the Styles menu in the Attribute menu or 
from a contextual menu when you Control- or right-click on an object.

To create a new attribute style:
o	 Select an object in the drawing which has the attributes you want to 

use to create the style.
o	 Choose Styles, New[…] from the Attribute menu — or Control- 

or right-click on the object and choose New Style from the Styles 
contextual menu.  The Attribute Style dialog will appear.

Attribute Styles

o	 Enter a name for the new attribute style in the name field. 
o	 Click Get Object Attributes to set the line, fill and hatch attribute 

settings to match the selected object in the drawing. 
o	 Select the checkbox next to each attribute you want saved with the new 

style.  You may also make any adjustments to an attribute choices by 
selecting a new attribute from any pop-up menu.

o	 Click OK. The style is saved and appears in the Styles submenu.

Attribute Styles are saved with the drawing.  If you want to save an attribute 
style and have it appear in all drawings, enable Global Attributes in the 
Preferences menu, General tab before creating your attribute style.

CAUTION: If Global Attributes has been turned On the choices displayed 
for selecting previously defined Attribute Styles is affected.  See Global 
Attributes. 

TIP: When Global Attributes is Off, adding a new Attribute Style to 
drawing 1 will only affect the menu display in that drawing.  If Global 

⚠
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Attributes is On, a new Attribute Style added to drawing 1 automatically 
appears in all drawings.

See Attributes Window in the Window section of this chapter for additional 
information.

Applying an 
Attribute Style

Deleting an 
Attribute Style

Once you have created a new attribute style, applying it as simple as 
choosing it from the Style menu.

To apply an attribute style to an object: 
o	 Select the object(s) in the drawing.
o	 Choose your custom attribute style name from Styles in the Attribute 

menu or Control- or right-click on an object and choose the style name 
from the Styles contextual menu.

o	 The attributes associated with the saved style are applied to the selected 
object(s).

To delete an attribute style: 
o	 Choose Styles, Delete[…] from the Attribute menu.  The Delete 

Attribute Style dialog will appear.

o	 Choose the style from the list and click Delete.

Deleting an attribute style only removes it from the Styles list; objects in 
the drawing are not affected.  To delete multiple styles at the same time 
Shift-click to select sequential styles, or Command-click to select multiple 
nonsequential styles.

!



Menus416

To rename or edit an attribute of a saved attribute style:
o	 Press the Option key while choosing Styles from the Attribute menu.
o	 The menu display changes, Edit is added to the start of each existing 

style name.
o	 Choose the style name to be renamed or edited.  The Attribute Style 

dialog appears.

Editing and Renaming  
Attribute Styles

o	 Enter a new name in the Style Name field, make any other attribute 
changes, and click OK.

o	 The new name and any associated attributes are saved.  The new name 
will appear in the Styles menu.
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The Fill Color menu is used to add color or gray scales to regular fills, 
hatched fills, and objects.  Colors selected reside in the PowerCADD color 
palette, managed in the Color Edit (…) dialog box.

To change the color or gray scale of a fill: 
o	 Select an object in the drawing.
o	 Assign a fill pattern to the object as explained in Fill (???).
o	 Choose the Fill Color name from the Attribute menu.
o	 Choose a color or gray scale from the Fill Color menu and release the 

mouse button.
o	 Upon release of the mouse button, the fill pattern (what?) will be 

applied to the color or gray scale specified.

You may also fill an object with a solid color by selecting an object and then 
choosing a color.   

For black-and-white Macintoshes, color can be determined by selecting the object 
from the drawing area, pulling down the Attribute menu, and observing which color 
is marked “3”. This permits the use of color plotting and printing devices with all 
Macintoshes. In addition, color drawings created on black-and-white Macintoshes can 
be transported to the color Macintoshes for correct color screen rendition.

If you set the fill color to white in this menu, the object will appear as an 
outlined, opaque object on the screen. 

You may change the fill colors available in your Fill Color submenu by 
choosing Color[…] under the Attribute menu.  To change the color in a 
particular position in the palette press the Option key when choosing a fill 
color and select the new color from the MacOS color panel.  Any change 
made to the Fill Color palette will also affect the Pen Color palette.

TIP: Editing an existing PowerCADD fill color will not affect the colors of 
objects in the drawings to which the previous color had been applied.  To 
update the old objects, use Select Special to select the objects with the old 
fill color then choose the edited (new) fill color from the fill color palette.

TIP: When Global Attributes is Off, editing a fill color position affects 
the PowerCADD pen and fill color palettes for the specific drawing.  If 
Global Attributes is On, editing a fill color position in the PowerCADD 
color palette affects the fill and pen color palettes in all drawings.

TIP: Fill colors in the PowerCADD color palette are saved with the object. 
Copying and Pasting an object with a custom fill color from drawing 1 into 
drawing 2 will retain the object’s color attribute but the PowerCADD color 
palette is not modified to show the new color.

Fill Color Menu

💡💡

💡💡

💡💡
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Fill Color… provides direct access to the MacOS Color Panel allowing you 
to assign color or gray scales fill colors to objects.  Colors accessed directly 
via the Color Panel are not stored in the PowerCADD color palettes.

To change the color or gray scale of a fill: 
o	 Select an object (or multiple objects) in the drawing.
o	 Choose Fill Color[…] from the Attribute menu — or Control- or 

right-click on an object — to open a submenu.  The MacOS Color 
Panel will appear.

Fill Color... 

o	 Choose a color or gray scale value from any of the MacOS color palettes 
and click OK.

o	 Upon release of the mouse button, the fill color will change to the color 
or gray scale specified.

The color assigned to the object does not appear in the standard PowerCADD 
color palettes.  To use the same fill color on a different object you can use 
the Eyedropper tool, manually add the color to the PowerCADD color 
palette or use any of the MacOS-level color management features to save 
and recall your favorite colors.

TIP: Editing an existing system fill color will not affect the colors of objects 
in the drawings to which the previous color had been applied.

TIP: Objects to which a system level fill color has been assigned using the 
MacOS Color Panel are saved with the object.  Copying and Pasting an 
object with a system level color from drawing 1 into drawing 2 will retain 
the object’s color attribute and the object’s system color is appended to the 
PowerCADD pen and fill color palettes.

💡💡

💡💡
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Pen allows you to assign a pattern to lines other than solid black.

Pen pattern allows you to create objects appearing to have no border.  If you 
fill an object with a diagonal crossed pattern, and you fill the pen with the 
same diagonal crossed pattern, the object will appear as a fill pattern because 
it has no border. 

To change the pen pattern:
o	 Select the object(s) you wish to change.
o	 Choose Pen from the Attributes menu.
o	 Choose the desired pattern from the Lines menu.

The lines or border of the object you selected will change to the specified 
pattern.

If you save your drawing as DXF file, pen patterns are automatically 
converted to solid in the saved file.  The original pen patterns in your 
drawing are not modified.

To change the pen pattern for continuous use:
o	 Deselect all items in the drawing area or the change will affect only 

that item.
o	 Select a drawing tool from the Tool palette.
o	 Choose Pen from the Attributes menu and choose a pen pattern as 

explained above.

From this point on, whenever the tool is selected, the pen will have the 
specified pen pattern.

When patterns are assigned to lines, thin lines will appear as unstructured 
dashes.  If you assign a pattern to a heavier line, the pattern will be more 
apparent.

We recommend that you do not use lines filled with a white pattern to hide 
unwanted lines.  Tools such as Break, Clip, and Cut with Line are much 
better alternatives for eliminating line segments.

You may change the pen patterns available in your Pen submenu by 
choosing Pattern[…] under the Attribute menu or pressing the Option key 
when choosing a pen pattern.  The first nine pen pattern positions in the 
first column starting from None and going down, are reserved and cannot 
be edited.  Any changes made to the Pen Pattern palette will also affect the 
Fill Pattern palette.

Pen Pattern Menu 
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TIP: Editing an existing PowerCADD pen pattern will not affect the pen 
patterns of objects in the drawings to which the previous pattern had been 
applied.  To update the old objects, use Select Special to select the objects 
with the old pen pattern, then choose the edited (new) pen pattern from 
the pen pattern menu.

TIP: When Global Attributes is Off, editing a pen pattern position affects 
the PowerCADD pen and fill pattern palettes for the specific drawing.  If 
Global Attributes is On, editing a pen pattern position affects all drawing 
pen and fill palettes.

TIP: Pen patterns are saved with the object.  Copying and Pasting an object 
with a custom pattern from drawing 1 into drawing 2 will retain the object’s 
pattern and a the custom pattern is added to the PowerCADD Pen and Fill 
pattern palettes.

💡💡

💡💡
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The Pen Color menu is used to add color or gray scales to lines and borders 
that outline objects.  Colors selected reside in the PowerCADD color palette 
managed in the Color Edit (…) dialog box.

To change the color or gray scale of a pen:
o	 Select an object on the drawing (or multiple objects).
o	 Choose Pen Color from the Attribute menu to open a submenu.
o	 Choose a color or gray scale form the submenu and release the mouse 

button.
o	 Upon release of the mouse button, the pen color will change to the 

color or gray scale specified.

You may also fill a line with a solid color by selecting an object and then 
choosing a color.

For black-and-white monitors, color can be determined by selecting the 
object from the drawing area, pulling down the Attribute menu, and 
observing which color is marked “3”. This permits the use of color plotting 
and printing devices with all Macintoshes. In addition, color drawings 
created on black-and-white Macintoshes can be transported to those with 
color monitors and display the correct color settings.

If you set the pen color to white in this menu, the object will appear as an 
object with no border. 

If you change the color of the pen or the pen pattern to white and print it 
through a laser printer, the color will revert to black.  This is because the 
laser printer does not recognize colors and any color assigned will print as 
black.  Some newer laser printer devices recognize colors and properly print 
the color white.

You may change the pen colors available in your Pen Color submenu by 
choosing Color[…] under the Attribute menu.  To change the color in a 
particular position in the palette press the Option key when choosing a pen 
color.  Any change made to the Pen Color palette will also affect the Fill 
Color palette.

TIP: Editing an existing PowerCADD pen color will not affect the colors 
of objects in the drawings to which the previous color had been applied.  
To update the old objects, use Select Special to select the objects with the 
old pen color then choose the edited (new) pen color from the pen color 
palette.

TIP: When Global Attributes is Off, editing a pen color position affects the 
PowerCADD pen and fill color palettes for the specific drawing.  If Global 

Pen Color Menu 

!
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Attributes is On, editing a pen color position in the PowerCADD color 
palette affects the fill and pen color palettes in all drawings.

TIP: Pen colors in the PowerCADD color palette are saved with the object.  
Copying and Pasting an object with a custom pen color from drawing 1 
into drawing 2 will retain the object’s color attribute but the PowerCADD 
color palette is not modified to show the new color.

Pen Color... 

o	 Choose a color or gray scale value from any of the MacOS color palettes 
and click OK.

o	 Upon release of the mouse button, the fill color will change to the color 
or gray scale specified.

The color assigned to the object does not appear in the standard PowerCADD color 
palettes.  To use the same pen color on a different object you can use the Eyedropper 
tool, manually add the color to the PowerCADD color palette or use any of the 
MacOS-level color management features to save and recall your favorite colors.

TIP: Editing an existing system pen color will not affect the colors of objects 
in the drawings to which the previous color had been applied.

TIP: Objects to which a system level pen color has been assigned using the 
MacOS Color Panel are saved with the object.  Copying and pasting an 
object with a system level color from drawing 1 into drawing 2 will retain 
the object’s color attribute and the object’s system color is appended to the 
PowerCADD pen and fill color palettes.

💡💡

💡💡

💡💡

Pen Color… provides direct access to the MacOS Color Panel allowing you to 
assign color or gray scales to lines and borders that outline objects.  Colors accessed 
directly via the Color Panel are not stored in the PowerCADD color palettes.

To change the color or gray scale of a pen: 
o	 Select an object(s) in the drawing.
o	 Choose Fill Color[…] from the Attribute menu (or Control- or right-click 

on an object) to open a submenu.  The MacOS Color Panel will appear.
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Pattern allows you to create your own fill patterns.  Specialized fills can be 
added to the Fill palette.

To edit or create a pattern:
o	 Choose Patterns from the Attribute menu.

Pattern Menu 

o	 To change an existing pattern, click on the Pattern box and hold the 
mouse button.  The Fill menu will appear.  Choose a fill from the 
menu you wish to change.  Note the fill you select is the fill that will be 
changed in the fill selection table.  The Editing Window in the center 
of the dialog box and the box in the upper right corner will display the 
selected fill pattern.

o	 To create a new pattern, select the New button.  A default pattern will 
be displayed in the Editing Window.  The pattern displayed will be 
a pattern from the Fill palette which will act as a starting point, but 
because you clicked New the original fill will not be altered and a new 
fill will be created with its own space in the Fill menu.

o	 Place the cursor inside the central Editing Window and click.  A black 
or a white square will appear.  By clicking on these squares to make 
them black or white, you will be able to create a new fill.

o	 To add color, click on the Color box.  A table will appear containing 
the color or gray selections.  To choose a color, drag the cursor onto the 
Color menu.  When the cursor is over the desired color and the box is 
highlighted, release the mouse button.  Upon release of the mouse, the 
Color palette will disappear and the Color box will change to the color 
you selected.  You may then place that color in the fill pattern in the 
same manner as the black-and-white squares were placed.

NOTE: The box in the upper right hand corner will change as you add or 
delete a square. This box shows you what the fill will look like when used 
in a drawing.

o	 When you have created a suitable pattern, click OK.  This will add the 
edited fill pattern to the fill table or replace the old fill pattern with the 
new pattern.  If a new fill pattern was created it will be displayed in a 
new column to the right in the Fill menu.  A new pattern will be added 
to the color table in a new column.  An edited color will replace the 

💬💬

!
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originally selected pattern.  Note when the new fill pattern is entered, 
the box entitled Pattern will change to the newly created fill.

o	 Click OK and the new fill pattern will be placed in the Fill menu under the 
Attribute menu.  The new fills will also be accessible through Hatch and Pen.

CAUTION: If Global Attributes has been turned on, changes made to the 
fill pattern palette affect all drawings.  If Global Attributes is Off, changes 
made affect the active drawing only.  

Other options in the Pattern dialog box:
o	 Fill allows you to begin creating with a black or colored background 

instead of white.  This is helpful when creating dark or colored fills.  If 
you are filling with a color, simply click on Color and select a color or 
a gray scale.  When you select Fill, the central editing window will fill 
with that color or gray scale.

o	 Mix lets you begin to create a fill starting with a color or gray scale 
checkerboard central editing window.  To mix colors or gray scales, first 
select a color and fill the central editing window.  Then select another 
color and click on Mix, a checkerboard effect will appear in the central 
editing window.  If you select another color and mix, the original fill 
will remain and the two colors you selected to mix will switch.

o	 Revert lets you switch back to a solid white background provided the 
New command has not been executed.

o	 New serves two purposes.  First, it specifies if the fill to be created is 
new or edited from an existing fill pattern.  Second, it specifies the fill 
is finished and is ready to be placed in the Fill palette.

o	 8 X 8 provides a coarse grid by which to edit.  The central editing 
window is broken down into 64 editable squares.

o	 16 X 16 provides a medium grid by which to edit.  The central editing 
window is broken down into 256 editable squares which allows for 
better resolution in the fill pattern.

o	 32 X 32 provides a very fine grid by which to edit.  The central editing 
window is broken down into 1024 editable squares which provides 
optimum resolution and color in the fill pattern.

NOTE: The fills you create are stored with the individual document, not 
with the PowerCADD program. 

If you intend to use the new or modified fill patterns in any drawing other than 
the current drawing, you must save the drawing as stationery.  You will want all 
of your customized settings in Untitled stationery in the PowerCADD folder.

You may also copy an object with a custom fill pattern from one drawing and paste 
it into another. The pattern will be added to the existing palette in the new drawing. 

⚠

💬💬
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Color allows you to edit individual colors in a PowerCADD color palette to 
suit your needs.  You may create hues and different brightness and variations 
of color to add to the Color palette.  Colors saved, added or edited here 
are separate from colors created or applied using the Pen Color(…) or Fill 
Color(…) menu items.

You may also create custom color palettes and assign identification numbers 
or text to specific colors.  You can create your own collections of color 
palettes and easily switch between collections.  Your office can standardize 
their color palettes.  Since you can apply identification to the colors, you 
can create a numbering/naming system and be able to discuss the subtle 
shades between colors, i.e., gray #6 rather than a slightly darker gray.

CAUTION: If Global Attributes has been turned On, changes made to the 
color palette affect all drawings.  If Global Attributes is Off, changes made 
affect the active drawing only.  See Global Attributes. 

When you select Color from the Attribute menu, the following Color Edit 
dialog appears:
To add a color to the Color palette: 

Color Position

Palette Choices

Add a Color

Delete a Color

Edit a Color

Mix 3 or
more colors

Add an ID tag
to a color

Make a color
Lighter

Make a color
Darker

Color Menu

o	 Choose Color(…) from the Attribute menu and the Color Edit dialog 
box will appear, containing all the colors present in the PowerCADD 
Color palette.

o	 Select Add from the dialog box.  The MacOS color panel appears.  You 
may use any of the MacOS color pickers available in the color panel, 
this example illustrates the HSB (Hue, Saturation and Brightness) 
color picker.

o	 Drag the Hue, Saturation, or Brightness sliders or type in a value in any 
of their respective fields.  The new color is shown in the color indicator 
at the top of the window.

o	 When you have created the color you need, click OK and the first 
dialog box will appear with the new color present.  Click OK on the 
first dialog box and the color is added to the Color palette.

⚠
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Hue shows the location angle of the color you have selected.  As you adjust 
the Hue slider, the color indicator will preview the change.

Saturation allows you to set the tone of a particular color.  As you adjust the 
Saturation slider, the color indicator will preview the change.

Brightness allows you to set the intensity of the color.  As you adjust the 
Brightness slider, the color indicator will preview the change. 

NOTE: You cannot add a color to full palettes, like 16Hues, EarthTones, 
Pastels or Rainbow. Instead, edit existing colors or delete unwanted colors.

To delete a color from the Color palette:
o	 Choose Color… from the Attribute menu.
o	 Select a color.  When selected, the color will be highlighted.
o	 Click Delete.  The color will be removed from the palette.
o	 Click OK to leave the dialog box.

NOTE: You cannot undo deleting a color.  If you delete the wrong color 
or did not want to delete the color, click Cancel to leave the dialog box 
without saving any changes.

When a color is removed from a palette, all colors following it will shift their 
place in the palette by one position.  Each object in the drawing remembers 
its specific color value.  As such, editing, adding or deleting color positions 
in the color palette has no effect on objects already in the drawing.

To edit an existing color:
o	 Choose Color from the Attribute menu.  A dialog box will appear.
o	 Select a color.  When selected, the color will be highlighted.
o	 Click Edit.  A second dialog box will appear.
o	 You may now edit the color in the manner described above.
o	 When the desired color has been created, click OK.  The color you 

selected to edit will be replaced by the color you created.  Click OK to 
leave the first dialog box.

If you select three or more colors, the Mix button will become active.  If the 
Mix button is selected, the colors selected will change to a scale of the first 
color selected to the last color selected.  For example, if you choose white 
first and drag to blue, Mix will result in a scale from white to blue with 
the number of colors in between governed by the number of color boxes 
selected.  If five boxes were selected, then two would be blue and white and 
three would be shades of the blue and white.

Using the ID field, you can give each color its own ID number.  Just select 

💬💬

💬💬



Menus427

a color—the ID field will become active, and you can type in a number or 
text up to four characters long.  If you use this color in another palette, the 
number or text carries over to the other palette.  The IDs that were entered 
are saved in a file called Color Palettes.

Lightness allows you to modify the saturation without entering the Color 
picker.  First select a color from the palette.  Then click on the Plus button to 
lighten the color or the minus button to darken the color.  The highlighted 
color will lighten or darken as you click.  If you select multiple colors at 
once, the Lightness buttons will change them simultaneously. 

Colors also allows you to use several pre-created palettes which are located 
to the left hand side of the color dialog box.  Pressing on the pop-up menu 
named Palettes opens a submenu.

To use one of the palettes:
o	 Choose Palettes and drag to the desired palette and release.
o	 Upon release of the mouse, the color table to the right will change to 

the selected palette. This palette will also show when you are using 
the Color palette under the Attribute menu as well as the Defaults 
Window or through contextual menus.
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Save Custom allows you to save new custom color palettes.

To save a custom color palette:
o	 Choose Save Custom from the Palettes pop-up menu.

Save Custom Palette 

o	 The Save Custom Palette dialog appears.

o	 Enter the name of the palette and click OK.  

The new palette will appear at the bottom of the list.

All custom color palettes you create in a single session of PowerCADD, 
as well as all IDs you assign to colors, will be stored in a single file called 
Color Palettes.  The Color Palettes file is stored in the PowerCADD folder 
in your User directory, Library folder, Preferences folder.  Any customized 
color palettes you create can be saved by copying the Color Palettes file into 
another folder, or by renaming the file.  If you rename the file, PowerCADD 
will create a new file called Color Palettes the next time you assign IDs to 
colors or make new palettes.

This makes color palettes easy to save, transport, and interchange between 
different users.  You can make customized color palettes for a project, and 
save them with the project in the same folder.  If you create a special color 
scheme or numbering system that a colleague wishes to use, you can send 
them the Color Palettes file.  Later, if you wish to use this color scheme with 
another project, you can copy the file back into your PowerCADD folder 
and rename it to Color Palettes of the list.
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Delete Custom Palette Delete Custom allows you to delete customized color palettes.

Only custom color palettes may be deleted.

To delete a custom color palette:
o	 Choose Delete Custom from the Palettes pop-up menu.  The Delete 

Custom Palette dialog appears.

o	 Choose the name of the palette so it highlights and click Delete.  A 
warning message will appear, to verify that you really want to delete 
the palette.  To delete multiple custom palettes at the same time Shift-
click to select sequential palettes, or Command-click to select multiple 
nonsequential palettes.

o	 Click OK.

If you intend to use the new or modified colors in any drawing other than 
the current drawing, Save As stationery or Save the colors in a custom 
palette. Otherwise, you will have to paste an object with the desired color 
from one drawing to another, or create the special colors in each drawing 
as needed.

Custom colors pasted from one drawing to another are not appended to the 
color palette. However, since the color value is saved with the object, the 
object will retain its color.

To add the pasted object’s color to the new drawing color palette:
o	 Choose Color(…) from the Attribute menu.  The Color Edit dialog 

will appear.  Click the Add button and the MacOS Color Panel will 
appear.

o	 Click on the magnifying glass next to the color well.
o	 Drag the magnifying glass cursor over the object in the drawing 

containing the color you want to add and click the mouse.
o	 The color will be displayed in the MacOS color well, click OK.
o	 The color will be appended to the PowerCADD color palette.
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Attribute Line Weight Lines allows you to enter customized line weights. These weights can be 
entered in inches, points, or millimeters.

To customize the Line Weight palette:
o	 Choose Lines from Attribute menu.
o	 The following dialog will appear:

status column

line weight column

preview column

unchecked items
are not listed in the

Attribute menu

checked items
are listed in the
Attribute menu

press and drag up or down
on an item in the list to changes

its position in the palette

press Delete to remove selected
line weights from the palette

press New to add a new
line to the palette

select a line weight and press
Edit to modify an item in the palette

(or double click on a line weight)

press Cancel to close the dialog
and not save any changes

press OK to save any changes
and close the dialog

o	 The dialog presents a list of current line weights in the drawing and which 
items are currently displayed in the Attribute menu.  You have complete 
control over how many line weights are displayed in the Attribute menu 
by checking or unchecking an item in the status column.

o	 Double-click any line in the preview pane or select a line and click 
Edit.  The Edit Pen dialog will appear. 

o	 The current pen size is listed in the Pen Size field.  You may type in 
the desired line weight and select the desired units (Points, Inches or 
Millimeters) from the pop-up list.

o	 After you have made all the changes necessary, click OK to place the 
line weights in the Line Weight palette.

o	 The line weight will remain in effect until you change them.  They are 
stored with the document and are not made available in other documents. 

If you intend to use the new line weights in any drawing other than the 
current drawing, you must Save As stationery.  If you do not Save As 
stationery, it will be necessary to create the special line weights in each 
drawing they are needed.  You will want all of your customized settings in 
Untitled stationery in the PowerCADD folder.



Menus431

New line weights may be added to the palette at any time.  

To add a line weight:
o	 Choose Lines[…] from the Attribute menu.
o	 Click New in the Pen… dialog box.  The Edit Pen dialog will appear.

New Line Weights

o	 Type the desired line weight in the Pen Size field and choose the desired 
units from the pop-up menu. 

o	 After you have made all the changes, click OK.  The new line is 
appended to the bottom of the palette.

o	 To change the position of the new line weight, click and drag on the 
line in the preview pane.  Release the mouse when you have positioned 
the line in the desired location.

Line weights are appended to the palette when pasting information from 
different drawings or inserting data from symbol libraries.  If you find the 
menu contains too many items or the items need to be reordered, simply 
turn items On or Off or change their order as previously described.

CAUTION: If Global Attributes has been turned On, changes made to the 
line weight palette affect all drawings.  If Global Attributes is Off, changes 
made affect the active drawing only.  See Global Attributes. 

⚠
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Attribute Arrows Menu Arrows allows you to create custom arrows to use with a particular drawing. 
The arrows created are stored with the document or the stationery, not with 
the PowerCADD program.

To change the selection in the Arrows menu:
o	 Choose Arrows from the Attribute menu.
o	 The following dialog will appear:

status column

preview column

unchecked items
are not listed in the

Attribute menu

checked items
are listed in the
Attribute menu

press and drag up or down
on an item in the list to changes

its position in the palette

press Delete to remove selected
arrow styles from the palette

press New to add a new
arrow style to the palette

select an arrow and press
Edit to modify an item in the palette

(or double click on an arrow)

press Cancel to close the dialog
and not save any changes

press OK to save any changes
and close the dialog

o	 This dialog shows a list of the current arrow styles in the document, 
their position in the menu and whether they are visible or not visible 
in the Arrow menu.

o	 Double-click any arrow in the preview pane or select an arrow style and 
click Edit.  The following dialog will appear:

Not all options are available for all arrow types.  If an option is unavailable, 
it will be dimmed, and you will be unable to select it.

Arrowheads can be constructed of straight lines, or curved lines for a 
more artistic look.  They can also be filled, have a heavier line for the 
arrowhead, or have any combination of the three options.
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Heavy is the only option for the tick mark arrow, and it will use a larger 
point size for the tick mark.

Filled is the only option for the node arrow, and it will fill the node.

o	 Select the desired type and the arrow will be placed in the Editing box.
o	 Place the cursor on the handle of the arrowhead in the Editing box.
o	 Drag the cursor in any direction.  Note how the arrowhead changes 

shape.  A second way to create an arrow is to type a length and angle.  
The arrow will snap to the parameters immediately.

o	 When you have created the arrow to your satisfaction, click OK and 
the arrow will be inserted in the menu box of the arrows.  

	 If the arrow was edited from an existing arrow and the same arrow 
appears in both windows, the OK button will place it in both the 
Available box and the Menu box.  

	 If the arrow was edited from an existing arrow and the arrow did 
not exist in both boxes, the edited version will only be placed in the 
Available box. 

	 If a new arrow was created, the OK button will place the arrow in the 
Available box, and you must transfer it to the Menu box.

If you intend to use the new or modified arrows in any drawing other than 
the current drawing, you must save as stationery.  If you do not save as 
stationery, you must create the special arrows in each drawing they are 
needed.  You will want all of your customized settings in Untitled stationery 
in the PowerCADD folder.
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Attribute Arrow 
Styles

New arrow styles may be added to the palette at any time.

To add an arrow style:
o	 Choose Arrows[…] from the Attribute menu.
o	 Click New in the Arrow… dialog box.  The following dialog will 

appear.

o	 Specify the desired options as described earlier for editing arrows.
o	 After you have made all the changes, click OK.  The new arrow style is 

appended to the bottom of the palette.
o	 To change the position of the new arrow style, click and drag on 

the arrow in the preview pane.  Release the mouse when you have 
positioned the arrow in the desired location.

Arrow styles are appended to the palette when pasting information from 
different drawings or inserting data from symbol libraries.  If you find the 
menu contains too many items or the items need to be reordered, simply 
turn items On or Off or change their order as previously described.

CAUTION: If Global Attributes has been turned On, changes made to the 
arrow style palette affect all drawings.  If Global Attributes is Off, changes 
made affect the active drawing only.  See Global Attributes. 

⚠
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Attribute Dash Menu Dashes allows you to create customized dashed lines.  These dashed lines are 
stored with the document or the stationery.

To change the dashed line forms in the Dash menu.
o	 Choose Dashes from the Attributes menu.
o	 The following dialog box will appear:

status column

preview column

unchecked items
are not listed in the

Attribute menu

checked items
are listed in the
Attribute menu

press and drag up or down
on an item in the list to changes

its position in the palette

press Delete to remove selected
dash styles from the palette

press New to add a new
dash style to the palette
select a dash and press

Edit to modify an item in the palette
(or double click on a dash)

press Cancel to close the dialog
and not save any changes

press OK to save any changes
and close the dialog

o	 This dialog shows a list of the current dash styles in the document, their 
position in the menu and whether they are visible or not visible in the 
Dash menu.

o	 Double-click any dash in the preview pane or select a dash style and 
click Edit or New.  The following dialog will appear:

	 In this box is a ruler to set up the dashes and breaks, a choice of inches 
or centimeters, a gauge line to construct the dashes and breaks, an 
Insertion box which adds dash segments and breaks, and an example 
line to display the appearance of the line.

o	 Click the small Insertion box on the right.  A line segment and 
a line break will appear.  The black handle on top of the gauge line 
corresponds to the dash segment while the white handle below the 
gauge line corresponds to the break segment.
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o	 Select one of the diamond-shaped handles and drag the cursor in either 
direction. The example line moves with the line segment change.  The 
ruler allows you to create dashed lines of a specific size.  When the 
mouse button is released, the line break/dash will be set until you 
change it.  For additional dashes or breaks, click the Insertion box at 
the right hand side of the gauge line.  If you place too many breaks in 
the line, select and drag the segment handle as far as possible to the 
right.  The segment will only stretch a certain distance, you must drag 
until the cursor is off of the gauge line to the right.  This will remove 
extra line dashes and breaks.

o	 When you have created the dashed line to your satisfaction, click OK 
and the line will be inserted at the bottom of the list in the dialog 
window.

The line forms that are created in a drawing are stored with that document.  
The dashed lines that were created will not be available in other drawings.

If you intend to use the new or modified dashes in any drawing other than 
the current drawing, you must save as stationery.  If you do not Save As 
stationery, it will be necessary to create the special dashes in each drawing 
they are needed.  You will want all of your customized settings in Untitled 
stationery in the PowerCADD folder.

CAUTION: If Global Attributes has been turned On, changes made to the 
dash pattern palette affect all drawings.  If Global Attributes is Off, changes 
made affect the active drawing only.  See Global Attributes. 

⚠
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New Dash Styles New dash styles may be added to the palette at any time. 

To add a new dash style:
o	 Choose Dashes[…] from the Attribute menu.
o	 Click New in the Dash… dialog box.  The following dialog will appear.

o	 Specify the desired options as described earlier for editing dashes.
o	 After you have made all the changes, click OK.  The new dash style is 

appended to the bottom of the palette.
o	 To change the position of the new dash style, click and drag on the 

dash style in the preview pane.  Release the mouse when you have 
positioned the dash in the desired location.

Dash styles are appended to the palette when pasting information from 
different drawings or inserting data from symbol libraries. If you find the 
menu contains too many items or the items need to be reordered, simply 
turn items On or Off or change their order as previously described.
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New Hatch New Hatch allows you to make your own custom hatch patterns.  Custom 
hatches from selected objects in the drawing or using the Line Hatch 
editing dialog.  Custom hatches are appended to the main hatch menu and 
are created to scale based on the current drawing or layer scale.

CAUTION: If Global Attributes has been turned On, changes made to 
the hatch pattern palette affect all drawings.  If Global Attributes is Off, 
changes made affect the active drawing only.  See Global Attributes.

From Selection

⚠

To create a custom hatch pattern from selected objects in the 
drawing:
o	 Set up your drawing scale and units to reflect the scale you want the 

hatch pattern created.  For example, if you want to create a custom 
tile or brick hatch appropriate for drawings at 1:48, setup the drawing 
scale and units accordingly.

o	 Draw the objects representing the hatch pattern and assign any desired 
attributes for color, line weight, fill, etc.  The hatch pattern may contain 
any type of PowerCADD object.

o	 Select all the objects to be included in the hatch and choose New 
Hatch, From Selection, from the Attribute menu.

o	 The custom hatch is appended to the end of the hatch palette.

There is no method to directly edit a hatch pattern once it has been added 
to the palette.  As such, it is recommended you save a PowerCADD drawing 
with the core objects used to create your custom hatch patterns.  Having a 
saved drawing makes it fast and easy to go back and edit the pattern or share 
the patterns with other PowerCADD users.

TIP: To lock the pen color and line weight of a hatch pattern, group the 
objects before choosing New Hatch, From Selection.  If the objects are 
not grouped you will be able to change the pen color and line weight after 
the hatch is applied to an object using the Hatch Settings, Line and Color 
menu items.

TIP: You can create a hatch from a bitmap image for anything.  A good 
example is shown for water below.  Of course, you could also have grass, 
fabric, gravel, etc.

💡💡

💡💡

🕺🕺!🥁🥁



Menus439

Line Hatch Editor The Line Hatch editor allows you create line-based hatch patterns which 
redraw seamlessly when an object they are applied to is reshaped or resized.  

The following general rules apply to new hatches created with the 
Line Hatch menu item:
o	 A new line hatch pattern cannot be edited using the Line Hatch dialog 

once it is added to the hatch palette.
o	 If the new line hatch contains multiple lines, using the Hatch Settings 

menu to change the hatch pen color or line weight of a pattern applied 
to an object will change all lines in the pattern.

o	 The origin of a Line Hatch pattern cannot be changed.
o	 The scale of a Line Hatch pattern cannot be changed.
o	 A line hatch may contain up to five lines.  The attributes and angle for 

each line may be set independently.

To create a new line hatch pattern:
o	 Choose Hatch, Line Hatch[…] from the Attribute menu, the Line 

Hatch editor will appear.

preview panel

click to add another
line to the pattern (up
to a maximum of three)

click to select a dash pattern
for the current line

click to select a pen pattern
for the current line

click to remove the current
line from the pattern

click to select a pen color from
the Mac OS X color panel

click to set a line weight
for the current line

click to select a pen color from
the PowerCADD color palette

repeat distance interval
for the current line

distance the current line is
offset from the previous line

line angle for the current line

current line number menu

o	 Selected the desired options from the dialog box and click OK.  The 
new line hatch is appended to the hatch pattern palette.

The Preview Panel provides instant feedback as changes are made to 
other line hatch settings.

The Current Line Number pop-up menu allows you to select a particular 
line number for editing.  The values and options displayed for angle, 
offset, spacing, and object attributes may be adjusted separately for 
each line number.  The display will update when switching between 
different line numbers from the Current Line Number pop-up menu.
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The Angle field allows you specify a line angle for the currently selected 
line number.  Angles may be entered in positive or negative values, 
decimal degrees, or degrees minutes and seconds.  For example an 
angle of 45.0 or an angle of –45.0 or an angle of 135.0 all produce 
the same result.  You may also enter math in the angle dialog box, for 
example 45-15 would draw the line at 30 degrees.

The Offset field affects multi-line hatch patterns, allowing you to 
specify the offset distance from Line 1 to Line 2, or from Line 1 to Line 
3.  The offset distance is always measured relative to Line 1, and each 
line may have a different offset distance.  The units and scale for values 
entered here are taken from the Drawing Setup, Scale tab settings.

The Spacing field allows you specify the interval before a line repeats 
itself.  Spacing is measured relative to a current line number, and each 
line may have a different spacing interval.  The units and scale for values 
entered here are taken from the Drawing Setup, Scale tab settings.

o	 Click on the MacOS Color Wheel to choose a pen color for the current line 
using the MacOS color panel.  Each line may have a different pen color.

o	 Click on the PowerCADD Color Swatch to choose a pen color for the 
current line from the PowerCADD color palette.  Each line may have 
a different pen color.  The values in this palette are the same as those 
available in the Attribute menu.

o	 Click on the Pen Pattern Swatch to choose a pen pattern for the current 
line from the Pen Pattern palette.  Each line may have a different pen 
pattern.  The values in this palette are the same as those available in the 
Attribute menu.

o	 Click on the Line Weight pop-up menu to choose a line weight for the 
current line.  Each line may have a different line weight.  The values in 
this palette are the same as those available in the Attribute menu.

o	 Click on the Dash Pattern pop-up menu to choose a dash pattern for the 
current line. Each line may have a different dash pattern.  The values in 
this palette are the same as those available in the Attribute menu.

CAUTION: When Global Attributes is On, values displayed for Pen 
Pattern, Line Weight, and the PowerCADD Color Palette are affected.  
See Global Attributes.

o	 Click the plus button to add a new line to the hatch pattern.  The new 
line number is displayed in the Current Line Number pop-up menu.

o	 Click the minus button to remove the current line number displayed in 
the pop-up menu at the top of the dialog from the hatch pattern.  This 
operation cannot be undone.

⚠
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Delete Hatch Delete Hatch allows you remove unwanted patterns in the hatch menu.

To delete a hatch pattern:
o	 Choose Delete Hatch from the Attribute menu.  The Delete Hatch 

dialog will appear.

o	 Select the hatch pattern to be deleted and click Delete.  To delete 
consecutive hatches, Shift-click on the patterns. To delete non-
consecutive hatches, Command-click on the patterns.

o	 Click OK to close the dialog box.

The hatch pattern will be removed from the Hatch menu.
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Text Menu Text can be entered at any zoom, but it is best entered at normal scale.  When 
text is zoomed too small to see, it becomes a rectangle the approximate size 
of the text.

Unusual character spacing problems can occur when you send a drawing to 
another office across the country and the MacOS the drawing is viewed on 
does not have the same fonts you have.

Convert Outlines Convert Outlines produces Bézier curves tracing the outlines of your 
TrueType fonts.

Convert Outlines is useful, as Bézier curves can be manipulated in ways not 
possible with text. 

These outlines can be scaled, reshaped, mirrored, or sheared.  Non-
proportional scaling or resizing creates expanded or condensed text.  
Sheared outlines can be used to place text in isometric drawings or can be 
used in desktop publishing applications.  Mirrored outlines can be used to 
produce plans to be used on light boards.

To convert text to outlines:
o	 Select the text to be converted.
o	 Choose Convert Outlines from the Text menu.  The original text is 

replaced with Bézier outlines.

NOTE: Convert Outlines converts TrueType and OpenType fonts only.💬💬

Anchor
[TextMenu]
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Spelling... Spelling finds words in your drawing having no match in the dictionary and 
makes suggestions for correction.  Spelling can be checked for the entire 
document or a selection of text.

NOTE: PowerCADD uses the standard spell checker and dictionaries used 
in other MacOS programs such as TextEdit or Mail.  This allows you to 
have one common dictionary for all MacOS applications.

To spell check your entire document:
o	 Choose Deselect All from the Edit menu.
o	 Choose Spelling from the Text menu.
o	 When a word having no match in the dictionary is encountered, the 

Spelling dialog will appear:

💬💬

The lower pane of the dialog selects the misspelled word and displays it as 
it is used in the text block.  The upper Guess pane of the dialog lists any 
suggested spelling corrections and selects the recommended change.

If the selected suggestion is correct, click Correct, or press the Return key, 
or double-click on the suggested word to apply the new spelling.  If the 
selected word is in fact correctly spelled but simply not in the dictionary, 
click Learn.  If a word was incorrectly added to the dictionary, select the 
word and click Forget.  You can change languages by clicking on the popup 
menu and choosing a preferred language dictionary from the list.

You can jump to the next misspelled word by pressing Find Next.  The misspelled 
will be selected and any suggested spelling changes are listed as shown here:
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You can go to the next word without any change by clicking Ignore.  To see 
a word suggestion for any word, click on the word in the lower portion of 
the dialog and a list of suggested words will appear in the Guess pane.

To spell check selected text in a document:
o	 Select text block or multiple text blocks to be spell-checked.
o	 Choose Spelling from the Text menu.
o	 When a word having no match in the dictionary is encountered, 

the Spelling dialog will appear. Follow the steps described earlier to 
complete the spell-check operation.
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Find Find searches the document for the text you specify.  It does not search in 
dimensions or symbols.

Find and Replace works very similarly to your word processing applications.  
You can find a single word or a combination of words, then replace one 
occurrence, replace all of them, or just find the next one.  Find and Replace 
can be a very efficient way to change references to detail keys in a drawing, 
change page number references or update part numbers, plant names or 
spot elevations in a drawing

To find a word or phrase:
o	 Select Find from the Text menu. The Find/Replace dialog will appear.

o	 Type the text you are searching for in the Find box and any text you 
wish to replace it with in the Replace box.  You can also select text 
within your document, copy the selection and paste it into the Find 
box.

o	 Click Next.  The first instance of the phrase will be highlighted.  
Alternately, you may replace just that occurrence by clicking Replace, 
or replace every occurrence by clicking Replace All.

Repeat these steps to find or replace the next occurrence.

Case Sensitive searches for instances of the word which has the same case 
spelling, so you can look for instances of SOAR and ignore instances of soar.

To change the type of search click Contains and choose the desired option 
from the popup list.  Contains searches for instances where the phrase is 
part of a word.  For example, if you are trying to find cat and Contains 
is active, it will consider cataract a valid choice.  If Starts with is active, 
only words which start with the specified phrase are found.  Full Word will 
search for instances where the phrase is a whole word (words separated by 
spaces), and will exclude instances where the phrase is part of a word.  For 
example, if you are trying to find cat and Full Word is active, it will not 
consider cataract a valid choice

Find goes to the first instance of the phrase and highlights the phrase in the 
text block.  Replace goes to that instance, substitutes in the phrase from the 
Replace field, and highlights the replacement in the text block.  Replace All 
performs a replacement for all valid instances in the document.
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Find Again finds the next occurrence of the given characters, highlighting 
them for editing.  After finding the last occurrence, it will start over, 
choosing the first occurrence again.

Find Again
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Replace Font Replace Font allows you globally change one font family to another.  For 
example, you can change all text blocks in your drawing from Geneva to 
Times.

To use Replace Font:
o	 Choose Replace Font from the Text menu. 
o	 The Replace Font dialog will appear.

o	 The Font-to-Find list contains a list of all fonts currently used in your 
document.  Click on the first font name in that popup list and select 
the desired font that is going to be replaced.

o	 The Replace-with list contains a list of all fonts available in MacOS. 
Click on the first font name in that popup list and select the desired 
font to be used as a replacement.

o	 Click Replace All and all fonts are updated in the drawing.
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Font Font allows you to select the font that you want to have in your text.

To select a font for continuous use:
o	 Select the Text tool from the Tool palette by double-clicking on it.
o	 Choose Font from the Text menu.
o	 Choose the Font you wish to use from the submenu.
o	 The font you selected is active and will remain active until you change 

it.

To change a font momentarily:
o	 With the Text tool selected, click where you want to place the next 

piece of text.
o	 Choose Font from the Text menu as explained before.
o	 Enter the text with the new font characteristics.  When you click on the 

next point to enter text, the font will revert to the font type that was 
active before the change.

This font change is temporary and will only remain in effect until you add 
another piece of text.

To change the font of existing text:
o	 Select the text you wish to change.
o	 Choose the correct font type from the Font menu.
o	 Upon selection of the font, the selected text will change to the specified 

font type.
o	 Alternately, select in the Text and highlight the text to be changed.  

Multiple styles and fonts may be used in a single piece of text.



Menus449

Font Size Size allows you to select the font size you wish to use.

To select a font size for continuous use:
o	 Select the Text tool from the Tool palette by double-clicking.
o	 Choose Size from the Text menu, press and hold the mouse button.
o	 Choose the size you wish to use.
o	 The size you selected is active and will remain active until you change 

it.

To change a font size momentarily:
o	 With the Text tool selected, click where you want to place the next 

piece of text.
o	 Choose Size from the Text menu and choose a font size as explained 

before.
o	 Enter the text with the new font size characteristics.  When you click 

on the next point to enter text, the font size will revert to the font size 
that was active before the change.

This size change is temporary and will only remain in effect until you 
attempt to add another piece of text.  The Text tool defaults are remembered 
and change only when the Text tool is selected.

To change the font size of existing text:
o	 Select the text you wish to change.
o	 Choose the correct font size from the Size menu.
o	 Upon selection of the font size, the selected text will change to the 

specified font size. 
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Font Style Style allows you to select the font styles you wish to use.

To select a font Style for continuous use:
o	 Select the Text tool from the Tool palette by double-clicking.
o	 Choose Style from the Text menu, press and hold the mouse button. 
o	 Choose the style you wish to use.
o	 The style you selected is active and will remain active until you change 

it.

To change a font Style momentarily:
o	 With the Text tool selected, click where you want to place the next 

piece of text.
o	 Choose Style from the Text menu and choose a font style as explained 

before.
o	 Enter the text with the new font style characteristics.  When you click 

on the next point to enter text, the font style will revert to the font style 
that was active before the change.

This style change is temporary and will only remain in effect until you 
attempt to add another piece of text.

To change the font Style of existing text:
o	 Select the text block you wish to change.  Selection handles will appear 

to indicate the text has been selected.
o	 Choose the correct font style from the Style menu.
o	 Upon selection of the font style, the selected text will change to the 

specified font style.
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Lowercase/Uppercase Lowercase or Uppercase allows you to change the case of existing text.

To change case in portions of existing text:
o	 Select the Text tool from the Tool palette.
o	 Select the text you want to change.
o	 Select the portion of the text you wish to change by highlighting. 
o	 Choose Lowercase or Uppercase from the Text menu.
o	 The text will change to the characteristics you specified. 

To change the case of entire portions of existing text:
o	 Select the text block you wish to change.  Selection handles will appear 

to indicate the text has been selected.
o	 Choose Lowercase or Uppercase from the Text menu.
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Title Text Title allows you to change existing text to title text.  You are able to select 
a piece of text and change the first letter of each word from lowercase to 
uppercase.

To change portions of existing text to Title text:
o	 Select the Text tool from the Tool palette.
o	 Select the text block you wish to change.
o	 Select the words you want to change by highlighting.
o	 Choose Title from the Text menu.
o	 The first letter of the words you selected will be changed to uppercase 

letters.

To change entire portions of existing text to Title text:
o	 Select the text block you wish to change.  Selection handles will appear 

to indicate the text has been selected.
o	 Choose Title from the Text menu.
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Text Alignment Alignment allows you to select the alignment you wish to use.

To select a font Style for continuous use:
o	 Select the Text tool from the Tool palette by double-clicking.
o	 Choose Alignment from the Text menu, press and hold the mouse 

button.
o	 Choose the alignment you wish to use.
o	 The alignment you selected is active and will remain active until you 

change it.

Left/Center/Right/Full Left, Center, Right and Full allows you to select how you want the text to 
be aligned. 

To select a text alignment for continuous use:
o	 Select the Text tool from the Tool palette by double-clicking.
o	 Choose Left, Center, Right or Full from the Text menu.
o	 The text alignment you selected is active and will remain active until 

you change it.

To change a text alignment momentarily:
o	 With the Text tool selected, click where you want to place the next 

piece of text.
o	 Choose a different text alignment from the Text menu.
o	 Enter the text with the new text alignment characteristics.  When you 

click on the next point to enter text, the text alignment will revert to 
the alignment active before the change.

This alignment change is temporary and will remain in effect only for this 
piece of text.

To change the text alignment of existing text:
o	 Select the text you wish to change.
o	 Choose Left, Center, Right or Full from the Text menu.
o	 Upon selection of the text alignment, the selected text will be aligned 

according to specifications.
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Text Spacing The Spacing commands in the Text menu allow you to control the distance 
between lines of text. 

Spacing between lines can be chosen as in any word processing program, by 
choosing single spacing, 1-1/2 spacing or double spacing.
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Text Leading Leading allows you to choose the exact amount of leading required in point 
size.

To use Leading:
o	 Select the text to which you wish to apply a specific leading.
o	 The following dialog will appear:

Leading Plus

Leading Minus

o	 Type the desired amount and click OK.

Leading+ adds space between lines.  If more leading is desired, you may 
choose Leading+ more than once for the same piece of text.

Leading- reduces space between lines.  As with Leading+, you may choose 
Leading- more than once for the same piece of text.
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Add Text Style Add Style allows you to add a style to the Text Style menu.

If you have a particular set of text attributes you use regularly, creating a 
favorite is an excellent way to streamline your workflow.

To create a new favorite:
o	 Select the text block in the drawing which has the correctly assigned 

text attributes.
o	 Click on the Favorites pop-up in the Text Attributes window and 

choose Add Style. The following dialog will appear:

Style Name field

Font List pop-up
menu

Font Size field

Font Size
Adjustment Arrows

Font Style buttons

o	 Enter a name for the new favorite in the Style Name field.
o	 Click the Get-Object-Attributes button to acquire the attributes of the 

selected item in the drawing.
o	 Make any desired changes by adjusting the Font Size or Style or select 

a different font from the Font List pop-up.
o	 Click OK and a preview of the new style is appended to the Text Styles 

menu and to the Favorites menu in the Text Attribute Window.

NOTE: Pen color, pen pattern, fill color and fill pattern are not saved with 
a text favorite.💬💬
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Delete Text Style Delete Style allows you to remove any text style from the Text Style menu.

To delete a style from the Text Style menu:
o	 Choose Delete Style from the Text menu and the Delete Style dialog 

box will appear.
o	 Choose the style you wish to remove from the Text Style menu and 

select the Delete button.  To delete multiple Styles at the same time, 
Shift-click to select sequential Styles, or Command-click to select 
multiple nonsequential Styles.
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Text Styles Menu Text Styles allows you to select a style from a menu of styles you have created 
for your drawing.

To use Text Styles:
o	 Select a block of text.
o	 Choose Text Styles from the Text menu and a submenu will appear.
o	 Choose the desired text style.
o	 The text style you just specified will be assigned to the selected text in 

the drawing.

If no text is selected, the selected tool’s default will change. 

If both the Text tool and text in the drawing are selected, the drawing text 
will be changed. 

Text in the drawing takes precedence and the Text tool defaults remain 
unchanged. 
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References Menu The References menu contains items pertaining to referencing other 
drawings, allowing you to add a reference (other drawing files) to your 
master drawing.  Any PowerCADD drawing or any file type PowerCADD 
can open (e.g. a PhotoShop file may be referenced if the Graphics Export 
External is loaded) may be referenced. 

You can place references in any drawing, including multiple references of 
the same drawing. 

When a drawing is added as a reference, it reloads the referenced drawing 
from the original as needed.  References allow you to work with other 
drawings without permanently adding them to the master drawing.

Referencing Key 
Concepts

The biggest advantage to using references is having the most current 
information without having to redraw content for use in another file or 
having to manually update drawings sharing the same content via copy and 
paste or other techniques. 

To fully understand how referencing works and how it might benefit your 
workflow we can break it down into two fundamental components:

o	 Master Drawing: A destination into which we put content.  In this 
case the content may be objects we draw from scratch or objects which 
come from a linked, outside source.

o	 Reference Drawing: A source of content which is placed into a master 
drawing, thereby establishing a dynamic link between the Master 
(destination) and Reference (source) drawings.

A master drawing can be composed of many referenced drawings.  When 
a referenced drawing is modified and saved, the master drawing is 
automatically updated with the new content.

In a simple example, a reference drawing might be a project title block 
drawing containing standard elements such as project name, your company 
name, and other standard graphic elements.  

A Master Drawing might be an electrical plan, and another master drawing 
may be a reflected ceiling or site plan.  Each Master Drawing can reference 
the same title block drawing.  Using References, a change made to the title 
block referenced drawing (e.g. adding a client logo to the title block) will 
automatically appear in each Master Drawing.

In a more complex example, a master drawing for a motel might be 
composed of many referenced drawings representing the entire project 
ranging from different suites, or perhaps different drawings representing 
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plumbing, electrical, and site development.  There may be many people 
working on the project, each with different directives.  

By using referencing, you can reference any or all of their drawings and 
consolidate the information into one master drawing.  When any of the 
original referenced drawings are modified, the master drawing will also be 
modified reflecting any changes.

Place Reference

o	 Apply the desired setting choices and click Place.  Each choice is 
described later in this section.

o	 A preview of the referenced drawing appears along with a move cursor 
in the top left-hand corner.  By default the preview matches the extents 
of the data in the referenced drawing.  The displayed extents may be 
modified by masking in the master drawing after it is placed.

o	 Drag to position the top left corner and click the mouse to place the 
referenced drawing.

o	 Snapping may be used to insert the top left corner in a precise location.
o	 A new layer titled “References” is automatically created.

CAUTION: Changing the layer status of the “References” layer to hidden 
(Off) will also automatically hide all referenced objects on all other layers.

Place Reference allows you to place a reference to another file in your master 
drawing which can be updated automatically without redrawing.

To place a reference drawing in your master drawing:
o	 Choose Place Reference from the References menu.  The standard 

MacOS Open dialog appears allowing you to navigate and locate your 
drawing.

o	 Select the drawing you wish to use as a reference.
o	 Click Open and the following dialog box appears:

⚠
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Reference Layer Settings

TIP: If you are placing multiple references into the same master drawing, 
the first reference placed sets the master reference origin.  Placing additional 
referenced drawings will automatically use the master reference origin.  
Each referenced drawing may be moved independently after it is placed if 
different origins are required.

The Scale to Destination Drawing Scale checkbox will automatically scale 
the reference drawing to the scale of the master drawing.  If left unchecked, 
the reference drawing will retain its scale as set in the original drawing.

CAUTION: The Layer Attributes settings for Opacity, Color, and Scale 
are not transferred when referencing drawings into a master drawing.  Line 
weights, dash patterns, and text sizes are not scaled.

Referenced Layers

Layer Name Prefix

💡💡

⚠

Layer Settings control how the layers on the reference drawing are handled 
by your master drawing.

All Layers will place all layers from the reference file into the new drawing. 
The layers will be placed as they are set up in the master drawing.  If there are 
more layers in the reference drawing than in the master drawing, additional 
layers will be added to the master drawing as needed.  As an example, if 
you have ten layers in your master drawing and ten layers in your reference 
drawing, as long as the name of the layer is the same in both drawings, each 
layer will be merged into a single layer.

If the names of the layers are different, new layers will be added to your 
master drawing to accommodate the reference drawing’s layers.

Visible Only will place only visible layers from the reference drawing into 
the master drawing. If the layer names match in the master and referenced 
drawings, the content is merged on to the common layer.  If layer names are 
different new layers are added to the master drawing.

No Prefix inserts new layers into the master drawing using the same name 
as appeared in the referenced drawing.  If the layer name in the reference 
and master drawings are the same, the data from both drawings is combined 
onto the same layer; referenced data on a common layer cannot be selected.

“Referenced Drawing 01.PC9” is a dynamic field where the name of this 
field will change to match the name of the drawing file you are referencing. 
Choosing this radio button will append the name of the file as it appears 
in the dialog to the start of every layer referenced into the master drawing.

Custom allows you specify what prefix should be appended to layer names 
from the referenced drawing into the master drawing. If the layer name in 
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Update All

the reference and master drawings are the same, the data from the referenced 
drawing appears on its own layer with the custom prefix appended to the 
start of the layer name.

TIP: If you have common layer names in the referenced and master drawing, 
and you want the data to appear on different layers when referenced, add 
the drawing name or a custom layer name prefix. The data will be referenced 
into an appropriately named new layer. 

Bind To Drawing

Update Selected

💡💡

Update All will reload all of the reference drawing content.  If you know the 
references in your drawing have changed, or you want to ensure  you have 
the most recent content, choose Update All from the References menu.

Update Selected allows you to specify which referenced drawing should be 
updated. 

To update a specific Referenced Drawing:
o	 Select the Referenced drawing as described in Working With References 

later in this section.
o	 Choose Update Selected from the References menu.
o	 The contents of the selected reference are updated in the master 

drawing.

Bind To Drawing allows you to permanently add (bind) a referenced 
drawing to your master drawing.  When you bind a reference drawing, you 
are disconnecting the reference and you will no longer be able to update the 
master drawing when you change the reference drawing.  When saving your 
drawing as .dwg or DXF, the references are automatically bound.

To bind a reference:
o	 Select the reference drawing as described in Working With References 

later in this section.
o	 Choose Bind To Drawing from the References menu.
o	 The following dialog will appear:

o	 Click OK and the reference is simply disconnected and the objects are 
placed into the master drawing permanently.

When saving drawings as DXF or DWG, binding is carried out automatically 
for you.
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Rectangle Mask

Rectangle and Polygon Masks allow you to hide (mask) part of a Referenced 
Drawing after it has been placed in the Master Drawing.  Masking in effect 
provides a window, or view port, into just the portion of the referenced 
drawing you want displayed.

For information on Selecting References see Working With References 
described later in this section.

Masks

To create a rectangular mask that hides part of a referenced drawing:
o	 Select the reference drawing; a bounding box appears around the 

selected reference.
o	 Choose Rectangle Mask from the Reference menu.
o	 The cursor changes to a cropping cursor.
o	 Click and drag inside the bounding box of the selected reference.
o	 When you release the mouse, the view port you defined by clicking and 

dragging is displayed in the drawing window.

To modify a rectangular mask hiding part of a referenced drawing:
o	 Select the reference drawing; a bounding box appears around the 

selected reference.
o	 Choose Rectangle Mask from the Reference menu.
o	 The cursor changes to a cropping cursor and the extents of the 

referenced drawing are displayed.
o	 Click and drag inside the bounding box of the selected reference to 

define the new view port.  To see the entire referenced drawing (no 
masking) click anywhere outside the bounding box.

!
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To create a polygon mask that hides part of a referenced drawing:
o	 Select the reference drawing; a bounding box appears around the 

selected reference.
o	 Choose Polygon Mask from the Reference menu.
o	 The cursor changes to a cropping cursor.
o	 Click and drag inside the bounding box of the selected reference to 

define the first segment of the polygon mask.
o	 Move the cursor and click to define each subsequent segment of the 

polygon mask.  Double-click when complete.
o	 Click anywhere outside the bounding box to complete the operation.

To modify a polygon mask hiding part of a referenced drawing:
o	 Select the reference drawing; a bounding box appears around the 

selected reference.
o	 Choose Polygon Mask from the Reference menu.
o	 The cursor changes to a cropping cursor and the extents of the 

referenced drawing are displayed.
o	 Click and drag inside the bounding box of the selected reference to 

define the new view port as described earlier.  To see the entire referenced 
drawing (no masking) click anywhere outside the bounding box.

Working With 
References

Polygon Mask

Referenced Drawings behave like typical PowerCADD objects as they must 
first be selected before they can be manipulated.  Once selected a reference 
may be manipulated using features found in the PowerCADD menus.  For 
example, referenced drawings may be rotated, moved, deleted, grouped, or 
mirrored just like any other PowerCADD object.

Objects in a referenced drawing cannot be edited but may be used as 
references for snapping to create new objects.  To make changes to the 
referenced objects simply open the original referenced drawing and make 
the desired changes.

To select a Referenced Drawing:
o	 In the Layer Window, ensure the References Layer has a layer status as 

the active layer.
o	 Click on one of the objects in the Referenced Drawing to select that 

reference.

TIP: If the References Layer is not the active layer, make sure Edit All 
Layers is On.  Then click on an object in the Referenced Drawing to select 
the reference. 

To hide a Referenced Drawing:
o	 Turn off the References Layer or turn off all layers associated with that 

reference.

💡💡

Anchor
[WorkWithReferences]
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After a reference drawing is placed in a master drawing it may be 
manipulated using menu items just like any other PowerCADD object. 
Typical manipulations of a reference drawing include moving, scaling, or 
rotating a reference after it has been placed in a master drawing.

To manipulate a referenced drawing:
o	 Select the reference drawing; a bounding box appears around the 

selected reference.
o	 Choose the desired menu item.  For example to rotate a reference 

choose Rotate from the Arrange menu.
o	 Complete the steps required for the chosen menu.

Manipulating References

Removing a Reference You may wish to permanently remove a reference drawing from the master 
drawing. 

To remove a reference:
o	 Select the reference you wish to remove.
o	 Press the Delete key or choose Clear from the Edit menu.
o	 The reference drawing will be deleted.
o	 To remove any empty layers associated with the deleted referenced 

drawing press Purge in the Layers Window.

See References Window (WTF?) in the Window section of this chapter for 
additional information on managing references.
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Missing References While PowerCADD always attempts to locate referenced drawings for you, 
there may be times when a referenced drawing cannot be automatically 
located.  If a referenced drawing can’t be found you will be prompted when 
the master drawing is loaded for the name of the missing file:

In most cases, provided the referenced drawing is on the same hard drive 
(be it a local hard drive or a server), PowerCADD will typically find a 
referenced drawing even it has been moved or renamed.  However, in those 
rare circumstances where a referenced file can’t be found you will need to 
manually reset the link to the reference drawing.

TIP: If you are in a network environment where drawings are saved and 
opened off a server and across the network it is important all your drawings 
be on the server BEFORE placing your references.

To reset a link to a missing reference:
o	 Select the reference you wish to remove.
o	 Press the Delete key or choose Clear from the Edit menu.

The reference drawing will be deleted and its name will be removed from 
the Reference Window (WTF?).  As an optional step, you can press Purge in 
the Layers Window to remove all empty layers before placing the reference 
again.

o	 Place the reference again using the steps described earlier.

💡💡
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Window Menu The Window menu gives you a method of managing multiple open 
documents, along with the ability to stack or tile your documents.  This 
option will allow you to bring any document currently open to the front in 
an active state.  

The Window menu is also used to bring Symbol Library windows to the 
front or turn any loaded floating window or tool palette On or Off.

If you have many documents or Symbol Libraries open at once, each will be 
represented by name in Window menu.  To bring a document to the front, 
choose Window and choose the document you wish to view.  When the 
selection is made, that document will be brought to the front in an active 
state and a checkmark will appear next to its name in the Window menu. 

Minimize collapses the active drawing window to the MacOS Dock.

Stack will display all open drawing windows in a staggered arrangement 
so the title bar of each drawing window is visible.  This allows you to very 
quickly locate and select a drawing which is behind other drawings. 

Tile will arrange the open drawing windows so a portion of each drawing is 
visible, simultaneously.  If two drawings are open, the screen will be divided 
horizontally by two; if three drawings are open, the screen will be divided 
by three, and so on.  The scroll bars for each window are also visible so you 
can adjust the view of each drawing.  This arrangement will make copying 
and pasting objects from one drawing to another a quick process because 
you can see all the drawings involved at the same time.

An open floating window or tool palette will have a checkmark next to its 
name.  To open or close a floating window or tool palette, choose Window 
and choose the tool palette or floating window name from the list.  These 
items may also be opened or closed using the Anchor Window or clicking 
on a palette or window close button.

Minimize/Stack/Tile
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Floating Windows and Tool Palettes provide direct access to various features 
and are managed from either the Anchor Window or selecting an item from 
the Window menu. 

When you activate a floating window or tool palette, either by clicking on 
a window name in the Anchor window or selecting it from the Window 
menu, it is opened in the last saved position. When a floating window or 
tool palette is closed its name appears in the Anchor Window.  When open, 
floating windows and tool palettes are not listed in the Anchor Window.

To customize the settings of a floating window:
o	 Press the Control key and click anywhere in a blank area of a floating 

window.  The following dialog will appear:

Floating Windows 
and Tool Palettes

Check this box if you want the edges of
this floating window to interact with

other floating windows or the screen edges.
Check this box if you want the window to
automatically snap to the edges of the
screen. Dragging the window close to a
screen edge will snap it in place.

Check this box if you want this floating
window  to stick to other floating windows.

Check this box if you want this window to
move with other windows it is stuck to.
Moving one floating window moves all
windows that are stuck together.

Drag this slider to adjust how
transparent this floating window
should be in it's normal state. A
value of 100% is solid and you

cannot see through it.
Check this box if you want this floating
window to automatically fade (become see
through) when it is idle. When the window is
active it returns to it's normal state (see
Window Opacity setting).

Enter a number here to specify how many
seconds this floating window should be idle
before it automatically fades.

Check this box if you want the window to
fade when it's over a drawing window.

Click the mouse here when you are
finished adjusting the settings for

this floating window.

Drag this slider to adjust now
transparent the window should

become when it automatically fades.
A value of 10% will be very transparent,

a value of 100% will be solid.
Check this box if you want the window

to fade when it is over your Desktop.

o	 Make the desired setting changes and click Done.

TIP: The settings for tool palettes may also be customized with the same 
options as described above for floating windows.  To customize the settings 
of a tool palette, Control- or right-click on the tool palette, and choose 
Palette Settings from the contextual menu.  The settings options for the 
specific tool palette will appear.

💡💡
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The settings for each floating window and tool palette may be adjusted 
independently.

NOTE: The normal state for a tool palette is determined by the Window 
Opacity setting.  A tool palette that has faded on screen will automatically 
return to its normal state when you click in the palette to activate it.

The ability to turn Auto-Fade On or Off for a tool palette or floating 
window is controlled by the Window Fading Preference settings.  If the 
Auto-Fade settings are dimmed as shown on the left: 

o	 Choose Preferences from the PowerCADD menu and select the 
General tab.

o	 Check the Window Fading box to turn it on and click OK.
o	 Set the Auto-Fade settings for the floating window or tool palette again 

as described earlier. 

💬💬
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Anchor Window The Anchor Window contains a list of all closed tool palettes or floating 
windows and may be positioned anywhere on screen.

To open a floating window or tool palette from the Anchor Window, choose 
Anchor from the Window menu and select the button next to the items 
name or click on the items name.

When a floating window or tool palette is open, its name is removed from 
the Anchor Window list.

To close the Anchor Window, click the button in the top left corner or 
choose Anchor from the Window menu.  Opening or closing the Anchor 
Window does not affect any open floating windows or tool palettes.

Anchor
[AnchorWindow]
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The Attributes Window is a floating window which allows you to change the 
drawing attributes of specific tools or all tools available in the Tool palette 
quickly and easily.  You may also use the Attributes Window to change the 
characteristics of existing objects just as you do using the Attribute menu.

To activate the Attributes Window:
o	 Choose Attributes from the Window menu or select Attributes in the 

Anchor Window.  The following floating window will appear:

Attributes Window

Pen Color: Mac OS X
Color Wheel

Pen Attribute Settings
Options to set pen 
color, pen pattern, line 
weight, arrow style, 
dash style, and pen 
opactity.

Fill Pattern and Fill Color

Fill and Hatch Opacity

Hatch Pattern and Origin

Pen Pattern Swatch
Pen Color: PowerCADD

Color Swatch

Close Button

Line Weight
Arrow Style and Direction

Dash Pattern
Pen Opacity Field

Fill Color: Mac OS X
Color Wheel

Pen Opacity Slider

Fill & Hatch Opacity Field
Fill & Hatch Opacity Slider

Hatch Origin

Hatch Pattern Swatch

Fill Color: PowerCADD
Color Swatch

Fill Pattern Swatch

The Attributes Window will display the current defaults of any selected 
tool or any selected object in the drawing.  As you change tools, you 
will also notice the Attributes Window display will change to the 
selected tool defaults. You may change the defaults, if they are not 
correct.  A checkmark appears next to the currently selected attribute 
setting in a given list.  The Attribute menu, Contextual menu, and 
Attribute window all share the same attribute options. 

CAUTION! When Global Attributes is On, values displayed for Pen 
Pattern, Line Weight, Pen Color, Fill Color and Fill Pattern in the 
Attributes Window are affected.  See Global Attributes. 

o	 Click on the MacOS Color Wheel to choose a color using the MacOS  
color panel.  Pen Color and Fill Color may be adjusted independently 
by clicking on their respective color wheel.

o	 Click on the PowerCADD Color Swatch to choose a color from the 
PowerCADD color palette.  Pen Color and Fill Color may be adjusted 

⚠

Anchor
[AttributesWindow]
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independently by clicking on their respective color wheel.
o	 Click on the Pen Pattern Swatch to choose a pen pattern from the Pen 

Pattern palette.
o	 Click on the Line Weight pop-up menu to choose a line weight from 

the Line Weight palette.
o	 Click on the Arrow Style and Direction pop-up menu to choose an 

Arrow Style and Direction.
o	 Click on the Dash Pattern pop-up menu to choose a dash pattern.
o	 Click and drag on the Pen Opacity Slider to adjust how transparent 

(‘see-through’) an the Line Weight and Pen Pattern should be.  As you 
drag the slider, the value in the Pen Opacity Field will change.  You 
may also type a specific whole number ranging from 0 to 100.  Press 
Tab to cycle between the Pen and Fill Opacity fields.

o	 Click and drag on the Fill & Hatch Opacity Slider to adjust how 
transparent (see through) an objects Fill or Hatch Pattern should be.  
As you drag the slider, the value in the Fill & Hatch Opacity Field will 
change.  You may also type a specific whole number ranging from 0 to 
100.  Press Tab to cycle between the Pen and Fill Opacity fields.  Fill 
and Hatch opacity cannot not be independently adjusted.

o	 Adjusting an Object’s Pen or Fill opacity determines to what degree 
information is hidden or revealed below the Object.  For example, an 
Object opacity of 100% hides all information below the Object.  An 
Object with 10% opacity would appear almost transparent, allowing 
you to see through to objects below.  The effects of overlapping two 
Objects with adjusted opacity is cumulative.  An object’s Pen Opacity 
and Fill Opacity may be adjusted independently.  When an object has 
a Shadow, adjusting the Fill opacity of the Object will allow you to see 
through to the Shadow and other objects below.

NOTE: The Pen and Fill opacity sliders are linked if the selected object 
is a Group.  Adjusting Fill opacity also adjusts Pen opacity.  To adjust 
the Pen or Fill opacity of a group independently, use the Edit Groups 
command and them make the desired adjustments.

💬💬
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o	 Click on the Fill Pattern Swatch to choose a pattern from the Fill 
Pattern palette.  Open and closed objects may have fill patterns 
assigned.  Assigning a fill pattern to a line will have no change on the 
lines attributes, use a Pen Pattern instead.

o	 Click on the Hatch Pattern Swatch to choose a pattern from the Hatch 
Pattern palette. Open and closed objects may have hatch patterns 
assigned.  An object may have both a hatch pattern and a fill pattern 
assigned; the hatch pattern will be on top of the fill pattern.

o	 Click on the Hatch Origin icon to select the starting point (origin) for 
a hatch pattern.  Each square in the icon is a hot point corresponding 
the hatch origin location.  For example, clicking on the center square 
would set the hatch origin to Middle (MM).  Setting the hatch origin 
with the Hatch Origin icon is the same as choosing Hatch, Hatch 
Origin from the Attribute menu.

See Hatch Settings in the Attribute menu for information on how to adjust 
the line weight, pen color, scale and origin of hatch patterns.

Fill: 100% opacity
Pen: 100% opacity

circle below
is hidden

Fill: 100% opacity
Pen: 50% opacity

circle below is
hidden below
filled area, partially
visible below pen area

Fill: 50% opacity
Pen: 50% opacity

circle below partially
visible below pen and
fill

filled rectangle is
bottom most object

all three circles have
a fill opactity of 50%
and pen opacity of 100%

observe how the degree
to which you can see
through the circles to the
rectangle below is different
depending on the number
of times they overlap

!
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You may assign specific attributes for a tool prior to drawing an object.  All 
objects will have the same attributes until the tool attributes are changed or 
you edit the attributes of an existing object in the drawing.

To set the attributes for a drawing tool:
o	 Double-click on the tool to deselect all objects in the drawing.
o	 Select an Attribute Window item and choose an item from the 

associated list.  For example, select the PowerCADD Pen Color Swatch 
and choose a color from PowerCADD Color Palette list.

o	 Repeat this process for each tool attribute you want to set prior to 
drawing an object.

o	 Start the drawing operation.  The tool will create an object with the 
selected attributes.

NOTE: Layer Color Attribute settings will override a tool’s Pen Color 
setting.  For example, drawing on a layer with a red Layer Color Attribute 
will draw all objects with red lines regardless of the pen color specified in 
the Attributes Window.

TIP: Pressing the Shift key as you set a tool’s attributes will set the attributes 
for all tools in the palette at the same time.

Setting Tool Attributes

Changing an 
Object’s Attributes

💡💡

💬💬

The attributes of any object may be changed after it has been drawn.

To change the attributes of an existing object:
o	 Select the object in the drawing whose attributes you want to change.
o	 Select the Attribute Window item you want to change and choose 

a new attribute from the associated list.  For example, select the Fill 
Pattern Swatch and choose a new pattern from the list.

o	 The Attribute for the selected object is changed.

If the selected object was a group, then all objects in the group will take on 
the new attributes.  The attributes for items inserted from Symbol Libraries 
as Symbols cannot be changed after they are inserted into a drawing.  To 
change the attributes of a Symbol, create or edit a new symbol and use 
Replace Symbol in the Tool menu to update your drawing.

TIP: Use the same process to change the attributes for multiple objects 
at the same time.  Simply select all the objects you want to change before 
making a selection in the Attributes Window.

See the Attribute menu for information on working with object and tool 
attributes.

💡💡
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The Defaults Window allow you to change the drawing defaults of specific 
tools or all tools available in the Tool palette quickly and easily.  You may 
also use the Defaults Window to change the characteristics of existing 
objects just as you do using the Attribute menu.

The Defaults Window will allow you to change pen color, pen pattern, 
fill color, fill pattern, line weight, line dash type, line arrow type, and text 
defaults without entering the menus.  

The Defaults Window is a floating window which may be moved and 
turned off just as the Edit Window and the Tool palette are.  

To activate the Defaults Window, choose Defaults from the Window menu 
or select Defaults in the Anchor Window.  The following window will 
appear:

Defaults Window

To change pen defaults:
o	 Select the tool you wish to change by double-clicking on it to insure no 

objects are selected.  If objects are selected, the objects will take on the 
changes instead of the tool.

o	 The two small rectangles at the top of the Defaults Window govern the 
pen defaults.  The left rectangle specifies the color of the pen while the 
right rectangle specifies the pen pattern.

o	 Press the left rectangle and a color palette will pop-out allowing you 
to choose a suitable color.  With the color palette open, drag to the 
desired color and release.  The color you select will appear in the 
Defaults Window.

o	 Press the right rectangle and a pen pattern palette will pop-out allowing 
you to choose a suitable pen pattern. With the pen pattern palette 
open, choose the desired pen pattern and release. The pattern you 
select will be displayed in the Defaults Window.

The pen default rectangles will display the current defaults of any tool 
selected.  As you change tools, you will also notice these rectangles will 
change to the selected tool defaults.  You may change the defaults, if they 
are not correct.
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To change fill defaults:
o	 Select the tool you wish to change by double-clicking on it to insure no 

objects are selected.  If objects are selected, the objects will take on the 
changes instead of the tool.

o	 The two squares located just below the pen default rectangles govern 
fill pattern defaults.  The left square specifies the color of the fill, while 
the right square specifies the fill pattern. 

o	 Press the left square and a color palette will pop-out allowing you to 
choose a suitable fill color.  With the color palette open, select the 
desired color and release.  The color you select will appear in the 
Defaults Window.

o	 Press the right square and a fill pattern palette will pop-out allowing 
you to choose a suitable fill pattern.  With the fill pattern palette open, 
select the desired pattern and release.  The pattern you select will be 
displayed in the Defaults Window.

o	 The fill defaults have now been modified and these changes will remain 
in effect until you change them again.

The fill default squares will display the current defaults of any tool selected.  
As you change tools, you will also notice these squares will change to display 
the selected tool defaults.  You may change the defaults if they are not 
correct.

On black and white machines, the fill default color will be specified in the 
Defaults Window by a number.  This number corresponds to the location 
of the selected color in the fill color palette.

To change the line weights: 
o	 Select the tool you wish to change by double-clicking on it to insure no 

objects are selected.  If objects are selected, the objects will take on the 
changes instead of the tool.

o	 The current line weight is displayed just below the fill default squares.
o	 Press the text below the fill defaults and the menu on the left will pop-up.
o	 Choose the correct line weight and release.
o	 The line weight you select will appear in the Defaults Window and will 

remain in effect until you change it.

The line weight default will display the default settings for the tool currently 
selected.  If two tools have different defaults, the line weight display will 
change as you select between the tools.
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To change dashed line types: 
o	 Select the tool you wish to change by double-clicking on it to insure no 

objects are selected.  If objects are selected, the objects will take on the 
changes instead of the tool.

o	 The current dash default is displayed just below the line weight display.
o	 Press the default line below the line weight default and the dash menu 

will pop-up.
o	 Choose the correct dash type and release.
o	 The dash selected will appear in the Defaults Window and will remain 

in effect until you change it.

The dash default line will display the default settings for the tool currently 
selected.  If two tools have different dashing, the dash line will change as 
you select between the tools.

To change arrow line types: 
o	 Select the tool you wish to change by double-clicking on it to insure no 

objects are selected.  If objects are selected, the objects will take on the 
changes instead of the tool. 

o	 The current arrow default is displayed just below the dash default line 
display as a default line.

o	 Press the default line below the dash default line and the Arrow menu 
will pop-up.

o	 Drag to the correct arrow line and release.  The four arrow placement 
lines at the top of the menu specify if the arrow will be placed at the 
start of the line, the end of the line, or on both ends of the line.

o	 Return to the arrow menu, drag to the desired arrow type, and release.
o	 The arrow you select will appear in the Defaults Window and will 

remain in effect until you change it.

The arrow default line will display the default settings for the tool currently 
selected.  If two tools have different defaults, the arrow line will change as 
you select between the tools.

To change text defaults: 
o	 Select the tool you wish to change by double-clicking on it to insure no 

objects are selected.  If objects are selected, the objects will take on the 
changes instead of the tool.

o	 The current text defaults are displayed in the square at the bottom of 
the Defaults Window.  Inside the box will be a number corresponding 
to the text size.  This number will be displayed in the current font 
setting and will contain all style settings such as italic, outline, or bold.

o	 Press the text default square and the Text menu will pop out.
o	 With the menu open, choose Font and a second pop-up menu will 

appear.  Choose the desired font and release.  The selected font will be 
displayed in the text default square.

Dash menu

Arrow menu

Text menu
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o	 Return to the menu by pressing the text default square and drag to 
Size and a second menu will appear.  Drag to the desired text size and 
release.  The number you selected under Size will be displayed in the 
text default square. 

o	 Continue returning to the text default menu and making default 
changes until all of the desired settings have been made.  These settings 
will remain in effect until you change them again.

Tools with different default settings will display different defaults as they 
are chosen.

The Defaults Window may be used to change existing objects as well.  To 
change an existing object, select the object and make default changes, as 
explained before.  Since the objects are selected, the default changes will 
affect the objects instead of the active tool.

Defaults for all tools in the Tool palette may be changed at one time.

To change the defaults of all tools:
o	 Select any tool by double-clicking on it to insure no objects in the 

drawing are selected.  If objects are selected, the objects will take on the 
changes instead of the tools.

o	 Press Shift and make any changes necessary.

The changes you make while pressing the Shift key will affect all tools in the 
Tool palette.  Every tool in the Tool palette will now have identical default 
settings.
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The Dimension window allows you to access dimension options from a 
floating window.  Options for Dimensioning tools and existing dimensions 
can be set in this window.

To activate the Dimension window, choose Dimension from the Window 
menu or select Dimension in the Anchor Window.  The following window 
will appear:

Dimension Window

	 Text Field allows you to place a prefix or suffix in the dimension text, 
and to edit any text in this field, including dimension text.

	 Text Placement allows you to change text placement relative to the 
dimension line. 

	 Leader Position (for circular dimensions and existing leaders with text) 
allows you to change the direction of the final leader.

	 Show Units allows you to turn unit abbreviation On or Off.

	 Arrow Position allows you to set arrows inside or outside of extension 
lines.

	 Rotate Text allows you to set the dimension text to remain horizontal 
regardless of the dimension line’s angle or to be parallel to the dimension 
line.

	 Units allow you to specify the standard of metric or imperial units of 
measure.

	 Accuracy allows you to specify the smallest unit of measure. 

	 Tolerance allows you to specify if a dimension will have a dimension 
only, a dimension with a single plus or minus tolerance, a dimension 
with a pair of tolerances, or a pair of limiting dimensions.

	 Draw Horizontal Bar Fractions allows you to specify how fractional 
dimensions are displayed.

Anchor
[DimensionsWindow]
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NOTE: The Dimension Window External must be loaded with 
PowerCADD to be active.  See Loader Preferences. 

If you wish to set the options for a Dimensioning tool itself, double-click on 
the tool before changing any option.  Selecting an existing dimension first 
will change only the selected dimension.

Text Placement

Leader Position

Editing Dimension Text

💬💬

To add characters to dimension text in the Dimension window:
o	 Select an existing dimension. 
o	 Click the Text field and enter additional characters before or after 

the up-carets(^).  Any text associated with the dimension will appear 
exactly as you type it.  If the carets are removed and text is typed in, the 
typed text will be displayed in place of the dimension.

o	 Press the Enter key or click in the drawing area to enter the text.

You can replace a numerical dimension with a label like width or size, etc.  
Select the existing dimension and delete all of the dimension text characters 
in the text field.  Enter the label and press the Enter key.

To set the Text Placement in the Dimension window:
o	 Select a linear dimensioning tool or an existing linear dimension.
o	 Click Text Placement button to cycle through the placement options.  

The “x” in the icon will indicate the text position each time the button 
is clicked.  Text may be placed either centered above, below, or on a 
dimension line or to the right, or left of the dimension lines.

If an existing dimension is selected before the text’s placement is edited, the 
dimension text will reflect the changes interactively as the Text Placement 
button is clicked.

To set the Leader Position in the Dimension window.
o	 Select a Circular Dimension tool, an existing circular dimension, or an 

existing leader with text.
o	 Click the Leader Position button to cycle to the desired option.  

The icon will reflect the change, either left or right.

If an existing circular dimension or leader with text is selected, the leader 
position will reflect the changes interactively as the button is clicked.
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To set Show Units using the Dimension window:
o	 Select a Dimension tool or an existing dimension.
o	 Click the Show Units button to cycle to the desired option.  

The icon will interactively reflect the change. 

If an existing dimension is selected, the unit abbreviation will appear or 
disappear as the button is clicked.

The Show Units option will only be highlighted when the appropriate 
dimension units are being used.  Units based on feet and inches or fractional 
inches will automatically display the foot (') and inch (") marks. Cartesian 
units will automatically display degrees (°).

Show Units

Arrow Position

Rotate Text

Units

To set the Arrow Position option using the Dimension window:
o	 Select a Dimension tool or an existing dimension.
o	 Click the Arrow Position button to cycle to the desired option. 

The icon will reflect the change.

If an existing dimension is selected, the arrow position will change 
interactively as the button is clicked.

To set the Rotate Text option using the Dimension window:
o	 Select a Dimension tool or an existing dimension.
o	 Click the Rotate Text button to cycle to the desired option.

The icon will reflect the change. 

If an existing dimension is selected, the text rotation will change interactively 
as the button is clicked.

To set the Units option using the Dimension window:
o	 Select a Dimension tool or an existing dimension.
o	 Choose the desired unit of measurement from the Units pop-up menu. 

The menu will display the units.

If an existing dimension is selected, the unit of measure will be reflected in 
the dimension.
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To set the Accuracy option using the Dimension window:
o	 Select a Dimension tool or an existing dimension.
o	 Choose the desired degree of accuracy from the Accuracy menu. The 

accuracy will display as fractions or decimal places depending on how 
units are set.

The Accuracy menu will display the accuracy.

If an existing dimension is selected, the degree of accuracy will be 
interactively reflected in the dimension.

Accuracy

Fractions

Tolerance To set the Tolerances using the Dimension window:
o	 Select a Dimension tool or an existing dimension. 
o	 Choose the desired tolerance from the Tolerance menu.  If One is 

selected, one numerical field will appear at the bottom of the palette.  
Selecting Two or Limits will provide two numerical fields.

o	 Click a numerical field and enter the desired tolerance.
o	 Press the Return key or click in the drawing window. 

If an existing dimension is selected, the tolerance changes will be reflected 
in the dimension when the Enter key is pressed.

Choosing None will retract all tolerance numerical fields.  Clicking the 
toggle switch in the top right corner of the Dimension window’s title bar 
will display or hide the Tolerance numerical fields.

To set how fractions are displayed:
o	 Select a Dimension tool or an existing dimension.
o	 Select the Horizontal Bar Fractions Icon.  You may toggle between the 

two display options for fractions by clicking on the icon again.
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The Edit Window allows you to specify an object’s dimensions and provides 
real-time display of an objects area and perimeter as it is being drawn. 

NOTE: When a bitmap image is selected the Edit Window will display the 
DPI (dots per inch) and bit depth (number of colors).

To activate the Edit Window,
o	 Choose Edit from the Window menu or select Edit Window in the 

Anchor Window.  The following dialog will appear.

Edit Window

Size Box: To change the size or orientation of the Edit Window click and drag here.

Object Type: The type of object selected
is displayed in the Title Bar.

Title Bar: To move the Edit Window
click and drag the title bar.

Edit Window Display.
Click to toggle the number

of fields displayed in the
Edit Window.

size box.

A preview or the new Edit Window
shape appears when resizing.

Close button.
Click this to close the Edit Window

Edit Window Display.
Click to toggle the number of

fields displayed in the Edit Window. Click and drag on the size box to 
change the size or orientation

of the Edit Window.
Layer: Displays the layer name the

selected object is on.
Area: Current area calculation based

on drawing units and scale.

Perimeter: Current calculation of the
objects perimeter length based on

drawing units and scale.

💬💬

The Edit Window may be resized by dragging its size box in the lower right 
hand corner.

The Edit Window Display can be modified to change the number of fields 
shown.  The specific fields will vary with the type of object selected.

Anchor
[EditWindow]
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To change the size of an existing object using the Edit Window:
o	 Select the object you wish to edit.
o	 Press the Tab key to cycle through the edit fields or click the mouse in 

the desired field.
o	 Enter the specified value or enter a mathematical equation. 
o	 Click the mouse in the drawing window or press the Return key.

The object will reflect the new values.

To specify the size of an object while drawing using the Edit Window:
o	 Select a drawing tool and begin to draw an object.
o	 Before you complete the draw operation, press the Tab key. 

	 The drawing operation will be suspended and the Edit Window will 
activate.

o	 Enter the specified value or enter a mathematical equation in the 
desired Edit Window field.

o	 Click the mouse in the drawing window or press the Return key.

The object is drawn to the specified values.
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The Layers Window allows you to access layer options from a floating 
window.

When the Layers Window External is loaded, it can be accessed by the 
Layer command in the Layout menu or through the Anchor window.  You 
can assign a Command key to the menu item, the default key command 
assigned is ‘L’.

The complete description is located in the Layout menu earlier in this 
chapter. 

We recommend that you always load the Layers Window External with 
PowerCADD.

Layers Window

Mechanical Tools The Mechanical Tool palette provides specialized tools for mechanical 
drafting and design, extending the capability of PowerCADD for mechanical 
engineers.

The complete description is located in the Tool menu section of this manual. 

To activate the Mechanical Tools Palette, choose Mechanical Tools from the 
Window menu or select Mechanical Tools in the Anchor Window.
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The Move Window provides an alternate Move dialog, which floats on your 
drawing for convenience while providing more defined control for your 
relative moves.

Move Window

💬💬
NOTE: The Move Window External must be loaded with PowerCADD to 
be active.  See Loader Preferences.

The Move Window can be put away by clicking on the close button in the 
upper left-hand corner.  It will reappear the next time you choose Move 
from the Edit menu while pressing the Option key. 

The Move Window provides a total of five move methods.  In each case, 
select the objects to be moved, then choose the appropriate type of move 
from the pop-up menu.

o	 Absolute allows you to specify the absolute center X,Y coordinate 
location of an object.

o	 Relative moves objects the specified amount relative to their current 
X,Y location.

o	 Angle moves objects the specified length and angle.
o	 By Mouse moves objects dynamically using the mouse and dragging 

on screen.
o	 By Line moves objects based on the length and angle of a line you click 

in the drawing.

Anchor
[MoveWindow]
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To move selected objects to an absolute position based on the 
center X and Y coordinates:
o	 Select the object(s) to be moved.
o	 Choose Move from the Edit or Window menu.
o	 Choose Absolute from the pop-up menu and enter a value in the X 

center and Y center fields.  

	 You may enter mixed units (metric, or imperial), mathematical 
equations, and positive or negative values.

o	 Press the Return key or click Apply.

The objects are moved from their previous X, Y center coordinates to the 
new X,Y center coordinates.

The Move window gives you more control and more option with relative 
moves.  Not only can you specify up (north), down (south), left (west) 
or right (east), you can also specify northwest, northeast, southwest, or 
southeast by clicking on the appropriate Direction buttons.

Absolute Moves
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To move selected objects a relative amount:
o	 Select the objects to be moved.
o	 Choose Move from the Edit or Window menu.
o	 Choose Relative from the pop-up menu and enter a value in the Delta 

X, Delta Y fields.
o	 Click the Direction button corresponding to the direction you wish 

to move. 

The objects will move the specified Delta X, Delta Y distances.  Negative 
numbers do not modify the direction of the move.

If you only have a move amount specified for Delta X, clicking any of the 
right- or left-hand Direction buttons will move your object horizontally, 
right or left. 

If you only have a move amount specified for Delta Y, any of the top or 
bottom Direction buttons will move your object vertically, up or down.

The last eleven relative move amounts are remembered in the Previous 
Moves pop-up menu. 

To reapply a saved relative move, select it from the Previous Moves pop-up 
menu.  When more than eleven relative move amounts are used, the oldest 
amount (the one entered first) is removed from the bottom of the list and 
the newest (most recently entered) amount is added to the top of the list.

Relative Moves

Direction Button

previous move values
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To move selected objects to a specified length and angle (direction):
o	 Select the objects to be moved.
o	 Choose Move from the Edit or Window menu.
o	 Choose Angle from the pop-up menu and enter a value in the Length 

and Angle fields. 

	 You may enter mixed units (metric, or imperial), mathematical 
equations, or positive or negative values for lengths. 

	 Angles may be entered in decimal degrees, or degrees minutes and 
seconds in either positive or negative values.

o	 Press the Return key or click Apply.

The objects are moved the specified length and angle.

TIP: When entering angular values in degrees, minutes and seconds, use 
spaces to separate the values to speed up data entry.  For example, to specify 
an angle of 30º 0’ 25’’ simply enter 30 0 25 (insert a space between each 
value).

The last eleven length and angle move amounts are remembered in the 
Previous Moves pop-up menu.

To reapply a saved angle and length move, select it from the Previous Moves 
pop-up menu.

When more than eleven length and angle move amounts are used, the oldest 
amount (the one entered first) is removed from the bottom of the list and 
the newest (most recently entered) amount is added to the top of the list.

Angle & Length Moves

💬💬

previous move values
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You can also use the mouse to specify the distance and direction of your 
move with the Move Window.  When using this method of movement, you 
may use the snap keys to aid in the precision of the move.

In the illustration below, there are two rectangles.  We want to move the 
center of the smaller rectangle to the center of the larger rectangle.

Move by Mouse

o	 Select the smaller rectangle.
o	 Choose Move from the Edit menu.
o	 Choose By Mouse from the pop-up menu.
o	 Click Apply and as you move to your drawing window, the cursor 

changes into a target cursor.
o	 Move your cursor to the small rectangle and press the C key for a center 

snap.
o	 Drag the cursor to the larger rectangle and press the C key for a center 

snap. 
o	 Release the mouse button and the center of the smaller rectangle will 

move to the center of the larger rectangle as illustrated below.
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To move selected objects based on the length and angle of a line in 
the drawing:
o	 Select the objects to be moved.
o	 Choose Move from the Edit or Window menu.
o	 Choose By Line from the pop-up menu.
o	 Move the mouse into the drawing window and the target cursor 

appears.
o	 Click on an existing line in the drawing.

The objects are moved to match the length and angle of that line.

TIP: Remember the length and angle of the move is determined by the 
length and angle of the line you click on.  The angle of a line is determined 
by the direction you dragged when drawing it.  Turning on Hollow Line 
Handles will show you the start and end point (direction) of a line when 
it is selected.  The Edit Window will also display the length and angle of a 
selected line.

Move by Line

💡💡
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The Notation Tool palette provides specialized provides specialized tools for 
inserting various styles of bubble notes into a drawing.

The complete description is located in the Tool menu section of this manual. 
To activate the Notations Tools Palette, choose Notations from the Window 
menu or select Notations in the Anchor Window. The Notations External 
must be loaded, see Loader Preferences.

Notations Tool Palette
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The Overview Window provides additional methods of navigating in 
the active drawing.  Changes made in the main drawing window are 
immediately updated in the Overview Window.

The Overview Window renders the entire drawing, or portion of the 
drawing, in a drawing view.  This high-performance drawing model makes 
it very efficient to navigate large drawings, or when switching between 
multiple open drawings. 

Positioning the Overview window on a second monitor can make drawing 
navigation even more efficient.

To activate the Overview floating window 
o	 Choose Overview from the Window menu or select Overview in the 

Anchor Window.  The Overview Window will open and display the 
active drawing:

Overview Window

1

2

3

4

5

6

7

8

9

10

11

12

13

	 (1) Window Buttons: Click the left button to close the Overview 
window.  Click the right-most button to maximize the size of the 
window to fit your screen. When a window is maximized clicking the 
same button will minimize the window to its previous size.  The center 
button is always inactive.

	 (2) Fit Drawing: Click to perform a reduce to fit operation.  The display 
in the Overview window is updated to show the entire drawing.

	 (3) Redraw: Click to force the contents of the Overview window to 
redraw.

	 (4) Pan Tool: Click to activate the Pan tool and the cursor in the 
Overview window changes to a hand.  Press and drag in the Overview 
Window to see a different area of the drawing.  Pressing the Spacebar 
will also allow for immediate interactive panning regardless of which 
toolbar item is currently selected.  The pan operation only affects the 
content displayed in the Overview Window, the main drawing view is 
not affected.

Anchor
[OverviewWindow]
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	 (5) Live Zoom: Click to activate the Live Zoom tool and the cursor 
in the Overview Window changes to a magnifying glass.  Press and 
drag up to zoom in, press and drag down to zoom out.  If you have 
a scroll wheel mouse, or a laptop touch pad, Live Zoom is always 
available regardless of which toolbar item is currently selected.  The pan 
operation only affects the content displayed in the Overview Window, 
the main drawing view is not affected.

	 (6) Drawing Area: The primary Overview window drawing area 
displaying the currently active drawing.  Switching between open 
drawings automatically updates the content in the drawing area.

	 (7) Toolbar Button: Click this button to show or hide the Overview 
Toolbar.

	 (8) Customize: Click to display a drop-down panel containing items 
to customize the toolbar.  You may add or remove items, change their 
location, or change the display size of icons in the toolbar.  Pressing 
Control and clicking on the toolbar will display a contextual menu to 
change the Window Opacity, Auto-Fade and Magnetic Edge properties 
of the window.

	 (9) Send View: Click to set the view in the current active drawing to 
match the current view in the Overview Window.

	 (10) Get View: Click to set the view in the Overview Window to 
match the current view in the active drawing.

	 (11) Draw View: Click to activate the Draw View tool and the cursor 
in the Overview Window changes to a crosshair.  Click and drag in 
the Overview Window to define the area to be displayed in the main 
drawing window.

	  (12) Pan View: Click to activate the Pan View tool and the cursor in 
the Overview Window changes to a move cursor.  Click and drag on 
the Draw View rectangle in the Overview Window to pan; the active 
drawing area will update in real time as the Pan View tool is used in the 
Overview window. 

	  (13) Resize box: Click and drag to make the window larger or smaller.

TIP: To see short tool tips, let your mouse hover over a toolbar icon.  To 
see extended tool tips, press the Command key after the short tool tip has 
appeared.

💡💡
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To zoom in your drawing using the Overview window.
o	 Click on the Draw View icon in the toolbar.
o	 Move the cursor into the Overview Window, the cursor changes to a 

crosshair cursor.
o	 Press and drag to define an area in the Overview Window.
o	 The main drawing window will zoom in and pan to display the defined 

area.

Zooming in a Drawing

1_Choose Draw
View in toolbar

2_Click 3_drag

4_Release

The Draw
View Region
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Zooming in the 
Overview Window

To change the zoom level displayed in the Overview Window:
o	 Click on the Live View zoom icon in the toolbar.
o	 Move the cursor into the Overview Window, the cursor changes to a 

zoom cursor.
o	 Click and drag up to zoom in, or click and drag down to zoom out.
o	 The area of the drawing displayed in the Overview will change 

interactively.

Changing the zoom level in the Overview Window does not change the 
view displayed in the main drawing window.  If you have a scroll wheel 
mouse, or use a laptop touch pad with Trackpad Gestures enabled, live 
zoom is always available when the cursor is in the Overview Window.
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Panning in a Drawing To pan in your drawing using the Overview Window:
o	 Click on the Pan View tool in the toolbar.
o	 Move the cursor into the Overview Window, the cursor changes to a 

Move cursor.
o	 Press and drag on the Draw View region to change the view in the 

active drawing window.

Using the Overview Window to pan the drawing view will change only the 
drawing window view. If you can’t see enough drawing area in the Overview  
Window to pan to the desired drawing area, resize the Overview Window 
or pan in just the Overview Window (described below) to see more of the 
drawing.
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To pan in the view shown in the Overview Window:
o	 Click on the Pan tool in the toolbar or press the Spacebar.
o	 Move the cursor into the Overview Window, the cursor changes to a 

Hand cursor.
o	 Press and drag on the Overview Window to change the view.

Panning the Overview Window does not change the view displayed in the 
main drawing window.

Panning in the 
Overview Window

1_choose Pan View tool

2_Move cursor: click and
drag on the  Draw View

region to Pan in the
active drawing.

The Draw View region.
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Selection Filter allows you to specify the type of objects that can be selected.  
This function will be very helpful when you are working in a very busy area 
of the drawing. 

Selection Filter

The complete description is located in the Tool menu section of this manual.  
To activate the Selection Filter floating window, choose Selection Filter 
from the Window menu or select Selection Filter in the Anchor Window.

Anchor
[SelectionFilter]

!
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Shadow Attributes 
Window

The Shadow Attributes Window is a floating window which allows you to 
assign and manage shadows attributes to selected objects.

To activate the Shadow Attributes Window:
o	 Choose Shadow Attributes from the Window menu or select Shadow 

Attributes in the Anchor Window.  The following floating window will 
appear:

The Shadow Attribute Window will display the current defaults of any 
selected objects which have a shadow attribute.  As different objects are 
selected, you will also notice the Attribute Window display will change to 
the selected objects shadow attributes.  If an object does not have a shadow 
attribute applied the default settings are displayed as shown in the diagram 
above. 

CAUTION: When Global Attributes is On, values displayed for Shadow 
Color choices when clicking on the PowerCADD Color Swatch are affected.  
See Global Attributes.

NOTE: At zoom levels equal to or greater than 1600 times, all shadows are 
drawn to screen with no blur effect.  Zooming out to less than 1600 times 
draws the shadows to screen with their specified blur settings.

o	 Click on the MacOS Color Wheel to choose a shadow color using the 
MacOS color panel.

o	 Click on the PowerCADD Color Swatch to choose a shadow color 
from the PowerCADD color palette. 

NOTE: An object’s shadow color may be adjusted independently from its 
fill or pen color (see Attributes Window for more on fill color).

click to remove all shadow
attributes from selected objects

close button

opacity amount slider

blur amount slider

offset distance slider

opacity amount field

blur amount field

offset distance field

angle fieldangle slider

shadow color: powercadd
color swatch

shadow color: mac 
os x color wheel

⚠

💬💬

💬💬

Anchor
[ShadowAttrsWindow]
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o	 Drag on the Opacity Slider to change how transparent (see-through) 
a shadow is.  As you drag the slider, the Opacity Amount Field will 
update.  You may also enter a specific amount in the opacity amount 
field.

o	 Adjusting an objects shadow opacity determines to what degree 
information is hidden or revealed below the shadow.  For example, a 
shadow opacity of 100% hides all information below the shadow.  A 
shadow opacity of 10% would appear almost transparent, allowing you 
to see through to objects below.  The effects of transparent overlapping 
shadows are cumulative.

Shadow Opacity = 100% Shadow Opacity = 50%

shadow hides
objects below

object below is visible
through shadow

bottom most object

Shadow Opacity = 50%Shadow Opacity = 50%

combined effect
of overlapping
shadows

bottom most
object
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o	 Drag on the Blur Slider to change how soft, or fuzzy, the edges of a 
shadow should be.  As you drag the slider, the Blur Amount Field will 
update.  You may also enter a specific amount in the blur amount field. 
A value of zero (minimum) blur creates a shadow with a sharp edge.  A 
value of fifteen (maximum) blur creates a shadow with a very soft edge.

Shadow Blur = zero Shadow Blur = fifteen

hard edge soft edge

Shadow Offset = ten Shadow Offset = thirty

shadow is
closer to the

original object
shadow is farther

away from the
original object

Shadow Angle = Shadow Angle =

Shadow Angle = Shadow Angle =

- 30 30

- 140 140

o	 Drag on the Offset Slider to set how far away from the source object 
the shadow should be. As you drag the slider, the Offset Distance Field 
will update.  You may also enter a specific amount in the offset distance 
field.  An offset value of zero (minimum) creates a shadow which is 
directly below the original object and therefore the shadow cannot 
be seen.  An offset value of ninety-nine (maximum) creates a shadow 
which is farther away from the original object.

o	 Drag on the Angle Slider to set the shadow casting angle relative to the 
source object.  As you drag the slider, the Angle Field will update.  You 
may also enter a specific amount in the angle field.  The angle of the 
shadow may be positive or negative.
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To assign a shadow attribute to an object:
o	 Select the object in the drawing to which you want to assign a shadow 

attribute. 
o	 Choose a color for the shadow by clicking on the PowerCADD Color 

Swatch or on the MacOS Color Wheel.  The object will have a default 
shadow in the selected color applied as shown below.  Adjusting any of 
the slider bars, instead of choosing a color, will assign a default color of 
black to the shadow which may be changed later.

default shadow after choosing
a grey shadow color

original object

Assigning a 
Shadow Attribute

o	 Drag on any of the slider bars to modify the associated shadow 
attribute.   The changes are previewed on screen in real time as you 
adjust a slider.  Release the mouse when the desired effect is reached. 

o	 Repeat this process for each of the shadow attributes.

If multiple objects are selected, the same shadow attributes are applied to 
all selected objects. 

TIP: The Eyedropper tool may be used to pick up and apply shadow 
attributes from one object to another.💡💡



Menus504

To edit the attributes of an existing object with a shadow:
o	 Select the object in the drawing you want to edit.
o	 Make the desired adjustments to any of the options in the Shadow 

Attributes Window.  The changes are previewed on screen in real time.
o	 Repeat this process for each of the shadow attributes you want to edit.

If multiple objects are selected, the changes will be applied to all selected 
objects.

TIP: Experiment!  The number of possible visual effects you can create 
by combining the various Shadow Attribute settings in combination with 
Layer Opacity Attributes and object opacity attributes for pen and fill are 
virtually endless.

Editing Shadows

Removing Shadows

💡💡

To remove a shadow attribute from an object:
o	 Select the object in the drawing that has a shadow to be removed.
o	 Click Remove in the Shadow Attribute Window.

The shadow is removed from the selected object.

If multiple objects are selected, clicking Remove will delete the shadow 
attribute from all selected objects.
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The Dynamic Snap Indicator is a floating window that provides additional 
visual feedback when a dynamic snap is applied when drawing, moving or 
editing objects.

NOTE: The Snap Indicator External must be loaded with PowerCADD to 
be active.  See Loader Preferences.

To activate the Dynamic Snap Indicator
o	 Choose Snap from the Window menu or select Snap in the Anchor 

Window.  

To change the font or size,
o	 Control- or right-click on the Dynamic Snap Indicator.  The following 

dialog will appear.

Dynamic Snap Indicator

💬💬

o	 Choose the desired font and size from the contextual menu.

When a particular snap is active, the corresponding letter will highlight 
in red in the Dynamic Snap Indicator.  For example, when Center snap is 
active, the ‘C’ will highlight in the Dynamic Snap Indicator.

Anchor
[DynamicSnapIndicator]
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The Status Window allows you to access many commands and functions 
easily from a floating palette which can be placed anywhere on the drawing.

The Status Window imports functions from various drawing setup 
preferences and other functions into a single floating window.   This window 
can be placed right where you need it at all times, which will allow you to be 
more efficient and therefore, more productive. 

NOTE:  The Status Window External must be loaded with PowerCADD to 
be active.  See Loader Preferences.

To activate the Status floating window
o	 Choose Status from the Window menu or select Status in the Anchor 

Window.  The following floating window will appear:

Status Window

Zoom Control consists of a small mountain icon on the left representing 
Zoom Out, a rectangular numerical field in the center displaying the 
Current View, and a large mountain icon on the right representing 
Zoom In.  A specific view can be set by typing a percentage in the 
Current View field.  The default is 100%, which represents Normal 
Size under the View menu.

Scale Status consists of a Scale field displaying the current drawing 
scale (as specified in Drawing Setup) or the current layer scale (as 
specified in Layer Attributes).  This is display value only, it cannot be 
modified from the Status Window.

Nudge Control consists of a Nudge pop-up menu and a numerical 
field (also available in Drawing Setup and in Drawing Window 
Toolbar) allowing you to enter a Nudge Amount.

Edit All shows the current status of Edit All Layers and allows you to 
toggle it On or Off.  An Object Count of selected objects is displayed 
beside the Edit All checkbox.  The Layer Name field shows a selected 
object’s layer and lets you activate that layer by clicking on the Go To 
button.  If the selected objects are on multiple layers, no layer name is 
displayed.

💬💬

Anchor
[StatusWindow]
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Zoom In and Zoom Out allow you to magnify part of the drawing for 
greater detail or show a greater area of the drawing on the Macintosh 
screen.  The Zoom Magnification enables you to set specific Zoom In/Out 
increments.  Current Zoom allows you to set a specific zoomed view. 

To use the Zoom In command from the Status Window:
o	 Click in the drawing at the location you wish to zoom.
o	 Click the Zoom In icon.
o	 Zoom will occur with the last mouse click in the center.

To use the Zoom Out command from the Status Window:
o	 Click the Zoom Out icon.
o	 This will execute the Zoom Out command.

To set a specific Current View:
o	 Double-click the Current View numerical field to highlight it.
o	 Enter a percentage and press the Return key.  Normal view is 100%.

Zoom In, Zoom Out, 
Current Zoom
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The Symbol Palette floating window provides an alternative method of 
seeing and placing symbols saved in Symbol Libraries.  The Symbol Palette 
displays your library as a row of thumbnail views.

Symbol Palette 
Window

NOTE: The Symbol Palette External must be loaded with PowerCADD to 
be active. See Loader Preferences. 

For more information on Symbol Palette, see Symbol Tool in the Tool 
chapter.

💬💬

Anchor
[SymbolPaletteWindow]
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The Text Attributes Window is a floating window allowing you to change 
the text defaults for any tool which supports text, or for editing existing text 
in a drawing. 

Choices available in the Text Attributes Window are also available in the 
Text menu, Text, or from contextual menus when Control- or right-clicking 
on an object. 

To activate the Text Attributes window:
o	 Choose Text Attributes from the Window menu or select Text 

Attributes in the Anchor Window.  The following floating window will 
appear:

close button

Favorites pop-up menu

Font List pop-up menu

Font Size field

Font Style buttons

Font Alignment buttons

Font Size adjustment
arrows

Text Attributes 
Window

o	 As you change tools, you will also notice the Text Attributes window 
display will change to the selected text defaults.  As you change tools, 
you will also notice the Text Attributes window display will change to 
the selected text defaults. 

o	 You may change the defaults, if they are not correct. 
o	 When an object is selected, the Text Attributes window will display the 

text attributes of the selected object. 
o	 When choosing items from the Favorites pop-up menu, select a favorite 

font style you have or to manage your saved font styles.  The choices 
here are the same as choosing Text Styles from the Text menu.

o	 When choosing items from the Font List pop-up menu, select the font 
you want to use.  PowerCADD will display all font families and font 
styles you have installed in MacOS and enabled using Apple’s Font 
Book application. The choices here are the same as choosing Font from 
the Text menu.

o	 In the Font Size field, type a value, in points, for the size you want the 
text to be.  You may also adjust the font size up or down one point size 
at a time by clicking on the Font Size Adjustment Arrows.

Anchor
[TextAttrsWindow]
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o	 Select a Font Style button to apply the associated style. The choices 
here are the same as choosing Styles from the Text menu.  If a button is 
dimmed then that particular font style has not been installed or is not 
available for the specific font family.

Bold

Italic
Underline

Shadow

Outline

Left justified

Center justified Right justified

Full justified

Setting Text Tool 
Attributes

o	 Select a Font Alignment button to apply the associated text justification.  
The choices here are the same as choosing Alignment from the Text 
menu.

You may assign specific text attributes for a text related tool prior to drawing 
the object or entering text.  All objects will have the same text attributes 
until the tool’s text attributes are changed or you edit the text attributes 
of an existing object in the drawing.  Tools which accept text attributes 
are the Text tool, Leader tool, Table tool, Date and Time Stamp tool, all 
Dimensioning tool, and all Notation tools.

To set the text attributes for a tool:
o	 Double-click on a text related tool to deselect all objects in the drawing.
o	 Select a setting in the Text Attribute Window and choose an item from 

the associated list.
o	 Repeat this process for each text attribute you want to set prior to 

drawing an object.
o	 Start the drawing operation.  Text will be created with the specified 

attributes.

TIP: Pressing the Shift key as you set a tool’s text attributes will set the text 
attributes for all tools in the palette at the same time.💡💡



Menus511

The attributes of existing text in a drawing may be changed. 

To change the text attributes of an existing object:
o	 Select the object in the drawing whose text attributes you want to 

change.
o	 Select the Text Attribute Window item you want to change and choose 

a new text attribute from the associated list.  For example, select the 
Right Justified button to change the alignment.

The Attribute for the selected text is changed.

If the selected text was a group, then all text objects in the group will take on 
the new text attributes.  If multiple objects were selected, the text attributes 
for all objects are changed.

See the Text menu, in this chapter, for information on working with text 
styles and working with fonts and text.

Changing an Object’s 
Text Attributes

!
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If you have a particular set of text attributes you use regularly, creating a 
favorite is an excellent way to streamline your workflow.

To create a new favorite:
o	 Select the text block in the drawing which has the correctly assigned 

text attributes.
o	 Select the Favorites pop-up in the Text Attributes Window and choose 

Add Style. The following dialog will appear:

Creating Text Favorites

Style Name field

Font List pop-up
menu

Font Size field

Font Size
Adjustment Arrows

Font Style buttons

o	 Enter a name for the new favorite in the Style Name field.
o	 Click the Get Object Attributes button to acquire the attributes of the 

selected item in the drawing.
o	 Make any desired changes by adjusting the Font Size or Style or select 

a different font from the Font List pop-up.
o	 Click OK and a preview of the new style is appended to the Favorites 

menu and to the Text menu, Text Styles submenu.

NOTE: Pen color, pen pattern, fill color and fill pattern are not saved with 
a text favorite.💬💬



Menus513

Using Text Favorites To apply a favorite font style to text in the drawing:
o	 Select the text block in the drawing.
o	 Click on the Favorites pop-up in the Text Attributes Window.
o	 Choose the desired font favorite from the list. 

TIP: You can assign a custom key command to a text favorite

Deleting Text Favorites To delete a favorite font style from the list:
o	 Choose Delete Style from the Favorites pop-up in the Text Attributes 

Window and the Delete dialog will appear. 

💡💡

o	 Select the text style favorite to be deleted and click Delete.  

	 To delete consecutive items, press the Shift key and click on the items 
in the list.  

	 To delete non-consecutive items, press the Command key and click on 
the items.

The style is removed from the favorites list.
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Tool Palette

Wall Tools Palette

The Tool palette contains all the PowerCADD tools for creating, 
dimensioning and modifying geometry in your drawings. 

The complete description is located in the Tool menu section of this manual. 

To activate the Tools palette
o	 Choose Tools from the Window menu or select Tools in the Anchor 

Window.

The Wall Tools palette provides specialized tools for walls in architectural 
drafting and design.  These tools extend the capability of PowerCADD for 
architects.

The complete description is located in the Tool menu section of this manual. 

To activate the Wall Tools Palette
o	 Choose Wall Tools from the Window menu or select Wall Tools in the 

Anchor Window.
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The Help menu contains help for both the novice and expert.Help Menu

What’s New opens an Adobe Acrobat PDF file with a list and general 
description of changes for this version of PowerCADD.

Tutorial opens an Adobe Acrobat PDF file with information to help you 
get started using PowerCADD.

PowerCADD Manual opens the entire PowerCADD manual in Adobe 
Acrobat PDF format on your computer. The manual is fully searchable, 
enabling you to quickly find information on any given PowerCADD related 
tool or menu item. 

PowerCADD Website takes you directly to the Engineered Software 
website homepage.

PowerCADD Help Web Page takes you to the Engineered Software web 
site help pages. 

Updates… allows you to update your version of PowerCADD when you 
receive an email notification from Engineered Software with detailed 
instructions and a description of what’s new or changed.  An internet 
connection is required to perform all updates.  If you are using a personal or 
network firewall, the default SQL port 3306 must be open. 

Anchor
[HelpMenu]
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Search: Users can use the Help Search feature to quickly locate help on 
various MacOS features or to locate PowerCADD menu items.  The Help 
Search results are broken into two parts.  The upper portion of the window 
contains results for PowerCADD Menu Items.  The lower portion of the 
window contains results from the MacOS Help Topics.

To search for PowerCADD menu items:
o	 Choose Help and click in the Search field.
o	 Type the desired menu item you are searching for (for example: Place).
o	 A list of results appears.  Click on an item to see the menu location 

activate.  Press Return when a search results item is selected to activate 
the menu command.

Safe Mode Instructions: Safe mode helps you troubleshoot technical 
difficulties with PowerCADD.  Choose this menu to see detailed 
instructions.

Submit Trouble Shooting Report:  Choose this menu item to open up 
a form and submit details about your version of PowerCADD and any 
additional comments to Engineered Software technical support.  An active 
email account and internet access is required to submit the report.
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Reset PowerCADD: If you are experiencing an unforeseen or unexpected 
problem with PowerCADD resetting a particular preference file can be a 
quick way to troubleshoot or fix the problem.

CAUTION! Resetting a selected item will permanently delete it from 
the PowerCADD Preferences folder.  We recommend making a backup 
of items in your PowerCADD Preferences folder prior to choosing Reset 
PowerCADD.  See Chapter 1 for additional information on what files and 
folders (??? can’t find so created list below) are saved in the PowerCADD 
Preferences folder.

To reset PowerCADD:
o	 Choose Reset PowerCADD from the Help menu.  The Reset 

PowerCADD dialog will open:
o	 Check the box next to the desired preference to be reset.  For a full list 

⚠

Reset PowerCADD

of Preference files see Chapter 1. (??? can’t find) 
o	 Click Reset PowerCADD.  PowerCADD will quit and the checked 

preference items will be deleted.

The next time you launch PowerCADD a new, factory default, version of 
the selected preference is automatically created.

The following preferences files are located in

User/Library/Preferences
	 com.engsw.ES Update Priv.plist
	 com.engsw.PowerCADD9.plist

	 PowerCADD
		  PowerCADD 9 Key Commands

PowerCADD 
Preferences Files
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Ongoing Quality Control Even with extensive testing and quality control efforts, it is virtually 
impossible to replicate the myriad of combinations of Apple hardware, 
MacOS system software, and third party applications and hardware 
PowerCADD users may be using.  To help us understand the nature of 
any problems and to help address them as quickly as possible we have 
implemented an automated crash log reporting system. 

If you experience an unexpected crash or situation where you are required 
to use the MacOS feature to Force Quit PowerCADD, the next time you 
launch PowerCADD you will see the following dialog:

Clicking OK automatically submits details of the PowerCADD crash log to 
Engineered Software for review and analysis. 

The information received is confidential and used exclusively by Engineered 
Software for ongoing quality control issues related to PowerCADD. 

If you have any additional information you’d like to share regarding the 
crash log, or to share a copy of the drawing file to assist in trouble shooting, 
please contact us directly by calling 1-336-299-4843 or emailing support@
engsw.com
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This chapter contains information that may save you time and energy 
trying to discover things on your own.  Many of these hints were discovered 
during the development and testing PowerCADD and are passed along to 
you for your benefit.

Networking High performance CADD requires high performance tools.  Dedicated 
local hard disk drives provide significant performance and productivity. 

It is advisable for both license and copyright laws and practical technical 
reasons, not to double-launch PowerCADD. PowerCADD will allow users 
to open the same drawing more than once concurrently to allow before and 
after referencing, different views on multiple monitors and so on.

For more information on opening files stored on a network server, see 
Network Servers.

Tips, Hints & Shortcuts

!
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Uses of the Option Key

Option Palette

Option Duplicate

Option Reshape

Option Editing

Move Points

Option Guidelines

Pressing Option while selecting certain tool palette items will present a 
dialog box allowing you to change the tool’s defaults.  Any tool that has 
two dots (..) in the tool icon will present a dialog box, including dimension 
tools, parallel line tool, round corner rectangles, regular polygons and 
others. Some menu items will display three dots (…) when you press the 
Option key and select a menu item.  Pressing the Option key when selecting 
the menu items will present a dialog box.

Choosing the Duplicate menu item with the Option key depressed presents 
a dialog box and allows multiple duplications and the selection of the offset.  

This can be used for placing the duplicate at a specific location and for 
setting the number of copies.  

Rectangular and circular arrays can be used. 

You can also duplicate an object while you drag it by pressing the Option 
key.

During Reshape, pressing the Option key while selecting a point deletes 
the point. 

Pressing the Option key while clicking on a line adds a point to the polygon, 
Bézier curve or B-Spline.

Only a few control points are necessary with Béziers.  You will find more 
points make the curve much harder to manipulate.

Pressing the Option key while selecting an attribute, fill pattern, hatch line 
type, arrow, dash, or color will bring up a dialog and allow editing of the 
attribute.

After selecting Move Points, the Option key will allow a lasso selection of 
the area to be moved.

Pressing the Option key while dragging a guideline from the rulers onto 
an existing angled object, like a rectangle or line, will force the guideline to 
assume the object’s angle.
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Uses of the Shift Key

The Shift key allows you to constrain and to release constraint while drawing 
and editing. 

Shift as a Constrain Key

Other Uses of the Shift Key

Setting Tool Defaults

When drag-moving an object, the Shift key will constrain its movement to 
vertical and horizontal. 

The Shift key unconstrains a dimension line so any angle dimension line 
can be drawn. 

Pressing the Shift key while completing a dimension line placement will 
create a parallel dimension.  

The Shift key unconstrains the Parallel Line tool to draw at any angle. 

Pressing the Shift key after a rectangle has been started will constrain the 
rectangle to a square and an ellipse to a circle.  The Shift key constrains the 
diagonal to any of the preset angles in the Drawing Setup under the Layout 
Menu.

Pressing the Shift key after line stretching has started causes the line to 
maintain its original angle while being lengthened or shortened.

Pressing the Shift key while using Reshape on a line will release the angular 
constraint on the line.

Pressing the Shift key while stretching a corner handle causes rectangles, 
circles, and ellipses to be stretched proportionately.

The Three-Point Arc tool is constrained to the preset angles by pressing the 
Shift key after drawing has started.  The constraint should make it easy to 
construct regular arcs starting and ending on North, East, South, or West.

The Shift key also allows deselecting an individual object in a selection.  
When making multiple selections by pressing the Shift key, you may 
deselect a selected item by continuing to press the Shift key and clicking 
on the object.

Pressing the Shift key while setting a tool attribute sets this attribute as the 
default in all of the tools if the default is applicable. 
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Uses of the Space Bar Key

Flipping Orientation

Draw by Center

Panning

Parallel Lines

While drawing an elliptical arc, an arc by its diameter, tapping the Space 
Bar to flip its horizontal or vertical orientation.

While drawing a rectangle, rounded rectangle or line, tapping the Space Bar 
will draw the object about its center point.

With any tool selected, pressing the Space Bar will enable interactive 
panning.  

Drag the mouse while pressing the Space Bar to pan, release the mouse to 
return to the previously selected tool.

While drawing the first segment of parallel lines, pressing the Space Bar will 
toggle the offset between left, center, and right.  Each keypress toggles the 
offset.
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Uses of the Command Key

The Command key releases all snapping while drawing.  Also, by pressing 
Command while moving an object will allow the object to be moved off 
the page. 

Using Command-Period and Command-Spacebar
o	 Stops screen updating.  Eliminates slow redraws. 
o	 Command-Spacebar and Command-Period will stop a redraw in 

process.

Killing the redraw is very valuable with huge drawings.  If no redraw is 
forced, the computer will catch up when it gets a chance.  It is more likely 
you will perform another screen move after scrolling, such as Zooming-to-
final-location for drawing.  After zooming, the update will be correct. 

Command Period (.) and 
Command-Spacebar

Selection Arrow

Dialog Shortcuts

Copy and Pasting

Selections can be made, by drawing a selection marquee touching the 
desired objects.  

By pressing the Command key, all objects inside the selection rectangle are 
selected.

Pressing the Shift key allows cumulative selection or deselection of objects. 

You may use keyboard shortcuts in a variety of dialog boxes for specific 
items.  

Pressing Command-Period is the same clicking Cancel.  

Pressing the Return or Enter key is the same as clicking OK.  

Pressing Command-D is the same as clicking the Don’t Save button.

Copying from one drawing and pasting to another drawing places the 
pasted material exactly in the location copied unless you are using another 
pasting option.  

If the drawing you are pasting to is smaller (page size) than the original, the 
material may be pasted off-page.  

Use Paste Special, At Mouse to move content from one file to another and 
control where it is pasted.

For more information on pasting at mouse, see Paste Special.!



Tips, Hints & Shortcuts525

Other Tips

Trim

Tool Settings

Editing Rotated Text

Measuring

If the trim defaults are set to delete the line segments, the line segments 
specified with the bridge line will be retained and the line segments 
extending past the intersection will be deleted. 

For the individual tool settings, you have the best of both worlds.  

In order to make a permanent change in a tool’s defaults, you cannot have 
any item selected.  

You may double-click on the desired tool, which will deselect any items in 
the drawing.  

Choose the preferred characteristics from the menus, such as fills or colors.   
The defaults you specified are assigned to the tool until you change them.  

To change the defaults momentarily, select a tool with defaults assigned 
to it.  Draw an object and while the object is still selected, change its 
characteristics using the menus.  When you draw the next item with that 
tool, you will find it has returned to its original defaults. 

Rotated text may be edited by selecting the text tool and clicking on the 
rotated text.  The text will temporarily return to zero rotation or horizontal 
for editing.  When you have finished editing, the text will return to its 
original rotation angle.

Measuring can be accomplished at any time by using the Show Location 
Bar, which is displayed in the lower left corner of the drawing window. 

To activate the Show Location bar, select Show Location from Show Tab in 
Drawing Setup chosen from the Layout menu. 

By clicking directly on the bar, you can toggle the measurement system 
through Absolute, Relative, or Length-and-Angle. 

By activating the Length-and-Angle option, you can measure from point to 
point.  Start by clicking where you wish to begin measuring.  The values in 
the Show Location Bar will reset.  As you move the cursor away from the 
starting point, the Show Location Bar will display the distance and angle 
or direction of cursor travel.  Therefore, by clicking to define the start of 
the measure, and placing the cursor on the end point of the measure, you 
can read the dimension and angle in the Show Location Bar.  You will find 
dynamic snapping is invaluable during this process.

Anchor
[OtherTips]
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There is a center snap location at the midpoint of each line.Bisecting Lines

Accuracy

Working at Angles

The drawing database is accurate to twelve decimal places at normal scale, 
and sometimes more.  

The manual drawing process is at best accurate to .005”. 

Paper stretch and shrinkage can create another 1/32” error. 

Basically, this means the computer is 5 to 30 times more accurate than a 
manual process, but not infinitely accurate. 

It is absolutely mandatory to test any computer operation for reasonableness; 
check your application of the computer tools against the desired results. 

Calculations requiring accuracy greater than the nearest .001”, at 1:1 scale, 
should be checked by other means.

Rotating an entire drawing or a layer will allow you to work at a fixed angle.  

The layer should be rotated about the drawing origin.  Work on the section 
desired until complete and then rotate back to the original angle. 

This method has been used on very large drawings with good results.  The 
concept is not much different than the way some of us worked when there 
were only T-squares and parallel bars.

Alternatively, use Custom Snap angles to set a baseline, which matches the 
rotation angle of the data. This allows you to snap to those angles without 
having to rotate the drawing to be perfectly vertical or horizontal. 
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Zooming Methods Of all the tasks performed during computer drawing production, the ability 
to easily zoom in or out (that is to change the on screen view by enlarging 
or reducing its size) may be at the core of efficient drawing navigation.  
Since none of us work in exactly the same way and drawing circumstances 
vary widely, multiple methods of zooming are available in PowerCADD to 
address those nuances.  While we can summarize the available methods, 
there is no ‘best method’.  Rather, each one has its own unique place in the 
workflow and with time they can all be mastered and used seamlessly.

Zooming method can be accessed using the mouse (for example to select a 
tool or menu item) and many of these methods can also be access using a 
preassigned key command, or you can add your own custom key commands.

Zoom Tool: Located in the first row of the tool palette, this tool allows you to 
press and drag in the drawing window to dynamically specify how far to zoom 
in.  Pressing the Option key with the Zoom Tool selected will zoom out.

View Menu: The view menu contains commands for zooming in and out 
of a drawing, normal size viewing and reduced to fit.  All of these may 
be accessed using key command shortcuts.  In addition, you may save 
frequently used views and assign your own custom key commands to access 
those views.  All of the view menu items work together to create a suite of 
time saving navigation features.

Overview Window: Click and drag in the Overview Window to specify 
which area of  the main drawing you’d like to see.  Drag a small marquee to 
zoom in, drag a large marquee to zoom out; the drawing window updates in 
real time to reflect the drag operation in the Overview Window.

Zoom In/Out/Previous ‘now’ (on the fly zooming): This feature is 
unique in that it allows you to modify the zoom ratio even when a drawing 
tool is selected.  The default key commands are (1) to zoom in , (2) to 
zoom out, and (3) to toggle between the current and previous zoom levels. 
If  you’d like to modify these key commands, choose Preferences from the 
PowerCADD menu and click on the Commands tab. Look for Zoom In 
Now, Zoom Out Now and Previous Zoom in the list of  items.

Scroll Wheel Zooming: If  you have a multi-button mouse with a center 
scroll wheel, turning the wheel can zoom in or out ‘on the fly’ while a 
drawing tool is selected.  This feature is Off  by default and needs to be 
enabled by checking Mouse Wheel Zooms in the PowerCADD Preferences, 
View tab. 

Drawing Window Toolbar: Icons in the drawing window toolbar also 
allow you to zoom in or out.
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Points are temporary markers used to locate other items. 

Points represent an excellent method to mark locations to be snapped. 
They may be left in the drawing indefinitely; however, we recommend you 
occasionally delete the points and other construction lines which are no 
longer necessary. 

Also, as a particularly crowded area gets busier, the snap-to will become 
more intense and slightly slower.  In any event, delete the points when they 
are no longer needed. 

A quick way to remove these points is to use the Selection Filter window.

Points

Bit Image Symbols Bit images as symbols can sometimes take much less space in the drawing 
than their vector counterpart.  For example a 1,990-object industrial stove 
takes a lot of space in each drawing in which it is used.

To experiment:
o	 Draw the item as you would normally as a vectored object in 

PowerCADD.
o	 When finished, place the symbol in an otherwise empty drawing or 

separate layer.
o	 Check About PowerCADD to determine the count and file size. 
o	 Select the objects and choose Objects to Bitmap from the Tool menu. 

The object has now been converted to bits.
o	 Compare the new file size and object count.

You will probably want both the vector and bit image copy of the symbol.  
As always, use the most efficient technique to accomplish the job.

Lines, Text and Color 
Settings in the Menu

As you have already observed, when you pull down a menu or sub-menu, 
some items are marked with a checkmark (4).  To determine an object’s 
attributes, select it and choose the appropriate menu; the objects attributes 
will have a checkmark next to the named menu item.  To determine a tool’s 
attributes, select the tool and choose the appropriate menu. 

CAUTION: Having both an object and a palette tool selected can be 
confusing.  To avoid confusion, double-click on the palette tool before 
checking the tool’s attributes.  Double-clicking assures only the palette tool 
is selected.  To avoid confusion, select the Selection Arrow tool and then 
select the object.  This assures only the object is selected.  The last item 
touched is the one for which the menu checkmarks apply.

⚠



Tips, Hints & Shortcuts529

The repeat length of the dashing is accounted for when turning the corner of 
polygons, rectangles, and other objects.  Polygons and smoothed polygons 
will be dashed when printed as you would draw them manually.

Line Types

Snap Angles

Multiple Scales

Drawing Walls

Snap angles may be set in the Snap tab of the Drawing Setup dialog.  The 
snap angles may be any angle you desire, including fractional angles.  Snap 
angles apply to virtually all drawing tools, move, and editing operations.  

Pressing the Shift key will override preset snap angles for a tool, which is 
always constrained (e.g. the Multi-Angle Line Tool).  

Pressing the Shift key will force a preset snap angle on a tool, which is 
always unconstrained (e.g. the Line tool).

Think of PowerCADD scaling the same as flipping your triangle scale over 
as you work on a document—same drawing—just measured differently.

To start a wall, select the Parallel Line tool, press and drag the mouse to 
define the first segment of the wall.  Once a wall is started, click at each 
intersection point of each wall.  The wall can be drawn on centerline or 
to the outside or inside of the wall.  The centerline is a construction line, 
which will disappear when finished drawing.  

Press the Option key while selecting the palette to bring up a dialog to change 
the left and right offsets of the wall.  The settings will be retained until changed. 

Press the Space Bar while drawing to toggle between left, right, and center 
offsets on the fly.

Double-clicking ends the drawing of this item.  Clicking close to the 
starting wall point closes the wall section.  Double-clicking rapidly while 
drawing, or clicking twice in the same place, ends the polygon.  If the end 
of the polygon joins itself at the beginning of the polygon (as in a building), 
a special wall closure occurs.

Once drawn, parallel line polygons can be filled or modified in the normal 
manner.  Reshaping allows adding points, moving lines, deleting points, 
and many other changes.

Parallel line walls can be stretched without changing the wall thickness. 
Choose Reshape and lasso all the points to be moved.  Pick one of the 
points, and drag the entire wall end to its new location.  Reshaping allows 
moving the wall without changing its thickness.  These polygons can be 
combined with other polygons.
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PowerCADD offers various methods for panning and scrolling in a drawing. 
Much like the various methods of zooming, taking the time to understand 
and master each one can help create a more efficient workflow. 

Pan Tool: In the first row of the tool palette, choose the Pan Tool then drag 
in the drawing window to ‘move the paper’ so you can see the desired area.

Interactive Pan: Similar to the Pan Tool only it goes to the next logical 
level.  With any drawing tool selected, press the Space Bar. The current tool 
or cursor will change to the grab hand; drag to pan.  Release the Space Bar 
and your drawing tool is still active.

Scroll Arrows: Clicking on a scroll arrow will move you up, down, left or 
right one line depending on which scroll arrow you press.  Pressing on a 
scroll arrow causes continuous scrolling.  This is a MacOS standard, and it is 
easy to overlook, especially for new users of Windows/AutoCAD converts.  
Of course PowerCADD offers a creative twist.  Choose Preferences from 
the PowerCADD menu and select the View tab.  Specify a smaller or larger 
number in the Line Scroll field to adjust how far you move each time you 
click on a scroll arrow.

Panning & Scrolling

vertical scroll arrow
vertical scroll box

horizontal scroll arrow

horizontal scroll box

horizontal scroll bar

vertical 
scroll bar

Scroll Box: Drag a scroll bar (vertical or horizontal) to reveal a different 
portion of the drawing area.  The position of the scroll bar in the scroll 
bar indicates the position of what is in the drawing relative to the entire 
drawing window.  Again, this is a MacOS standard, which can be 
customized in PowerCADD to help you optimize performance for your 
particular hardware configuration.  Select the View tab in the PowerCADD 
Preferences and specify a smaller or larger number in the Page Scroll field.
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Area Between Scroll Bars and Scroll Arrows: Here is yet another MacOS 
golden oldie method of navigation.  If you click in the grey area between 
a scroll bar and a scroll arrow, you will advance the height or width of the 
drawing window.  This can be a great way to surf around a drawing, one 
drawing window tile at a time.  Think of this as moving one page at a 
time where a page is defined as what you can see in the drawing window.  
Remember, the drawing window can be any size, and this feature will 
behave consistently with respect to that size.

Scroll Up/Down/Left/Right: You can assign custom key commands which 
perform the same task as clicking on an up, down, left, or right scroll arrow 
in the drawing window.  Select Commands tab from the PowerCADD 
Preferences dialog box.  Select the Miscellaneous pop-up menu and assign 
key commands to Scroll Up, Scroll Down, Scroll Left or Scroll Right.  Now 
you can scroll in any direction simply by selecting the command key instead 
of moving your mouse.

Page Up/Down/Left/Right arrows: There are key commands which are 
also available to move one drawing window at time in the direction specified 
by the arrow.  This has the same effect as clicking in the grey area between 
scroll boxes and scroll arrows described earlier.  The default key commands 
assigned are Shift key + [the arrow key] where [the arrow key] is left, right, 
up or down as shown on the keyboard.  Like all other PowerCADD key 
commands, you may also assign your own custom values in the Preferences 
dialog, Commands tab, Miscellaneous pop-up menu and choosing Page 
Up, Page Down, Page Left or Page Right.

Auto Scroll: When dragging to draw or move an object, the screen will 
automatically scroll when your mouse collides with an invisible barrier on 
all sides of the drawing window. 

Overview Window: Drag the red zoom rectangle in the Overview Window 
to move it.  As the red zoom rectangle moves the main drawing window is 
updated.

area between scroll boxes
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Concentric circles can easily be drawn by leaving object snap on.  The 
radius will snap to the point in the center of the circle for each new 
circle.  Alternately, you can draw concentric circles rather sloppily at their 
approximate location.  Later lock the smallest of the circles, select all of the 
circles and arrange by aligning centers and middles.  You might also place 
a point at the circle center, and let the center snap to the point.  Another 
method of drawing concentric circles is using the Parallel Offset tool.

Concentric Circles

Layer Info

Grid Snap

Bit Images

Log

Bounding Box

In the Layer window, multiple selection across a range of layers is possible 
with use of the Shift key.  Multiple selection of random layers is possible 
with the use of the Command key.  Multiple selections should make it much 
easier to change many layers to dimmed or invisible at once.  Remember the 
current layer cannot be hidden or deleted.

Grid snap is a toggle setting—On or Off.  We highly recommend you 
always leave the grid snap on.  When required, you can release your drawing 
from the grid snap by pressing the Command key.

Bit images may be resized by dragging their corner handles.  The bit 
image retains its original accuracy when reduced or enlarged.  Enlarging 
may produce unusual printed results.  Shrinking or reducing the size will 
generally enhance the printed appearance.  Try drawing the bit images twice 
as large as needed and Scale by .5 when in PowerCADD.  Any PowerCADD 
object may be converted to a bit image using the Object to Bitmaps menu 
item in the Tool menu.  Bit images may also be cropped by pressing the 
Command key when dragging an edit handle.

The Log is a method of keeping a cumulative record of the amount of 
time a drawing is open or in use.  Some caution is in order here since two 
drawings can be open and accumulate time together.  Also, the drawing will 
be accumulating time while you are on the phone.  In some circles this is 
known as “double dipping”.  This is also the method some professionals use 
to determine billing.  The log file can be opened directly in Microsoft Excel 
or other spread-sheet applications.  Double-click on the file.  The log file 
can be read by most word processors.  To align things, the tab settings will 
need to be made in most word processors.

A bounding box is the smallest rectangle that will completely enclose an 
object or multiple selected objects.  The sides of the bounding rectangle 
are the horizontal and vertical axis.  In the Cartesian coordinate system the 
“X” is always the horizontal axis and the “Y” axis is always the vertical axis.
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Screen scrolling is connected to the cursor arrows in addition to paging in the 
scroll bar and line scroll in the scroll arrow.  Cursor control is approximately 
one-half page.  This is intuitive and reacts much like a spreadsheet and word 
processor program.

Cursor Arrow Control

Spot Color Separation

Printed Circuit Traces

Printed Circui

Self-Healing Walls

Using a layer for each color will allow easy spot color separation.  When you 
are finished with your drawing, print each color (layer) individually.

The Parallel Line tool represents a good method for drawing printed circuit 
traces.  The resulting trace would normally be filled black.  Using a wide 
line is probably not a good method of representing a printed circuit board 
trace.  Parallel Line Polygons can be scaled up and down.  Also, the pad to 
trace clearance will be correct on Zooming. 

Some of our customers have used PowerCADD to create chip circuitry. 
One-mil-wide traces are commonplace.  Normal silicon design techniques 
are used to maintain accuracy.

Walls constructed as polygons or rectangles can always be self-healing.  
Construct the doors and windows with opaque fills.  When the window 
is placed over the wall, the wall lines disappear.  When the window is 
removed or its location changes, the wall lines reappear.  Printing, screen 
appearance, and plotting will be correct.  The “permanent self healing” is 
a most powerful feature and is unique to the MacOS.  You will find many 
other uses for “permanent self healing” in PowerCADD.

NOTE: The use of opaque or white-filled objects to mask other areas should 
be avoided on drawings destined for DXF or DWG translation.

Digitizing

💬💬

First, scan the maps or other drawings.  Use either the scanning software or 
a paint program to clean up the stray pixels.  Save the scanned image in any 
of the many raster formats that PowerCADD can Open, Place, or Import.  
Place the scanned and cleaned-up material into a blank PowerCADD layer.  
Add a layer to PowerCADD and draw over the top of the scanned material 
to trace the image.  The screen digitizing process works best when one of 
the layers is a different color. 

Entering Keyboard Data You will find the process of entering keyboard data to be much faster if you 
first draw a rough outline of an object with the mouse and then edit the 
drawn shape to exact dimensions with the Edit Window and the keyboard.  
This is also true for polygon survey boundaries.
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Screening a Bitmap If you have a bitmap, which you would like to use as a faded or screened 
backdrop, place it on its own layer.  Then use the Layer Attributes, Fill 
Opacity setting to fade the bitmap.  Reduce the Fill Opacity to about 35% 
and you can draw easily on top of the bitmap.

Alternatively, you can also use the Apply Bitmap Effects menu item and 
apply a color tint to the bitmap, which can simulate the same effect.  Using 
the Layer Opacity technique is typically faster, easier and non-destructive 
but does not allow you to specify a color tint.  Color tints may also be 
applied by assigning a pen color to a black and white bitmap.

Database Choices What are my choices when using PowerCADD to create schedules, lists, and 
build a database of text data for drawing, project and facility management?

Unfortunately there is no one-click answer and a sound understanding of 
the fundamentals is critical to success in this type of situation.  The trade 
off is some time and effort is required on your part to learn the available 
methods and how they can be applied to your specific needs.

The key to remember is PowerCADD is a graphic interface to the 
drawing database.  Every object in the drawing already contains a variety 
of information (example: its x,y location and size among many other 
attributes).  You can also assign your own unique text attributes to special 
objects using Symbol Tags.  This additional data becomes part of the 
PowerCADD database and can be exported for use in other applications to 
perform value added analysis.

We can’t really tell you what to do as it depends on your specific drawing 
and data management needs.  However, we can give you an overview of  
your available options, which may help get you started.  In all cases, it is 
important to clearly understand and plan out in advance just what your 
data management needs will be, then compare those needs to your available 
choices.  There is rarely a single ‘auto-magic’ solution to a particular data 
management situation.  Rather, you may need to look at using several 
techniques to meet your project needs.

Here is a basic breakdown of  the current features and what they do to 
help guide your decision-making process.  Each feature has a unique and 
valuable place in the database workflow.  In the case where a report can be 
saved, the resulting exported files are in plain text format, which may be 
opened in a variety of  applications to value added analysis.
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Symbol Libraries: Libraries may contain any PowerCADD object or 
collection of  objects. A symbol may be as simple as a snap point containing 
text attribute data or as complex as a master construction detail, site plan 
or wall assembly. 

Behavior / Qualities:
o	 Very easy to use
o	 Library is not linked to a specific drawing file
o	 Object drawing data (but not associated database attributes) will 

export via DWG or DXF once in the drawing (not including raster 
based data).

o	 Can contain any valid PowerCADD object(s)
o	 Can be applied at any time in the drawing process
o	 Automatic scaling of objects when inserted into drawings
o	 May contain additional database attribute data in addition to ‘name’
o	 Preplanning required prior to using to maximize its power
o	 Symbol library object may contain special user defined text assigned 

using Set Symbol Tags command.

Symbol Tool: This tool contains two optional settings and works in 
conjunction with Symbol Libraries and the Set Symbol Tags Command.

Behavior / Qualities:
o	 Very easy to use
o	 Option-click to set tool for inserting objects as groups or instances
o	 Symbol instance creates a one to many relationship for updating Set 

Symbol Fields
o	 Ability to use Replace Symbol to globally replace symbols inserted into 

a drawing with this tool speeds up drawing management/increased 
productivity

o	 Ability to Set Data Fields (as opposed to Set Symbol Tags) when objects 
inserted into the drawing.

Set Symbol Tags: This command permits data tags to be set for any existing 
object in a drawing or for objects inserted from Symbol Libraries. Data tags 
can be reported and opened in other applications for value added editing 
and analysis.

Behavior / Qualities:
o	 Moderate ease of use
o	 Requires preplanning to make best of use of this feature
o	 Use Save As, Symbol Report, to generate a report of Symbols in the 

drawing and their related database attribute tags
o	 Up to four unique data fields in addition to one name field
o	 When objects are inserted as Symbol Instances, the data fields have a 
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one to many relationship (edit one data field will update all data fields 
of symbol instances with the same name)

o	 Best applied to items inserted from Symbol Libraries but may also be 
applied to individual objects in a drawing

o	 Reporting feature can discriminate to report all symbols in drawing or 
only selected symbols

o	 Data does not print or export unless included as a table in the drawing

Replace Symbol: This commands permits global replacement of symbols 
in a single drawing.

Behavior / Qualities:
o	 Very easy to use
o	 Works across all layers, whether layer status is on, off, grayed or locked
o	 Remembers scale and automatically re-scales objects to correct % 

during replacement
o	 Works with symbols inserted as groups or instances (keys on group 

name)
o	 Very fast method to update an entire drawing with new objects that 

may contain different or updated database attributes

Summary: There are several components to database creation and 
management in PowerCADD.  Each feature will have pros and cons 
depending on your particular needs.  Remember, each feature fits a specific 
niche in the work flow, and they can be used alone or in combination 
with other tools and commands to solve a variety of reporting needs.  The 
learning curve can be steep in some respects but time and costs invested in 
self study and training in the short term can pay off significant dividends 
in the long run. 



DXF & DWG 
Translators 
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This chapter provides information on the .dxf and .dwg Translator Externals 
that allows you to open various non-PowerCADD file formats or to save 
your PowerCADD drawings into other file formats. 

Translator Externals The file suffix “.dwg” is a generic reference to a “drawing” file used in the 
Windows environment.

The Translator Externals provide an integrated interface to translate drawings 
to or from PowerCADD to any application that uses the AutoCAD® DWG 
or DXF native file format. 

The Translators are Externals. As such, they must be activated in the 
PowerCADD Preferences, Loader tab. 

Using the example files included on your PowerCADD Master CD-ROM, 
we’ll explore the various features and methods for translating drawings. We 
recommend having the examples files on hand to work through each 

Since the process for reading or writing .dwg or .dxf file names to or from 
PowerCADD is the same, we will use the .dwg translation process for 
illustration and demonstration purposes.  Any translation process, which 
differs for .dxf will be noted.

The .dwg and .dxf Translator External contains the following 
sections:
o	 Terminology used in the section.
o	 What you should know before translating.
o	 Translating your PowerCADD drawings to .dwg or .dxf.
o	 Translating .dwg or .dxf files to PowerCADD.
o	 Reference Guide.
o	 Frequently Asked Questions.

NOTE: The Translator reads AutoCAD (ACAD) files, release 10 through 
release 2010.

NOTE: The Translator writes files in AutoCAD release 2000 through 2010. 
Newer versions can read older versions.  For example, if you are sending 
a .dwg file to someone using version 2006 they will be able to open a file 
saved as version 2000.

💬💬

💬💬

Anchor
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NOTE: Binary .dxf files cannot be opened by the Translator and .dxf 
files must be saved in ASCII (American Standard Code for Information 
Interchange).

NOTE: To open any .dwg or .dxf file, the filename must have the appropriate 
.dwg or .dxf suffix.  Files without the correct filename suffix will appear 
dimmed in the Open dialog.

💬💬

💬💬

Terminology The following terms and definitions are used when describing the 
.dwg or .dxf translation processes:
o	 Translate a drawing: The act of converting the drawing data from 

one file type to another.  For example a PowerCADD drawing may 
be translated to a .dwg or .dxf file. The language used in the file, for 
example English or French, is not affected. 

o	 .dwg: The internal drawing file format and extension used by AutoDesk 
for their AutoCAD drawing application running in the Windows 
computer operating system.

o	 DXF or .dxf: The Drawing Interchange Format and file extension 
created by AutoDesk (authors of AutoCAD).  DXF files can be created 
by almost all CAD applications.

o	 Read: To Open a .dwg or .dxf file into PowerCADD.  The result is a 
new PowerCADD drawing.

o	 Write: To Save a PowerCADD drawing as a .dwg or .dwg file. The 
result is new drawing saved to disk which is independent of your 
PowerCADD drawing.
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Introduction
When opening a .dwg or .dxf file, the translator will detect which release is 
being used and adjust accordingly.

When sending a file to another computer on a CD or DVD, you need to 
consider the type of computer when formatting a disk to hold your file.  

To send a file to a Windows machine, it should be formatted accordingly. 

When sending a file to another Macintosh, no special formatting of the disk 
is required.

While every effort has been made to insure your data arrives correctly, there 
are many capabilities of the MacOS we all take for granted, that are simply 
not available or difficult to accomplish in other applications on different 
operating systems.  Fill patterns, bit images, line weights, line patterns and 
many different fonts are standard in the Macintosh environment; this is not 
the case in the Windows world.  Although add-ons can be purchased to do 
some of the same types of things, they are very expensive and generally not 
owned by all users. 

Although the ability to create line weights exists through polylines (and 
some recent versions have started to support line weights in the traditional 
PowerCADD sense), it is not as easy to accomplish and therefore, used less 
often. Line weights are commonly identified by color. Red might indicate 
a 2-point line, so all lines that need to be 2 points are assigned a red color. 
The Translator will maintain the pen colors when reading the file, but all 
line weights in PowerCADD will have a default value of 1 point.

Since fills, patterns, and pen patterns are bit images, these bit images do 
not translate. If you are constructing a drawing you know will be used in 
Windows, there are certain things you can do to ensure your drawing will 
have the same characteristics when used there. 

In the Windows world, there basically is no scale as PowerCADD knows 
it, i.e. one mile equals one mile.  They deal in generic units or unitless 
drawings. PowerCADD, on the other hand, provides a scaling factor, in 
much the same way as the drawing board, in fact, every layer can have 
its own scale. PowerCADD scales with inches, feet, decimals, meters, 
centimeters, etc., and thus, 1/4”=1’ is 1:48. This can create some confusion 
if you are not aware of the scaling conventions. 

CAUTION: You should not use Layer Scales in PowerCADD if your 
drawing is going to be translated to Windows.

What You Should Know 
Before Translating

⚠
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In a 2D program such as PowerCADD, the “Z” dimension is not used.  All 
3D entities are read as flat.  This includes 3D lines, 3D polylines, 3D faces 
and polyface meshes. 3D meshes are ignored.

A PowerCADD drawing saved as a .dwg file will be considerably smaller 
than a corresponding .dxf  file, making it easier to send and receive files on 
CD-ROM, over the network, or over the Internet.  Generally, the .dwg file 
format is preferred, but if  you are not sure which type of  file to write when 
translating your PowerCADD drawing, contact the person who requested 
the file.
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Translating Your PowerCADD Drawings to .dwg or DXF

The translation from a PowerCADD document to a .dwg document is as 
simple as choosing .dwg as your format in the Save As dialog box.  However, 
when you know initially your document will ultimately need to be in a .dwg 
format, you might consider using some techniques to ensure success.

There are many things, we Macintosh users take for granted.  Special looks 
can be achieved in PowerCADD, through custom fill patterns, custom 
colors, bit image scans, and clipping just to mention a few.  For best results, 
knowing their limitations is the best technique for trouble-free translations. 
Clipping, the cover-up of lines or objects with other lines or objects, is a 
natural way for you to create a PowerCADD drawing; however, Windows 
programs do not ‘clip’.  If you would like to see how your ‘clipped’ drawing 
will look, use the Select All command with Edit All Layers turned On and 
set the fill pattern to None.

Since the process for writing .dwg or .dxf file names from PowerCADD 
is the same, we will use the .dwg translation process for illustration and 
demonstration purposes.  Any translation process which differs for .dxf, 
will be noted.

PowerCADD to 
DWG or DXF

Saving a .dwg File To save your PowerCADD file as a .dwg file:
o	 Choose Save As from the File menu.
o	 Choose .dwg from the Format pop-up.  The .dwg suffix is automatically 

appended to the file name in the Save As field.  This suffix is required 
for the file to be recognized in Windows.

o	 Click Save.
o	 If your file contains multiple sheet setups, or various layer status 

settings the Write Options dialog will appear.
o	 Choose the desired settings and press OK to complete the translation.
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The Write Options dialog allows you to specify what data in your 
PowerCADD drawing should be translated.

Options...

Choosing Write Options

Choosing a version of .dwg

Visible Layers: Click this radio button to write out only those layers in 
your drawing which have a drawing status of Visible or Dimmed.  Objects 
and layers, which are hidden (off), will not be saved with the translation.

Sheet Setup: Click this radio button to choose a specific sheet setup for 
translation from the pop-up list.  Only objects and layers, which are visible 
for the specified Sheet Setup, are saved with the translation.

Entire Drawing: Click this radio button to translator your entire drawing.  
All objects on all layers are saved with the translation.  Hidden layers will be 
off, visible layers will be on, when the file is opened.

The Options…  button in the Save As .dwg dialog opens the Write Settings 
dialog where you can customize which version of .dwg is used, and map 
PowerCADD line weights to specific pen color values.

o	 Choose the desired version from the list and click OK.
o	 You are returned to the Save As dialog to complete the Save As process.

To choose which version of .dwg to save as:
o	 Press Option in the Save As dialog. 



DXF & DWG Translators544

When checked, the Set Colors for Line Wts box allows you to create a table 
to translate line weights in your drawing to specific pen color numbers. 
When not checked all line weights default to a default pen color of black.

o	 Press Option in the Save As dialog.
o	 Check the Set Colors for Line Wts box.
o	 Click Settings.  The Line Weight to Color Settings… dialog will appear 

(pictured and described later in this section).
o	 Make the desired settings and press OK.
o	 You are returned to the Save As dialog to complete the Save As process. 

Set Colors for Line Wts

There is a free file converter available from Open Design Alliance called  .  
It basically looks for .dwg files in a folder, converts them to your chosed 
AutoCAD version and places thoese into another folder.  It works very well 
as a batch converter.  

Teigha File Converter

Draftsight Another option is Draftsight, a free program, will open most dwg files and 
can then save back to AutoCAD 2010.    

Some Other Options

Import DXF Import DXF is now part of WildTools.  It is definitely not what you need 
for a full translation of a complete drawing with dimensions.

It is optimized for dealing with files exported from LIDAR data where 
you often end up with a file of 250,000 to 400,000 objects that should be 
combined into a single object, which it does.

It’s also optimized for dealing with files exported from the Concepts Pro 
iPad app where you can do architectural sketches with an Apple Pencil and 
iPad Pro.
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Line Weight to Color Settings… displays a table allowing you to match 
specific PowerCADD line weight values to specific pen color numbers 
often used by other applications to create line weights when printing.

Set Line Weight to 
Color Settings...

o	 Line Weight column: Displays the PowerCADD line weight to be 
mapped to a specific color. 

o	 Units column: Displays the line weight units.  To change a unit click 
on the unit name to choose from Points, Millimeters, or Inches.

o	 Color column: Displays a color swatch of the value specified in the # 
column.  To change the color swatch specify a different numeric value 
in the # column.

o	 # column: Displays the color number which will be assigned to a given 
line weight. Click on a number to change it.

o	 Color Name column: Displays the standard name assigned to the color 
specified in the # column.  To change a color name specify a different 
numeric value in the # column.

o	 + / - buttons: To add a new line weight to the table click +.  To remove 
an existing line weight from the table click on the line weight entry in 
the table then click -. 

o	 Extract From Active Drawing: Click this button to automatically fill 
the table with line weights from the active drawing.  By default all 
entries are assigned a sequential color number.  Click on a value in the 
# column and enter a new value to change the color. 

o	 Save: Click to save the currently displayed Line Weight to Color table.  A standard 
MacOS Save dialog appears allowing you to specify a location and file name.  Saved 
settings may be used again with other drawings or shared with other PowerCADD 
users.  For example, a unique line weight to color table may be saved for coordination 
with a specific consultant to match their internal drawing standards.

o	 Load: Click to load a previously saved Line Weight to Color table.  
A standard MacOS Open dialog appears allowing you to locate the 
previously saved settings.

o	 Cancel: Click to abort any changes in this dialog and return to the 
Incoming Settings dialog to complete the translation.

o	 OK: Click to accept any changes in this dialog and return to the 
Incoming Settings dialog to complete the translation.
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The translation from a .dwg or .dxf file is as simple as opening the file and 
specifying the translation settings to be used to create a new PowerCADD 
drawing.

While the Translator automatically interprets the content of the file being 
read, clear communication with the person sending the .dwg or .dxf file can 
help make the process even easier. 

Items to consider for coordination include:
o	 What drawing units were used to create the original .dwg or .dxf 

file?  For example: inches, feet, miles, millimeters, centimeters or 
kilometers could have been used and affect the scale and drawing units 
in PowerCADD.

o	 What was the intended printed scale and sheet size from Windows?  
This will help you determine what the PowerCADD drawing scale and 
drawing sheet size should be.

o	 Does the file contain external references (X-Ref ’s)?  If so, have the 
user bind the references into a single file or make sure they include all 
referenced drawings.  If they are sending referenced drawings ensure 
they identify which file is the master so you know which one to open.

Please review the Translator Reference Guide and Frequently Asked 
Questions section for additional information.

Since the process for reading .dwg or .dxf file names into PowerCADD 
is the same, we will use the .dwg translation process for illustration and 
demonstration purposes.  Any translation process which differs from .dxf 
will be noted.

NOTE: To open a .dwg file, the filename must have a .dwg suffix. Files 
without the correct filename suffix will appear dimmed in the Open 
dialog.

Translating .dwg 
or .dxf files to 
PowerCADD

💬💬
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The Incoming .dwg Settings dialog allows you to assign and preview 
settings, which directly affect the translation process. 

Any time you open a .dwg or .dxf file the following Incoming Settings 
dialog will appear:

Incoming .dwg 
Settings

	 (1) Model Space Units: When translating Model Space drawings you 
may specify the units used to translate the drawing from this pop-up 
list.  When translating Paper Space layouts this pop-up is unavailable.

	 (2) Model/Paper Space menu: Use this menu to select which content 
should be translated.  If there are multiple Paper Space layouts their 
names are listed in this list.

	 (3) Stationery Sheet Size: Displays the current sheet size of the 
stationery file selected at the start of the translation process.

	 (4) Thumbnail Panel: A small, thumbnail, view of the .dwg file is 
displayed here.  It will always contain one Model Space view which 
is displayed first in the panel.  Some files will display multiple Paper 
Space layouts which are displayed in this panel.  Click on a thumbnail 
view to see the contents display in the Preview Pane.

	 (5) Preview Pane: Displays a preview of the thumbnail selected in 
the Thumbnail Panel.  To change the content displayed here click on 
a different thumbnail.  To navigate within the Preview Pane use the 
Zoom In, Zoom Out, Pan, or Reduce to Fit tools. 

	 (6) Open Bitmap Copy: Check this box to open a copy of the drawing 
in a raster (pixel) format.
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	 (7) Explode Groups Spanning Layers to Respective Layers: When 
checked a multi-layer block is ungrouped and all objects are inserted 
onto their appropriate layer in the translated drawing.  When not 
checked, blocks are not ungrouped.  A block is translated as a group 
onto a PowerCADD layer corresponding to the block insertion layer in 
AutoCAD.

	 (8) Cancel Button: Click to abort a translation operation.

	 (9) Scale Fields: When translating Model Space drawings you may 
directly enter scale values in these fields or choose a scale from the User 
Scale popup menu to display its values here.  When translating Paper 
Space layouts these fields will display the translated drawing scale and 
cannot be edited.

	 (10) User Scale Menu: When translating Model Space content, click 
here to display a list of standard drawing scales to choose from.

	 (11) Metric Checkbox: Check this box to change the display options 
in the User Scale Menu from Imperial (feet and inches) to Metric units.

	 (12) Lines Button: Click to access additional color to line weight 
translation features as described later in this section.

	 (13) Reduce To Fit: Click to change the zoom percentage so all the 
content of a selected thumbnail fits to the extents of the Preview Pane.

	 (14) Pan Tool: Click to select this tool.  With the cursor in the Preview 
Pane, click and drag to change which portion of the preview is shown.

	 (15) Zoom Out Tool: Click to select this tool.  With the cursor in the 
Preview Pane, click to zoom-out of the previewed thumbnail.

	 (16) Zoom In Tool: Click to select this tool.  With the cursor in 
the Preview Pane, click to zoom-in on a portion of the previewed 
thumbnail.

	 (17) Select Area Tool: This tool is available only when the Model Space 
thumbnail is selected.  Click to select this tool.  With the cursor in the 
Preview Pane, click and drag to define a selection rectangle around the 
model space content to be translated.

	 (18) OK Button: Click to proceed with a translation based on settings 
in the Settings dialog. 
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The translator is capable of loading the file from either Model Space or a 
Paper Space layout.

Model Space and Paper Space layouts are the two primary spaces in which 
objects reside.

Paper Space is used for creating a finished layout for printing or plotting, 
as opposed to drafting or design work.

Model Space is used for creating and editing the drawing.  

Objects created in paper space are visible only in paper space.  

Objects in model space can only be edited in model space. 

All drawings will contain Model Space information.  

Most drawings will contain both Model Space and at least one Paper Space 
layout. 

When translating a drawing you have a choice of opening either the Model 
Space or Paper Space views. 

Model Space and 
Paper Space
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The process of opening Model Space content is the same whether the .dwg 
file contains only Model Space content, or both Model and Paper Space 
content.

NOTE: You must use the Select Area tool in the Settings dialog to define a 
selection rectangle (marquée) which includes the data you want translated 
in Model Space.  If no selection is made the entire model space content is 
translated.

HINT: To follow along with the Model Space instructions use the housepln.
dwg file included on your master installation CD.

To translate Model Space content:
o	 Choose Open from the File menu, locate the .dwg file, and click Open. 
o	 The progress indicator will appear.  After the drawing has processed 

the New Document dialog opens asking you to choose a Stationery 
drawing to be used to process the file. 

o	 Choose the desired Stationery drawing and click Choose.  The Settings 
dialog will open.

Opening Model 
Space Content

💬💬

💡💡

o	 If the drawing has only model space data then Model Space is 
automatically selected from the Layout Thumbnail Panel.  If your 
drawing contains both Model Space content and Paper Space layouts, 
click on the Model thumbnail.A preview of the drawing appears in the 
Preview Pane.

o	 Choose the Select Area tool.  Click and drag in the Preview Pane to 
define the area of the drawing to be translated.  Drag a marquee that 
includes all the model space content to translate the entire drawing.  If 
you can’t see all the content use the Zoom Out tool.

o	 The scale fields activate in the upper left corner of the Settings dialog.  
Type a scale or select from any predefined industry standard drawing 
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scale from the popup list.  If you enter a scale that would cause the 
selection to not fit on the drawing page, PowerCADD will prompt you 
with the minimum scale required.

o	 Click OK and the drawing appears in your custom stationery pad at 
the specified scale.

NOTE: A new layer titled “ES IMPORT INFO” is added to the drawing. 
It is the top most layer and hidden by default.  This layer contains detailed 
information about the settings used to translate the file.

NOTE: Remember drawing scale and sheet size are related when translating 
Model Space content.  If the drawing scale you choose will not fit on your 
chosen sheet size, Cancel the translation operation and start again, choosing 
a larger sheet size from your list of Stationery drawings.

NOTE: All layers of the file are translated.  The layer status (On or Off, 
locked) in PowerCADD matches the layer status based on the last time the 
file was saved.

TIP: To translate only a portion of the Model Space content, use the Select 
Area tool to drag a marquee over just a portion of the drawing area displayed 
in the Preview Pane.

💬💬

💬💬

💬💬

💡💡
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A Paper Space layout translation allows you to create, with a single click, a 
PowerCADD drawing which matches the Paper Space layout content.

Paper Space Layouts are typically used to display the Model Space content 
at a printable scale, similar to how you start drawing in PowerCADD (to 
scale).  In most cases the layouts also contain a title block and additional 
drawing notes.

To translate content from a Paper Space layout:
o	 Choose Open from the File menu, locate the .dwg file, and click Open. 
o	 A progress indicator will appear.  After the drawing has processed, 

the New Document dialog opens asking you to choose a Stationery 
drawing to be used to process the file.

o	 Choose the desired Stationery drawing and click Choose.  The Settings 
dialog will open.

Opening Paper 
Space Content

o	 Click on a thumbnail of the Paper Space layout.  The Preview Pane 
updates to display the entire layout.

o	 Optional: Use the zoom tools to zoom in, out, or pan to examine the 
drawing more closely prior to translating.

o	 The paper size and drawing scale has been set by the sender and cannot 
be changed.

o	 Click OK and the drawing appears in your custom stationery pad at 
the scale specified by the originator.

If the custom stationery drawing you specified was larger than the actual 
Paper Space layout, simply perform a page setup to adjust the page size 
accordingly.  

If the user specified a scale that was too large to fit on your stationery you 
may need to use Scale from the Edit menu to make it small enough to 
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fit the page, or translate the file again using Model Space and specify an 
appropriate scale.  

Examine the information on the “ES IMPORT INFO” layer from the first 
translation for helpful information on determining an appropriate scale.

NOTE: The Custom Print Scale assigned to the View Port, as defined by 
the originator when creating the layout, is used to determine the drawing 
sheet size and scale of the translated drawing.

NOTE: Only layers visible in the View Port are included when the drawing 
is translated into PowerCADD.  Hidden layers in the View Port are not 
translated.  If all hidden and visible layers are required translate using Model 
Space instead.

💬💬

💬💬
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The Lines button in the Settings dialog gives you access create a table for 
mapping incoming Pen Colors to PowerCADD Line Weights.  

To change the Line Weight translation settings:
o	 Click Lines in the Settings dialog.  The Color To Line Weight Settings 

dialog will open.

Lines... Settings

	 Color To Line Weight Settings… displays a table allowing you to 
match specific pen color numbers to PowerCADD line weights.

	 Color column: Displays a color swatch of the value specified in the # 
column.  This value cannot be edited.

	 # column: Displays the color number to which a line weight will be 
assigned.  This value cannot be edited.

	 Color Name column: Displays the standard name assigned to the 
color specified in the # column.  This value cannot be edited.

	 Line Weight column: Displays the PowerCADD line weight to be 
assigned to a specific color.  Click in the field and enter a number to 
change the line weight.

	 Units column: Displays the line weight units.  To change a unit click 
on the unit name to choose from Points, Millimeters, or Inches.

	 Save: Click to save the currently displayed Color to Line Weight 
table.  A standard MacOS save dialog appears allowing you to specify 
a location and file name. Saved settings may be used again with other 
drawings or shared with other PowerCADD users.  For example, a 
unique line weight to color table may be saved for coordination with a 
specific consultant to match their internal drawing standards to yours.

	 Load: Click to load a previously saved Line Weight to Color table. 
A standard MacOS open dialog appears allowing you to locate the 
previously saved settings.
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	 Cancel: Click to abort any changes in this dialog and return to the 
Incoming Settings dialog to complete the translation.

	 OK: Click to accept any changes in this dialog and return to the 
Incoming Settings dialog to complete the translation.

o	 Make the desired changes to the Line Weight and Units columns for 
each color number and click OK.

o	 You are returned to the Settings dialog to complete the translation. 
o	 The translated drawing will contain specified line weights for each 

color specified.  The objects color is also retained.
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To correctly translate .dwg files containing Xrefs, all Xref files must be in the 
same folder as the Master Drawing before translating.

Xrefs, or references drawings, are commonly used to combine multiple 
drawings into one Master, or Root, Drawing.  The Translator is capable of 
binding those Xref files for you during the translation process.  The Master 
Drawing is the file you want to translate as it links all the other drawings 
together.  If you don’t know which drawing is the Master Drawing contact 
the original drawing author. 

To translate a .dwg file that uses Xref’s:
o	 Place the Master Drawing and all Xref files in the same folder.
o	 Choose Open from the File menu and open the Master Drawing.
o	 Proceed with the file translation process as described earlier.

NOTE: There is no warning dialog for missing reference drawings.  If your 
drawing looks incomplete, perform a visual audit of the file and contact the 
original file author for all related reference files.

Xrefs 
(Referenced Drawings)

💬💬
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The Reference Guide is designed to provide information to you and your 
clients who send or receive drawings.  Plan ahead by alerting your clients of 
potential problems.  You will save time in the long run. 

The .dxf file format allows users of different CAD software to exchange 
drawings through a common format.  It also allows those drawings to be 
sent to CNC equipment and analytical programs.  The Drawing Interchange 
Format (DXF) is supported by most CAD programs.  The .dwg file format 
also allows for the exchange of drawings, but is not supported by all CAD 
programs.  Generally, .dwg will be a preferred method of file exchange when 
dealing in a cross-platform environment with most design professionals.

As with any channel of communication, a less destructive interference 
means more accurate and timely data.  While the transfer of data 
between PowerCADD and other CAD programs is virtually seamless, 
communication problems can and do occur.  Planning is beneficial to 
success in all aspects of drawing, especially when exchanging data between 
clients.  Communication between drawing file users is mandatory.

Many translation problems can be prevented by substituting or avoiding 
certain types of objects. It helps to know when drawing is destined to 
be translated so substitutions can be made during a drawing’s initial 
construction.  If that is not possible then editing the file before translation, 
using the wide range of features in PowerCADD, is possible and may be 
necessary to ensure the best possible translation result.

The information presented is applicable to most any .dxf or .dwg file created 
with many programs.  If AutoCAD will not open the file, there is a good 
chance the Translator will not either.

Translator Reference 
Guide
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Whether you use the Translator External to read files on a daily basis or once 
a month, you should read this entire guide at least once.  It will help you 
respond more quickly to problems and ask the right questions.

While the most common use for this guide will be a trouble-shooting 
reference, you could also use it as a translation checklist.  

Before you send a file to a client, check off each item in the appropriate 
section.  

If you receive a drawing that is difficult to translate, check off the possible 
problems.  If all else fails, call your client and use the guide to ask questions. 
Communicate!

The guide has two main sections:
o	 PowerCADD to dwg & dxf
o	 dwg & dxf to PowerCADD

Each main section is separated into smaller divisions that address specific 
commands, objects, and ideas. Each division is listed in the table of contents 
for quick referencing.

Using This Guide
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PowerCADD to .dwg and .dxf
The following information is applicable to sending files created in 
PowerCADD to other CAD programs running on a Windows-based 
personal computer.  With the exception of DOS file naming conventions, 
and a few minor changes, opening a .dwg or .dxf file in other applications 
on an Apple or Windows operating system are similar to those described 
here.  Please reference the documentation for the other applications or 
operating systems for additional information.

File Names DOS is very specific about file names. Spaces are not allowed.  When 
naming your file for a DOS-based system, use up to eight characters or 
numbers.  The Translator External will add a period (.) and the 3-digit file 
extension, .dxf or .dwg, automatically when saving. For example: 

FILENAME.dwg

While the Windows Operating System does support longer file names, it 
still requires a 3-digit file extension.  As a general guide, avoid the use of 
special characters in file names, as those may not translate correctly between 
all operating systems.

Scale PowerCADD handles scale differently than Windows programs.  

For example, some programs will allow you to draw a large commercial 
building site at full scale with a paper size measured in acres rather than 
inches.  The user then creates a paper space layout with a scale assigned for 
printing.  

PowerCADD scales a drawing for use on standard drafting paper sizes, just 
like manual drafting.  

A drawing that leaves PowerCADD at 1:48 scale (1/4”=1’0) will arrive in 
Windows programs at full scale 1” = 1”.
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Text styles and fonts set up in PowerCADD will become the standard text 
style in other programs.  All PowerCADD text, whether caption or multiple 
lines will become single line text when translated into .dwg.  

If you are sending text content that will not be edited (or should not be 
edited) and want to retain your exact look and feel, you might consider 
PowerCADD Convert to Outlines menu item.  Convert to Outlines can 
convert your text content to Bézier curve outlines. While the content cannot 
be edited as text, it will retain the precise look and feel. A practical use for 
Convert to Outlines might be for a company logo in a drawing title block.  

Caption text in PowerCADD (single line text) will be single lines of text 
when translated via .dwg or .dxf.  Paragraph text in PowerCADD will 
map to a single text block when translated.  In general the following font 
mapping is used when reading and writing .dwg or .dxf files (PowerCADD 
Font/Windows Font):

Geneva/Arial
Courier/Courier New

Times/Times New Roman
Helvetica/Helvetica

Arial/Arial
Times New Roman/Times New Roman

Georgia/Georgia
Arial Black/Arial Black

Impact/Impact
Verdana/Verdana12
Tahoma/Tahoma
Palatino/Palatino.

Font styles of regular bold, italic, and underline are supported for the above-
noted fonts.

Text and Fonts
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Macintosh fill patterns do not translate.  There is no such thing as a fill 
pattern in AutoCAD.  Convert all fill patterns to hatch patterns.

Fill Patterns

Line Types and Pen Fills Macintosh pen patterns do not translate. Convert all pen patterns to solid 
or dashed lines before translating.  By default, all objects with pen patterns 
are converted to solid during the translation process.  Dash patterns on a 
line with pen patterns are retained.

Pen Widths

Symbols

Groups

Pen widths do not translate as WYSIWYG line weights; they will become 
the default pen width. 

Symbols created in PowerCADD will translate as a block, which is simply 
a group of objects. The block name will assume the PowerCADD symbol’s 
name. If your symbols used additional Symbol Tag fields, that data is 
ignored when saved as .dxf or .dwg.

Grouped objects created in PowerCADD will translate as an unnamed 
block.

Attributes Object attributes such as opacity, shadows, fill or pen pattern, fill or pen 
color do not translate.
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Here are a few tips on sending files:
o	 If you are sending files on a CD-ROM to be used in the Windows 

operating system, format the CD to be used on that system.  Some third-
party CD Burning software requires you choose that option separately.  
If you are burning the CD using the MacOS built-in burning software 
the CD is automatically burned in a format supported by both the 
MacOS and Windows.

o	 Always compress files before sending them by email as this protects 
the file from possible data corruption during the email encoding and 
decoding process. 

	 Use third-party applications such as ZipIt, DropZIP, or the MacOS 
Create Archive command. PC users will generally not be able to read 
files compressed in formats other than zipped (*.zip).  

	 If you are sending files to another Macintosh user, you may use either 
the MacOS Create Archive command to create a zipped archive (*.zip) 
or a third party utility such as Stuffit to create a Stuffit Archive (*.sit or 
*.sitx).  

	 If you are using a Stuffit Archive the recipient must have Stuffit 
Expander installed which is not common on all systems.  

	 For ease of coordination, it is typically easiest to use a *.zip archive 
created with the MacOS Create Archive menu item as it can be read 
natively by PC and MacOS users alike.

 
o	 Be sure your files have a valid file extension at the end of the name such 

as: FLOORPLN.dwg or FLOORPLN.dwg.

	 If the file was zipped, it would have a .ZIP extension.  The file should 
have ONLY ONE file extension and only one ‘dot’ (.) in the file name.  

	 For example, FILENAME.dwg.ZIP is INCORRECT and should be 
changed to FILENAME.ZIP.

o	 Ask the person receiving the .dwg or .dxf file what version of software 
they are using to find out what version their application can read.  
When saving your PowerCADD file as .dwg or .dxf, click Options in 
the dialog and choose the appropriate version from the list.

Sending DXF or 
.dwg files created in 

PowerCADD for use in 
other applications

👍👍❤ !
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Dxf and dwg do not support bit images.  

If you have important bit-imaged shapes in the PowerCADD file, trace or 
redraw them with lines and B-Spline or Bézier curves.  

This will create a polygon, which will translate as polylines.  

If it is critical your bit image be part of the file, you can send them as 
separate attachments along with the .dxf or .dwg file. 

The receiver will then need to use the Insert command to bring your bit 
images into the drawing. 

Opening the .dxf File 
in AutoCAD

Bit Images

DXF is imported using the DXFIN command, which can be full or partial.  

A full DXFIN will load all definitions, layer information, block references, 
etc. along with the entities.  

In order to get a full DXFIN, the user must load into a new (generic or 
empty prototype) drawing. 

A partial DXFIN is one that is loaded into an existing drawing.  Incoming 
data like block definitions and layer information will be ignored and 
overridden by the current drawing’s definitions.  Only entities will import. 

When a full DXFIN is opened into an existing drawing or a modified 
default drawing, an error message will state: “Not a new drawing, only 
Entities section will be input.”

AutoCAD Error: “Not a new 
drawing, only Entities section 

will be input.”

General Make sure you send a clean drawing.  Delete objects that are off the drawing 
page, using PowerCADD’s Cleanup Drawing menu item.  Convert any 
smashed polygons, arcs, circles, and curves back to one-piece polygons with 
Attach.  Delete stray marks that may appear outside of the main drawing’s 
border.
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Following are recommendations for coordination when requesting files for 
use in PowerCADD.  Take the time to discuss and test the translation process 
prior to a deadline to establish the specific process for a given project.

o	 Request a printed hard copy or Adobe Acrobat PDF file of the drawing 
sheets you will be translating. This will assist you in setting up the 
correct drawing scale, units and sheet size when reading the file into 
PowerCADD.

o	 Given the choice between .dwg or .dxf files, request .dwg.  Using .dwg 
is easier for both you and the Windows user as it requires fewer steps 
for them in preparing the files and retains more drawing information 
resulting in a better translation.  If .dxf is the only file type available, 
make sure the user exports the file using the DXFOUT command as 
an ASCII (not binary) file with an accuracy of 6 decimal places (the 
default).  PowerCADD and other Macintosh applications cannot read 
Windows binary data.

o	 Have the user create a Paper Space Layout containing the data you 
need in PowerCADD.  This includes the sheet size, printed drawing 
scale (your PowerCADD drawing scale) and visible layers.  Typically 
most Windows users already create paper space layouts for their various 
drawing sheets, but if you don’t see one in the printed hard copy as 
noted in item 1 above then ask for what you need.  The process of 
creating the layout is a common task and one that will take only a few 
moments for them.

o	 Make sure they package together all the X-refs (referenced) drawings 
along with the main (master) file.  It is common practice to use one 
master drawing with multiple referenced drawings, but if information 
you received does not have all the referenced content the translation 
will be incomplete.

o	 If it is important to maintain precise font formatting, use one of the 
standard supported fonts as outlined earlier in this section.

o	 If the drawing is being issued via email, make sure they zip (compress) 
the file before attaching it to the email message.  They should NOT 
create a self-extracting archive (*.EXE) as you will not be able to extract 
that content without using the Windows Operating System.  If the 
files are being issued on CD or DVD discs compressing them is not 
required.

o	 If the drawing is be issued on a CD or DVD disc, no special steps are 
necessary on the part of the Windows user.  Your Macintosh can read a 
Windows formatted CD or DVD.

Tips when requesting 
Windows files for use in 

PowerCADD
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Keep these tips in mind when receiving the .dxf or .dwg files. 
o	 Copy the file(s) from the CD-ROM disc to your hard disk.  Do not try 

to translate the file directly from the disc.
o	 If the files are compressed (with a “.Zip” extension in the name) 

decompress them with ZipIt, Stuffit Deluxe or another compression 
program that reads ZIP files.  In MacOS, double-click the zip file to 
automatically extract its contents.

o	 Open the file from the File menu in PowerCADD or drag and 
drop the file onto the PowerCADD application icon in your Dock 
or in the PowerCADD application folder.  If you have not specified 
PowerCADD as the default application to open .dwg or .dxf files in 
MacOS, double-clicking the file in the Finder may open the file in 
another application.  Reference the MacOS help files to learn how to 
change the application that opens a document.

o	 If you can’t open the file in PowerCADD, try opening the file with a 
word-processing application to make sure it is a valid .dwg file.  The 
first entry in a valid .dwg file will have something similar to “AC1018” 
as the first entry.  This refers to the version number used to create the 
file so the actual numbers shown in your example may vary from what 
you see.  However, it will always begin with ‘AC####’.  If you don’t see 
that, then check with the original file author to determine just what 
type of file was sent. 

o	 If the file was received via email, make sure it was compressed first.  It is 
not uncommon for uncompressed files to become damaged when sent 
as email attachments.  If the sender is using the Windows operating 
system have them use WinZIP to create a zip archive (filename.zip).  If 
the sender is using a Macintosh operating system have them create a 
zip (filename.zip) or Stuffit archive (filename.sit).

o	 Make sure you have all the X-ref (referenced) drawings and any special 
fonts you might need.  Please reference “Tips for requesting Windows 
files for use in PowerCADD” discussed earlier in this section.

Tips for opening 
Windows files in 

PowerCADD
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The following information is applicable to opening .dxf or .dwg files in 
PowerCADD. 

.dwg or .dxf to 
PowerCADD

Limits and Extents

Unusually Large Limits

External References (Xrefs)

Scale Basics

It is possible to receive a drawing whose Limits are much larger than its 
Extents. Limits can also be smaller than Extents.  This tends to be confusing 
and for good reason.

The textbook method of setting Limits is to set them slightly larger than the 
objects drawn to accommodate a border and title block.  If the Limits are 
huge compared to the actual object boundary, it is possible the drawing you 
received is a small part of a much larger drawing.

By creating Xrefs, users can work on many different parts of the same 
drawing simultaneously.  Each time the Xref ’s source drawing is updated, it 
appears in each of the group member’s Xrefs.  This allows members of the 
design team to make corrections on their part of the drawing during the 
initial design phase.  In principle, this is similar to using References in your 
PowerCADD drawings. 

NOTE: Some attribute information may come through in the translation, 
if it was actually visible on the drawing itself.  It will appear as text, usually 
near the object it represents, but it will not be linked to the object as an 
attribute.  Make sure you request all Xrefs form the original file author to 
ensure a complete translation.

💬💬

Look at the Architectural scale 1/4” = 1’0”.  It says each 1/4 inch of the 
drawing represents one foot of the actual size of the building at the site.  You 
can also say that one inch of the drawing represents four feet of the real size 
of the building because 4 x 1/4” = 1”. 

Now, four feet is equal to 48 inches, so you can say one inch of  the drawing 
represents 48 inches of  the real size of  the building, or 1:48 scale.  These 
are the two most common ways of  representing one of  the many scales 
used in drafting, 1/4” = 1’0” and 1:48.
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Drawing scale is a difficult concept for many CAD users, especially those 
who have not done much manual drafting.  PowerCADD drafts on the 
Macintosh very similarly to the way you draw on a drafting board, in a 
reduced scale, so it will fit on a standard sheet of paper.  

Both manual drafting and PowerCADD require paper and rulers, and both 
will produce a scaled-down drawing when printed.  

For example, if you are creating a house plan in PowerCADD in 1/4” = 
1’0”, you would first get out a sheet of paper (Page Setup) and then your 
architect’s ruler or scale (Drawing Setup).  

The next item needed is your pencil (Line Tools).  

When completed, a builder will take your scaled drawing to the building 
site and produce a real, life-sized model.  

Each 1/4” on the drawing will equal 1’0” at the building site.  The builder 
will read your scaled drawing in real life numbers, or real world coordinates.

PowerCADD 
Drawing Scale

Windows 
Drawing Scale

Windows handles drawing scale opposite of manual drafting.  

For example, when you set a sheet of paper (set Drawing Limits), you are 
choosing a sheet of paper in full scale, or the actual size of the building site. 

Drawing is like going to the building site with a long tape measure and 
really big pencil and laying out the house plan in the dirt, one foot equals 
one foot.  

Drawings are stored on disk this way in World Coordinates.  Only when 
it is time to plot, on standard-sized drafting paper, do you apply a reduced 
scale to the drawing.  

It is the lack of scaling that can be confusing when trying to set the scale of 
an incoming file. 

Many of  the other CAD programs also draw in full scale, but may use 
different terminology to describe it.
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When opening drawings in Model Space, the Translator External treats the 
incoming drawing coordinates as FULL SCALE INCHES.  For example, 
if the user typed in 10’6” while drawing a line, that line would appear as 
126.0 in the file.

NOTE: There are some rare conditions where the scale of a translated 
drawing may appear to be off by a factor of twelve, which is easy to correct.  
Choose Drawing Setup from the Layout menu.  Multiply the scale by 12 
and type that into the scale text field.  For example, if you specified 1:40 
scale in the translation dialog, you should now specify 40 x 12 or 480.  
Alternately, you may perform the math in the dialog by typing the scale as 
40*12.

Scale Information 
Received

Paper Space

Rel. 9 or Earlier

Text/Fonts

Blocks

Identifying Solid 
Hatches

💬💬

Paper space allows you to plot different views of the same drawing, at 
different scales all at once.  The plotted end result looks like several different 
drawings on one sheet.  On disk, it appears as one drawing file.  The 
Translator will show you any paper space layouts in the translation preview 
window.  Select the desired paper space layout to translate the file.

The Translator External may not read .dxf or .dwg files correctly if created 
with versions before Rel. 9.

Because the Macintosh handles text and fonts differently from Windows, 
any non-proportional text will appear as normal text in PowerCADD.  Text 
aligned or fitted to the starting and ending points will be left justified only 
from the starting point.

Blocks will translate as PowerCADD groups.  The block names will be 
translated and can be read and printed with the PowerCADD’s Symbol 
Report.  Unnamed blocks will appear as grouped objects.  Write Blocks, 
Wblocks as they are called, will be treated only as blocks.

Once the drawing is in PowerCADD, look for arrowheads used in section 
details, North indicators, and dimensions or leaders.  If you spot any object 
that appears to have a solid fill, select it and try to ungroup it a couple of 
times.  You may see the handles of several hundred lines appear. 
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To convert solid hatches to fills:
o	 Open the drawing in PowerCADD.
o	 Delete all of the lines that created the filled area.
o	 Use Attach to create a polygon from the hatch’s border.
o	 Use a PowerCADD fill pattern to refill the object. 

3D Objects

Conclusion

References

Converting 
Solid Hatches to 

PowerCADD Fills

True 3D objects, meshes, and solid models are not supported in 
PowerCADD.  If the file being translated contained 3D data, the last saved 
view will be translated as a 2D view in PowerCADD.

This reference makes no attempt to give all of the comparisons, nor can 
it address every single situation when translating .dxf and .dwg files.  It 
does provide information about these programs you can utilize when 
communicating via .dwg and .dxf file exchanges.  We hope the guide will 
help you avoid problems.  Knowing something about how your clients’ files 
originate will save time, effort, and aggravation.  Plan and communicate.

AutoDesk, Inc. (1990) AutoCAD v.10, 11, 12 Reference Manuals

Kurland, D. (1991) “DXFIX.” AutoDesk, Inc.

Raker, D. & Rice, H (1991) Inside AutoCAD. Gresham. Oregon: New 
Riders
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No, there is no equivalent to bit image fills. 

Frequently Asked Questions
Will using .dwg instead of .dxf 

retain my fill patterns?

Why do my fonts change when 
sending a .dwg file?

Is there any way to create a 
drawing without the use of 

clipping?

What I can do to improve the 
performance of translating?

My curved arrowheads seem straight 
in Windows, what happened?

Will Layer Scales be preserved?

Why do my layer names change 
after the conversion to .dwg?

Text is mapping to a single character type, but the bounds of the text should 
be correct.  Caption text in PowerCADD (single line text) will be single lines 
of text when translated via .dwg or .dxf. Paragraph text in PowerCADD will 
map to a single text block when translated.  In general the following font 
mapping is used when reading and writing .dwg or .dxf files (PowerCADD 
Font/Windows Font):

Geneva/Arial
Courier/Courier New

Times/Times New Roman
Helvetica/Helvetica

Arial/Arial
Times New Roman/Times New Roman

Georgia/Georgia
Arial Black/Arial Black

Impact/Impact
Verdana/Verdana12
Tahoma/Tahoma
Palatino/Palatino

Font styles of regular bold, italic, and underline are supported for the above 
noted fonts.

Absolutely. Using the various trim, clipping and break tools or smart tools 
such as the parallel line, door and window tools that automatically cut and 
heal lines are options to consider when creating your PowerCADD drawing.

Ungrouping objects will significantly improve the performance, sometimes 
as much as 6X.

There is no object for curved arrowheads in AutoCAD, and they are turned 
into polylines, which are straight.

The case of layer names is changed to all UPPERCASE

No. The drawing will have the scale selected in drawing setup applied.
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About PowerCADD222
Absolute Moves487
Accuracy114,482,526
accuracy, conversion299
Active Layer353
Adding Text to a Line of Existing Text29
Advanced Caption Text35,36,38
Advanced Paragraph Text39,43
Advanced Paragraph Text Edit Window39
Advanced Text Edit Window Contextual Menus46
Advanced Text tool43
Advanced Text Tool34
Align338
Align...339
Alignment44
Align Menu342
Align to Grid339
All Layers461
Alpha Channel250,252
Anchor Points94
Anchor Window470
Angle & Length Moves489
Angle Preferences386
Apply Bitmap Effect316
Arc by Chord Tool80
Arc by Diameter Tool79
Arcs and Objects346
Arc Tools77
Arc Trim/Extend Tool148
Area Accuracy315,385
Area Units315
Arrange Menu331
Arrow Menu405
Arrow Position481
Arrow Styles434
At Mouse275
At Scale275
At Scale Text275
Attach308,309

Anchor
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Attach Tool131
Attribute Menu403
Attributes, Assigning140,143
attributes, default5
Attribute Styles414
Attributes Window471,474
Auto Alpha320
AutoCAD

scale540
versions translated538

auto-fade3
Auto-Fade4,351,469
Autoscroll10,31
AutoScrolling57,97

B

Background Color232
Baseline41
Base Line Dimension Tool105
Béziers93
Bézier Tool91
Bind To Drawing462
Bisecting Lines526
Bit Image Symbols528
Bitmap Effect Tool167
Bitmap Image files250
Bitmap Resolution319
Bitmap Transformation Tool169
Black Background395
Blending Colors161
Blending Shapes160
Blend Objects Tool160
Blocks568
Blossom220
Break152
Breaking a Curve95
Breaking Curves and Polygons151
Break Tool150
Bridge Distance308
Bring Forward333
Bring to Front332

C

Cell Borders and Backgrounds44
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Centerline Tool120,190
Chain Dimension Tool103
Chamfer Tool158
Change Palette Orientation2
Changing the Appearance of Text in a Drawing30
Circle and Ellipse Tools71
Circular duplication281
Clear277
Clearing All Recent Items251
Clearing Selected Recent Items251
Click-Click238
Click-Drag238
Clip Tool164
Close262
Close Polygon305
Closing a Curve95
Color Edit dialog425
Color Menu425
Color palette426
Color Panel45,320,429
Columns44
Combine Tool165
Command Key524
Command keys379
Command Keys236
Commands Preferences233
complex polygon314
Constrained Angles390
Constrained Ellipse Tool75
Constrained Rectangle Tool67
Construction Lines232
Contextual Menus215
Continuous Line Tool61
Control Points94
Convert Outlines442
Convert to Bézier302
Convert to Béziers308
Convert to Lines298
Convert to Object411
Convert to Objects301
Convert to Polygon300
Convert to Polygons:308
Copy42,273
Copy/Pasting Objects358
Cropping261
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Current Zoom507
Custom Command Keys237
Custom Palette378,428,429
Cut273
Cut At Intersection147
Cut with Line311

D

Dash Menu406,435
Dash Styles437
Date Stamp Tool56
Deep Zoom5
default attributes5
Defaults Window475
Delete an Object18
Delete View401
Deleting Characters from Existing Text30
Deleting Text From a Drawing31
Deselect All285
Deselect All Objects14
Diameter Circle Tool71
Diametrical Dimension Tool109
Differences Between Advanced Text and Regular Text35
Dimension Defaults113,116
Dimension Edit Dialog117
Dimensioning Tools97
Dimension Line Tool99
Dimensions Preferences387
Dimensions tab52
Dimension text98
Dimension Text480
Dimension Window118,479
Display Accuracy Specified231
Display Selection400
Distribute Points304
Door Insertion tool126
Door Insertion Tool199
DPI255
Draftsight544
Drag Distance238
Draw by Center58
Drawing Béziers92
Drawing Origin106
Drawing Profile223
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Drawing Rulers Contextual Menu216
Drawing scale567
Drawing Setup381
Drawing Setup dialog291
Drawing Size382
Drawing Tools57
Drawing Window Contextual Menu215
Drilled Hole Tool193
Duplicate278
duplicate an object15
duplicate an object while moving it24
Duplicate an Object While You Move It16
Duplicate Objects329
dwg251
DWG360
DXF251,360
Dynamic Snap Indicator505
Dynamic Snapping57,97

E

Edit All Layer322,542
Edit All Layers9,13,138,141,144,166,171,283,285,295,311,325,328,333,334,350,359,364,464,506
edit a text block287
Edit Group145,286
Editing Advanced Text46
Editing an Existing Table45
Editing an Object Using the Edit Window58
Editing an Object Using the Mouse58
Editing Existing Notation Text209
Editing Rotated Ellipses346
Editing Rotated Text30,525
Edit Menu271
Edit Text Window32,33
Edit Window28,29,48,57,58,68,76,84,141,144,483
Ellipse Tools75
Elliptical Arc Tool81
Empty Text Blocks329
Enable Tool Tips240
End Caps Menu407
EPSF250,260,301
Estimated Memory255
Exit Groups286
Export253
Exposé236
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External Tool Palettes189
Eyedropper Tool153

F

Face Dimension Tool102
Fall Out on Shift Click240
Fence Cut tool276
Fence Cut Tool170
File Menu243
Fill Color418
Fill Color Menu417
Fillet157
Fillet Polygon306
Fillet Tool155
Fill Menu408
Find445
Find Again446
Find/Replace37
Fit Bézier304
Fit to Page268
Flip Horizontal348
Flipping Symbols127
Flip Vertical348
Flip Vertical Axis394
Floating Windows468
Font448
Font Panel37
Font, Replace447
Font Size449
Font Style450
Formatted Text from Other Applications42,45
Four-Point Angular Dimension Tool111
Fractions482
Freehand Bézier Tool90
Freehand Tool88

G

General Preferences223
Get Object Attr283
Global Attributes224,225,226,408,438
Global Origin396
Go To Layer333
Gradient Fill Tool161
Gradients174
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Gradient tool175
Gradient Tool173
Graphic Export External254
Gray Pattern for Dimmed or Transparent Layers268
Greek Text233
Grid Behind Objects230
Gridlines393
Grid Spacing385
Group334
groups126
Groups and Symbols126,141,144
Groups and Text Objects171
Guidegrids377
Guidelines145,374,394
Guidelines In Front231

H

Handle Size232
Harden Hatches411
Hatch410,412,438,441
Hatch Menu410
Hatch Origin413
Hatch Rotation Angle413
Hatch Scale413
Hatch Settings Menu411
Heal/Join Tool187
Help button269
Help Menu515
Hex Bolt Tool196
Hex Nut Tool197
Hide336
Hide Invisible365
Hide Others242
Hide PowerCADD242
Hide Reshape Fill230
Hierarchical Font Menu224
Hilite Color232
Hilite Selection232
Hollow Line Handles230
Horizontal Alignment341
Hybrid Click-Click238

I

Import252
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Import DXF544
Indents41

J

JPEG252
justification54
Justification41

K

Kerning40
keyboard shortcuts215

L

Layer...349
Layer Attribute355
Layer Attributes461
Layer Buttons362
Layer Color In Name231
Layering Tips366
Layer List352
layer opacity361
Layer Scale358,359
Layers Window231,485
Layer Tools372,373
Layer Window332,464
Layout Menu349
leader object text51
Leader Position480
Leader Text52
Leader Tool49
Legacy PowerCADD Drawings and Symbol Libraries250
Ligature39
Linear Dimensioning Tools99
Linear duplication279
Line Scroll232
Line Tool59
Line Trim/Extend Tool145
Line Weight430
Line Weights276
Lists41
Live Area315
Loader Preferences241
Local Origin395
Location393
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Lock335
Locked Objects335,336
Locking/Unlocking Layers356
Log Preferences398
Long Break Tool121
Long Crosshair240
Lowercase451

M

Magic Wand Tool9,23
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